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Preface

Intended Audience

Welcome to Release 11i of the Oracle Incentive Compensation Implementation
Guide.

This guide assumes you have a working knowledge of the following:

The principles and customary practices of your business area.
Incentive Compensation

If you have never used Oracle Incentive Compensation, Oracle suggests you
attend one or more of the Oracle Incentive Compensation training classes
available through Oracle University.

The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications
product information.

How To Use This Guide

This document contains the information you need to understand and use Oracle
Incentive Compensation.

Chapter 1 is an introduction that covers general features, lists new features in
this release, and discusses the HTML user interface.

Chapter 2 lists steps to perform before implementation and also dependency
requirements.

xiii



= Chapter 3 presents an overview of the implementation steps in table format.

= Chapter 4 comprises the main body of the document, with the implementation
steps detailed step by step.

= Chapter 5 contains verification information.
s Chapter 6 contains troubleshooting information.

»  Chapter 7 discusses integration between Oracle Incentive Compensation and
other Oracle products.

s The Glossary defines the most important terms used in the document.
= The Index supplies quick access to specific topics in the document.

= Appendix A contains a detailed listing of flexfields used in Oracle Incentive
Compensation.

= Appendix B presents the lookups used in Oracle Incentive Compensation,
updated for this latest version of the product.

= Appendix C details the profile options used in this release of Oracle Incentive
Compensation.

= Appendix D presents a useful road map that compares the navigation in earlier
versions of the application, which was primarily in Forms, to the latest release,
which uses an HTML user interface.

= Appendix E shows the different responsibilities used in Oracle Incentive
Compensation and the access each responsibility has to the tabs in the
application.

Documentation Accessibility

Xiv

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with other
market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/.



Accessibility of Code Examples in Documentation JAWS, a Windows screen
reader, may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, JAWS may not always read a line of text that
consists solely of a bracket or brace.

Other Information Sources

You can choose from many sources of information, including online documentation,
training, and support services, to increase your knowledge and understanding of
Oracle Incentive Compensation.

If this guide refers you to other Oracle Applications documentation, use only the
Release 11i versions of those guides.

Online Documentation

All Oracle Applications documentation is available online (HTML or PDF). Online
help patches are available on MetaLink.

Related Documentation

Oracle Incentive Compensation shares business and setup information with other
Oracle Applications products. Therefore, you may want to refer to other product
documentation when you set up and use Oracle Incentive Compensation.

You can read the documents online by choosing Library from the expandable menu
on your HTML help window, by reading from the Oracle Applications Document
Library CD included in your media pack, or by using a Web browser with a URL
that your system administrator provides.

If you require printed guides, you can purchase them from at
http:/ /oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate using the
graphical user interface (GUI) available with this release of Oracle Incentive
Compensation (and any other Oracle Applications products). This guide also
includes information on setting user profiles, as well as running and reviewing
reports and concurrent processes.
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You can access this user’s guide online by choosing “Getting Started with Oracle
Applications” from any Oracle Applications help file.

Documents Related to This Product

Oracle Incentive Compensation Concepts and Procedures

This guide contains two sections. The first, Understanding, explains the basic
functions of the application. The second section, Using, contains the text of the
online help for Oracle Incentive Compensation.

Oracle Incentive Compensation Technical Reference Manual

Use this manual to obtain the specific technical details used in setting up Oracle
Incentive Compensation.

Installation and System Administration

Oracle Applications Concepts

This guide provides an introduction to the concepts, features, technology stack,
architecture, and terminology for Oracle Applications Release 11i. It provides a
useful first book to read before an installation of Oracle Applications. This guide
also introduces the concepts behind Applications-wide features such as Business
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Release 117, much of the installation process is handled
using Oracle Rapid Install, which minimizes the time to install Oracle Applications,
the Oracle8 technology stack, and the Oracle8i Server technology stack by
automating many of the required steps. This guide contains instructions for using
Oracle Rapid Install and lists the tasks you need to perform to finish your
installation. You should use this guide in conjunction with individual product
user’s guides and implementation guides.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Release 11i. This guide describes the upgrade process and
lists database and product-specific upgrade tasks. You must be either at Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i.
You cannot upgrade to Release 11 directly from releases prior to 10.7.



Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle Applications
System Administrator. It contains information on how to define security, customize
menus and online help, and manage concurrent processing.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle Applications
development staff. It describes the Oracle Application Object Library components
needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Other Implementation Documentation

Oracle Workflow Administrator's Guide

This guide explains how to complete the setup steps necessary for any Oracle
Applications product that includes workflow-enabled processes, as well as how to
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide

This guide explains how to define new workflow business processes and customize
existing Oracle Applications-embedded workflow processes. It also describes how
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide

This guide describes how Oracle Applications users can view and respond to
workflow notifications and monitor the progress of their workflow processes.

Oracle Workflow APl Reference

This guide describes the APIs provided for developers and administrators to access
Oracle Workflow.

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup and reference information for the
Oracle Incentive Compensation implementation team, as well as for users
responsible for the ongoing maintenance of Oracle Applications product data. This
manual also provides information on creating custom reports on flexfields data.
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Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams and a
detailed description of database tables, forms, reports, and programs for a specific
Oracle Applications product. This information helps you convert data from your
existing applications, integrate Oracle Applications data with non-Oracle
applications, and write custom reports for Oracle Applications products. Oracle
e€TRM is available on Metalink.

Oracle CRM Application Foundation Implementation Guide

Many CRM products use components from CRM Application Foundation. Use this
guide to correctly implement CRM Application Foundation.

Training and Support

Training

Oracle offers training courses to help you and your staff master Oracle Incentive
Compensation and reach full productivity quickly. You have a choice of educational
environments. You can attend courses offered by Oracle University at any one of
our many Education Centers, you can arrange for our trainers to teach at your
facility, or you can use Oracle Learning Network (OLN), Oracle University’s online
education utility. In addition, Oracle training professionals can tailor standard
courses or develop custom courses to meet your needs. For example, you may want
to use your organization’s structure, terminology, and data as examples in a
customized training session delivered at your own facility.

Support

From on-site support to central support, our team of experienced professionals
provides the help and information you need to keep Oracle Incentive
Compensation working for you. This team includes your Technical Representative,
Account Manager, and Oracle’s large staff of consultants and support specialists
with expertise in your business area, managing an Oracle8i server, and your
hardware and software environment.

OracleMetalLink

OracleMetaLink is your self-service support connection with web, telephone menu,
and e-mail alternatives. Oracle supplies these technologies for your convenience,
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain
information and advice from technical libraries and forums, download patches,



download the latest documentation, look at bug details, and create or update TARs.
To use OracleMetaLink, register at (http:/ /metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows:
Technical Libraries/ERP Applications/Applications Installation and
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the
Self-Service Toolkit page as follows: Technical Libraries/ERP
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using
Oracle Applications can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps
track of who changes information. If you enter information into database tables
using database tools, you may store invalid information. You also lose the ability to
track who has changed your information because SQL*Plus and other database
tools do not keep a record of changes.

About Oracle

Oracle Corporation develops and markets an integrated line of software products
for database management, applications development, decision support, and office
automation, as well as Oracle Applications, an integrated suite of more than 160
software modules for financial management, supply chain management,
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manufacturing, project systems, human resources and customer relationship
management.

Oracle products are available for mainframes, minicomputers, personal computers,
network computers and personal digital assistants, allowing organizations to
integrate different computers, different operating systems, different networks, and
even different database management systems, into a single, unified computing and
information resource.

Oracle is the world’s leading supplier of software for information management, and
the world’s second largest software company. Oracle offers its database, tools, and
applications products, along with related consulting, education, and support
services, in over 145 countries around the world.
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Getting Started

This section of the Oracle Incentive Compensation Implementation Guide contains
the following chapters:

= Chapter 1, "Introduction”
= Chapter 2, "Before You Begin"






1

Introduction

This chapter provides information on the following topics:

Section 1.1, "The Oracle E-Business Suite"
Section 1.1.2, "Oracle Sales Family Overview"
Section 1.2, "Oracle Incentive Compensation Overview"

Section 1.3, "Navigation"

1.1 The Oracle E-Business Suite

The Oracle E-Business Suite is a comprehensive web-based answer for
business-to-business (B2B) and business-to-consumer (B2C) selling, marketing, and
servicing through the Internet. The Oracle E-Business Suite consists of front-office
Customer Relationship Management (CRM) applications and back-office Enterprise
Resource Planning (ERP) applications. These applications automate marketing,
sales, contracts, service, manufacturing, and supply chain processes as well as
financial operations, project management, human resources operations, and
business intelligence systems.

The Oracle E-Business Suite sits on a multi-layer platform which includes:

Oracle 9i Database
Oracle 9i Application Server
Common Services and Components

Oracle Internet Business Intelligence
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Oracle 9i Database

All applications reside on the Oracle9i Database. The Oracle database drives
enterprise E-Business applications, online transaction processing applications
(OLTP), query-intensive data warehouses, and high capacity web sites. Because the
Oracle database is available on many different platforms, applications can scale
from handheld to laptop to desktop to enterprise providing consistent information
over multiple channels.

Oracle 9i Application Server

The Oracle 9i Application Server (Oracle 9iAS) is a middle-tier server which
independently delivers the technology needed to build web sites and applications,
create personalized portals, extract business intelligence, and manage a secure web
site infrastructure.

Common Services and Components

All the applications can leverage the common infrastructure and services
components. Functionality includes Oracle Forms, Oracle Reports, Oracle
Application Object Library (AOL), the Oracle JDeveloper and Oracle Discoverer
development tools, the coding and Ul standards, and other functionality used by
the applications.

For example, you can extend the applications according to your business needs
using flexfields. You can create and assign responsibilities using the system
administrator responsibility. Also, you can use Oracle Workflow to configure
background processes and set up notifications so that all the appropriate managers
and groups are notified.

Oracle Internet Business Intelligence

Above the E-Business Suite sits the Internet Business Intelligence application. This
application integrate data from all of the E-Business Suite applications to provide
key performance measurements, operating alerts, and management reports to every
decision maker across the enterprise.

1.1.1 The Applications in the E-Business Suite

1-2

Customers can seamlessly share data from front-end applications (CRM) to backend
applications (ERP). The CRM applications include:

= the Marketing suite

s the Sales suite
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the Contracts suite
the Service suite

the eCommerce suite

The ERP applications include:

Oracle Order Management
Oracle Supply Chain Planning
Oracle Manufacturing

Oracle Financials

Oracle Human Resources Management System

Customer Relation Management (CRM)

Companies use Oracle’s CRM suite of applications to acquire, maintain, and
enhance customer relationships, by assisting companies with marketing
automation, sales force automation, contracts management, customer service and
support, and business intelligence, in a multi-channel environment.

The Marketing suite provides campaign planning and execution, budget
management, list creation, reporting and analysis tools. Marketing
professionals use the Oracle Marketing applications to drive quality leads to
sales, to expand reach and to maximize marketing effectiveness by using a
comprehensive set of marketing automation, analysis and multi-channel
execution capabilities. The Marketing suite offers seamless integration with
sales, service and operations.

The Sales suite provides integrated tools for all those who are involved in the
sales process, including field salespeople, telesales agents, distributors and
resellers, customers purchasing over the Internet and sales executives.

Armed with up-to-the minute information regarding customers, leads and
opportunities, as well as forecasts and compensation plans and projections,
managers can proactively and effectively manage a sales force while providing
the sales people with the information needed to close sales. Using this
information, the field sales force, telesales teams, resellers, and web storefronts
can collaborate in closing more business together as one sales team.

The Contracts suite enables authoring, executing and managing contracts,
warranties and extended warranties which provides visibility to contract
entitlements and proactively acting upon contractual commitments. Whether a
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buyer or a seller, issuing contracts or receiving them, the Contracts suite
automates the full contract life cycle.

The Service suite manages service activities with the goals of profitability,
employee productivity and complete customer satisfaction by addressing all
service and support activities from initial contact with the customer through
issue resolution. Automating service efforts can potentially transform an area
that has historically proven to be a cost center into a revenue generator.

This suite of applications provides customer support, field service and depot
repair functionality. In addition, Oracle Services offers complete visibility into
spare parts availability, logistics, service billing and customer contract
entitlements. Oracle Customer Care provides full access to customer
information from each touch point in the enterprise and to each customer care
agent or other employees who interact with the customer. All of the Service
products can be deployed across web, call center and mobile field channels.

The eCommerce suite of products aids in establishing profitable long-term
relationships with customers through one-to-one marketing and personalized
shopping experiences as well as proactive support and self-service capabilities.
Oracle eCommerce synchronizes all customer interactions and transactions by
integrating web-based channels with traditional channels.

Enterprise Resource Planning (ERP)

Companies use the ERP applications to control their back-office operations. For
example:

Oracle Order Management applications feature advanced configurator
functionality, global available to promise, flexible pricing support, efficient
delivery, high volume transactions and flexibility to adapt to changing business
conditions.

Oracle Supply Chain Planning applications provide the tools required to
optimize flow of material, cash, and information across the extended supply
chain.

Oracle Manufacturing applications support all styles of manufacturing -
engineer-to-order, discrete, process, flow, lot based, and project based
manufacturing.

Oracle Financials provide solutions for strategic planning, accounting, treasury,
project management, and travel management.
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= Oracle Human Resources Management System is a comprehensive solution for
managing a company’s human resources, allowing organizations to attract,
retain and develop critical skills and knowledge on a global basis.

Common Application Architecture

The Common Application Architecture includes functionality that supports both
CRM and ERP applications. For example, TCA, Oracle’s Trading Community
Architecture, consists of a database schema and Application Programming
Interfaces (APIs) where you can model the complex relationships that occur within
a business community and enter that data consistently throughout the enterprise.
Because the model is not hierarchical, Oracle applications can model complex
B2B2C relationships and not to be limited to either a B2B or B2C implementation.
TCA delivers a 360-degree view of the customer.

1.1.2 Oracle Sales Family Overview

Oracle Sales is a comprehensive family of tightly integrated applications to
maximize sales, increase selling effectiveness, and align sales behavior to corporate
objectives across all sales channels. Oracle Sales enables the field sales force,
telesales teams, resellers, partners, and web storefronts to collaborate in closing
more business together as one sales team. Oracle Sales enables companies to
implement flexible, customer-centric processes, not only to sell effectively and
increase revenue, but also to create and enhance long-term customer relationships.

The Oracle Sales Family includes:
= Sales Online
= Sales Offline
»  TeleSales
= Incentive Compensation
= Oracle Collections

= Sales Intelligence

1.2 Oracle Incentive Compensation Overview

Using Oracle Incentive Compensation you can automate the complex task of
calculating compensation and customize compensation to suit the unique
operations of your organization’s sales force.
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Because sales tasks vary greatly from one company to another, a compensation
system that produces windfall sales for one company might not suit another. Oracle
Incentive Compensation calculates and assigns compensation based on functions
that precisely mirror the operations of your sales organization.

Oracle Incentive Compensation enables you to perform a wide variety of different
functions.

You can define the structure of a compensation transaction, or the set of information
your sales organization needs to calculate incentive compensation. You specify the
data you need, and Oracle Incentive Compensation then collects this data for you
from the sources you specify.

You can categorize your business revenue into revenue classes that specify the
types of revenue that warrant compensation in your organization. Oracle Incentive
Compensation assigns a revenue class to a compensation transaction using a set of
classification conditions you define for each class. Oracle Incentive Compensation
only awards credit based on the revenue classes you assign to a resource’s
compensation plan, so you can pay a resource for certain revenue classes but not for
others.

You can define an unlimited number of compensation plans and assign them to
individuals or groups of resources. You can compensate many different kinds of
resources by mixing and matching compensation terms when you build each plan.

You can define how your organization tracks and pays incentive compensation.
You can specify how your organization typically makes adjustments.

You can view information about your resources and also make customizations to
their individual compensation plans. You can view a resource’s compensation
summary, compensation plan, sales roles, and compensation group. In addition,
you can assign pay groups and payment plans to customize the way a resource is
paid.

After you define precisely how your sales force operates, you can generate your
own customized version of the system from which to pay incentive compensation.
You can respond to changing sales strategies by making changes in your setup and
regenerating the system.

You can model different versions of compensation plans before you distribute them
to resources.

As a manager, you can systematically distribute your quota to the resources who
report to you directly. Your resources can accept their plans by using Oracle Sales
Online, after which you can approve the plans in Oracle Incentive Compensation.
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1.3 Navigation

1.3.1 HTML Navigation

Starting with the 11.5.6 release of Oracle Incentive Compensation 11i, an HTML
user interface replaced the Forms user interface used in previous releases.

This change improves integration of Oracle Incentive Compensation with other
Oracle products, and put it in line with the consistent look and feel of other HTML
based Oracle applications. Users upgrading from pre-11.5.6 releases of Oracle
Incentive Compensation will notice that the HTML interface reduces the number of
steps and drilldowns required to perform some functions. The Forms Navigator,
icons, "View By" drop-down lists, and hierarchies have been replaced by a row of
nine tabs, using subtabs and side panel menus to display finer levels of detail.

The HTML user interface uses five levels of navigation: global icons, tabs, subtabs,
and side panel menu (two levels). Most of the features in previous Forms versions
of Oracle Incentive Compensation have been converted, and are placed in different,
more logical locations. See Appendix D Road Map for a complete listing. In addition,
some data entry and organization has changed. In general, the HTML-based pages
are easier to use and require fewer drilldowns to complete a task.

For example, to see a listing of plan elements or to create new ones, navigate to the
Incentive tab > Element subtab. When navigating in HTML, place your cursor over
a tab or subtab, the arrow changes to a pointing hand. Click to go to the new page.

HTML pages provide links to other pages. Links are shown as underlined text. Use
a link the same way you use a tab or subtab:

1. Roll the cursor onto the link.
2. C(lick the left mouse button.
The new page appears.

In the previous version of Oracle Incentive Compensation, to view or create plan
elements you clicked the Compensation Plans icon, selected View By Plan Element,
and then opened a node in the Navigator. After opening a plan to view it, four tabs
appeared, for General information, Revenue Class, Formula, and Rate Tables. In the
HTML interface, formulas and rate tables are found on neighboring subtabs, along
with the calculation expressions used to create them. Revenue classes, which are
less frequently changed, now are placed on the Administration tab.

Many tabs and subtabs open with a brief search page. Enter search data in a field or
use a list of values, click Apply, and a summary page appears. Continue to search
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using the search button, or move to the next group of rows by clicking the drop
down list and then selecting a range. In some cases, you can click the Next or Last
links to see the following or final group of listing, or click the First or Previous links
to view the first or previous listings. If there are hundreds of items listed, the
drop-down lists enable easier selection.

HTML pages use a Quick Find search field, located at the top of the page just below
the subtabs. Each subtab has a Quick Find, with a drop down menus and an
Advanced Search link. Many pages provide a wildcard search and drop down
menus in the parameters area near the top of the page. A Go button is provided to
initiate searches of lists of values. Many of the pages that display tables use Update,
Restore, Create, and Clear buttons at the beginning and end of the display:

Update - Used to saving newly entered data

Restore - Returns the display to the original content before the last save

Create - Opens a new page on which to create new data

Clear - On a Create page, clears any data that has been entered prior to being saved

Listed below are the nine tabs in Oracle Incentive Compensation. Explanations of
each tab follow the list.

s Section 1.3.2, "The Home Tab"

s Section 1.3.3, "The Incentive Tab"

= Section 1.3.4, "The Modeling Tab"

s Section 1.3.5, "The Resource Tab"

s Section 1.3.5, "The Resource Tab"

s Section 1.3.6, "The Quota Tab"

s Section 1.3.7, "The Transaction Tab"

= Section 1.3.8, "The Requests Tab"

s Section 1.3.9, "The Product Tab"

s Section 1.3.10, "The Administration Tab"

1.3.2 The Home Tab

The Home tab is the starting point for using Oracle Incentive Compensation. The
text on it can be configured.

1-8 Oracle Incentive Compensation Implementation Guide



Navigation

1.3.3 The Incentive Tab

The Incentive tab is where compensation plans are built, viewed, and activated.
There are seven subtabs.

The first subtab, Agreement, is used in Incentive Planning. It opens to an
Agreements search page. Click the link in the Name column of search results to go
to the Sales Role Detail page, where you can define the agreement for the role.

The Activation subtab is where agreement definitions from Incentive Planning are
activated into the Commissions module of Oracle Incentive Compensation: Role
assignment, compensation plan assignment, plan element assignment, formula and
rate table assignment, and effective date assignment.

The Plan subtab is where you can assign plan elements and sales roles. Below the
subtab level you can view plan details, assign plan elements and sales roles, and
view the list of resources using the compensation plan.

The Element subtab is where you view and create plan elements. Drill down on a
plan element on the opening page to go to the Plan Element Details page, where
you can assign formulas and revenue classes.

The Formula subtab is where you create formulas from input expressions, output
expressions, and rate tables.

The Rate subtab is where you can create rate dimensions and rate tables, and define
commission rates.

The Expression subtab is where you create expressions to be used in formulas.

1.3.4 The Modeling Tab

The Modeling tab contains compensation planning and modeling features. A
compensation analyst can create different commission scenarios and compare the
commissions earned by each compensation plan. The most appropriate
compensation plan can then be activated for use with the commissions module.

The three subtabs in the Modeling tab are Agreement, Comparison, and
Performance. All three subtabs open to a search page and then display summary
pages that show various agreement versions.

The Agreement subtab is where the agreements are defined. Quota and on-target
earnings are also defined in the Agreement tab. Analysis of earnings payouts occurs
in the other two Modeling tab subtabs.

The Comparison tab displays in graphs and tabs the payouts earned in each version
of a plan.
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The Performance tab shows Estimated Achievement and Estimated Payout fields
along with other plan version information. The analyst must input a revenue
amount to evaluate what the commissions will be.

Agreement versions are created in the Agreement subtab and can be activated to
final agreements from the Comparison subtab or Performance subtab.

1.3.5 The Resource Tab

Use the Resource tab to manage information about resources. The Resource tab
contains four subtabs, including Planning, Resources, Role, and Group.

The Planning subtab is used by Incentive Planning and enables the assignment of
roles to resources for a specific group. It displays current assignments and allows
earnings to be customized as defined by the agreement to the role.

The Resources subtab displays all resource assignments such as roles, compensation
plan, plan elements, customized quotas and rates, pay groups, payment plans, and
compensation summaries.

The Role subtab is where you can search for a role and then assign compensation
plans to it.

The Group subtab enables a view of compensation groups to which a logged in user
is a member. It also displays details about those groups. Click a group name on the
Groups page, and then you can view details and a hierarchy by clicking links on a
side panel menu.

1.3.6 The Quota Tab

The Quota tab is where you use Incentive Planning to distribute quota from a sales
manager to directs and down to street level resources. The five subtabs are Allocate,
Approve, Distribute, Activate, and Report, which brings includes ten Incentive
Planning reports.

The Allocate subtab is where you allocate quota to resources. Sales projections can
be spread from top-to-bottom as the page displays managers and direct reports. The
manager’s ratio of his or her quota to the allocated quota of the reports is calculated
and displayed here.

The Approve subtab is where a quota, after it is allocated to a resource, becomes a
generated contract and is submitted to the contract approver for approval. The
approver receives notification that a contract has been submitted and must approve
or reject it.
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The Distribute subtab enables you to distribute approved contracts by using the
Distribute column.

The Activate subtab updates the quota and rates agreed upon by the resources and
moves it into the commission module of Oracle Incentive Compensation.

The Report subtab gives access to the ten Incentive Planning reports.

1.3.7 The Transaction Tab

The Transaction tab contains eight subtabs: Collect, Import/Export, Adjust, Load,
Calculate, Notification Log, Payment, and Report.

Use the Collect subtab to view past collection submission records or to submit
collection. The View Request Status page allows you to view the collection type,
phase and status of the transactions collected, with a default of All in each. On the
Submit Request page you can indicate a start period and end period, and submit a
request for a new collection. On the Runtime Parameters page you can narrow the
collection process by entering values for previously defined runtime parameters.

On the Import/Export subtab you can import data into Oracle Incentive
Compensation for hierarchies, classification rulesets, calculation expressions, and
revenue classes. You can export data from Oracle Incentive Compensation for
hierarchies and expressions.

Use the Adjust subtab to correct errors in transactions or adjust sales credit
assignment for transaction information in the CN_COMMISSION_HEADERS table.
You can create a new transaction or load a transaction from the first page of the
subtab.

Use the Load subtab to copy transactions from the Transaction Interface Table into
Oracle Incentive Compensation. This must be performed before calculation can take
place.

Use the Calculate subtab to run calculation processes. The opening page enables
you to select a batch name or create a new batch by clicking the Create button.

Use the Notification Log subtab to view the Notify Log. The Notify Log
automatically records every change in the system that affects calculation and lists
what part of the calculation must be rerun as a result of an event.

Use the Payment subtab to create or view information on a payrun. A payrun pays
members of a pay group for a particular pay period.

Use the Report subtab to refer to the eight Compensation reports.
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1.3.8 The Requests Tab

The Requests tab is where you can make concurrent requests to perform collection,
calculation, and payment. There are four subtabs: Collection, Transaction,
Calculation, and Payment. These subtabs have redundancy with pages on the
Transaction tab, particularly in the Collection and Calculation areas.

Use the Collection subtab to submit collections of clawbacks, invoices, orders,
payments givebacks, and custom transaction sources. Three subcategories include
View Request Status, Submit Request, and Runtime Parameter.

Use the Transaction subtab to identify all credit memos and payments that need to
be split. The two links on this page are View Request Status and Submit Request.

Use the Calculation subtab to run calculation processes. The opening page enables
you to select a batch name or create a new batch by clicking the Create button.

On the Payment subtab you can delete a payrun, create a worksheet, or pay a
payrun.

1.3.9 The Product Tab

The product tab is used to manage products and their price lists. In a connection to
Oracle Marketing, this tab is used to work with products or product bundles. Use of
the tab in Oracle Incentive Compensation is optional.

Functions include:

= Searching, creating, or viewing details for a product or a product bundle in
inventory

= Creating or viewing offers for a product or a product bundle

= Specifying products for a product bundle

= Modifying a product or product bundle

» Displaying, creating, or modifying price lists

»  Other activities relating to marketing products and product bundles

The Product tab is accessed through Oracle Marketing. See the section,
"Implementing the Product Tab" in the Oracle Marketing documentation.

1.3.10 The Administration Tab

The Administration tab is the home of many of the setup functions of Oracle
Incentive Compensation. Administration tab functions mostly are those that are
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provided when Oracle Incentive Compensation is implemented, but are
infrequently changed afterwards.

The Administration tab has multiple subtabs, including General, Marketing,
Partner, Sales, Incentive, and Collections, to enable administrative functions in
different Oracle products. The Incentive subtab is the one that applies to Oracle
Incentive Compensation.

Click the Incentive subtab to open a side panel menu with 22 selections. Their
primary functions are listed below:

Parameters - View and set System Parameters.

Tables - Define tables from Accounts Receivable, Order Management, or an external
source that are used in collecting and calculating transactions in Incentive
Compensation.

External Table - Map external tables to destination tables in Oracle Incentive
Compensation. Column mapping is performed here, too.

Accumulation Period - Change the status of accumulation periods.

Pay Periods - View essential information about pay periods that are set up for a
particular calendar.

Interval Types - View and define interval types.

Revenue Class - Create or remove revenue classes and assign expense codes and
liability codes.

Ruleset - Create and synchronize rulesets in the rules hierarchy.

Hierarchy - Display hierarchy types and create, remove, or edit them, and set the
effective date intervals.

Credit Type - Set credit types.
Credit Conversion - Set conversion rates between credit types.

Collection - Define and Maintain Collection setup. There are six subheadings within
this subtab, including Transaction Sources, Source Tables, Queries, Mapping,
Actions, and Generate.

Pay Group - View, create, or remove pay groups.

Payment Plan - View payment plan data, with check boxes to indicate if
compensation is recoverable or to be paid later.

Payroll - Map Oracle Incentive Compensation plan elements to Payroll Pay
Elements. Remove or deactivate elements, or map input values.
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Component - Display or remove Quota Components by name, description, type,
unit/revenue, and computed flag.

Attainment - Add, delete, or edit existing attainment schedules by defining the
specific levels of quota achievement.

Job Titles - Assign a Sales Role to a Job Title.

User Access - Set the access privilege of users with finance manager responsibility
only.

Settings - Set the Transaction Calendar and write Contract Text for a compensation
plan.

Seasonality - Set up a schedule to define the pattern of a product or service income
by period in the form of proportions expressed in percentages of the year’s total.

Rate Dimensions - View, edit, or create rate dimensions here that can be used when
building rate tables for formulas.
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Before You Begin

This chapter provides an overview of what you need to have installed,
implemented, and verified before implementing the Oracle Incentive
Compensation. Topics include:

Section 2.1, "Related Documentation”
Section 2.2, "Installation Verification"
Section 2.3, "Application Procedures"
Section 2.4, "Mandatory Dependencies"

Section 2.5, "Conditional Dependencies”

2.1 Related Documentation

See the Oracle Incentive Compensation User Guide and MetaLink.

2.2 Installation Verification

Create users and assign Oracle Incentive Compensation Super User responsibility
and System Administrator responsibility to one or more users. All implementation
of Oracle Incentive Compensation can be completed using these responsibilities.

2.3 Application Procedures

You must be able to complete each of the following non-CRM tasks successfully for
your CRM applications to work properly. If you are unable to complete a task

successfully, then correct the problem before continuing. The listed tasks are generic
tasks that are typical of all users of the Oracle E-Business Suite. Depending on your
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business processes, and the modules that you are installing, not every listed task is
applicable to your installation.

2.3.1 Creating an FND User

Perform the following steps to create a FND user in the Application Object Library.

Reference

Oracle Applications System Administrator’s Guide, See Chapter 2, Managing Oracle
Applications Security

Prerequisites
None

Responsibility
System Administrator

Navigation
Navigate to Security > User > Define.

Steps

1. In the User window, enter a new user name in the User Name field.

2. Enter a password in the Password field.

3. Re-enter the password for verification.

4. Select the employee’s name from the list of Values (LOV) in the Person Field.
5

In the Responsibilities sub-tab, select the CRM HTML Administration
responsibility from the drop-down list of values.

6. Save the new user.

To verify that the user setup is successful, perform the following steps:
1. Login to your Personal Home Page as the newly created user.

2. Enter your new password when prompted.

You should now be able to access the Personal Home Page for this user.
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Note: For this user to have access to HTML applications, you
must set additional profile options as detailed in the Implementing
Oracle CRM Application Foundation manual.

2.3.2 Assigning AOL Responsibilities to the User

A responsibility defines an application user’s current privileges while working with
Oracle Applications. When an application user signs on, they select a responsibility
that grants certain privileges, specifically:

= The functions that the user may access. Functions are determined by the menu
assigned to the responsibility.

= The concurrent programs, such as reports, that the user may run.

= The application database accounts to which forms, concurrent programs, and
reports connect.

You cannot delete a responsibility because this information helps to provide an
audit trail. You can deactivate a user’s responsibility at any time by setting the End
Date to the current date. If you wish to reactivate the responsibility for the user,
change the End Date to a date after the current date, or clear the End Date.

After creating the FND User, perform the following steps to assign the user AOL
responsibilities.

Reference
Managing People Using Oracle HRMS (US), See Chapter 1, Employee Management

Prerequisites
None

Responsibility
System Administrator

Navigation
Navigate to Security > User > Define.
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Steps

1. With the user information populated in the window, select the Responsibility
field in the Responsibilities tab.

2. Select the necessary responsibility from the List of Values (LOV).
3. Define the Effective dates.

4. Save your work.

2.3.3 Setting User Application, Responsibility, or Site Level Profile Options

A user profile is a set of changeable options that affect the way your application
looks and behaves. As System Administrator, you control how Oracle Applications
operate by setting user profile options to the values you want. You can set user
profile options at four different levels: site, application, responsibility, and user.

After creating the FND User, perform the following steps to set profile options.

Reference
Managing People Using Oracle HRMS (US), See Chapter 1, Employee Management

Prerequisites
None

Responsibility
System Administrator

Navigation
Navigate to Security >Profile > System.

Steps

1. In the Find System Profile Values window, Enter the profile option you want to
set and click Find.

The System Profile Values window opens with the profile option you searched
for.

2. Set at least one of the following;:

a. Set the Site value.
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This field displays the current value, if set, for all users at the installation
site.

b. Set the Application value.

This field displays the current value, if set, for all users working under
responsibilities owned by the application identified in the Find Profile
Values block.

c. Set the Responsibility value.

This field displays the current value, if set, for all users working under the
responsibility identified in the Find Profile Values block.

d. Set the User value.

This field displays the current value, if set, for the application user
identified in the Find Profile Values block.

You should set site-level default values for any required options after
installation of an application. If you do not assign a particular profile option
at any of the four levels, that option does not have a default value and may
cause errors when you use forms, run reports, or run concurrent requests.

3. Save your work.

2.3.4 Creating an Employee

To successfully run most of the CRM products, you must first create employee
resources within the ERP Human Resource Management System (HRMS)
application. Perform the following steps to define an employee for minimal
functionality.

Note: If Oracle HRMS is not installed, then you must enter a new
employee using the Enter Person form by navigating to Resource
Manager > Maintain Employee > Employee.

Reference
Managing People Using Oracle HRMS (US), See Chapter 1, Employee Management

Prerequisites
None
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Responsibility
US HRMS Manager or US Super HRMS Manager

Navigation
Navigate to People > Enter and Maintain.

Steps
1. Click New In the find window.

The People window opens.
2. Enter the following employee information in the appropriate form fields:
s Last Name
s First Name
= Title
Select the person’s gender from the drop-down list.
Select Employee from the type drop-down list.

Enter the person’s social security number.

o o & W

Save you work.

2.3.5 Creating a New Business Unit

A Business Group is a special class of organization. Every Business Group can have
its own set of default values, with its own internal organizations, grades, jobs,
positions, payrolls, employees, applicants, compensations and benefits.

Organizations are the basic work structure of any enterprise. They usually represent
the functional, management, or reporting groups which exist within a Business
Group. Perform the following steps to create a new business unit.

Reference
Oracle Applications System Administrator’s Guide, See Chapter 2, Managing Oracle
Applications Security

Prerequisites
None
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Responsibility
US HRMS Manager or US Super HRMS Manager

Navigation
Navigate to Work Structures > Organization > Description.

Steps

1. Click New in the Find Organization window.

2. Enter the name for the Organization

3. Select Business Unit from the list of values (LOV) in the Type field.
The current date populates the From Date field.

4. Enter the Organization location details from the LOV.

5. Save your work.

6. In the Organization Classification region, select the classification from the LOV.

7. Select the Enabled check box.

8. Save your work.

9. Click Others for additional information on the classification you selected.

10. Save your work.

2.3.6 Creating a Customer

Perform the following steps to create an new customer, with an address and contact
information in the Oracle ERP Accounts Receivables application.

Reference
Oracle Receivables User’s Guide, See Chapter 3, Customers

Prerequisites
None

Responsibility
Receivables Manager
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Navigation
Navigate to Customers > Standard.

Steps

1.

In the Find/Enter Customers window, select Person from the Customer Type
drop-down list.

Enter the name of the customer in the Name column.
Click Find to ascertain if the customer already exists.

As this customer does not exist, the New button is enabled in the Decisions
window.

Click New.

The Customer-Standard window opens.

On the Address tab, click New to create a new address.

The Customer Addresses window opens.

Fill in the necessary information. Yellow fields are mandatory.

On the Business Purpose tab, fill in the Usage, Location and select the Primary
check box. For example:

= Usage: Marketing

s Location: 60p9

s Primary: Yes

On the Contacts: Telephones tab, enter a new contact and phone number.

Save your work.

Verify the Information
To verify that the process worked properly, perform the following steps.

1.

2
3
4,
5

Open the Customer-Standard window again.

Enter the company name you entered above.

Click Find to query for the record you created in the Match Results window.
If the record is found, click the Contacts: Telephone tab.

Place the cursor in the Last Name field
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6. From the menu, select View > Query by Example > Enter.
7. Enter the contacts last name as the search criteria.
8. Click View > Query by Example > Run.

If the record for your contact name populates in the form, then you have
successfully created a customer with an address and a contact person for the
customer.

2.3.7 Creating a New Organization

Perform the following steps to create a new organization, with an address and
contact information in the Oracle ERP Accounts Receivables application.

Reference
Oracle Receivables User’s Guide, See Chapter 3, Customers

Prerequisites
None

Responsibility
Receivables Manager

Navigation
Navigate to Customers > Standards.

Steps
1. In the Find/Enter Customer window, select Organization from the Customer
Type drop-down list.

2. Enter the name of a test corporation in the Name field.
3. Click Find to ascertain if the customer already exists.

As this customer does not exist, the New button is enabled.
4. Click New.

The Customer-Standard window opens.

5. On the Address tab, click New to create a new address.
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The Customer Addresses window opens displaying the same business purpose
table as on the first tab.

6. Fill in the necessary information. Yellow fields are mandatory.

7. On the Business Purpose tab, fill in the Usage, Location and select the Primary
check box. For example:

= Usage: Marketing
= Location: 60p9
s Primary: Yes
8. On the Contacts: Telephones sub-tab, enter a new contact and phone number.

9. Save your work.

2.3.8 Creating a Workflow With Notifications

Perform the following steps to create and run a workflow with notifications.

Reference

Oracle Workflow Guide 2.5, See Chapter 3, Defining a Workflow Process and Chapter
4, Defining Workflow Process Components

Prerequisites
None

Responsibility
Workflow Administrator

Navigation
Navigate to Workflow >Launch Processes.

Steps

1. In the Launch Processes window, In the Item Type column, click Document
Management. If you have renamed the item types, this option appears in the
Internal Name column as WFDM.

The Initiate Workflow-WFDM page opens.

2. Enter values in the following fields:
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= Item Key: Enter your name plus a sequence number (for example, jdoe1001)
= User Key: You may copy the value in the Item Key field

ms  Process Name: Enter Document Review

= Process Owner: Your logged in user name populates automatically

= Send Document: Leave blank

= Document Owner: Select a valid resource name

= Document Reviewer: Choose one from the list of values

= Comments: Enter Workflow Verification

= Response Document: Leave blank

Click OK.

The Activities List page opens to show workflow statuses. The status of the
workflow you just initiated should be Active.

If the status of the workflow is Error, click Exception in the Result column to
see an explanation of the error.

Click View Diagram to see a graphical representation of the workflow process.
Leave the View Diagram window open as you continue to check the workflow.

Save your work.

To Review the Progress of a Workflow
Use the following procedure to verify that the Workflow notification is sent.

Steps

1.
2.

Login to your Personal Home Page.

In the list of Self Service Apps, choose the Workflow User Web Application
responsibility.

In the Navigator, choose Workflow >Find Notifications.
The Find Notifications page opens.

In the Type field, enter Document Management. In the To field, enter the
document reviewer.

Click Find.
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The Worklist window opens.
6. Click Subject to open the notification.
If you see the notification, then workflow is set up correctly.

7. Click Approve to return to the Worklist window.

Further Verification

You may go back to the View Diagram window that you opened earlier. Click
Reload in the browser window to refresh the contents of the window. After the
workflow process completes successfully, you can see a green line from the Start
icon to the End (Approve) icon.

2.3.9 Creating a Supplier Contact

Set up suppliers in the Suppliers window to record information about individuals
and organizations from whom you purchase goods and services. You can also enter
employees whom you reimburse for expense reports. When you enter a supplier
that does business from multiple locations, you store supplier information only
once, and enter supplier sites for each location. You can designate supplier sites as
pay sites, purchasing sites, RFQ only sites, or procurement card sites. For example,
for a single supplier, you can buy from several different sites and send payments to
several different sites. Most supplier information automatically defaults to all
supplier sites to facilitate supplier site entry. However, you can override these
defaults and have unique information for each site.

The system uses information you enter for suppliers and supplier sites to enter
default values when you later enter transactions for a supplier site. Most
information you enter in the Suppliers window is used only to enter defaults in the
Supplier Sites window. When the system enters that information in a later
transaction, it only uses supplier site information as a default, even if the supplier
site value is null and the supplier has a value. If you update information at the
supplier level, existing supplier sites are not updated.

When you enter a supplier, you can also record information for your own reference,
such as names of contacts or the customer number your supplier has assigned to
you. Perform the following steps to create a supplier contact.

Reference
Oracle Public Sector Purchasing User’s Guide, Chapter 5, Supply Base Management
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Prerequisites

Verify that the supplier does not exist in the system. Use the Suppliers Report
and Supplier Audit Report.

Define the following lookups in the Oracle Purchasing Lookups window: Pay
Group, Supplier Type, Minority Group.

Define Supplier Types in the Oracle Payables Lookups window.
If you have installed Purchasing, complete Purchasing setup.

If you use Oracle Purchasing, define Supplier Types in the Oracle Payables
Lookups window.

If you use Oracle Purchasing, define FOB codes, Minority Groups, and Freight
Terms codes in the Oracle Purchasing Lookups window.

If you use Oracle Purchasing, define Ship Via codes in the Defining Freight
Carriers window.

Responsibility
Purchasing

Navigation
Navigate to Supply Base > Suppliers.

Steps

1.
2.

5.

In the Suppliers window, enter a unique Supplier Name.

If the Supplier Number Entry option in the Financials Options window is set to
Automatic, Payables automatically enters a Supplier Number for you. If this
option is set to Manual, you must enter a unique Supplier Number.

(Optional) Enter the supplier’s tax identification number in the Taxpayer ID
field; for example, an individual’s social security number, or a corporation or
partnership’s federal identification number /federal tax ID.

(Optional) Enter the value-added tax (VAT) registration number in the Tax
Registration Number field if you are entering a VAT supplier.

If you want to prevent invoice or purchase order entry for this supplier after a
certain date, then enter the date in the Inactive On field.

Enter supplier information in the appropriate tabs of the Suppliers window.
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6. In the Suppliers window, choose the Sites button to navigate to the Supplier
Sites window. Enter at least one supplier site name and address.

7. Save your work.

2.3.10 Defining Sales Credit Types

Order Management uses sales credit types to determine if the sales credit for an
order is a quota or non-quota amount. Perform the following steps to define sales
credit types.

Reference
Oracle Order Management User’s Guide, See Chapter 1, Setting up

Prerequisites
None

Responsibility

Order Management Super User

Navigation
Navigate to Setup > Sales > Credit Types.

Steps
1. Navigate to the Sales Credit Types window.

2. In the Sales Credit Type window, enter the Credit Type Name and Description
for the credit type.

3. Select the Quota check box if the sales credit type applies to revenue quota sales
credit that you assign to resources.

4. Select the Enabled check box to activate the sales credit type.

5. Save your work.

2.3.11 Setting Up Accounting Flexfields

Use descriptive flexfields to tailor General Ledger to fit your unique information
needs. For example, you may want to collect additional information on budget
organizations, such as the manager and the size of the organization. You can even
define context-sensitive flexfields that prompt you for additional information based
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on your previous entries. Perform the following steps to set up accounting
flexfields.

Note: You only need to set up accounting flexfields if you are
using the Freight, Revenue, or Receivables Account fields, in the
Resource Manager Receivables tab.

Reference
Oracle General Ledger User’s Guide, Chapter 9, Setup

Prerequisites
Use the Value Sets window to define any value sets you need.

Responsibility
General Ledger Super User

Navigation
Navigate to Setup > Financials > Flexfields > Descriptive > Segments.

Steps

Consult the following manuals for more information:
»  Oracle General Ledger User Guide
»  Oracle Applications Flexfields Guide

2.4 Mandatory Dependencies

Oracle Incentive Compensation requires the following related products and
components to be installed and implemented:

s Oracle Resource Manager

2.5 Conditional Dependencies

s Oracle Order Management or third party collection program
s Oracle Workflow

s Oracle iStore
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s Oracle Marketing

= Oracle Sales Online
= Oracle Telesales

= Oracle Payroll

= Oracle Inventory

= Oracle Payables

m  Oracle Receivables
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Part li

Implementing Oracle Incentive
Compensation

This section of the Oracle Incentive Compensation Implementation Guide contains
the following chapters:

= Chapter 3, "Implementation Overview"

»  Chapter 4, "Implementation Tasks for Oracle Incentive Compensation"






3

Implementation Overview

Oracle strongly recommends that you implement Oracle Incentive Compensation in
the order listed.

3.1 Process Description

The steps needed for implementing Oracle Incentive Compensation are listed in the
order in which they should be carried out. When the step includes steps performed
in another application such as Oracle CRM Application Foundation, the relevant
implementation guide is referenced.

3.2 Implementation Task Sequence

The following table describes the order and process of implementing Oracle
Incentive Compensation.

Further information detailing the implementation procedures is provided in the
sections following the table.

Note: In the Mandatory column, an asterisk (*) next to No means that the step is
optional, and is only required if Incentive Planning is used.

Prerequisites

Completion of installation and implementation steps as outlined in the following
documents:

»  Oracle System Administrator’s Guide

»  Supplemental CRM Installation Steps Release 11i
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Implementation Task Sequence

Steps

Mandatory

Step Number

Oracle Incentive Compensation Implementation Steps

Yes

4.1

General Ledger Setups
4.1.5 Define Period Types
4.1.2 Define Calendar
4.1.3 Define Periods
4.1.4 Define Currency
4.1.5 Define Set of Books

Reference: GL Implementation Guide or GL User’s Guide

Yes

42

System Parameters
4.2.1 Pick Set of Books in Oracle Incentive Compensation
4.2.2 Collection
4.2.3 Calculation
4.2.4 Payment

4.2.5 Income Planner Disclaimer

Yes

43

Open/Close GL Periods
4.3.1 Create Period Type
4.3.2 Create Accounting Calendar
4.3.3 Activate Pay Periods

44

Open Accumulation Periods

45

Define Tables
4.5.1 Define Columns

4.6

Define External Table Mapping

47

Define Calculation Expressions
4.7.1 Input Expressions
4.7.2 Output Expressions
4.7.3 Performance Measures

4.7.4 Create Bonus Calculation Expressions

Yes

48

Define Rate Dimensions

Yes

49

Define Rate Tables
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Mandatory Step Number Oracle Incentive Compensation Implementation Steps
Yes 4.10 Define Formulas
No* 411 Associate Responsibilities with Responsibility Groups
No 4.12 Define Default Contract Text
4.12.1 Workday Calendar
No* 413 Define User Access
No* 4.14 Define Quota Components
4.14.1 Edit Computed Component Formula
No* 415 Define Attainment Schedule
4.15.1 Seasonality Schedule
Yes 4.16 Define Roles
Reference: Appropriate sections of CRM Foundation Implementation
Guide or CRM Foundation Concepts and Procedures (Resource Manager)
Yes 4.17 Define Agreement Details
No* 4.18 Define Jobs
Reference: Appropriate sections HRMS Implementation Guide or HRMS
User’s Guide (Resource Manager)
No* 4.19 Associate Jobs with Roles
Yes 4.20 Define Resource Groups (Compensation Groups)
Reference: Appropriate sections of CRM Foundation Implementation
Guide or CRM Foundation Concepts and Procedures (Resource Manager)
Yes 421 Define Resources
4.21.1 Set up Resources for Team Compensation
Reference: Appropriate sections of CRM Foundation Implementation
Guide or CRM Foundation Concepts and Procedures (Resource Manager)
Yes 4.22 Assign Resources to Roles and Groups
Reference: Appropriate sections of CRM Foundation Implementation
Guide or CRM Foundation Concepts and Procedures (Resource Manager)
No* 423 Assign Roles to Job Titles
No* 4.24 Assign Job Titles to Resources
No* 4.25 Customize On Target Earnings and Anchors
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Mandatory

Step Number

Oracle Incentive Compensation Implementation Steps

No*

426

Assign and Distribute Quotas to Resources
4.26.1 Email Alert Messages
4.26.2 Workflow Background Process

4.27

Resources Accept Plans using Oracle Sales Online

Yes

428

Activate Pay Periods

Yes

429

Define Pay Groups

4.30

Set Up Collections
4.30.1 Set up a New Transaction Source
4.30.2 Source Tables
4.30.3 Queries
4.30.4 Set up Collection Mapping
4.30.5 Direct Mapping
4.30.6 Indirect Mapping
4.30.7 Actions
4.30.8 Generate
4.30.9 Run Collections
4.30.10 Set Up a Standard Transaction Source
4.30.11 Use Filters
4.30.12 Receivables Posting and Order Booking Special Features
4.30.13 Order Booking
4.30.14 Adjustments

431

Set Up Expense and Liability Account Mapping

4.31.1 Account Generator

4.32

Set Up Plan Element to Oracle Payroll Pay Element Mapping
4.32.1 Pay Element Input Values Mapping

Yes

4.33

Map Classification Attributes and Collection Attributes. Referred to in
Oracle Incentive Compensation as "Tables".

Yes

4.34

Define Revenue Classes

Yes

435

Define Revenue Class Hierarchy
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Mandatory Step Number Oracle Incentive Compensation Implementation Steps
Yes 4.36 Define Classification Rule Sets for Revenue Classification
4.36.1 Build a Rules Hierarchy
No 4.37 Define Interval Types (optional)
No 4.38 Define Credit Types (optional)
4.38.1 View, Change, or Remove a Credit Type
4.38.2 Add a New Credit Type
Yes 4.39 Define Plan Elements
4.39.1 Assign Revenue Classes
4.39.2 Accelerators and Transaction Factors
4.39.3 Assign Rate Tables
Yes 4.40 Define Compensation Plans
4.40.1 Compensation Plan Details
4.40.2 Assign Plan Elements
Yes 441 Define Roles
Reference: Appropriate sections of CRM Foundation Concepts and
Procedures (Resource Manager)
Yes 4.42 Define Compensation Groups (Resource Groups)
Reference: Appropriate sections of CRM Foundation Implementation
Guide or CRM Foundation Concepts and Procedures (Resource Manager)
Yes 443 Define Resources
Reference: Appropriate sections of CRM Foundation Implementation
Guide or CRM Foundation Concepts and Procedures (Resource Manager)
Yes 4.44 Assign Resources to Roles and Groups
Yes 4.45 Assign Compensation Plans to Roles
No 4.46 Define Payment Plans (optional)
Yes 4.47 Assign Pay Groups to Resources
No 4.48 Assign Payment Plans to Resources (optional)
No 449 Customize Quota and Rates for Resources (optional)
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Mandatory

Step Number

Oracle Incentive Compensation Implementation Steps

No

4.50

Reports
Incentive Planning Reports
4.50.1 Quota Modeling Summary
4.50.2 Average Quota Report
4.50.3 Quota Overassignment Report
4.50.4 Quota Range Report
4.50.5 Compensation Contract Status
4.50.6 Overlay Report
4.50.7 Vacancy Report
4.50.8 Transition Report
4.50.9 Plan Activation Status Report
4.50.10 Role to Compensation Plan Mapping Report
Compensation Reports
4.50.11 Year to Date Summary
4.50.12 Transaction Details
4.50.13 Compensation Group Hierarchy
4.50.14 Classification Rules Report
4.50.15 Commission Summary Report
4.50.16 Quota Performance
4.50.17 Commission Statement

4.50.18 Unprocessed Transactions
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Implementation Tasks for Oracle Incentive
Compensation

Perform the following tasks to implement Oracle Incentive Compensation:
= Section 4.1, "General Ledger Setups"

s Section 4.2, "System Parameters"

= Section 4.3, "Open and Close GL Periods"

= Section 4.4, "Open Accumulation Periods"

s Section 4.5, "Define Tables"

= Section 4.6, "Define External Table Mapping"

= Section 4.7, "Define Calculation Expressions"

s Section 4.8, "Define Rate Dimensions"

s Section 4.9, "Define Rate Tables"

s Section 4.10, "Define Formulas"

= Section 4.11, "Associate Responsibilities with Responsibility Groups"
s Section 4.12, "Define Default Contract Text"

s Section 4.13, "Define User Access"

= Section 4.14, "Define Quota Components"

s Section 4.15, "Define Attainment Schedule"

s Section 4.16, "Define Roles"

= Section 4.17, "Define Agreement Details"
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s Section 4.18, "Define Jobs"

= Section 4.19, "Associate Jobs with Roles"

= Section 4.20, "Define Resource Groups (Compensation Groups)"

m  Section 4.21, "Define Resources"

= Section 4.22, "Assign Resources to Roles and Groups"

= Section 4.23, "Assign Roles to Job Titles"

= Section 4.24, "Assign Job Titles to Resources"

= Section 4.25, "Customize On Target Earnings and Anchors"

= Section 4.26, "Assign and Distribute Quotas to Resources"

m  Section 4.27, "Resources Accept Plans Using Oracle Sales Online"

= Section 4.28, "Activate Pay Periods"

= Section 4.29, "Define Pay Groups"

= Section 4.30, "Set Up Collections"

= Section 4.31, "Set Up Expense/Liability Account Mapping"

= Section 4.32, "Set Up Plan Element to Oracle Payroll Pay Element Mapping"
= Section 4.33, "Map Classification Attributes and Collection Attributes"
s Section 4.34, "Define Revenue Classes"

= Section 4.35, "Define Revenue Class Hierarchy"

s Section 4.36, "Define Classification Rulesets for Revenue Classification”
= Section 4.37, "Define Interval Types"

= Section 4.38, "Define Credit Types"

s Section 4.39, "Define Plan Elements"

= Section 4.40, "Define Compensation Plans"

s Section 4.41, "Define Roles"

= Section 4.42, "Define Compensation Groups"

s Section 4.43, "Define Resources"

= Section 4.44, "Assign Resources to Roles and Groups"

= Section 4.45, "Assign Compensation Plans to Roles"

4-2 Oracle Incentive Compensation Implementation Guide



General Ledger Setups

= Section 4.46, "Define Payment Plans"

= Section 4.47, "Assign Pay Groups to Resources"

= Section 4.48, "Assign Payment Plans to Resources"

s Section 4.49, "Customize Quota and Rates for Resources"

= Section 4.50, "Reports"

4.1 General Ledger Setups

To use Oracle Incentive Compensation, at the beginning of the implementation you
must define in General Ledger the period types, calendar, periods, currency, and set
of books on which you want to base your compensation periods. After you have
defined these in Oracle General Ledger, you need to identify this information in
Oracle Incentive Compensation on the System Parameters page (Administration >
Incentive > Parameter).

For the specific General Ledger setups, please refer to Oracle General Ledger User’s
Guide, Chapter 9, Setup.

Responsibility
System Administrator

4.1.1 Define Period Types

Oracle Incentive Compensation requires the period types to be defined in General
Ledger so that compensation can be calculated. Examples of period types are:

»s  Period (month)
s Quarter
s Year

Custom period types can be defined, such as six weeks or fiscal year.

4.1.2 Define Calendar

You can define different calendars for different business activities. Examples of
these calendars include Fiscal, Standard 12-month, or variations such as a Fiscal
13-month calendar with 12 months and an adjustment period.
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4.1.3 Define Periods

After you have defined your calendar, you need to add periods to it in General
Ledger.

4.1.4 Define Currency

Any currency that Oracle Incentive Compensation needs to calculate compensation
must be defined in General Ledger. For example, if your company trades in North
America, you want to define US dollars, Canadian dollars, and Mexican pesos. You
can also define multiple forms of the same currency, such as US dollar (next day)
and US dollar (same day).

4.1.5 Define Set of Books

Oracle Incentive Compensation requires that a set of books be set up in General
Ledger. The set of books includes a chart of accounts, functional currency, calendar,
and period types. A set of books can be used for your entire company or different
sets of books can be set up for different divisions or locations.

4.2 System Parameters

Now that you have defined these in Oracle General Ledger, you need to identify
this information in Oracle Incentive Compensation on the System Parameters page.
Navigate to Administration > Incentive > Parameter to perform steps 5.2.1 through
5.2.5.

4.2.1 Pick a Set of Books in Oracle Incentive Compensation

A set of books identifies a company or fund within Oracle Applications that shares
a common chart of accounts, structure, calendar, and functional currency. Oracle
Incentive Compensation processes incentive compensation payments according to
periods defined in a calendar associated with a set of books you define in Oracle
General Ledger (see Oracle General Ledger User’s Guide, Chapter 9, Setup).

Prerequisites
The set of books must be defined in Oracle General Ledger (GL) using these forms:

s Set of Books
s Calendar

»  Period Types
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= Open and Close Periods
= Key Flexfields

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Parameter

Steps
1. In the Set of Books field, choose a GL set of books from the list of values, which
Oracle Sales Compensation obtains from all sets of books you have defined.

You will then see this information obtained from the GL books:
= Currency associated with this set of books
= Calendar associated with this set of GL books (view only, cannot be edited)

»  Period type associated with this set of GL books (view only)

4.2.2 Collection

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Parameter
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Steps
1. Select a collection batch size. This affects the amount of time the application
requires to process the total transactions.

2. Select the number of takeback grace days. This determines the number of days
allowed after the payment due date before sales credit is taken back.

Note: The Transfer Batch Size field is obsolete. It will be removed in a future release.

4.2.3 Calculation

Within the Calculation area of the System Parameters page, there are five fields.
Four of the fields may affect calculation and its performance: Transaction Batch Size,
Latest Processed Date, Resource Batch Size, and Managerial Rollup. A fifth field
included under calculation, Rule Batch Size, does not affect calculation in any way.
This option is used when creating the Classification Rules Package.

The Transaction Batch Size and Resource Batch Size together determine how many
transaction batch runners get submitted for calculation. During the transaction
batch processor phase, calculation determines how many batches will be run for
this calculation process. For example, if you want to calculate 10,000 transactions
and the batch size is 1,000, ten batches will be created.

The resources are first assigned to a PHYSICAL_BATCH_ID based on the
transaction batch size and salespeople batch size as defined on the System
Parameters page. During the assignment, calculation moves through each of the
salesrep_id sequentially (for example, 1000, 1001, 1002, 1010, and so on).

Calculation assigns each resource to a single physical_batch_id. It does not split the
resource across two batches.

To improve the performance of concurrent calculation, and thereby save time,
Oracle Incentive Compensation reuses existing resource groupings to create batch
runners. Sometimes, over time or due to certain circumstances, the existing
groupings create a skewed distribution of transactions and need to be regrouped. A
simple setting of the Transaction Batch Size parameter controls this. To reuse
existing groupings, enter a transaction batch size ending in a zero (0), for example,
2,500. To make the application regroup resources and transactions into new batch
runners, enter a transaction batch size ending in a number other than zero, for
example, 2,501. After you are satisfied with the new grouping and want to reuse it,
reset the transaction batch size parameter to a number ending in zero.

Note: A good starting point for setting the values for resource batch size is a rough
equivalent to the maximum number of concurrent manager slots and the number of
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server processors available. You can then fine tune the numbers to get the best
setting for your setup.

The Latest Processed Date field is a view-only field that indicates the date of the
latest transaction for which calculation has been run. If the system profile OSC:
Prior Adjustment is set to no, it allows all plan elements in a period to be calculated
incrementally. Before enabling the profile option, be sure that any transactions that
have a processed date earlier than the latest processed date showing in the System
Parameter window have been calculated. Note: After you change the setting of a
profile option, you must bounce the server to reset it.

Check the Managerial Rollup check box if you want sales credits to roll up through
the compensation group hierarchies. If the box is checked, Oracle Incentive
Compensation awards indirect credit for each transaction whose direct credit
receiver is in the compensation group hierarchy. This parameter affects all
transactions--you cannot selectively allocate indirect credit on a
transaction-by-transaction basis.

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Parameter

Steps
1. Configure a transaction batch size that is appropriate to your calculation
requirements.

2. Configure a resource batch size that is appropriate to your calculation
requirements.

3. Check the Managerial Rollup check box if you want sales credits to roll up
through the compensation group hierarchies.
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4.2.4 Payment

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Parameter

Steps

1.

Indicate whether Oracle Payable and Payroll are implemented.

2. Use the Account Generation field to instruct the application from what level
you want account codes to be generated. Select Revenue Class, Plan Element,
Custom, or Classification from the drop-down list.

Guidelines

Account Generation is an option you can use to populate account codes at the
appropriate detail level and then select from where the application pulls expense
and liability information. Note: If the account level population is set to
Classification or Revenue Class, the system profile Pay by Transaction must be set
to Y for the account to be populated to the Accounts Payable interface.

There are four levels of detail where population can occur:

Classification - The application takes expense and liability accounts that are
provided on the Ruleset Details page and passes that information to Accounts
Payable.

Plan Element - The application takes expense and liability accounts that are
provided on the Plan Element page and passes that information to Accounts
Payable.

Revenue Class - The application takes expense and liability accounts that are
provided on the Revenue Class Summary page and passes that information to
Accounts Payable.
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s Custom - The Custom option provides flexibility for companies that want to
pass along expense and liability data which are independent of the normal
Oracle Incentive Compensation classification process. Mapping to this data is
required.

Account Generation is set at the application level. Once it is set, the application
obtains all of the information from only that level. This means that regardless of
where you populate data, if it doesn’t match the system option, it cannot be used.
For example, if you set the system parameter to Plan Element and begin populating
expense and liability account information at the Revenue Class level, the
application ignores whatever you enter at the Revenue Class level.

4.2.5 Income Planner Disclaimer

Income planner enables resources to plan their sales volumes to reach their
commission earning goals. However, an organization can add a disclaimer to what
resources see when they use Incentive Planner in Oracle Sales Online. A typical
disclaimer warns the user that amounts generated using Income Planner may not
match the exact amount of commission paid.

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Parameter

Steps

1. In the Income Planner area, type the information that you want to be displayed
into the Disclaimer field.

2. C(Click Update.
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4.3 Open and Close GL Periods

To administer Oracle Incentive Compensation periods, set up your periods to the
future enterable state. It can be Never Opened at the beginning. When you are
ready to calculate the compensation payments, open the appropriate accounting
period. You may close an accounting period after you have calculated and paid the
compensation, or you may leave multiple periods open if you expect to make
adjustments for prior periods.

4.3.1 Create Period Type

A period type determines how you divide your calendar or fiscal year. The
Calendar Type page enables you to create period types for either a calendar or a
fiscal year. On the page you can also indicate the number of periods per year and
enter a description. After you have defined the period type, you must create an
accounting calendar. To create a period type, perform the following procedure:

Prerequisites
None

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > General > Calendar Type

Steps
1. Click the Administration tab and click the General subtab.

2. Click Calendar Type in the side panel menu.
The Calendar Types page appears.

3. If the period type you need is already defined, proceed to the next step. You can
use the search parameters at the top of the page to find a specific period type.

4. To create a new period type, enter it in the first available blank field in the
Period Type column.
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Enter the number of periods per year in the Periods Per Year column.
Select Calendar or Fiscal from the drop-down list in the Year Type column.

Optionally, enter a description of the period type.

©® N o @

Click Update to save your work.

4.3.2 Create Accounting Calendar

The accounting calendar contains the exact date ranges for all the periods in a
specific calendar or fiscal year. To set up an accounting calendar, perform the
following procedure:

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > General > Accounting Calendar

Steps
1. Click the Administration tab and click the General subtab.

2. Click Accounting Calendar in the side panel menu.
3. The Accounting Calendar page appears.

4. Use the search parameters as needed at the top of the page to locate a specific
calendar type. Select a calendar type from the Calendar drop-down list.
Accounting is the default setting for the Calendar field, which is a required
field.

5. In the first available blank field in the Prefix column, enter the prefix you want
to use for a period. For a month, it is usually the abbreviation, such as Jan for
January. For a year, it can be FY-02 or something similar. This field is required.

6. In the Type field, select a type from the drop-down list. This field is required.
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10.

Enter the year, month, and number in the next three fields. All three are
required. Number indicates the sequence of the period. For monthly periods,
for example, enter 4 for April, 8 for August, and so on.

Enter dates in the From and To columns. Click the calendar icon to open a
calendar from which you can select the dates you need. These fields are
required.

The Name field is required, but it is automatically populated by the application.
You may see a message displayed mentioning that the field is required.

By default, the application builds the contents of the Name field by combining
the data in the Prefix column with the year suffix and hyphenating them. You
can customize the Name field by entering a different name in the field and
clicking Update.

Click Update to save your work. To return to the previously saved information,
before saving, click Restore.

4.3.3 Activate Pay Periods

To activate pay periods, perform the following procedure:

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Pay Periods

Steps

1.
2.

Click the Administration tab and the Incentive subtab.
In the side panel menu, click Pay Periods.

The Pay Periods page appears.
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3. In the Period Status column, select Active from the drop-down menu next to the
period you want to activate.

4. Click Update to save your changes.
5. Note:

4.4 Open Accumulation Periods

Use the Accumulation Periods page to set the status of your accumulation periods,
or freeze them to enable them to be opened for a year-to-date summary for a
resource using Oracle Sales Online.

Most of the Accumulation Periods page is read-only information. The System
Status, Calendar, and Period type fields at the top display information that was set
previously.

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Accumulation Period

Steps
1. Click the Administration tab and click the Incentive subtab.

2. Click the Accumulation Period link in the side panel menu.
The Accumulation Periods page appears.
3. Select a year from the drop-down list. Click Apply.
The accumulation periods for the selected year are displayed.
4. For each period, choose a period status from the drop-down list:

= Never Opened
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= Future - Entry

= Permanently Closed
= Open

s Closed

5. Check the Freeze check box if you want to use the data in a Year To Date
Summary report.

6. Click Update to save your changes. If necessary, click Restore before clicking
Update to return to the most recently saved information.

Guidelines

You can change a Never Opened period to Future - Entry and then to Open. You can
close an Open period and open a Closed period. After you open a period, the
choices in the drop-down list become Permanently Closed, Open, and Closed.

After you permanently close a period, you cannot reopen it and no transactions of
any kind can be processed. Be sure that there are no new transactions, adjustments,
takebacks, payments, or any other outstanding transactions before you permanently
close a period.

You cannot close a period if there is a period before it that is open. For example, you
cannot close the June 2002 period if the March 2002 period remains open. If you
attempt to close a period that has an open period before it, a message displays at the
top of the page:

Cannot close a period when previous period is not closed.

If this occurs, click the Back button on your browser and close any previous periods
with an Open status.

You cannot open a period if the previous period is in Never Opened status.

4.5 Define Tables

Use the Tables page to define tables from Accounts Receivable, Order Management,
or an external source that are used in collecting and calculating transactions in
Incentive Compensation. Tables must be defined before they can be used in
collection or calculation.

Prerequisites
Tables must exist in the database.
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Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Tables

Steps

1.
2.

3.
4,

Click the Administration tab and click the Incentive subtab.

On the side panel menu, click Tables.

The Tables page appears.

If you want, enter search parameters by Schema, Table Name, or User Name.

Click Apply.

To enter new Tables, perform the following procedure.

1.

Enter a Schema in the Schema field. Click Go to open a pop-up list from which
to select a name.

Enter a Table Name from which you want to collect data. Use the pop-up list if
necessary.

Enter a user name.
Enter a description if desired.

In the Usage column, select Collection, Calculation, or None from the
drop-down list.

Click Update to save your work.

Use the details field to add any useful information. Click Columns in the details
column to go to the Columns page.

If necessary, click Restore to return to the previously stored information.

Click Update to save your work.
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4.5.1 Define Columns

After you have defined tables for collection or calculation, use the Columns page to
define specific columns and relate them to columns in other tables.

There are four views of the Columns page, selected from the View drop-down list at
the top of the page. The four views have different fields of information that can be
entered.

s The Columns view displays the column’s data type and data length, and
contains check boxes for Usage and Foreign Key.

s The Dimensions view contains a field for Dimension Name and a Value check
box.

»  The Classification view provides a Value check box, enables classification as
alphanumeric, date, or numeric, and contains a field for selecting a value set
name.

s The Primary Key view supplies a Primary Key check box. The Position column
is not used in the current release.

All four views contain the column name, the user name assigned to it, and a field
for an external call. The external call column is used only in the Column view. The
column name is set in the application, but you can assign a user name to it to match
your business process or for ease of use.

The external call column enables you to optionally enter the name of a jsp, which is
then invoked by Oracle Incentive Compensation as the source of data for the
Invoice Number and Order Number fields in the Commission Statement report. For
the Commission Statement drilldown to work, the Enable Commission Statement
Drilldowns profile should be set to Yes.

Also, the standard integrations must be set up.

Prerequisites
None

Responsibility

Incentive Planning Super User
Incentive Compensation Analyst

Incentive Planning Analyst
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Navigation
Administration > Incentive > Tables > Columns link

Steps
1. The Columns view is the default display. To use a different view, select it from
the View drop-down list.

2. To use the Columns view, click Apply.
The Columns page display changes to the view you have selected.
3. For the Columns view, perform the following steps:

a. Change the name in the User Name field to assign a name that is used in
your business or is easy to understand.

b. Optionally, enter an external call (see previous information in this section).

c. The Data Type field indicates if the column contains alphanumeric material
(VARCHAR?), numerical data (NUMBER), or a date (DATE).

d. Check the Usage check box if you plan to use the column for calculation.

e. Check the Foreign Key check box if you plan to use the column as a foreign
key to relate the column to columns in another table.

f. Click Update to save your changes. If necessary, click Restore to return to
the previously stored information.

4. For the Dimensions view, perform the following steps:

a. Change the name in the User Name field to assign a name that is used in
your business or is easy to understand.

b. Select a dimension name. Enter four or more characters in the Dimension
Name field and click Go. A pop-up list appears from which you can make a
selection.

c. Check the Value check box next to the column to use that column’s value as
the basis for defining the hierarchy of the selected dimension.

d. Click Update to save your changes. If necessary, click Restore to return to
the previously stored information.

5. For the Classification view, perform the following steps:

a. Change the name in the User Name field to assign a name that is used in
your business or is easy to understand.
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b. Check the Value check box next to a column to use that column for defining
classification rules.

c. Make a selection from the Classification drop-down list. Choices include
Alpha Numeric, Date, or Numeric.

d. Optionally, enter a name in the Value Set Name field. Enter four or more
characters in the Dimension Name field and click Go. A pop-up list appears
from which you can make a selection.

e. Click Update to save your changes. If necessary, click Restore to return to
the previously stored information.

6. For the Primary key view, perform the following steps:

a. You can change the name in the User Name field to assign a name that is
used in your business or is easy to understand.

b. Optionally, check the Primary Key check box. If a column is enabled as the
primary key, it will be used in the join condition with an external table
when doing an external table join.

c. Click Update to save your changes. If necessary, click Restore to return to
the previously stored information.

4.6 Define External Table Mapping

Use this page to join external tables to destination tables in Oracle Incentive
Compensation.

Prerequisites
External tables must already exist.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > External Table

4-18 Oracle Incentive Compensation Implementation Guide



Define Calculation Expressions

Steps

1.
2.

10.

11.
12.

Click the Administration tab and click the Incentive Subtab.
Click External Table on the side panel menu.
The External Table Join Conditions page appears.

If the list is long, you can search for a join condition by entering a search string
in the Name field at the top and clicking Apply. Note: This search is case sensitive.

Enter a name for the condition in the Name column. This is a required field.

In the Usage column, select Collection or Calculation from the drop-down list.
This is a required field.

Enter the source table. You can enter four or more characters in the field and
click Go to open a pop-up list. Click your selection to enter it into the field.

Enter a name of the destination table in Oracle Incentive Compensation. You
can enter four or more characters in the field and click Go to open a pop-up list
from which to make a selection.

Click Update.

The Alias is system generated and the Columns link appears in the External
Columns column.

Click Columns in the External Columns column to another page where you can
specify source and destination columns.

If you want to remove a line, check the Remove check box and the line will be
deleted the next time Update is clicked.

If necessary, click Restore to return to the previously saved information.

Click Update to save your changes.

4.7 Define Calculation Expressions

Calculation expressions are interchangeable, reusable parts that are used in input
and output expressions of formulas, expression-based rate dimensions, and
performance measures.

A compensation plan is built from plan elements and is assigned an effective start
and end date. The plan can then be assigned to multiple sales roles.
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There are 100 user definable column attributes. You can use these calculation
expressions as performance measures, input expressions, output expressions, or rate
table dimensions. You can also embed one calculation expression within another.

As part of the definition process you can select columns from a list of table columns
on the Expressions subtab of the Incentive tab to create expressions. Once they have
been saved the expressions can be assigned and reassigned to any number of
formulas you need.

When defining a formula, you select a valid expression from a drop-down list at
each of the areas for input, output, and performance measure on the Expressions

page.
You can place a formula inside a calculation expression if you want to be certain
that the expression is used after that formula. Sequencing plan elements in a

compensation plan can also assure that calculations are performed in the order you
need.

4.7.1 Input Expressions

Input expressions tell Oracle Incentive Compensation what to evaluate from the
transactions and how to match the results to the corresponding rate table. Think of
the input expression as a sorter for all incoming transactions for Oracle Incentive
Compensation. An example input formula expression looks like this:

(TRANSACTION_AMOUNT*EVENT_FACTOR)/TARGET

For example, as a condition, a company can establish that its sales force will be
compensated based on transaction amount. The input expression will merely state
that transactions will be sorted by TRANSACTION_AMOUNT from the CN_
COMMISSION_HEADERS column.

This is an example of a rate table:

Transaction Amount Commission

$0 - $100 4%
$100 - $500 5%
$500 - $99,999 6%

As transactions are sorted by through the input expression they are matched to the
established rate table tiers. If a transaction is collected in Oracle Incentive
Compensation with the following attributes:
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1. Customer X
2. Transaction Amount $100
3. ProductZ

Oracle Incentive Compensation, using the input expression created matches the
above transaction of $100 with the rate table and determines that 5% will be paid on
this order.

4.7.2 Output Expressions

Outputs of the formula instruct the application how much to pay resources. The
payment amount can either be tied to a rate table or not. This will be determined by
the users.

In this example above, business users determined that the resources will be paid
based on the rate table result, transaction amount, and a constant uplift/accelerator
factor of 1.035. Users will need to tell Oracle Incentive Compensation in which
columns this information resides and then apply the calculations.

Example of an output expression:
Rate Table Result * (TRANSACTION_AMOUNT * PAYMENT_FACTOR)

Using the above output expression, multiply 5% times the transaction amount
($100), event factor of 100% and 1.035 for the payment accelerator or payment
uplift. The 5% is multiplied by the result of the sum in the brackets. If the payment
factor is 1.05, then the result or commission is $5.25 ($100 x 5% x 1.05 = $5.25).

4.7.3 Performance Measures

A performance measure can be an accumulation of transaction values that are
captured by the plan element to which it is assigned. Performance measures serve
as a mechanism to gather cumulative information by plan element and group them
for use in reports that compare achievements to quota, goal and performance
measure.

An example of a performance measure is revenue. You can select and define the
columns where revenue information for transactions is held. As transactions are
entered and collected for the assigned plan element, the transaction values are
accumulated. An example performance measure is:

TRANSACTION_AMOUNT
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Note: Performance measures must use numeric expressions to work correctly. In a
formula, if no performance measure is assigned, the application uses the first input
expression. If that expression evaluates to string values, the calculation will fail.
Therefore, it is important when using an input expression that is not numeric to
assign a numeric performance measure.

Use the following procedure to define calculation expressions.

Prerequisites
Table and column mapping is complete.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Incentive > Expression > Create

Steps
1. Click the Incentive tab and click the Expression subtab.

The Calculation Expressions page displays a list of already created calculation
expressions.

2. To create a new calculation expression, click Create.

The Calculation Expressions page with blank fields appears.
Enter a unique name for the expression. This is a required field.
Optionally, provide a description for the expression.

The status of the expression in the read-only field is Invalid until it is saved.

o o & W

Select a Type from the drop-down list. The seven selections represent groups of
calculation elements, such as expressions, formulas, and SQL functions. Only
the calculation elements in that selection are displayed in the Calculation Values
box.

7. In the Calculation Values box, select the column to be used in the expression.
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10.

11.
12.

13.

14.
15.

16.

Click the right shuttle box arrow button to move the element in the Calculation
Values box into the Expression box. You can click the left-arrow button to
remove an entry from the Expression box.

If your expression requires it, select an operand from the row below the
Expression box. It appears immediately in the Expression box without using the
right arrow button.

To remove an item from the Expression box, click the left arrow button.

Optionally, numeric constants or string values can be added to an expression.
Enter the numeric value or string value in the Constant field and click the right
arrow button to move it to the Expression box. As above, click the left arrow
button to remove an entry from the Expression box.

Add elements and operands until the desired expression has been created.

To use values from another plan element or to create an interdependent plan
element, enter the name of the plan element in the Plan Element field.

Select from the list of metrics next to the Plan Element field. Use the right
shuttle box arrow to add the plan element and metric to the expression. See
Guidelines.

Add elements and operands until the desired expression has been created.

Click Update to save and compile your expression. Optionally, click Restore to
return to the previously saved information.

The status of the expression should read Valid if it has compiled properly.

The usage of the expression is also displayed after the expression is saved. The
usage rules determine where the expression may be applied.

Guidelines

User table names are listed under External Elements. You join an external table to an
internal table by mapping them using Administration > External Tables.

Selected columns are accessible for use in building formulas and performance
measures. The user column name is listed rather than the actual column name.

The following Oracle Incentive Compensation tables are predefined in the system
and can be used as calculation values in defining performance measures and
formulas:

CN_COMMISSION_HEADERS
CN_COMMISSION_LINES
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s CN_SRP_QUOTA_ASSIGNS
= CN_SRP_PERIOD_QUOTAS
= CN_QUOTAS

A rate dimension calculation expression can only be defined from the following
tables:

» CN_SRP_PERIOD_QUOTAS

» CN_SRP_PLAN_ASSIGNS

» CN_SRP_QUOTA_ASSIGNS

= CN_SALESREPS

An output expression cannot contain both ITD_TARGET and ITD_PAYMENT.

4.7.4 Create Bonus Calculation Expressions

Bonus calculation expressions are used in a formula to pay a bonus to a resource
that is based on something other than transactions. For example, if a company has
had a successful year and wants to pay every employee a percentage of their annual
salary as a bonus, it can be calculated by using employee salary information. You
can map to this information in another schema and use it to calculate the bonus.

However, because bonus expressions, unlike commission expressions, are not based
on achievement, you can’t calculate bonuses based on transactions and you can’t
use any table that contains transactional information.

Bonus expressions cannot include a column from the following tables or from any
external table that is mapped to these tables:

= CN_COMMISSION_HEADERS
= CN_COMMISSION_LINES

A Bonus calculation expression cannot be used as an embedded formula and cannot
be mixed with a commission type formula. See "Formula Bonus" for more
information.

However, if you want to calculate bonuses based on the accumulated total sales
credit for the resource, you can perform the following procedure.

1. Runa SQL script to create a view. (Refer to SQL documentation).

2. Register this view on the Tables page. See Section 4.5, "Define Tables" for steps.
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3. On the External Table page, enter a name (user definable) See Section 4.6,
"Define External Table Mapping" for steps.

4. Choose the view created as the external source table and CN_SRP_PERIOD _
QUOQOTAS as the destination table.

5. Map source column and destination column:
= Salesrep_id > Salesrep_id
= period_id > period_id

6. Define input/output expression using commission_paid_ptd or input_
achieved_ptd of the view depending upon the requirement.

This view will appear under external element. You can also define performance
expression using input_achieved_ptd.

7. Use the bonus expression when you define the bonus plan formula.

Example

This is an example of creating a bonus plan element. Bonus calculation is normally
based on the total commission earned by the resource or transaction total (sales
credit total) of the resource. But in this case the bonus is calculated based on the
commission earned by the resource.

The resource has a commission plan element with the following details:
s Input expression = Transaction Amount
= Output expression = Transaction Amount * Rate table result /100

= Rate table for the commission plan element:

Amount Commission
0-10,000 1%
10,000-50,000 2%
50,000-100,000 3%

100,000-999999999999 4%

s  Commission Plan element Interval = Period
= Apply transaction= Individually

This resource also has bonus plan element with the following details.
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= Input expression = Commission_paid_ptd column from a view created based
on the cn_srp_period_quotas.

s Output expression = Commission_paid_ptd of the view * Rate table Result /100

= Rate table for the bonus plan element:

Amount Bonus
0-500 75
500-1,000 65
1,000-5,000 55
5,000-10,000 45
10,000-99999999999 25

s Bonus Plan element Interval = Period.

The resource has the following transactions:

Date Transaction Amount
01-Jan-01 9,000

02-Jan-01 15,000

01-Feb-01 40,000

Commission calculated for the above transactions using the commission plan above
is:

Date Transaction Amount Rate Commission
01-Jan-01 9,000 1 90

02-Jan-01 15,000 2 300

01-Feb-01 40,000 2 800

Data from the view used for bonus calculation:

Period-id Input_achieved_ptd Commission_paid_ptd

2001001 24,000 390
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Period-id Input_achieved_ptd Commission_paid_ptd

2001002 40,000 800

Bonus calculation using the bonus plan and bonus rate table

Period_id Input_achieved_ptd Commission_paid_ptd Rate Bonus
2001001 24,000 390 75 292.5
2001002 40,000 800 65 520.0
Guidelines

Use Commission_paid_ptd in the bonus input expression if your bonus is based on
the commission of the resource. Use Input_achieved_ptd in the bonus input
expression if your bonus is based on the total sales credit of the resource.

Here is a suggested view definition for the quarterly bonus:

select salesrep id, max(a.period id) last period id, sum(input achieved ptd)
input_achieved ptd, sum(commission paid ptd) commission paid ptd

from cn_srp period quotas a, contracts b

where a.quota id = b.quota id

and a.period id between 2001001 and 2001012

and b.incentive type code = ’'COMMISSION'

group by salesrep id, ceil((a.period id - 2001000)/3)

Please note that a view created based on CN_COMMISSION_HEADERS will not
work. However, the requirement can be achieved using view created based on cn_
srp_period_quotas.

4.8 Define Rate Dimensions

Rate dimensions define the tiers that are used in a rate table. There are four kinds of
rate dimensions:

= Amount: The rate tiers are quantities.
»  Percent: The rate tiers are percentages of a quota.
= Expression: The rate tiers use an expression that has already been defined.

= String: The rate tiers are alphanumeric, such as product numbers or the names
of states.
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These values comprise the ranges from which compensation is calculated in a rate
table.

You can select Amount or Percent dimensions on the Dimensions page from a
drop-down list.

If a commission rate is based on multiple criteria, then a multidimensional rate table
must be created to reflect all criteria. Use one dimension per criterion.

Note: This version of Oracle Incentive Compensation does not support accumulated
revenue with multidimensional rate tables.

In the following example, three dimensions are used to calculate various
commission rates: License Revenue (percent of quota), State, and Product. The
formula first compares transaction revenue with the first dimension, License
Revenue. Next, the formula compares transaction location with the second
dimension, State. Finally, the formula compares product identification with the
third dimension, Product.

A dimension contains rate tiers to establish different levels of achievement to be
compensated at different rates. In this example, two dimensions have two tiers and
one has three, but any number can be defined.

The License Revenue dimension:

License Revenue
0-100
100-9,999

The State dimension:

State

Arizona
California

Oregon

The Product dimension:

Product
PCs
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Product

Peripherals

Together, there are 12 possible combinations, and each one can be assigned a
different commission rate.

Your minimum and maximum values in the Rate Tiers section must be stated in
terms consistent with your input information.

You can change both the tiers and rates for a rate table. Any changes you make are
propagated to all plan elements to which those rate tables are assigned, and thus to
any resources that are assigned to roles that are assigned plans containing those
plan elements. If you change the levels of quota achievement in a tier, or add or
delete a tier in a rate table, those changes propagate to all resources, regardless of
whether their plans have custom quotas or rates.

The following table shows four columns of a Dimension and Rates Example.
Columns are License Revenue, State, Product, and Rate. Product is chosen as the
base dimension. There are 6 possibilities for each of the two tiers in the License
Revenue dimension, including all combinations with the other two dimensions.

License Revenue State Product Rate
0-100 Arizona PCs 1%
0-100 Arizona Peripherals 5%
0-100 California PCs 1.5%
0-100 California Peripherals 4.5%
0-100 Oregon PCs 1.25%
0-100 Oregon Peripherals 6.25%
100-9,999 Arizona PCs 4%
100-9,999 Arizona Peripherals 8%
100-9,999 California PCs 4.5%
100-9,999 California Peripherals 7.5%
100-9,999 Oregon PCs 4.25%
100-9,999 Oregon Peripherals 9.25%
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Prerequisites
For an expression type dimension, the expressions must already be defined.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Incentive > Rate > rate table link

Steps

1.

10.
11.

Click the Incentive tab and click the Rate subtab.
The Rate Tables page appears.

Click the name of the rate table for which you want to create or edit a
dimension.

The Rate Table Details page appears.

In the Dimension area, click Details next to any already created dimensions to
open the Rate Table Detail - Dimensions page. It contains the rate tiers assigned
to the dimension.

To create a new dimension, click Create.
The Dimension page opens. The fields are blank.

On the Dimensions page, for a new dimension, enter a name in the Name field.
If you are editing an existing dimension, be sure the field contains the name of
the dimension on which you want to work.

Select or verify the type from the drop-down list.
Optionally, enter a description.

In the Rate Tiers area, enter numbers in the From and To columns to create rate
tiers. Follow the sequence, and do not leave any gaps between the tiers.

If you want to add a tier, use the blank fields at the bottom of the table.
To delete a tier, click the Remove check box next to the tier and click Update.

If necessary, click Restore to return to the previously saved information.
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12. Click Update to save your work.

13. Click Back to return to the Rate Table Details menu, where you can assign the
dimension you created to the rate table.

Guidelines

If the application is unable to find a match in a string dimension in a rate table, the
application picks the last rate value by default. For example, suppose that in the
example above, a transaction has dimension values of 10,000, Iowa, and Service. No
matches occur, and the rate table result is 9.25%, the last value in the Rate column.

If you do not want non-matching transactions to receive commission, add "OTHER"
as the last string value to each string dimension with a corresponding commission
rate of 0, for example.

Another method of dealing with non-matching transactions is to use classification
rules. Transactions with attributes that do not match your classification rules will
have a failed classification status. You can correct these failed transactions’
attributes by changing their values and maintain a record of the adjustment through
the manual adjustments window.

Note: If you have string-based dimensions in a rate table, you must assign the same
table or one of similar structure to the formula in the plan element. If you do not do
this, the generated formula package assumes that all of the inputs evaluate to
numeric values, and an error message and XCALC status results.

4.9 Define Rate Tables

Rate tables are used to establish compensation percentage rates or fixed amounts
for different performance levels. The compensation formula and plan element
determine the type of information to be compared to the rate table as well as how
the resulting rate is used in the calculation.

The Rate subtab contains a side panel menu that provides links to several pages.
After you have chosen a rate table, click the links to see the following;:

= Summary: Lists all rate tables that have been created

= Detail: Displays details of the rate table you selected

s Commission Rates: Displays the commission rates for the selected rate table
= Formulas: Displays the formulas to which the rate table is assigned

s Plan Elements: Displays the plan elements in which the rate table is used
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Amount type rate tables base compensation on amount of sales volume. Percent
type rate tables are based on percentage of goal achieved.

To define rate tables, perform the following procedure:

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Incentive > Rate > Create

Steps
1. Click the Incentive tab and click the Rate subtab.

The Rate Tables page appears
2. Click Create.
The Rate Table Details page appears.
In the Name field, enter a unique name for the rate table.
Select a Rate Table type, either Amount or Percent, from the drop-down list.

Click Update to save your work.

o o & W

To add an already created dimension to the rate table, on the Rate Table Details
page, enter four or more characters in the Dimension Name field and click Go
to open a pop-up list. See Guidelines.

7. Select a rate dimension from the list.

8. To assign or change commission rates, click the Commission Rates link to go to
the Rate Table Details - Commission Rates page.

9. To create a new dimension, on the Rate Schedule Detail page, click Create.

The Dimensions page appears.
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10. After you have assigned the dimensions you need to the rate table, click Update
to save your work. If necessary, click Restore to return to the previously saved
information.

Guidelines

If a rate schedule is already assigned to a formula or plan element, it cannot be
deleted and the commission type cannot be updated. Dimension assignments
cannot be changed. An error message displays if you attempt to delete or change a
rate schedule that is already assigned.

4.10 Define Formulas

You have complete flexibility to create formulas for calculating compensation. Some
formulas can be embedded in another formula definition or in a plan element
definition. You can save an incomplete formula and return to complete it later.

Any expressions that you use in a formula must be created before you define a
formula. Expressions can be repeated in your formula and can be reused in other
formulas as well. See the Guidelines section of Define Calculation Expressions for
more information on the types of calculation expressions that you can use for
commission and bonus formulas.

Any column from any table can be part of your formula, as long as the Calculation
Value check box for the column is selected in Columns and Tables.

To create formulas, perform the following procedure.

Prerequisites
Expressions must be created first.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Incentive > Formula > Create
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Steps

1.

10.

11.

12.

13.
14.

15.
16.

Click the Incentive tab and click the Formula subtab.
The Formulas page appears.

Click Create to create a new formula.

The Formula Definition page appears.

In the General area, enter a unique name and a description for your formula.
The Name field is required.

Enter Commission or Bonus from the Type drop-down list. This is a required
field. (See Guidelines)

In the Rules area, select Individually or Group from the Apply Transactions
drop-down list. This is a required field. (See Guidelines)

Make a selection from the Split drop-down list: No Split, Proportional, or
Non-Proportional. This is a required field. (See Guidelines)

Check the Cumulative check box if you want to aggregate the transactions. (See
Guidelines).

Check the Interval To Date check box if you want to base the calculation on a
period different from the plan element interval. (See Guidelines)

Check the Planning check box if this formula is used for plan modeling
purposes.

Click Generate to save your work. You can click Update to save changes, or
Restore to return to the previously saved information.

Click the Expressions link on the side panel menu.
Expressions page appears.

In the Input area, select an expression from the drop-down list to represent your
formula input. You can use more than one input expression, but the number of
input expressions must equal the number of dimensions in the rate table that
you select later.

Assign a forecast, if desired.

Click the eraser icon in the Remove column to delete an expression from the
formula.

In the Output area, select an expression from the drop-down list.

As with the input expression, you can select a forecast from the drop-down list.
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17. In the Performance Measure area, select an expression from the drop-down list.
The performance measure, as well as the quota, is used in reports for
comparison with achievement.

18. Click Update to save your work. If you saved the expression before, you can
click Restore before you click Update to return to the previously saved version.

19. Click the Rate Tables link on the side panel menu to assign a rate table to the
formula.

The Rate Tables page appears.

20. Click Go in the first blank field in the Name column to open a pop-up box.
Select a rate table and click it.

21. Enter an effective start date and end date. You can view the rate table details
and rates by clicking Rate Table Details.

22. Click the Detail link on the side panel menu and click Generate. If you have
successfully created the formula, the status field above the Generate button will
change from Incomplete to Complete.

23. Click Update to save.

Guidelines

A Bonus Formula is a type of Formula where there are no links or references to
transactions. See the Guidelines section of Define Calculation Expressions for more
information. Also see "Formula Bonus".

Do not split tiers if you want a rate from the rate table applied to the full amount.
Split tiers if you want portions of the full amount paid at each rate up to the top
qualifying rate. For example, the rate table shows 0-1000 at 1%, 1000-2000 at 2%.
The transaction amount is 1500. If you select No Split in the drop-down list, 2% is
applied to the whole transaction amount of 1500. If you select Non-Proportional in
the drop-down list, 1% is applied to 1000 and 2% is applied to 500.

The Proportional selection in the Split drop-down list is intended for use with
amount rate tables. For example, if the rate table shows 0-1000 at 100, 1000—2000 at
200. The first transaction amount is 200. The commission for this transaction is 20
because 200 is one fifth of the first rate tier and one fifth of the 100 rate is 20. If the
second transaction amount is 1300, the remaining four fifths of the first rate tier
pays 80, and half of the second tier [(1300-800)/(2000-1000)] pays 100 (half of the
rate 200). Total commission for the second transaction is 180.
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Select the Cumulative check box if transactions are required to be aggregated in
total. The rate applied will be determined by the transactions-total achieved to date
within the interval.

Note: If you are selecting the Cumulative or Split functions, you can use percent,
amount, or expression type rate dimensions. You cannot use string dimensions.

Use interval-to-date quotas and fixed amounts if:

= Calculation is to occur before the end of the plan element interval (for example,
if the interval is quarter and calculation occurs monthly)

= Quotas are set cumulatively within the interval
= Performance to date is to be compared to the quota to date

Note: Performance measures must use numeric expressions to work correctly. In a
formula, if no performance measure is assigned, the application uses the first (*)
input expression. If that expression evaluates to string values, the calculation will
fail. Therefore, it is important when using an input expression that is not numeric to
assign a numeric performance measure.

Dependency Notes

Formula Commission

1. Individual Option for Transactions can be used with any Cumulative/Interval
to Date option.

= By default Interval to Date and Cumulative options must be used together.
You cannot select Interval to Date by itself. Split options are selectable (each
is mutually exclusive).

= Accumulate can be selected by itself. Split options are selectable (each is
mutually exclusive).

2. Group by Interval for Transactions can only be used with Cumulative. Split
options are selectable (each is mutually exclusive).

Formula Bonus

Bonus formulas calculate only against Individual transaction options. Split options
are selectable (each is mutually exclusive).

Use interval to date quotas and fixed amounts if:

= Quotas are set each period
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= Quotas are set cumulatively within the interval

= Performance to date is to be compared to the quota to date

4.11 Associate Responsibilities with Responsibility Groups

Oracle Incentive Compensation uses responsibilities for Incentive Planning. For
example, in Incentive Planning, an analyst creates agreements while a contract
approver approves them. Some activities can be performed by multiple
responsibilities. Because of their different job functions, users with one
responsibility may see different tabs than those with another responsibility when
they log in to the application.

Some Incentive Planning responsibilities are seeded with the application, such as
Incentive Planning Analyst, Incentive Planning Contract Approver, and Incentive
Planning Manager. However, you can create your own responsibilities to meet your
business requirements. For example, you can create US Planning Analyst, Europe
Planning Analyst, and Australia Planning Analyst, all with the same job function.

Whether the responsibilities are seeded or created by you, Oracle Incentive
Compensation uses responsibility groups to assign access privileges to them. These
groups determine which groups and resources the person assigned to the
responsibility can work on. The four available responsibility groups are Super User,
Finance Manager, Contract Approver, and Sales Manager. All seeded
responsibilities are already placed in appropriate responsibility groups during
installation of the application, but any new responsibility that you create for use in
Incentive Planning must be assigned a responsibility group.

This can be done by setting the OSC: SFP Responsibility Group profile for the
responsibility. A typical responsibility group setup is displayed below:

Responsibility Responsibility Group
Incentive Planning Analyst Super User
Incentive Planning Finance Manager Finance Manager

Incentive Planning Contract Approver  Contract Approver

Incentive Planning Sales Manager Sales Manager

Prerequisites
None
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Responsibility
System Administrator

Navigation
Forms Instance > Profile > System

Steps

1. Log in to the Forms instance.

2. Select the System Administrator responsibility.
The Navigator - System Administrator window opens.

3. Double-click Profile.

4. Under Profile, double-click System.
The Find System Profile Values window opens.

5. Check the Responsibility check box.

6. Enter Incentive in the Responsibility field. Click Find.
The Responsibilities window opens.

7. Select Incentive Planning Analyst. Click OK.

8. In the Find System Profiles window, enter OSC%Resp% in the Profile field.
The System Profile Values window opens.

9. In the Responsibility column, in the row for OSC:SFP Responsibility Group,
select the access for the Super User responsibility from the list of values. Click
OK in the list of values window.

10. Repeat steps 7 through 9 for each of the three other responsibilities as shown
above.

11. Close the window.

4.12 Define Default Contract Text

Use this page to customize and define the text that accompanies the Compensation
Plan. The contract text and displayed components can be defined at a company
level, as well as at the agreement level.
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Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Settings

Steps
1. Click the Administration tab and click the Incentive subtab.

2. (Click Settings in the side panel Menu.
The Settings page appears.

3. Select a Transaction calendar from the drop-down list. You can choose from Five
Day Week or a Six Day Week.

Enter the title of the contract in the Contract Title field.
Enter the Eligibility Rules in the Club Qualification text box.
Enter the Terms & Conditions of the Compensation Plan.
Enter the Approver’s details in the Approver section.

If necessary, click Restore to retrieve the last saved set of information.

© ® N o o &

Click Update to save your work.

Guidelines

The text in the Terms & Conditions text box can be made to refer to the location of
the Terms & Conditions. Example, “I accept the Terms & Conditions as set out in the
Company Handbook that is posted on the Notice Board or the Company Handbook
that was issued with the Employment Contract.” This text will appear at the bottom
of the Compensation Plan that will be generated later.

The Approver’s details will appear at the bottom of the Compensation Plan as well.

The contract text hold approximately 1,000 characters.
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4.12.1 Workday Calendar

The workday calendar is a type of transaction calendar that is assigned to a
compensation plan. The value of a transaction calendar is that it defines the specific
workdays of a particular year, and excludes weekends and holidays. For example, a
USA Workday Calendar 2002 lists only the workdays in the United States for the
calendar year 2002. The holidays vary from country to country, from state to state
and even from organization to organization.

Workday calendars are useful for calculating compensation based on the exact
number of workdays in a given month. A calendar’s duration can be defined to
match your organization’s financial year. You need to assign a new workday
calendar every year as the dates of weekends and many holidays change from year
to year.

To view or change the workday calendar that is assigned to a particular
compensation plan, perform the following procedure.

Prerequisites
The profile option OSC: Use Work Day Calendar must be set to Yes.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > General > Transaction Calendar

Steps
1. Click the Administration tab.

The General subtab appears automatically.
2. Click Transaction Calendar in the side panel menu.

The Transaction Calendar page appears, listing all transaction calendars that
have been defined.

3. To modify the days of the week of an existing transaction calendar, check or
uncheck the appropriate check boxes. To modify exact dates, see step 8.
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9.

10.
11.

To create a new transaction calendar, enter the name of the new calendar in the
first empty name field.

Optionally, enter a description.

Check the check boxes for the days of the week that you want to designate as
workdays in the transaction calendar.

Click Update to save your work. Before clicking Update, you can return to the
previously saved settings by clicking Restore.

To define the exact dates of holidays or additional work days, click the
transaction calendar link in the Name column.

A different Transaction Calendar page appears. This page lists each date as a
separate row, containing the calendar date, day of the week, and a Business Day
check box. See Guidelines for more details.

Check the check box next to any date that you want to set as a business day.
Uncheck the check box next to any date that you want to designate as a holiday.

Click Update to save your work. Before clicking Update, you can return to the
previously saved settings by clicking Restore.

Perform the following procedure to complete setup of a transaction calendar.

Steps

1.

Click the Administration tab and click the Incentive subtab.

2. Select Settings from the side panel menu.
The Settings page appears.

3. Select a transaction calendar from the drop-down list.

4. Click Update to save your changes. Before clicking Update, you can return to
the previously saved settings by clicking Restore.

Guidelines

This Transaction Calendar page does not start at the current year, and the listing of
dates is extensive. In the current release, dates begin at January 1, 1994 and run
through December 31, 2010. To get to the beginning of the year you want, use the
drop-down list and select the area that is approximately where you want to work.
Then, use the Previous and Next links to get to the exact dates you need.
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If you use the Search field, the application displays only the single day you
requested.

4.13 Define User Access

The User Access functionality defines to which Incentive Planning group a user
with Incentive Planning Finance Manager has access. In order for a finance manager
to view or modify planning data for an incentive planning group, the access must
be explicitly defined. Use the User Summary page to select a User. After that, enter
specific information on the User Access Detail page to make alterations to the
selected User’s access privileges.

Prerequisites

Users must be assigned Incentive Planning Financial Manager responsibility to
appear on the User Access screen.

Responsibility
Incentive Compensation Super User

Navigation
Administration > Incentive > User Access

Steps

1. On the Administration tab, click Incentive.
2. Click User Access on the side panel menu.
The User Access page opens.
3. Select a User by clicking on the name.
The User Access Details page opens.

4. On the User Access Details page, enter a compensation group in the
Compensation Group column, or click Go to select one from the pop-up menu.

Only groups with a usage of "Sales Force Planning" can be selected from the list
of values.

5. In the Organization column, select an organization from the drop-down list.
6. Select an access level of Update or View from the drop-down list.

7. If necessary, click Restore to return to the most recently saved information.
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8. (Click Update to save your changes.

4.14 Define Quota Components

Components are parts of an agreement that is created in Incentive Planning that
capture specific agreement data, such as salary and quota amounts. The
components can be of three types: Fixed, Variable Quota Based, or Variable
Non-Quota Based. Variable components are further classified as computed or
non-computed components. A computed component takes other variable
components as inputs to its definition. Fixed pay components do not change from
period to period, for example, Salary or Car Allowance. Variable pay components
change depending on sales activity and are associated with commission rather than
salary or expenses. Variable pay components can be based on a quota or be
nonquota based.

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Component

Steps
1. Click the Administration tab and click the Incentive subtab.

2. In the side panel menu, click Component.
The Quota Components page appears.
3. Use the search parameters to find an existing component.

a. Enter one or more characters in the Name field to narrow your search. Or,
leave the percent sign (%) to display all components matching the other
parameters you select.

b. Select one of five types from the Type drop-down list.
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c. Select Unit or Revenue from the Unit drop-down list.

d. Click Apply. The page refreshes and displays a list of all components that
match the search parameters.

4. To create a new component, enter a name in the first blank field in the Name
column. This field is required.

Optionally, enter a short description of the component.
Select a component type from the Type drop-down list. This is a required field.

Select Unit or Revenue from the Unit column drop-down list.

© N o o

Check the Computed Flag check box if the value of the component is to be
derived from a formula.

9. Click Update to save your work. If necessary, click Restore to return to the
previously stored information.

10. If you want to delete a component, check the Remove check box and click
Update.

Guidelines

Component types are either fixed or variable. Variable component types are either
Quota Based or Non Quota Based, depending on whether there is a quota as part of
the compensation plan.

If the Quota for a Component is to be derived from using a formula, then check the
Compute Flag box.

4.14.1 Edit Computed Component Formula

When a computed component has been defined and assigned to an agreement, it
requires inputs so that its value can be calculated. The valid inputs are variable pay
non-computed components and other variable pay computed components that have
already been defined. A percentage value is assigned to each input. Use this page to
define a formula for a computed formula.

Prerequisites
Components must be created.

Responsibility

Incentive Compensation Super User
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Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Incentive > Agreement > Sales Role Detail > Edit hyperlink

Steps
1. Select a component from the list of values.

2. Enter the percentage against this selected component. Repeat steps 1 and 2 until
all variables of the formula have been defined.

3. C(lick Restore to retrieve the last saved set of information.

4. Click Save to save new information.

Guidelines

The percentages entered against each component selected will be multiplied with
the value of each component. The results of all multiplication will be added
together.

4.15 Define Attainment Schedule

Attainment schedules are used with the generated contracts. THey display the
calculated earnings for different levels of quota attainment. For instance, if an
attainment schedule is created with 0%, 50%, and 100% as its attributes, then the
contract displays any fixed and variable pay earnings if 50% of the quota was
achieved. The Attainment Schedule is used in the Compensation Contract where
earnings for each level of achievement are displayed. To create an attainment
schedule, perform the following procedure. See Oracle Incentive Compensation User
Guide, Chapter 12, for more details.

Prerequisites
None

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst
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Navigation
Administration > Incentive > Attainment

Steps
1. Click the Administration tab and the Incentive subtab.

2. Click Attainment in the side panel menu.
The Attainment Schedule Summary page appears.

3. Enter the name of the attainment schedule you want to create in the blank field
in the Attain Schedule Name column.

4. Click Update.

5. Click the new name from the Attainment Schedule Summary.
The Define Attainment Schedule page opens.

6. Enter the desired percentages in the blank fields.

If you need more than two fields, click Update and two more blank fields will
appear under the saved ones.

7. Repeat step 6 until your attainment schedule is complete.

8. Click Update to save.

Guidelines

To delete an attainment schedule, check the Remove check box and click Update.
You cannot delete an attainment schedule that is already assigned to a role. To
change the name of an attainment schedule, create a new schedule with the same
percentages, assign it to the role, and remove the old schedule.

4.15.1 Seasonality Schedules

Seasonality schedules show how a product/service income or cost/expense is
distributed throughout the year, expressed in percentages of the year’s total.
Seasonality schedules can be assigned to multiple agreements, and agreements can
use multiple seasonality schedules for different components. Because of the
variability from period to period, a new hire’s quotas and pay are affected. If
seasonality schedules are not assigned, an even distribution is assumed by default,
where each period’s quota is the same amount for the entire year.

Seasonality schedules are built using the Incentive subtab of the Administration tab
in Oracle Incentive Compensation.
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Seasonality can only be applied to variable non computed plan elements, such as
salary or a car allowance.

Seasonality schedules show how a product/service income or cost/expense is
distributed throughout the year, expressed in percentages of the year’s total.
Seasonality schedules can be assigned to multiple agreements, and agreements can
use multiple seasonality schedules for different components. Because of the
variability from period to period, a new hire’s quotas and pay are affected. If
seasonality schedules are not assigned, an even distribution is assumed by default,
where each period’s quota is the same amount for the entire year. Seasonality
schedules are built using the Incentive subtab of the Administration tab in Oracle
Incentive Compensation. Seasonality can only be applied to variable non computed
plan elements, such as salary or a car allowance.

To create a new seasonality schedule, perform the following procedure.

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Seasonality > Click Create

Steps
1. Click the Administration tab and click the Incentive subtab.

2. Select Seasonality on the side panel menu.
The Seasonality Schedules page appears.
3. Click Create.
The Create New Seasonality Schedule page appears.

4. Enter a name for the new seasonality schedule in the name field. This is a
required field.

5. Enter a description. This is a required field.
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6. Select a year from the drop-down list.
7. If necessary, click Restore to return to the previously saved information.

8. In the Seasonality area, enter the percentage of annual quota in each field next
to each month. Be sure that the percentages add up to 100 percent.

9. When the schedule is the way you want it, click Update to save your work.

10. Click Validate to verify that your percentages add up to 100 percent. If
validation is successful, then the Validation Status in the top area of the page
reads Valid.

Guidelines

You must click Update to save a new seasonality schedule before clicking Validate. If
you click Validate without clicking Update first, it will return the all percentage
entries to 0.

4.16 Define Roles

A sales role describes a set of resources who share a common compensation
structure. Examples of roles are PC Salesperson, Consultant, and PC Regional Sales
Manager.

Use the following procedure to define the details of a sales role.

Prerequisites

Sales Roles must already be created in Oracle Resource Manager. Rate tables,
components, and attainment schedules must be created first in Oracle Incentive
Compensation.

Responsibility

Incentive Compensation Super User

Incentive Planning Analyst

Navigation
Incentive > Agreement > select sales role

Steps
1. Click the Incentive tab.
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10.
11.

12.

The Agreements page appears. It is the first page of the Agreement subtab.

Select a sales role name. Use the search parameter at the top of the page to
search if needed. Enter all or part of the sales role name before the percent sign
and click Apply to use the search parameter. Click the sales role to go to the
Sales Role Detail page.

Optionally, copy the fields from an existing role by selecting a role from the
drop-down list. Click Apply.

The On Target Earning field, which is read-only, displays the Total Earnings if
the resource assigned this role achieves 100% of quota. It is derived from
information entered in the Fixed Pay Amount and Commission at 100%
Attainment fields on this page.

Check the Club Eligible check box if this role is entitled to Club participation on
achieving Club rules.

Use the Rounding Factor field if you want to round the assigned quota. For
example, input 1000 if assigned quota is to be rounded up to the nearest 1000.

In the Quota Minimum and Quota Maximum fields, enter the range of quota
figures that this role should have.

Input the Plan Level to indicate the position of the role in the sales hierarchy.
For example, a street level resource will be assigned to Level 1.

Select an Attainment Schedule from the Attain Schedule drop-down list that is
applicable to the compensation plan for this role.

The currency code is displayed as a read-only field.

Select Fixed Pay Components and then enter numbers against each component
to indicate the sequence that it is to appear in the Assign Quota and My Quota
Estimate windows. Enter the fixed pay amount for each fixed component. (For
example: if the fixed salary of a resource is 50,000, then enter 50,000 against the
fixed salary component).

Select Variable Pay, Non Computed Components as in step 11:
a. Enter the name of the component. Click Go to open a pop-up list.
b. Enter the sequential order of display in the Sequence column.

c. In the % of Total Quota column, enter the percentage of the quota that you
want this component to represent in the compensation plan. This must be
entered for the Distribute Quota function to work.

d. Enter the amount of commission at 100% of attainment.
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e. Select a seasonality schedule. Click Go to open a pop-up list from which to
make your selection. The default seasonality schedule is even.

f.  Select a calculation formula by clicking Go and selecting it from the pop-up
list.

To appear in the list, the formula must be cumulative and the Planning
check box must be checked.

Select a rate table from the drop-down list.
Select a rate calculation method:

= Anchors - These must be defined separately. If Anchors is selected, the
Define link appears in the Anchors column.

= Manual - Uses the predefined rate table.
= Single Rate - All transactions are compensated at the same rate.

13. Select Variable Pay Computed Components and enter the sequential order of
display. The selections are the same as the Non Computed Components in step
9, except that seasonality is not used but formulas are.

14. Select Variable Pay Non Quota Components. Click Go to open a pop-up list.
Then, perform the following:

a. Enter the sequential order of display.

b. Enter the calculation formula. Click Go to open a pop-up list from which to
make your selection.

c. Select a rate table from the drop-down list.

15. The sections for variable components in steps 9, 10, and 11 also contain fields
for selecting a Calculation Formula and Rate Table. Enter information into these
fields to enable calculation for these variable components.

a. Components with quotas additionally include an anchor column and a
Disable Anchors check box.

b. Click Define in the Anchors column to go to the Agreement Details page.

c. Use anchors to indicate the maximum that can be earned at each tier of the
rate table you selected.

16. Enter the name of the compensation plan in the Map to Compensation Plan
field if you want the element to appear in that compensation plan after the
activation process has been run.
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17. Enter a start date and end date for the compensation plan mapping.

18. Click Update to save, or Restore to return to the previously saved information.

Guidelines

Entering the Quota range enables the Quota Range Report to be run. The minimum
quota on the Sales Role Details window will be picked up on the Minimum Quota
field on the Quota Modeling window when the minimum function is invoked by
the user.

Compensation Plan Levels are used in the Quota Model Summary and Average
Quota Summary Reports where the quota for each Component are totaled for each
level of Salespeople in the Salespeople Hierarchy for the selected parameters
(example, Organization, Effective Date) of each Report.

The Attainment Schedule will be used in the Compensation Contract where
earnings for each level of achievement are displayed.

Oracle Incentive Compensation automatically accounts for seasonality when it
calculates prorated annual quotas.

4.17 Define Agreement Details

Use this page to complete the definition of the rate table and quota anchor details
for a sales role.

Prerequisites

Rate tables must be created and assigned to the component to which you want to
apply anchor values.

Responsibility

Incentive Compensation Super User

Incentive Planning Analyst

Navigation
Incentive > Agreement > Search > click sales role link

Steps

1. On the Sales Role Detail page, in the Variable Pay, Computed Components area,
click Define in the Anchors column.
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The Agreement Details page appears.

2. Select a calculation method, Line or Step, from the Anchor Rate Calculation
Method drop-down list (See Guidelines).

3. In the Rate Range area, enter the Minimum Rate and Maximum Rate for each
tier of the Rate Table (optional).

4. In the Multi-Tier Rate Table Anchors area, enter the Percent of Attainment in the
first column. This is displayed based on the rate dimension definition. You can
change only the first and last values in this column (See Guidelines).

5. In the drop-down list of the Anchor Type column, select the method of
commission calculation to be used. Choose Amount if you are entering the
commission earnings amount for each attainment/achievement level. If the
percentage of quota is to be used, select Percent in the Anchor Type column and
enter the percentage of quota for each attainment level. See Guidelines for more
explanation.

6. Click Update to save new information.

7. If necessary, click Restore to retrieve the last saved set of information.

Guidelines

There are two methods of Anchor Rate calculation, Line and Step. These
methods are used to fill in the Commission rates for the rate tables created in
the Administration part of Oracle Incentive Compensation.

Step calculation simply uses the amounts in the anchor (expected commission
column), with no calculation. When attainment reaches the percent in the tier,
the commission amount shown in the tier is paid. The Line method calculates
commission on a sliding scale, with commission depending on the exact rate in
each separate tier of the rate table, calculated on a sliding scale.

Here is an example of how Line and Step calculation works:

Step 1. Create a rate dimension in the administration part of Oracle Incentive
Compensation:

Attainment
0-25%
25-50%
50-75%
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Attainment
75-100%
100-999%

Step 2. Assign the rate dimension to a rate table. Here the dimension type is
percent and the rate type is amount:

Attainment Expected Commission
0-25% To be calculated
25-50% To be calculated
50-75% To be calculated
75-100% To be calculated
100-999% To be calculated

Step 3. Assign this rate table to a component in Incentive Planning and define
the anchors as follows:

% of Attainment  Type Expected Commission
0% Amount 0

25% Amount 100,000

50% Amount 150,000

75% Amount 180,000

100% Amount 200,000

999% Amount 200,000

Step 4. If the anchor method calculation is Step calculation, the commission
rates for the rate table are:

Attainment Commission Rate
0-25% 0
25-50% 100,000
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Attainment Commission Rate
50-75% 150,000
75-100% 180,000
100-999% 200,000

Step 5. If the anchor calculation method is Line calculation, commission rates
for the rate table will be calculated as follows (TQ = 20,000 total quota):

» 1st Tier (1 - 25%)
100,000 - 0/(25% - 0%) TQ
100,000/25% * 20,000 = 20

»  2nd Tier (25% - 50%)
(150,000 - 100,000) /50% - 25%) TQ
50,000/25%*TQ = 10

s 3rd Tier (50% - 75%)
(180,000 - 150,000) / (75% - 50%) TQ
30,000/25% *TQ =6

»  4th Tier (75% - 100%)
(200,000 - 180,000) / (100% - 75%) TQ
20,000/25% *TQ =4

= 5th Tier (100% - 999%)
(200,000 - 200,000) /(999% - 100%) TQ =0

Note: Real data will be set up so that the commission rates increase from tier to
tier.

Step calculation can be used only for rate type of amount.

Anchors are used only to calculate the commission rates for the rate table. After
activation from Incentive Planning to Administration, these rates can be seen in
Resource > Resources, which are customized rates for the specific resource.

If the step calculation method is used in Incentive Planning, the rate table in
step 4 will be used to calculation commission. If the line calculation method is
used, then the rate table in step 5 will be used to calculation commission.
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In step 3 above, if the rate dimension for a rate table is defined as:

Attainment
0-25%
25-50%
50-100%

Then when this rate table is assigned to a compensation plan in Incentive
Planning, the multi-tier rate table percent of attainment column is displayed as:

Attainment
0%

25%

50%

100%

You can change only the 0% and 100% values.

4.18 Define Jobs

Job titles are used by Human Resources to categorize employees. Oracle Incentive
Compensation uses roles, and a job title can be assigned to a particular role by using
the Job Titles page.

Perform the following procedure to assign roles in Oracle Incentive Compensation
to Job Titles.

Prerequisites
Resources must be set up in Oracle Resource Manager.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst
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Navigation
Administration > Incentive > Job Titles

Steps

1.

Click the Administration tab and click the Incentive subtab.

2. Click Job Titles in the side panel menu.
The Job Titles page appears.

3. Use the search parameters at the top of the page to search for a job title by name
or by job code. Click Go to display the search results.

4. Click the link in the Job Titles column to go to the Resource Details - Job Titles
page.
This page displays any roles that are already assigned to the job title.

5. Toadd a role, enter it in the Role column. You can click Go to open a pop-up
window listing roles from which to select.

6. Enter a start date and end date. Click the calendar icon to open a pop-up
calendar. A start date is mandatory; the end date is optional.

7. Click Update to save your work. If you are editing a role assignment, you can
click Restore to return to the previously saved version.

Guidelines

If using Oracle Human Resources Management System, the job title information
here is read from HRMS via Oracle Resource Manager. If you are not using HRMS,
please refer to Oracle Resource Manager for more information.

4.19 Associate

Jobs with Roles

This procedure is done in Resource Manager. See Resource Manager information in
Oracle Incentive Compensation Implementation material (before step 1).

4.20 Define Resource Groups (Compensation Groups)

Compensation Groups are defined in Resource Manager. Refer to appropriate
sections of the Oracle CRM Foundation Implementation Guide (Implementing
Resource Manager) or Oracle CRM Foundation Concepts and Procedures

(Un

derstanding Resource Manager).
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4.21 Define Resources

Resources are created in Resource Manager. Refer to appropriate sections of the
Oracle CRM Application Foundation Implementation Guide (Implementing Resource
Manager) or Oracle CRM Foundation Concepts and Procedures (Understanding
Resource Manager).

4.21.1 Set Up Resources for Team Compensation

You can use Resource Manager to define resource teams that are recognized by
Oracle Incentive Compensation when calculating compensation amounts for
members of a team.

A transaction typically is associated with a single resource (especially if Oracle
Order Management is the transaction source). If the resource on the transaction is a
member of a team, then Oracle Incentive Compensation automatically calculates
compensation for every member of the team. For example, assume Steve is a
member of a team consisting of Steve, John, and Bill. A transaction for $100 is
collected into OIC. Steve is entitled to 100% credit for this transaction, but because
he is also a member of a team, OIC automatically gives 100% credit to John and Bill
as well.

However, even though team members all receive credit for the transaction, the sales
credit rolls up a sales hierarchy only on the original transaction. For example, if
Steve, John, and Bill all report to Bob, Bob receives only $100 sales credit (from
Steve). If Steve reports to Bob but John and Bill report to Sally, only Bob receives
rollup sales credit. Even if Steve, John, and Bill each have different managers, only
Bob receives the rollup sales credit.

Refer to the Oracle CRM Application Foundation Implementation Guide for the specific
steps necessary for creating a team and adding resources to it.

4.22 Assign Resources to Roles and Groups

Resources are assigned to roles and groups in Resource Manager. Refer to
appropriate sections of the Oracle CRM Foundation Implementation Guide (Defining
Dynamic Groups) or Oracle CRM Foundation Concepts and Procedures (Understanding
Resource Manager).

Prerequisites

Refer to Oracle CRM Application Foundation Implementation Guide (See:
Implementation Tasks for Resource Manager).
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Responsibility
System Administrator

Navigation
Forms Instance > Tasks > Import Resources

Steps

Note: All items that have a reference of creating or assigning an item should be
noted as a prerequisite prior to adding a Supplier to Oracle Payable. The following
steps are in the Forms user interface.

1. In the Toolbar, click Tasks > Import Resources
2. In the Resource Category field, select Supplier Contact from the list of values.

Enter information into the Name and Contact fields or select from the list of
values.

d

Click Search. This populates the Search Results field.
Click Create Resource.

Verify the start date, then click OK.

Click Save Resource, then click Details.

Create Sales Role and Compensation Group.

© ® N o o &

In the Resource form, assign a valid Resource number.

10. Click the Roles tab. Assign a role type from list of values as Incentive
Compensation.

11. Assign a Role from the list of values. Save.
12. Click the Group tab and assign Group from list of values.

13. Click Save. Resources tab is displayed. Select desired sales credit type from list
of values. Save.

Guidelines

Do not change a role type or delete a role if it is already assigned to any resources.
This can cause corrupted data in the system. Only the member flag and manager
flag can be updated.

To be sure that commission is calculated correctly, a sales role should not be
associated with a resource that is attached to a group with no group member role.
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In some cases you may not be able to find Sales Compensation in the Role Type list
of values. If this is the case, try the following:

Run the following SQL query.

select table name, nullable

from dba tab columns

where column name = 'ROLE_MODEL ID’

and owner = ‘CN’ ;

This is the correct output for the above query:

TABLE_NAME Nullable
CN_PLAN_TEXTS
CN_ROLE_MODELS_ALL
CN_ROLE_PLAN_MAPS
CN_ROLE_QUOTA_CATES
CN_SRP_QUOTA_CATES_ALL
CN_SRP_ROLE_DTLS_ALL
CN_SRP_TOTAL_COMPS_ALL

< KRR =7

If CN ROLE_QUOTA CATES, CN SRP QUOTA CATES ALL,and CN_SRP_ROLE
DTLS_ALL are not set to "Y’, run the following SQL scripts and commit after each
script:

ALTER TABLE CN.CN ROLE QUOTA CATES MODIFY (ROLE MODEL_ ID
NULL) ;

ALTER TABLE CN.CN SRP QUOTA CATES ALL MODIFY (ROLE MODEL_ ID
NULL) ;

ALTER TABLE CN.CN SRP ROLE DTLS ALL MODIFY (ROLE MODEL ID
NULL) ;
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4.23 Assign Roles to Job Titles

Job titles that are to be used in Planning need to be assigned to a role for a given
date range.

Prerequisites
Job titles must be defined in Oracle HR.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Job Titles

Steps
1. Click the Administration tab and click the Incentive subtab.

2. In the side panel menu, click Job Titles.
3.  On the Job Titles page, search for a job title.
4. In the search results listing, click a Job Title link.

The Resource Details - Job Titles page appears. The page displays any roles that
are already assigned to the Job Title and Job Code.

5. To associate a new role to the Job Title Code and Job Code, enter four or more
characters, including wildcards (%), in the Role field and click Go.

6. Click the link for the sales role you want to use.

7. Enter a start date for the role. You can click the calendar icons to open a date
picker.

8. Optionally, enter an end date. You can use the calendar icon as in step 7.

9. Click Update to save. Before saving, you can click Restore to return to the
previously saved setting.
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4.24 Assign Job Titles to Resources

This procedure is performed in Resource Manager. See Resource Manager
information in Oracle Incentive Compensation Implementation material (before
step 1).

4.25 Customize On Target Earnings and Anchors

On Target Earnings and Anchors are part of the definition of a role. They can also be
customized for individual resources. On the Resource Details - On Target Earnings
page, you can view fixed and variable compensation plan elements for a resource,
based on their compensation plan.

Prerequisites

The sales role must already be created in Resource Manager. The sales role details
must already be created in the Agreement subtab of the Incentive tab. Rate tables
must be created and assigned to the component to which you want to apply anchor
values.

Responsibility

Incentive Compensation Super User
Incentive Planning Analyst

Incentive Planning Contract Approver
Incentive Planning Finance Manager

Incentive Planning Sales Manager

Navigation
Resource > Planning

Steps
1. Click the Resource tab.

The Resource Search appears on the Planning subtab.
2. Use the Resource Search page to search for a resource.
The Resource Search Results page appears.

3. Click the name of the resource you need.
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The Resource Details - Main page appears.
4. Click the amount in the On Target Earnings column.
The Resource Details - On Target Earnings page appears.
5. Enter revised amounts in the fields for the Fixed and Variable Amount fields.

6. To customize anchors, click Anchor in the Details column in the Variable, Quota
Based area.

The Resource Details - Customized Anchors page appears.

7. In the Rate Schedule Detail section, enter the commission rate range for each
tier of the Rate Table.

8. In the Quota Anchors Detail section, select Amount if entering the commission
earnings amount for each attainment/achievement level. For Percentages, select
percentage and enter the percentage for each attainment level (percentage of
quota). See Guidelines for more explanation.

9. To view rate tables for variable non-quota elements, click the Rate link in the
Details column of the Variable, Non-Quota area.

10. If you are editing previously created information, you can click Restore to
retrieve the last saved set of information.

11. Click Update to save your work.

Guidelines

In the example below, at 0% achievement of quota, the variable pay is zero. At
25% of quota, the additional variable pay is 5,000. At 50% of quota achievement,
the additional variable pay is increased to a maximum of 12,000. This means
that the earnings in the 25-50% tier of the rate table are compensated at a higher
percentage than the 0-25% tier. At the 100% level of quota achievement, the
additional variable pay is 20,000. Any achievements over 200% of quota are
capped by entering the same value as the previous tier (no additional variable
pay) against the highest rate tier.

Anchor Type Pay

0 Amount 0

25 Amount 5,000
50 Amount 12,000
100 Amount 20,000
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Anchor Type Pay
200 Amount 50,000
9999 Amount 50,000

4.26 Assign and Distribute Quotas to Resources

4.26.1 Email Alert Messages

Follow this procedure to customize alert messages that are emailed to resources.
The messages are a method to prompt the email receiver to perform an action. For
example, when sales managers click the distribute button, their directs will receive
an email that prompts them to view and accept their compensation plan.

Prerequisites
None.

Responsibility

Incentive Planning Analyst

Contract Approver

Navigation
Oracle Workflow Builder

Steps

1. Start Oracle Workflow Builder and connect to the database by entering its
name, user login ID and password.

2. In the Show Items Types window, select Compensation Plan Processing in the
Hidden panel. Transfer Compensation Plan Processing to the panel called
Visible by clicking the Visible button. Click OK.

3. In the Oracle Workflow Builder main window, expand the tree to view the
approval process points that are represented by nodes. Expand the messages
node. There are three messages for the sales force to view:

= Accept Compensation Plan

= Approve Compensation Plan
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= Distribute Compensation Plan

4. Select one of the messages for editing. For example, select Accept
Compensation Plan.

5. Inthe Navigator Control Properties window, select the Body tab.
6. Edit the standard text message to suit user requirements.

7. Click the save icon in the toolbar.

Guidelines

Workflow Attributes are commands to fetch actual values. Example, &FORWARD_
FROM_NAME in the Body tab will enable the name of a user with Contract
Approver responsibility to appear in the email alert. The Workflow Attributes can
be identified as they are text expressed in capital letters and preceded by &. You
should edit message text around these Attributes and not to edit the Attributes
themselves.

4.26.2 Workflow Background Process

The Workflow background engine process needs to be scheduled so that the
workflow notification process can run (refer to Workflow User Guide > Setup Steps
> Setting Up Background Workflow Engines). To enable the notification process, the
Workflow Background Process concurrent program must be submitted from the
Submit Request form.

In the parameters window, enter the following parameters:
Item Type: Choose Compensation Plan

Processing:

Minimum Threshold: Ignore this field

Maximum Threshold: Ignore this field

Process Deferred: Choose Yes

Process Timeout: Choose Yes.

Schedule this concurrent program to run at regular intervals. For example, if
notifications are required to be delivered every half hour, then set the schedule at
30-minute intervals and the workflow background process will activate every 30
minutes and process any unprocessed items.

4-64 Oracle Incentive Compensation Implementation Guide



Assign and Distribute Quotas to Resources

4.26.3 Notification Mailer

For email notifications to be sent, submit the Notification Mailer concurrent
program as a concurrent process or from the command line. Before this, the
notification mailer configuration file wfmail.cfg that is provided as a part of Oracle
Workflow will need to be modified for your installation. Please look at the
Workflow User Guide for details on how to do this.

4.26.4 Regoaling

Regoaling enables managers to change the quota or variable pay of a resource’s
compensation plan at any time. These changes could be required because of:

= A change in business circumstances

= Aresource is receiving too much commission

= Aresource is receiving too little commission

= Aresource receives a promotion to a new role with a new goal
Regoaling can only be used if a plan is already accepted and activated.

Regoaling uses new seasonality and workday calendar features to calculate the
exact amount to be paid. Seasonality allows planners to assign different quotas to
each month to accommodate business cycles, and the workday calendar lets
planners count each workday of each month, accounting for holidays and
weekends. Seasonality and workday calendar can only be used on variable
non-computed components, such as Licenses and salary.

For example, a resource’s compensation plan has effective dates of January 1 to
December 31. The resource can receive a new compensation plan on the 24th of July
and the exact amount of compensation can be calculated for the rest of the year,
based on the quotas assigned to August through December and on the exact
number of work days remaining in July.

Prerequisites

Workday calendar profile must be set up in Forms. The transaction calendar must
be set up in General Ledger and selected from the drop down list in Administration
> Incentive > Settings. Seasonality must be set up in Administration > Incentive >
Seasonality.

Responsibility
Incentive Compensation Super User
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Incentive Planning Analyst

Navigation
Incentive > Agreement

Steps

1.

10.
11.

12.

Click the Incentive Tab.

The Agreements page is displayed.

Use the search parameter to list roles.

Click a role.

The Sales Role Details page appears.

Select seasonality in the Variable Pay, Non Computed Components area.
Select a rate calculation method:

= Anchors - These must be defined separately

= Manual - Use the predefined rate table

= Single Rate - all transactions are compensated at the same rate

Click Submit to enter any changes.

Click the Resource tab.

The Resource Search page on the Planning subtab appears automatically.
Use parameters to search for the resource.

Click the Resource name on the Resource Search Results page.

The Resource Details - Main page appears.

Check the Adjust Quota radio button.

Click Update.

The Resource Details - Quota Adjustment page appears.

Check the button next to an existing role to adjust it, or click the button next to
the blank row to enter information for a new role.

If you are regoaling an existing role, enter start and end dates for the new
quota. Be sure to set the end date an old quota the day before the start of a new
one.
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13.

14.
15.

16.

17.
18.

19.

20.
21.

22,

Click the link to Quota Allocation Details.
The Allocation Details - Quota and Pay Assignment page appears.
Click Prorate.

Adjust any prorated amount that you want to manually. This is good for
rounding amounts to even numbers.

When you change the amounts manually, it changes the proration factor, which
changes the On Target Earnings (OTE) as well.

After you have made any changes you want to make, click Update to save
them.

Click Lock.

Click Generate.

The Generate button then becomes the Submit button.

Click Submit to submit the plan to the Contract Approver.

Click the Single Tier Rate link to go to the Allocation Details - Rate page.

Check the Standard Rate button if you want to calculate based on the computed
figures. Click the Effective Rate button if you want to base calculations on
previous achievements.

Click Generate Effective Rate.

After the plan is submitted to the Contract Approver, it needs to be approved by
someone with the responsibility of Contract Approver or Incentive Compensation
Super User. This is the procedure:

Prerequisites
Plan is submitted to contract approver.

Responsibility
Incentive Compensation Super User

Incentive Planning Analyst

Incentive Planning Contract Approver

Navigation
Quota > Approve
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Steps
1. Click the Quota tab and click the Approve subtab.

The Resource Search page appears.
2. Enter search parameters and click Go.
The Resource Search Results page appears.
3. Click the resource name link to go to the Contract Approval Page.

4. Select Approve in the drop down list in the Action column next to contracts you
want to approve. You can also click Approve All to approve all of the submitted
contracts at once.

5. Click Distribute.
A manager can distribute a plan by using My Salespeople in Oracle Sales Online.

After the compensation plan has been distributed, the resource must log into Oracle
Sales Online to accept the plan. See Section 4.27, "Resources Accept Plans Using
Oracle Sales Online".

To Activate the sales role, perform the following procedure:

Prerequisites
The compensation plan must already be accepted by the resource.

Responsibility

Incentive Compensation Super User

Incentive Planning Analyst

Navigation
Incentive > Activation

Steps
1. Click the Incentive tab and click the Activation subtab.

The Role Activation page appears.
2. Check the Activate check box.
3. Click Update.
4. To activate all plans, click Activate AlL
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To activate the resource, perform the following procedure:

Prerequisites

Compensation plan must be accepted by the resource. The sales role must be
activated.

Responsibility

Incentive Compensation Super User

Incentive Planning Analyst

Navigation
Quota > Activate

Steps
1. Click the Quota tab and click the Activate subtab.

2. Enter parameters in the Resource Search page to find the resource you need.
The Resource Search Results page appears.

3. Click the name in the Resource Name column.
The Compensation Plan Activate page appears.

4. Click the check box in the Activate column.

5. Click Activate.

4.27 Resources Accept Plans Using Oracle Sales Online

Resources can log on to Oracle Sales Online and accept their Compensation Plans.
To do this, perform the following procedure:

Prerequisites
Compensation plan must be distributed. Resource must have access to Oracle Sales

Online.

Responsibility
Sales Online User (with access to the Compensation tab)
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Navigation
Oracle Sales Online > Compensation > Compensation Plan

Steps
1. Click the Compensation tab and click the Compensation Plan subtab.

The plan status is Issued.
2. Click the Rate link to go to the Contract page.
3. Review the contract and click Accept to accept the contract.

The plan status changes to Accepted.

4.28 Activate Pay Periods

To activate a pay period, perform the following procedure:

Prerequisites
Pay periods must be defined in Oracle Incentive Compensation.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Pay Periods

Steps
1. Click the Administration tab, and click the Incentive subtab.

2. Select Pay Periods in the side panel menu.
3. Select a calendar from the list of values. Click Apply.

4. Activate a pay period by selecting Active from the list of values (LOV) in the
Period Status column.

5. If necessary, click Restore to return to the previously saved information.

6. Click Update to save your changes.
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4.29 Define Pay Groups

A pay group defines the frequency of payments, such as monthly or semimonthly,
for the resources who are assigned the pay group. Use this procedure to define pay
groups.

Prerequisites

Calendars must be defined in GL and pay periods must be activated in Oracle
Incentive Compensation.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Pay Group

Steps
1. Click the Administration tab and click the Incentive subtab.

2. Select Pay Group from the side panel menu.

The Pay Group page appears.
3. Assign a unique name to the pay group. This field is required.
4. Optionally, enter a description.

5. Select an effective start date and end date for the pay group. Click the calendar
icon to open a calendar. These fields are required.

6. Select a calendar. Click Go to open a pop-up box from which to make a
selection.

7. Select a period type from the list of period types that were defined for the
selected calendar. Click Go to open a pop-up box.

8. If necessary, click Restore to return to the previously stored information.

9. Click Update to save the pay group.
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Guidelines

The period type defines the frequency of payments for the pay group. Even if a
period type, such as quarter or year, is displayed in the pop-up box, it must be
activated in Oracle Incentive Compensation before it can be used.

Note: In this release of Oracle Incentive Compensation, the period type must be set
to Month for values to roll over to the next year in Year to Date reports.

Each pay group can have one or many pay periods. A pay period is a range of dates
over which calculated plan element commissions are collected for payment.

The pay group reflects the frequency of the pay periods.
Each pay group requires a separate payrun.

Pay groups can be assigned to multiple resources at the same time and you can start
and end pay group assignments by individual resource at any time within the
duration of the pay group. Therefore, the application does not default any dates in
the Resource Details > Assign Pay Groups table in the Resource tab.

When you assigned a pay group to a resource, the application automatically checks
to see if there are any conflicts between the start and end dates of the pay group and
the start and end dates for every resource to which the pay group has been
assigned. For example, if you define a pay group starting Jan 1 and ending on Mar
31 and you have assigned it to a resource, the application will not let you change the
end date for the pay group assignment beyond Mar 31.

4.30 Set Up Collections

Two major processes are required to compute incentive compensation: data
collection and compensation calculation.

As a data collector, Oracle Incentive Compensation collects data from Oracle
Receivables, Oracle Order Management, or other data sources and prepares that
data to be transferred to the Oracle Incentive Compensation calculation processes.

4.30.1 Setting Up A New Transaction Source

Use this page to set up from which source you want to get the data for processing
your transactions, and also to determine which Receivables events you want to
generate the transactions. In the Transaction Source area, perform the following
procedure:
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Prerequisites
Tables must be set up already in the transaction source.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Collection

Steps
1. Click the Administration tab and click the Incentive subtab.

2. Click Collection on the side panel menu.

The Collection - Transaction Sources page appears. It is the first of six
Collections pages.

3. Enter the name of the transaction source in the first empty field in the
Transaction Source column.

4. Enter a type, or an abbreviation for a legacy source. See Guidelines for
restrictions.

5. Enter a Line Table name. Click Go to open a pop-up list from which to select a
line table name. Click your selection to enter it into the field.

6. Select a Key Column for the table. Click Go to open a pop-up list.

7. Toremove a transaction source, check the remove check box and the line will
disappear after the next update.

8. Click Update to save your work. Before saving, you can click Restore to return
to the previously saved information.

The Receivables Event area displays which receivables events are set up to collect
transaction data. To set these events to collect data, perform the following;:

1. Check the check box in the Collect Column next to the event for which you
want to collect.

2. Click Update. Before saving, you can click Restore to return to the previously
saved information.
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Guidelines

The Status column tells you whether the collection package has been generated for
the Transaction Source since the latest setup changes were made.

For each Transaction Source there are three pieces of information:

= Name: User-defined and changeable, and may include legacy sources.

= Type: The short name of the Transaction Source. It is user-defined, must be
unique, and cannot be changed after it is created. When creating a new
transaction source, the Type (for example, the short name of the transaction
source) has the following restrictions:

= It cannot be empty
= It must be unique

= It cannot be the same type as any existing seeded transaction source, such
as OC - Order Booking, or AR - Receivables.

= It cannot be the same as the type of existing receivables events, such as INV,
PMT, CBK, or WO.

= Status: Complete/Incomplete. This indicates whether the Collection package
has been generated for the Transaction Source since the latest setup changes
were made.

4.30.2 Source Tables

This page is used to specify all the tables which are used during the creation of
compensation transactions--the Direct Mapping tables. For the Receivables Posting
and Order Booking selections, all the transaction source data is predefined and
cannot be deleted or modified. A line table is mandatory.

There are two standard transaction sources: Receivables Posting and Order
Booking. All of the fields for these two predefined transaction sources are fixed and
cannot be deleted or modified.

To define source tables for nonstandard transaction sources, perform the following
procedure:

Prerequisites
Tables must be registered in the Tables subtab.
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Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Collection > Source Tables

Steps
1. Click the Administration tab and click the Incentive subtab.

2. C(lick Collection in the side panel menu.
3. Click the Source Tables link.
The Collection - Source Tables page appears.
4. Select a transaction source from the drop-down list.
5. Click Apply.

The Type and Status fields populate, and any tables that are already defined
populate in the fields below.

6. If a field can be changed, enter a table name, or click Go to open a pop-up list.
Click your selection to enter it into the field.

Guidelines

A Line table is mandatory. It contains the line items against which compensation is
to be paid. L_ORDER_LINES has been designated as the Line table.

The Key Column of the Line table is also mandatory. It is the field in the table that
uniquely identifies each line.

Specify any additional tables to be used in creating compensation transactions in
the Extra Direct Tables List.

Optionally, you can specify a header table in the Header Table area. If you specify a
Header Table, also specify a key column for it and in the Line Table Header
Identifier field specify the field in the line record (foreign key) which allows it to be
joined to the Key Column field of the Header Table.
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Before using any table, be sure that table is registered using the Tables page
(Administration > Incentive > Tables). Table aliases are system defined. These are
the values that you must use if you refer to a table by its alias.

4.30.3 Queries

On this page the significance of the information entered in the Source Tables tab
becomes apparent. The capability for querying depends on the information entered
into the Source Tables. You can generate a list of transactions that are eligible for
compensation using the Notification Query and Parameters.

The Queries page is divided into two areas: Notification Query and Collection
Query. The Notification Query area shows the exact query which will be used to
create the Notification list of line-level transactions which are eligible for
compensation. The Parameter subsection of the Notification Query area allows you
to narrow your focus, for example, by start date and end date.

The second part is the Collection Query. The Collection Query area lists the exact
tables and rows from those tables that you need to perform a collection.

The Queries link is active only if new transaction sources have been created. It does
not appear for predefined transaction sources--Receivables Posting and Order
Booking.

You can only use the queries subtab to define a Custom Source from which to
collect to Oracle Incentive Compensation. For standard integration with Oracle
Receivables and Oracle Order Management (through Order Capture) you cannot
edit the query conditions which are part of the standard process.

To change or enter new parameters in the Notification Query area, perform the
following procedure:

Prerequisites
The Queries page is only accessible for nonstandard collection sources.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst
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Navigation
Administration > Incentive > Collection > Queries

Steps
1. Click the Administration tab and click the Incentive subtab.

2. Click Collection on the side panel menu.
3. Click the Queries link.
The Collection - Queries page appears.
4. Enter the name of the parameter in the field.
5. Click Update.
The Type field populates.

Note: The value field of the parameter is read-only on this page. When the
parameter is created, the value field is empty. The value can be assigned in the
Collection Submission - Runtime Parameter page before running the collection.

6. While entering data, click the eraser icon to clear the field. If you want to return
to the previously stored information, click Restore.

Guidelines

This Notification query joins together the mandatory Line table (L_ORDER_LINES)
and the optional Header table (L_ORDER_HEADERS). You must specify a header
table, even though the purpose of the notification query is to get a list of identifiers
from the Line table. The reason for this lies in the additional criterion which has
been added to the end of the WHERE clause:

AND loh10000.booked_date BETWEEN p_start_date AND p_end_date

This restriction means that the user wants to collect only the orders that were
booked between a specific start and end dates. The booked date of the order resides
in the Order Header, so it is necessary to bring the L_ORDER_HEADERS table into
the Notification Query to allow this. This requirement often applies, so the Header
Table field on the Source Tables is provided to enable this match without the need
for advanced SQL knowledge.

P_start_date and p_end_date are parameters whose values are set by the user before
collections is run for this Transaction Source. Although the parameters must be
registered on this tab, their runtime values are set on a different page (Setup ->
Collection Parameters menu option). A separate page is used because for any changes
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made on the Collections page to take effect, it is necessary to regenerate the
collections package, whereas the parameter values can be changed without needing
to regenerate.

The list of tables in the Collection query FROM clause (the Direct Mapping tables)
consists of the Line table, the (optional) Header table and all of the tables listed as
Extra Direct Tables on the Source tables tab.

The WHERE clause of the query already contains the necessary join information to
get the right rows from the Line and Header tables. The user is required to complete
the WHERE clause with all the join information necessary to get the right rows from
the Extra Direct tables.

Once the information on the Queries page is entered, you have completed all the
setup necessary to build a correct set of compensation transactions from the source
tables in your legacy system. The next step is to define what information will
actually be stored in the compensation transaction. That is the function of the
Mapping tab.

4.30.4 Set Up Collection Mapping

Use the Mapping page to specify what data is needed to fill each destination
column when a compensation record is collected from the Transaction Source.

When you move to the Mapping page for the first time after creating a new
Transaction Source, you can see that the Source Expression/Destination list has
been prepopulated with a number of records. These records are the mappings for
the mandatory Destination Columns, those columns in CN_COMM_LINES_API
that must always be filled before a CN_COMM_LINES_API record can be imported
into Oracle Incentive Compensation. Examples of mandatory columns are
Employee_Number, Transaction_Amount, Transaction_Type and Source_Doc_Type.
You cannot delete these mandatory mappings.

In some cases the Source Expression Field for the mapping, that is, the description
of the data used to fill the Destination Column, has been prepopulated and cannot
be updated. An example of this is the mapping for Source_Doc_Type, which is set to
be the Type that you enter when you name the Transaction Source (‘LEG” in our
example). Most Source fields are left blank, though, and you have to define the
source data for these mappings. You cannot generate a Collection package if any
mapping has a blank Source Expression (although you can enter the value NULL in
the Source Expression field if you need to).

The Source Expression field can contain a simple column specification or any other
valid SQL expression. Each of the following is potentially a valid Source value:
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NULL NULL Value

"My Text’ literal value

booked_date column_name
1_order_headers.booked_date table_name.column_name
1oh10000.booked_date table_alias.column_name
NVL(10110001.ordered_quantity, 0) SQL function
my_function(loh10000.booked_ user function

date,1sc10002.salesrep_id)

Direct and Indirect Mappings are set up differently. A description of each follows.

4.30.5 Direct Mappings

Direct Mappings are those in which the source data is derived exclusively from one
or more tables in the FROM clause of the Collection Query (any table listed on the
Source Tables tab).

If the source data does not include any database information at all, and it is just
NULL or a literal value, then this can also be regarded as a Direct Mapping.

To define a Direct Mapping, type the appropriate SQL expression into the Source
Expression field. A Direct Mapping is simply incorporated into the Collection
Creation query that was described earlier. This single SQL statement already knows
how to join all of the Direct Mapping tables together, so you need to define only
what column information (if any) you need from these tables.

Notice that all seven of the example expressions shown in the table in 5.12 refer
either to no table data at all, or only to columns from one of the Direct Mapping
tables. These are therefore valid Direct mappings in the context of our example
setup. Suppose for example that for the Quantity Destination Column, you want to
use NVL(10110001.ordered_quantity, 0) as the Source value. All you would need to
do is type exactly this text into the Source Expression field for that mapping.

Although you can type this text directly into the Source field, this approach is
potentially error prone. You need to spell the column name (ordered_quantity)
correctly and you should normally precede that with either the full name of the
source table (I_order_lines) or the exact alias of the table (lol10001). Instead of this
manual procedure, you can click the Go button next to the Source Expression field
to get a List of Values (LOV) to help you.
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The required Source field text, for example, can be created as follows:

Prerequisites

Tables must exist in the transaction Source and the destination. For relationship
indirect mapping, a Join relationship must be set on the External Tables page of the
Administration tab for any tables you plan to use.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Collection > Mapping

Steps
1. Click the Administration tab and the Incentive subtab.

2. Click the Collection link in the side panel menu.
The Collection - Transaction Sources page appears.
3. Click the Mapping link.
The Collection - Mapping page appears.
4. Enter a source expression in the Source Expression field.

5. Enter a destination. Click Go to open a pop-up list. In the Select box, enter
search parameters and click Go. Select from the list. See Guidelines.

6. If necessary, click Restore to return to the previously saved information.

7. Click Update to save your work.

4.30.6 Indirect Mappings

Indirect Mappings are implemented as UPDATES to the existing CN_COMM_
LINES_API record. You need to define the FROM and WHERE clauses of this
UPDATE statement. There are two ways that this mapping is performed: the
Free-Form Indirect Mapping and the Relationship Indirect Mapping.
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With a Free-Form mapping you must manually enter the exact FROM/WHERE
clause on the Mapping tab. With a Relationship Mapping you first use the External
Tables form to define a join relationship between CN_COMM_LINES_API and the
table from which the source data is to be collected. Then, on the Mapping tab, you
specify this join relationship in the Relationship field. The FROM/WHERE field
then becomes read-only and is automatically set according to that Relationship
definition.

The remainder of this section describes an example of Indirect Mapping.

If you want to store the resource territory in the Attributel field of CN_COMM_
LINES_AP]I, the territory can be taken from L_TERRITORIES, using the Salesrep_
ID, which is also present in the L_SALES_CREDITS table.

The first requirement to implement this is to set up a direct mapping to store the
Salesrep_Id from L_SALES_CREDITS. To set up the direct mapping, perform the
following steps:

Prerequisites

Tables must exist in the transaction Source and the destination. For relationship
indirect mapping, a Join relationship must be set on the External Tables page of the
Administration tab for any tables you plan to use.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Collection > Mapping

Steps

1. Create a new record in the mappings list.
2. Enter Isc.salesrep_id in the Source Expression field.

3. In the Destination field, select a spare column, such as Attribute99, from the
LOV.
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4.30.6.1 Free-Form Indirect Mapping

To set up a Free-Form Indirect Mapping for Territory, perform the following steps:

Prerequisites

Tables must exist in the transaction Source and the destination. For relationship
indirect mapping, a Join relationship must be set on the External Tables page of the
Administration tab for any tables you plan to use.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Collection > Mapping

Steps

1. Create a new record in the mappings list.

2. Enter FROM 1_territories lte WHERE lte.salesrep_id = api.attribute99 in the
FROM/WHERE field.

3. Enter lte.territory_name in the Source Expression field.

Note: If you click Go to do this, the Table Name LOV lists all of the tables that
are currently registered in Oracle Incentive Compensation. This is because the
FROM clause is free-form text which could contain multiple tables. It is easier to
list all the tables for the user to choose from than to try to extract table names
out of the FROM/WHERE clause.

4. In the Destination field, select Attributel from the LOV.

4.30.6.2 Relationship Indirect Mapping

Alternatively, to set up a Relationship Indirect Mapping for Territory, perform the
following steps:

Responsibility

Incentive Compensation Super User

Incentive Compensation Analyst
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Incentive Planning Analyst

Navigation
Administration > Incentive > External Tables

Steps

1. Use the External Tables page to set up a join relationship. In this relationship the
Source Table is L_ TERRITORIES and the Destination Table is CN_COMM _
LINES_APL The Source Column is Salesrep_id and the Destination Column is
Attribute99.

2. Go back to the Mappings page of the Collections subtab (Administration >
Incentive > Collections > Transaction Source > Mapping). Create a new record
in the mappings list.

3. Use the LOV on the Relationship field to select the relationship that you have
just set up. The FROM/WHERE clause is automatically populated.

4. Enter lte.territory_name in the Source Expression field.
5. In the Destination field select Attributel from the LOV.

Whether you set this up as a Free-Form or a Relationship mapping, you will see that
the following text is displayed beneath the Relationship field:

UPDATE cn_comm_lines_api api SET attributel = SELECT lte.territory_name
The FROM/WHERE field completes the statement:
FROM 1_territories lte WHERE lte.salesrep_id = api.attribute99

This shows you in SQL exactly how your Indirect Mapping will be physically
implemented.

4.30.6.3 Free-Form vs. Relationship Indirect Mapping

When should you use a Free-Form Indirect mapping and when should you use a
Relationship Indirect mapping?

The Relationship Mapping is more restrictive than the Free-Form version. On the
External Tables form you can define simple equivalence joins only between tables,
which means joins of the form:

WHERE tablel.columnA = table2.columnB
AND tablel.columnC = table2.columnD
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This rules out the use of other tests such as OR, BETWEEN, <, != and so on as well
as the use of functions such as NVL and the outer join operator.

A relationship also only allows you to join to a single Indirect table. If you need to
join multiple tables together, then you cannot use the Relationship option, unless
you create a custom view to hide the join.

Therefore, Free-Form mapping is the one to choose.

There is no occasion where you actually have to choose a Relationship mapping
over a Free-Form one. Relationship mappings are chosen because of setup
simplicity (they can be reused in multiple mappings) and maintainability.

4.30.7 Actions

The Actions page allows you to change the Collection processing for the transaction
source in two ways--the addition of User Code Blocks and the specification of
Transaction Filters. User code blocks are PL/SQL statements (functions and
procedures) that you can insert at certain points in the collection procedure. You can
insert user code blocks into the cn_comm_lines_api_all table.

Transaction filters are especially relevant to Receivables and Order Management,
because you cannot change the collection query for those standard transaction
sources. Filters allow you to define criteria for unwanted transactions (See
Guidelines).

To create a User Code Block, perform the following procedure.

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Collections > Actions

Steps
1. Click the Administration tab and click the Incentive subtab.
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2. (Click Collections on the side panel menu.
3. Click the Actions link.
The Collections Setup - Actions page appears.

4. Select a location for the user code block from the Location drop-down list.
Choices include:

= Pre-Notification: at the beginning of the procedure
= Post-Notification: between running the Notification and Collection queries
= Post-Collection: after the Collection query has been run

5. Enter the code in the Code field.

6. If necessary, click Restore to return to the previously saved information.

7. Click Update to save your changes.

To create a filter, perform the following procedure:

1. Select the method of filtering by clicking one of two buttons:

= Mark as Filtered: The transaction will appear in CN_COMM_LINES_API
but be marked as filtered.

= Physically Delete: The transaction will be deleted from CN_COMM_
LINES_APIL

2. Enter the text of the action you want in the Filters area of the page.
3. If necessary, click Restore to return to the previously saved information.

4. Click Update to save your work.

Guidelines

User code blocks are single or multiple PL/SQL statements which you can choose
to have inserted at defined points within the Collect procedure that will be
generated for your Transaction Source. You can insert user code blocks at three
locations:

= At the beginning of the procedure
= Between running the Notification and Collection queries

= After the Collection query has been run
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Because you cannot access the Queries page for a standard transaction source, you
cannot change the collection query to filter transactions that you do not want. This
is why the filters on the Actions page are useful for these transaction sources.

Filters allow you to define criteria for the removal of unwanted transactions.
Suppose, for example, you do not want to compensate people for any transaction
with a value of less that $100 (assuming that all your sales are in dollars). You can
specify this on the Actions page simply by entering the text api.transaction_amount <
100 on a line in the Filters area.

You can also decide which method of filtering should be carried out for your
transaction source, using the button in the Filter section. If you select Physical
Delete then filtered transactions are physically deleted from CN_COMM_LINES_
APL If you select Mark As Filtered, the transactions are not deleted—they are
marked as FILTERED and are never imported into Oracle Incentive Compensation.

4.30.8 Generate

When the collection setup is complete, you are nearly ready to generate your
Collections package. However, since clicking the Generate button on the Generate
page will replace the existing version of the package with a new one based upon the
current setup, test first whether this new package is valid. The Test Generate button
on the Generate page enables you to test the validity of the new package.

When the Test Generate button on this tab is clicked, a test version of the Collection
package is generated for the selected Transaction Source.

After the setup is complete, use the Generate page to generate a test collections
package. After it tests successfully, you can generate the final collections package
from this page as well.

Prerequisites
Collections setup must be complete.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Collection > Generate
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Steps
1. Click the Administration tab and click the Incentive subtab.

2. Click Collection on the side panel menu.
3. Click Generate.
The Collection - Generate page appears.

4. In the Summary area, click the button in the Select column next to the
transaction source for which you want to run a test generation.

5. Click Test Generate.
A test version is generated.

6. If Error appears in the Test Status column, click it to open the details area below
the Summary area.

The Error Text and entire Package text are displayed.

7. Fix the errors and rerun the test generation until you are satisfied with the
result.

8. You can click Yes or No in the Collect Flag to return to the Transaction Sources
page and verify it or change it.

9. If everything is correct, click Generate to generate the actual Collection
package.

Guidelines

The Error Text field lists compilation errors in the generated package together with
their line numbers. The Package Text field displays the entire code, with line
numbers, for the package. This way, if any errors are listed for the package, you can
easily find the offending line of code in the Package Text field.

The usual cause of a compilation error is invalid SQL which has been typed in on
the Queries or Mappings tabs or in a User code Block. It is easy to identify such
problems during the test generation, go back and fix them, and then rerun the test
generate.

Apart from finding compilation errors, the other main use of this function is to
allow you to scan through the generated package and confirm that it is doing what
you had intended when you set up the information on the other tabs. It enables you,
for example, to see exactly where in the Collect procedure your User Code Block(s)
will be executed.
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4.30.9 Run Collections

After performing all of the setups on Administration > Incentive > Collect, you
actually run the package to collect transactions that you created in the Collection -
Generate page. Collection Submission has three parts, represented by three pages:

= Runtime Parameter
= Submit Request
= View Request Status and Logs

Runtime Parameters

Runtime parameters are used to narrow the range of transactions collected in a
collection package if you are using a custom transaction source. For example, a start
date and end date can be defined. The parameters are defined on the Queries page
in the setup process. These values are not provided during the collection setup, but
are instead entered during the collection submission process. This allows you to
change the values without regenerating the collection package.

Prerequisites
Parameters must already be created in the Collection setup process.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Navigation
Transaction > Collect > Collection Submission - Runtime Parameter

Steps

1. Select the parameter you want to change.
2. Enter a value in the Runtime Parameters field.
3. If necessary, click Restore to return to the previously saved information.

4. Click Update to save your changes.

Submit a Request
To submit a transaction collection request, perform the following procedure.
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Prerequisites

The collection setup must be completed and the collection package must have been
generated successfully.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Navigation
Transaction > Collect > Submit Request

Steps

1.

Click the Transaction tab. The Collect subtab page opens automatically. Click
the Submit Request link. The Collection Submission - Submit Request page
appears.

In the Collection Type field, select a collection type from the drop-down list.
The collection types include:

»  Collect Clawbacks

s Collect Custom Transaction Source
= Collect Invoices

= Collect Orders

s Collect Payments and Givebacks

= Collect Revenue Adjustments

»  Collect Writeoffs

Click Apply.

Note: If you select Collect Custom Transaction Source, the parameter changes to
Transaction Source. Specify the custom transaction source on which you want to
run collection and skip to step 5.

Select Start Period and End Period dates from the drop-down lists.
Click Submit Request.
A confirmation window appears.

Click OK to submit the request. Click Cancel to return to the current page.
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If you clicked OK, the requested data is displayed below the search parameter

fields.

7. Click Refresh Data periodically to monitor the progress of the calculation
submission.

Guidelines

The Collect Orders collection type collects data from Oracle Order Management.
The Collect Custom Transaction Sources collection type collects data from external
sources. The other events collect data from Oracle Receivables.

The Process Log page shows the details of the processing of a request.

Transactions collected for a specific period cannot be collected again for the same
period unless the collected_flag is set back to N or the records are physically
deleted. If you need to recollect previously collected transactions, consult with
Oracle Support.

Viewing the Request Status and Logs

Data must be collected from the mapped tables into Oracle Incentive Compensation
before calculation for payment can occur. Use this procedure to view the status of
the collection submission.

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Navigation
Transaction > Collect > View Request Status

Steps

1. Click the Transaction tab. In the Collect subtab the Collection Submission - View
Request page appears automatically.

2. Select the type of collection event you want from the Collection Type
drop-down list. The list includes:

= Al
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Select one of five options from the Phase drop-down list:

Clawbacks

Custom Transaction Source
Invoices

Orders

Payments and Givebacks
Revenue Adjustments

Writeoffs

All
Completed
Inactive
Pending

Running

Select one of 18 statuses in the Status drop-down list.

All
@@Normal
@Normal
@Waiting
Cancelled
Disabled
Error

No Manager
Normal
On Hold
Paused
Resuming
Scheduled
Standby
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= Suspended

s Terminated

s Terminating

s Waiting

= Warning
5. Optionally, enter a search string in the Request ID field.
6. Click Apply to view a list of collection submissions.
Click View Log in the Log column to go to the Process Log.

It is recommended that you actually run the package to collect transactions. This is
accomplished by the Collect Custom Transaction Source concurrent program. This
program requires you to enter a single parameter, the name of your Transaction

Source. The LOV on this parameter lists all custom Transaction Sources that are set

up.
Remember that if you created any parameters on your Queries page, you do not set
their values on the Concurrent Program run page. You have to use the Collection

Parameters page to set their runtime values before you call up the Concurrent
Program.

The final action required to pull these transactions from the API table into Oracle
Incentive Compensation is to run the Transaction Interface Loader concurrent
program, or to click the Load Transactions button on the Maintain Transactions

page.

4.30.10 Set Up A Standard Transaction Source

Oracle Incentive Compensation is delivered with two predefined Transaction
Sources: Receivables Posting (integrated with Oracle Receivables) and Order
Booking (integrated with Oracle Order Management).

The setup of Collections for these Transaction Sources is very similar to the setup of
new user-defined sources. The difference is that for the standard transaction sources
you cannot make any changes to the Source Tables or Queries tabs. This is because
collection from Oracle Receivables and Oracle Order Management is implemented
as complex procedural logic rather than as simple Notification and Collection
queries and it is not possible to express that logic on the Queries page.

Both of the standard transaction sources are delivered with a set of mappings to
populate the important columns in CN_COMM_LINES_API. You are allowed to
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change source values for these mappings and also to create new mappings of your
own.

Prerequisites
Tables must exist in the transaction source and in the destination.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Navigation
Administration > Incentive > Collection > Mapping

Steps
1. Click the Administration tab and click the Incentive subtab.

2. Click Collection in the side panel menu.
3. C(Click Mapping.
The Collection - Mapping page appears.
4. Enter a source expression in the Source Expression field.

5. Enter a destination. Click Go to open a pop-up list. In the Select box, enter
search parameters and click Go. Select from the list.

6. If you want to perform indirect mapping, click Indirect to open the Indirect
Mapping Details area at the bottom of the page.

7. In the Indirect Mapping Details area, enter a join relationship or click Go to
select one from a pop-up list.

8. If necessary, click Restore to return to the previously saved information.

9. Click Update to save your work.

Guidelines

When you first display the Mappings page for a standard transaction source, the
Inherited column will display === for every mapping. This tells you that the
mapping is a standard one and has not been changed. If you change the value in
either the Source, Relationship or FROM/WHERE field for a standard mapping, the
Inherited column will change to display =X=. If you want to revert a mapping to its
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original standard setup, click the Inherit button. The Source, Relationship and
FROM/WHERE fields change back to their original values and the Inherit field
reverts to ===. If you create any new mappings, the Inherited column is blank for
these rows and the Inherit button has no effect.

4.30.11 Use Filters

See Filters in Section 4.30.7, "Actions".

4.30.12 Receivables Posting and Order Booking Special Features

4.30.12.1 Receivables Posting

The predefined Receivables data source differs slightly from any other data source
because it really represents four transaction sources that have been combined into
one so that the sources can share a set of mappings. The five sources are referred to
as receivables events and are as follows:

= Invoice, credit memo posting

= Payment, giveback posting (a giveback is a past due invoice that had been taken
back but has now been paid)

= Writeoff posting

= Takeback posting (once an invoice due date goes beyond the set grace period,
the credit for the sale is deducted from the resource’s sales credit)

= Revenue Adjustment Posting

These events occur when the relevant transaction is posted to the Oracle General
Ledger application.

The transaction collection queries for these events are all based around the same
core set of Receivables source tables, but the tables are joined together in different
ways so five different Transaction Sources would normally be required. The five
have been combined into a single Transaction Source so that you set up only the
Mappings that you want once and they are applied to the collection of
Compensation Transactions for all five Events.

When you click the Generate button for the receivables transaction source
(Administration > Incentive > Collections > Generate), five packages are generated,
one for each Receivables event. This generation takes five times as long as for any
other transaction Source. However, you may not be interested in all of these events.
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It is therefore possible to restrict the generation to only those packages for the
events that you require.

To select which packages to collect, perform the following procedure:

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Collection

Steps
1. Click the Administration tab and click the Incentive subtab.

2. Click Collection in the side panel menu.
The Collection - Transaction Sources page appears.

3. In the Receivables Event area, check the check boxes in the Collect column for
which you want to collect transactions.

4. Click Update to save your changes. Click Restore to return to the previously
saved information.

5. Click Generate to open the Collection - Generate page.
6. Click Generate.

Guidelines

Each receivables event has a dedicated concurrent program. Each of these requires
two parameters: a start period and end period. The parameter entry is supported by
a list of values. The concurrent programs are as follows:

s Collect Invoices
s Collect Takebacks
= Collect Payments and Givebacks
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s Collect Writeoffs

= Collect Revenue Adjustments

4.30.12.2 Order Booking

Compared with Receivables, the Order Booking transaction source behaves more
like the user-defined transaction sources which were defined earlier.

A single collection package, Collect Orders, is called by a dedicated concurrent
program. The concurrent program requires two parameters, a start period and an
end period. The parameter entry is supported by a list of values.

Although this transaction source collects from Oracle Quoting - Forms (formerly
known as Order Capture), the transactions actually originate in Oracle Order
Management. Oracle Quoting - Forms acts as an interface. The transactions
themselves are sales credits for orders that have reached the Booked status in Order
Management.

4.30.13 Adjustments

Order information often is changed after the Order has been set to the status of
Booked. Such changes, known as adjustments, can be automatically applied to
transactions which have already been collected. If a change is made to any line on
an order, then all of the sales credits (compensation transactions) for that line are
considered to be changed. There are two possible scenarios:

= Scenario 1: The compensation transactions have been collected but have not
been loaded into Oracle Incentive Compensation.

= Scenario 2: The compensation transactions have been collected and also loaded
into Oracle Incentive Compensation.

In the scenario 1, the transactions have only got as far as the CN_COMM_LINES_
API table. In such cases the original transactions are marked OBSOLETE and they
will be re-collected into CN_COMM_LINES_API with their new values the next
time Collect Orders is run.

In the scenario 2, the transactions are already inside Oracle Incentive Compensation
and may have even been used to calculate resource commission. This requires a
different approach. The original transactions in CN_COMM_LINES_API are
marked FROZEN. For each of these a reversing transaction is also created in CN_
COMM_LINES_API This is a duplicate of the FROZEN line, but with an opposite
polarity (usually meaning it becomes negative) on the Transaction Amount. This
transaction will have the effect of reversing out the original. Finally, as in scenario 1,
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the Compensation Transactions for this line will be re-collected into CN_COMM._
LINES_API with their new values the next time Collect Orders is run.

Each time Collect Orders is run, the list of unprocessed updated Order Lines must
first be processed. This can take a long time to complete. To avoid having a long
wait when running Collect Orders, it is a good idea to process this list of updated
Order Lines at regular intervals (perhaps daily). There is a Concurrent Program to
do this called Order Update Notification.

The list of updates to Orders is maintained for Oracle Incentive Compensation by
the Oracle Quoting - Forms application. However, this only occurs if you inform
Oracle Quoting - Forms of this requirement. You must register Oracle Incentive
Compensation with Oracle Order Management.

Coping With Adjustments

You can cope with adjustments to transactions in your custom transaction sources
in the same way as standard Collections from Oracle Quoting - Forms does. All you
need to do is to call a Collections API, identifying the transaction that has been
changed.

If you specified a Header Table on your Source Tables tab then you need to pass the
unique identifiers of both the Header record and the Line record of the changed
transaction. Otherwise only the identifier of the Line record is required.

Suppose that Collections has already been run for October 2000 transactions in the
example legacy system. Also, those transactions are already imported into Oracle
Incentive Compensation. Now, a change is made to one of the orders for that
month. In the table below, the ID of the Order Header is 1001 and the ID of the
Order Line is 1234. To notify Oracle Incentive Compensation of this change you
make the following call:

CN_NOTIFICATION_PUB.Create_Notification

This API can be called either:

= At the time that the adjustment was done in the source system
= In the prenotification phase, or

= In the notification phase itself

This is the code:

( p_api version => 1.0,
X _return status => 1 return status, -- OUT parameter
X_msg_count => 1 msg_count, -- OUT parameter
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x msg_data => 1 msg data, -- OUT parameter

p line id =>1234, -- Line Table Id

p_source doc_ type => 'LEG', -- Transaction Source Type
p_adjusted flag = 'Y’", -- Adjustment (not new record)
p_header id =>1001, -- Header Table Identifier

p _org id => your org id, -- Operating Unit (optional)
x loading status => 1 loading status -- OUT parameter

)

Note: To understand the p_org_id parameter, you need to first understand the
Oracle Applications ‘Multi-org’ strategy, which allows data for multiple operating
units to exist, partitioned from each other, within a single database. Discussion of
Multi-org is beyond the scope of this document. If you do not understand this
concept then please consult the appropriate documentation before trying to
understand the following paragraph.

If your procedure which calls CN_NOTIFICATION_PUB.Create_Notification is
running in a database session where the Org-Id has been set, and your procedure is
only dealing with transactions for this Org-Id, then you can omit the p_org_id
parameter. In any other situation (for example where you have a single procedure
or database trigger which detects updates to transactions from multiple Org-Ids)
you must specify the correct value of p_org_id for the transaction when you call
Create_Notification.

4.31 Set Up Expense/Liability Account Mapping

In this release of Oracle Incentive Compensation, information can be transferred
and posted from Oracle Incentive Compensation to Oracle Payable. This function is
used for outside suppliers and vendors, not for regular employees. Regular
employees are paid using Oracle Payroll.

Expense and Liability Accounts can be assigned at three levels: plan element,
revenue class, and classification. There is an interface table in Oracle Incentive
Compensation. After the data is mapped to the interface, the subledger is updated
to reflect the amounts paid. The Liability Account will also be mapped to the Oracle
Payable interface using the account generator in Oracle Incentive Compensation.

4.31.1 Account Generator

Expense and Liability Account information is supported by default at three levels of
detail:

= REVENUE CLASS
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» PLAN ELEMENT
= CLASSIFICATION

See Guidelines for more about the three levels. To set the level, perform the
following procedure:

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > System Parameters

Steps
1. Click the Administration tab and click the Incentive subtab.

2. The system parameters page opens. It is the first selection on the side panel
menu.

3. Scroll down to the Payment area.

4. Select the level of account generation from the Account Generation drop-down
list.

5. Click Update to save your changes. If you are making changes to existing
System Parameters, you can click Restore to return to the previously saved
information.

If you select the Classification level from the Account Generation drop-down list,
you must perform the following setup, which is similar to the current classification
Ruleset procedure:

Steps
1. Click the Administration tab and click the Incentive tab.

2. In the side panel menu, click Ruleset.
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10.
11.

12.
13.

14.

15.

16.

17.

The Rulesets page appears.
Define the name of the ruleset.

Enter a start date and an end date for the ruleset. Click the calendar icons to
open pop-up calendars.

Select the type of Account Generation from the drop-down list.
Click Update to save your work.

Click Rules in the Rules column.

The Rules Hierarchy page appears.

In the lower part of the page, enter a name for the new rule.

Add Expense Code and Liability Code names. Click the flashlight icons to open
a search box. Enter four or more characters in the search field and click Go, then
select the code you need.

Click Update to save your changes.

Click the Attributes link for the new rule.

The Rule Attributes page appears.

Choose an attribute and a value using the flashlight icons to open search boxes.

Optionally, check the Not check box to specifically exclude the value of the
attribute from classification.

Optionally, enter additional attributes for the rule.

Note: Every attribute is assumed to be linked to other attributes with AND. If
you want any of the attributes to be related with OR, use the Build Expression
tab to relate the first two attributes with AND or OR.

Save the rule.
The expression appears.

To add rules in the rules hierarchy, position your cursor over the parent rule,
right click, and choose New Rule. Repeat from step 2.

Return to the Ruleset form for every ruleset that has new or changed rules and
click Synchronize.

In order for the system to know to transfer the account code, you must first be able
to classify the transactions. To classify the transaction, see Section 4.36, "Define
Classification Rulesets for Revenue Classification". Create the same rule as you
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created in the Ruleset for Account Generation. Then, you can calculate and pay for
transactions.

Guidelines

The application checks to see what account generator level has been set. Based on
this level, the appropriate Accounts Payable accounts are associated to the line item.
The three levels are as follows:

Revenue Class: Each revenue class will be assigned a specific liability and expense
account. This option should be used if tracking expenses for each product is
required.

Plan Element: Each plan element can be assigned a specific liability and expense
account. This option should be used if all products assigned to the plan element will
be assigned to the same expense and liability account.

Classification: An entire rule can be assigned a specific liability and expense
account.

4.32 Set Up Plan Element to Oracle Payroll Pay Element Mapping

Use this page to map the plan elements in Oracle Incentive Compensation to the
pay elements in Payroll. To add or change a record, perform the following
procedure.

Prerequisites
Plan elements and pay elements must already be created.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Payroll

Steps

If you want to make a change in mapping or dates to an existing line, perform the
following procedure.
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1. Click the Administration tab and click the Incentive subtab.
2. Click Payroll on the side panel menu.

The Payroll Mapping page appears.
3. Enter the changes to the Plan Element or Pay Element fields.

= Enter four or more characters in the element fields and click Go to open a
pop-up list.
»  Click the calendar icon in the date fields to open a pop-up calendar.

4. Check the Remove check box if you want to eliminate the plan element to pay
element mapping.

5. Click the Inactive Employees check box if you want to keep the mapping but
not use it now.

6. If necessary, click Restore before clicking Update to return to the previously
stored information.

7. Click Update to save any changes you have made.

8. You can click Element Input to go to the Pay Element Input Values Mapping
page.
To enter a new mapping, perform the following procedure.

1. Enter a plan element in the first blank plan element field. Click Go to open a
pop-up list.

2. Enter the pay element from Payroll that you want to use.

3. Enter a start date and an end date.

4. If necessary, click Restore to return to the previously saved information.
5. Click Update to save your mapping.

Guidelines

The mapping information is stored in the CN_QUOTA_PAY_ELEMENT_MAP
table. The three-column table below shows examples of how the mapping is set up
between Oracle Incentive Compensation plan elements and Payroll pay elements,
with the resource status indicated in the third column:

Plan Element (OIC) Pay Element (Payroll) Resource Status
01 Account Quota Commission Pay ACTIVE
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Plan Element (OIC)

Pay Element (Payroll)

Resource Status

01 Account Quota Commission Pay INACTIVE
Recoverable Payment Plan Commission Pay ACTIVE
Payment Plan Recovery Commission Pay ACTIVE
Q1 OCG Bonus Bonus Pay ACTIVE
Q1 OCG Bonus Bonus Pay INACTIVE
Education Commission Pay ACTIVE
Education Commission Pay INACTIVE

4.32.1 Pay Element Input Values Mapping

If a pay element in Payroll has been defined to have input values, then you can
define a mapping in Oracle Incentive Compensation that identifies which data
columns in application tables map to the input value of a pay element. The
following tables can be used to map Oracle Incentive Compensation to pay element
input values:

CN_PAYRUNS
CN_SALESREPS
CN_PAYMENT_TRANSACTIONS

This mapping is stored in the CN_PAY_ELEMENT_INPUTS table in Oracle
Incentive Compensation.

Prerequisites
Plan elements and pay elements must already be created.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Payroll
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Steps

1.
2.

Click the Administration tab and click the Incentive subtab.
Click Payroll on the side panel menu.
The Payroll Mapping page appears.

Click the link in the Element Inputs column next to the plan element and pay
element that you want to work on.

The Pay Element Input Value Mapping page appears.

Enter a table name in the first blank field in the Table Name column. Click Go
to open a pop-up list.

Enter a column name in the Column Name column. Click Go if needed.

In a line that is not yet saved, you can click the eraser icon to clear the fields
before entering new information.

To remove a saved line, check the check box in the Remove column.
If necessary, click Restore to return to previously saved information.

Click Update to save.

4.33 Map Classification Attributes and Collection Attributes

Use the Columns page to define the descriptive flexfields in the CN_
COMMISSION_HEADERS table. You can link a user Name for an attribute to the
application’s name for it. This process makes the names easier to use because they
specifically describe the attribute. For example, Sales Region is easier to remember
and apply than Attribute 6.

Prerequisites
None

Responsibility

Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst
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Navigation
Administration > Incentive > Tables

Steps

1.
2.

8.
9.

Click the Administration tab and click the Incentive subtab.
Click Tables in the side panel menu.
The Tables page appears.

In the schema search parameter field, enter CN% to query for Incentive
Compensation tables.

Note: Be sure to enter CN in uppercase letters.
Click Update.

The CN schemas are now listed.

Scroll down to CN_COMMISSION_HEADERS.
In the Details column, click Columns.

The Columns page appears.

In the View drop-down list, select which columns you want to view. Choices
include Columns, Dimensions, Classification, and Primary Key:.

Click Apply.

Use the search drop-down list to narrow find the column name you need.

For Columns or Dimensions, the following steps apply:

10.

11.

12.
13.

14.

Enter the name of your choice in the User Name field. Make sure it is a name
that is easy to understand and use.

The Data Type field indicates if the column contains alphanumeric material
(VARCHAR?2), numerical data (NUMBER), or a date (DATE).

Check the usage check box if you plan to use the column for calculation.

Check the Foreign Key check box if you plan to use the column as a foreign key
to collect data from the table.

Click Update to save your changes. Before saving, you can click Restore to
return to the previously stored information.
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4.34 Define Revenue Classes

Revenue classes are user-defined categories of business revenue used to determine
whether a sales credit is applied to a compensation payment. A hierarchy composed
of broader revenue classes at the top, or root, with subclasses as children of the root,
makes it possible to pay compensation for broader revenue classes without
specifying all possible subclasses in a compensation plan.

Each revenue class represents a different type of sale for which an organization pays
compensation. Different companies have different revenue classes, because each
sales organization awards compensation differently. After defining your
organization’s revenue classes, you assign one or more revenue classes to a plan
element, assign the compensation plan to a role, and then assign the role to a
resource. By assigning revenue classes, you specify the types of revenue for which
each resource can earn compensation.

All revenue classes on the same plan element share the same quota and
compensation rate table. If revenue classes in a compensation plan have different
quotas or are paid according to different rate tables, you must create a plan element
for each revenue class that has a different quota or compensation rate.

Many companies award compensation based on the types of products or services its
salespeople sell. Depending on the business practices of your sales organization,
you might award compensation based on factors other than products or services
sold. For example:

= Your sales organization might have customer account teams, where salespeople
only receive compensation for sales to their assigned set of accounts. In this
case, each customer account is probably a separate Oracle Incentive
Compensation revenue class.

= Your company might organize its sales strategy around expansion into new
markets, where each new market is defined as a separate revenue class.

= Your company might use industry-based incentive compensation, paying
compensation only for sales made in a resource’s assigned set of industries.

For a specific example, a computer hardware company awards compensation based
on the types of products or services its salespeople sell. At the broadest level, the
company sells PCs, peripherals, education services, consulting services, and
support maintenance services. While some types of salespeople, such as resellers,
are only authorized to sell a subset of this offering, the company awards
compensation to some of its salespeople for all types of products and services. Thus,
for the company, each product or service category is an Oracle Incentive
Compensation revenue class.
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Each transaction gets classified with a specific revenue class. A plan element lists all
revenue classes that are eligible for commission calculation. Therefore, using the
revenue class, a transaction is mapped to the plan element and thus the formula
where commissions are calculated.

Use the following procedure to define your revenue classes and build revenue class
hierarchies.

Prerequisites
None

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Revenue Class

Steps
1. Click the Administration tab and click the Incentive subtab.

2. Select Revenue Class from the side panel menu.

The Revenue Class page appears. The Revenue Class page displays all
previously defined revenue classes.

3. To define a new revenue class, enter the name in the first blank Name field.
4. Optionally, enter a description. The description often is the same as the name.

5. In the Liability Code and Expense Code columns, select a liability code and
expense code if needed to integrate with Accounts Payable (optional).

To search for liability codes and expense codes, click Go to open a pop-up list.
6. Click Update to save your work.

A confirmation message displays across the top of the page when the save is
successful.
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4.35 Define Revenue Class Hierarchy

When matching the revenue class on a compensation transaction, such as a sales
order, to a revenue class on a resource’s compensation plan, the class of the
classified transaction is rolled up in the revenue class hierarchy to determine
matches to any revenue class on the plan.

You can use this process to create new hierarchies or to make changes to an existing
hierarchy. To access an already created hierarchy, simply click Details on the
Hierarchy Types page and click Details next to the hierarchy name on the Hierarchy
page that appears.

There are three placements of nodes that you can make for any hierarchy:
= Root

= DParent

s Child

Root node is the highest level of the hierarchy. In Oracle Incentive Compensation,
you can place as many nodes under the root node as necessary to meet the business
objective. Oracle Incentive Compensation provides you with the flexibility of
creating multiple root nodes. For example, you can create a root node for France
Products and another for Germany Products.

A parent node is a node that has at least one node that rolls up to it. A parent node
typically summarizes information concerning the nodes below it, referred to as
child nodes. An example of a parent node would be Western States and under it
child nodes called California, Oregon and Washington.

A child node rolls up to a parent node. A child node can roll up to only one parent
node. For example, under the parent node of California the child nodes could be
called San Francisco and Los Angeles.

You can create a new hierarchy under an existing hierarchy type, or you can create a
new hierarchy type and then build the hierarchy there.

The hierarchy determines the eligibility of other revenue classes. A transaction can
be classified with a revenue class at a granular level, but by creating a revenue class
hierarchy, other revenue classes are eligible for compensation as long as they exist
higher in the hierarchy.

For example, sales representatives sell laptops and desktop computers and the
transactions are classified at the lowest level, the product name. In the revenue class
hierarchy, the revenue class All Computers exists higher than the Laptops and
Desktops revenue classes. The manager of the sales representatives does not have to
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list Laptops and Desktops on her plan element but only All Computers, because it
exists higher in the hierarchy. She will get calculated commissions even though the
transaction was classified as Laptops.

Warning: Do not delete the Base Node of the seeded Revenue Class hierarchy.
For more information on the structure of a hierarchy, see Guidelines.

To create a hierarchy in a new hierarchy type, perform the following procedure.

Prerequisites
Revenue classes have been created.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Hierarchy

Steps
1. Click the Administration tab and click the Incentive subtab.

2. Select Hierarchy in the side panel menu.
The Hierarchy Types page appears.
3. Enter a name in the first blank Name column.

4. Enter four or more characters in the Base Table field and click Go. This field is
required.

5. Enter four or more characters in the Primary Key field and click Go. This field is
required.

6. Enter four or more characters in the Hierarchy Values field and click Go. This
field is required.

7. Click Update to save.
A Confirmation message appears on the screen.

8. Click Details to enter the name of the new hierarchy.
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10.
11.

12.

13.

14.

15.

16.

17.
18.

19.

20.

21.
22.

The Hierarchies page appears.

Enter the name of the new hierarchy in the Name field and click Update.
Click Details.

The Intervals page appears.

Enter the start and end dates for the hierarchy. Click the calendar icon to open a
pop-up calendar.

Click Update to save your hierarchy. If necessary, click Restore before clicking
Update to return to the previously saved information.

The page refreshes with a system generated root node displayed and a details
link in the Details column.

Click Details.

The Hierarchies page appears. It displays the existing available root classes. The
application provides a default root class called Hierarchy Base Node.

Enter one or more root class names.

When you select the root name, a plus sign next to the name indicates you can
click it to expand and view the hierarchy that is part of the selected root. You
can expand and view any level of the hierarchy.

To add a child, select the parent revenue class for which you want to add a
child.

Click the Add Child button.
Select where you want the new node to appear.

s Add new node under selected node: The node is added as a child to the
selected parent node

= Add new node as root node: The node is added to the hierarchy as another
base node

Click Go to open a pop-up box with a listing of available options for new
nodes. Click your choice.

Click Update to add the revenue class to the hierarchy.
The new revenue class appears in the hierarchy.
Repeat steps 10 to 14 to build your hierarchy.

If necessary, click Restore to return to the most recently saved information.
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23. Click Update periodically as you go and at the end to save your work.

Guidelines
You can create as many hierarchies as you need. However, only one hierarchy can
be effective at a time.

You can import any portion of another hierarchy to become a child of your selected
node in the hierarchy you are building.

4.36 Define Classification Rulesets for Revenue Classification

A classification ruleset is used to classify sales transactions to determine the
appropriate revenue class for the transaction. Then, using the revenue class, a
transaction is matched with a compensation plan and a compensation amount to be
paid when the transaction is calculated. Use this procedure below to define a set of
attributes and values that uniquely identify each revenue classification.

There are two ruleset types: Revenue Classification and Account Generation.

= Revenue Classification defines the rules that are used to identify a revenue class
for each transaction that the system processes as part of calculating
commissions.

= Account Generation is used to integrate Oracle Incentive Compensation
automatically with Accounts Payable and to classify transactions to identify
Expense and Liability Accounts.

Add a rules hierarchy that accurately reflects your business requirements. The rule
names are user defined, but many customers have found it useful to give rules a
name that is similar to the revenue classes that is assigned to the rule. Rules do not
require unique names.

Prerequisites

Revenue Classes have been created and the user-defined flexfields of the CN_
COMMISSION_HEADERS table have been defined. These flexfields will become
the attributes that will be evaluated when determining a revenue class.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst
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Navigation
Administration > Incentive > Ruleset

Steps

1.
2.

Click the Administration tab and the Incentive subtab.
Click Ruleset in the side panel menu.
The Rulesets page appears.

In the first blank field in the Ruleset Name column, enter the name of the new
ruleset.

Enter a start and an end date for the ruleset. Click the calendar icons to open
pop-up calendars.

Select Revenue Classification from the Ruleset Type drop-down list.
Click Update to save your ruleset.

Note: If the ruleset dates overlap the dates of another ruleset, an error message
displays at the top of the page and you cannot continue with creating the
ruleset.

4.36.1 Build a Rules Hierarchy

At this point, the ruleset status is incomplete. Now, you must create the rules and
put them into a hierarchy. A rules hierarchy sets up relationships between rules. The
structure of a rules hierarchy starts with a root, then adds one or more parent rules,
and then as many child rules as needed. A rule can have one or more child rules or
siblings.

To query for a rule or to create a rule and add it to the rules hierarchy, perform the
following procedure:

Prerequisites
Classification Ruleset has been created.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst
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Navigation
Administration > Incentive > Ruleset > Click Rules link

Steps

1.
2.
3.

10.

11.

Click the Administration tab and click the Incentive subtab.

Click the Ruleset link in the side panel menu.

Click the Rules link in the Rules column.

The Rules Hierarchy page appears.

To query for a rule, enter it into the Rule Name search parameter and click Go.
The rule name, along with its hierarchy;, is displayed in the List of Values.

To add a rule, in the lower section of the Rules Hierarchy page, select Root from
the Add Rule column drop-down list.

Name the rule.

To assign the rule a revenue class name, enter at least four characters in the
Revenue Class Name field and clicking Go. Click the revenue class from the list
generated by the search. This step is optional.

Click Update. The rule is displayed in the upper table of the Rules Hierarchy
page. A confirmation message appears at the top of the page.

To define attributes for the rule, click Attributes in the Rule Attributes column.

The Rule Attributes page appears. All of the columns defined in the CN_
COMMISSION_HEADERS table that have been designated for classification
will appear as attributes in the drop-down list. If more attributes are needed,
then the administrator must modify the CN_COMMISSION_HEADERS table.

In each of the three areas, enter four or more characters in the Attribute field
and click Go to open a pop-up window list from which to select an attribute.

= For Single Value attributes, enter a single value in the Value field.
= For Range Value attributes, enter a low value and a high value in the fields.

= For Hierarchy values, enter a hierarchy and a value. For the Hierarchy and
Value fields you can enter four or more characters and click Go to open a
list of values.

Each area has a Not Flag column containing a check box. Check the check box
to indicate that you want to exclude that value from the rule. See Guidelines.
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12. To add rules in the hierarchy of rules, select the button next to the rule in the
Add Child/Sibling column, then enter the rule information in the lower section
of the page. See steps 5 through 8 for details.

An alternative is to drill down on the rule name link itself. This takes you to the
Create Rules page. The same functionality for creating child and sibling rules is
available here as it is on the Rules Hierarchy page.

13. When you are done, return to the Rulesets page and check the Synchronize
check box next to the changed ruleset. Click Update. See Guidelines.

If any rules do not have attributes, an error message displays along the top of
the page indicating which rule requires attributes to be assigned to it. The
messages continue to display for one rule at a time until all contain attributes.

14. To get to the Build Expression page, Return to the Rules Hierarchy page. Click
Expressions in the Rule Expression column. The Expressions link is enabled
only when the rule has two or more attributes defined.

The Build Expression page appears. See Guidelines.

15. Click Update to save your work. Before saving, you can click Restore to return
to the most recently saved information.

Guidelines

The classification engines evaluates the rules from top-to-bottom, left-to-right. As
soon as a positive match is made and any child rules evaluated, the transaction is
classified and no longer evaluated against any other rules. The rules higher in the
hierarchy must be built accordingly so that the transactions locate the appropriate
rule.

You can define multiple date-effective classification rulesets. Ruleset active dates
may not overlap.

When you make changes to a ruleset, you must synchronize it. When you check the
Synchronize check box and click Update, the application generates a PL/SQL script
based on the revenue classes and revenue class rules and saves it in an internal
table. Before the status changes from Incomplete to Complete, it may display Install
Pending. You do not need to synchronize a ruleset if you only rearranged the rules
but did not otherwise change them.

A hierarchy of rules can be defined for each ruleset.
Every rule must have at least one attribute.

You can build expressions on the rules using the Build Expression page.
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A rule may or may not have a revenue class. If the rule does not have a revenue
class, then its children rules must define the revenue class. If a rule has a revenue
class, then the revenue class is assigned to the transaction only if none of its child
rules match the transaction.

If you specify high and low values in a rule condition, the values can be
alphanumeric.

Every attribute is assumed to be linked to other attributes with AND. If you want
any of the attributes to be related with OR, use the Build Expression page to relate
the first two attributes with AND or OR.

Selecting the Hierarchy Values option allows you to enter the value in the hierarchy
you want to match. The fields that appear are Hierarchy and Hierarchy Values. If
the value of the transaction attribute rolls up the hierarchy to the value you specify,
then the compensation transaction satisfies the condition.

You can specify the inverse of a value you defined by checking the Not check box.
The compensation transaction satisfies the condition if the attribute is not equal to
the specified value, is not between the range of values specified, or does not roll up
to the specified ancestor value.

Always customize the classification rules using the setup forms available. Do not
modify the generated PL/SQL code.

4.37 Define Interval Types

Quota and payment targets are defined for a specific period of time. Intervals are
used to accumulate achievements for a specific period of time. The accumulated
achievements in turn determine the rate at which commission is calculated.

Commonly used intervals include period, quarter, and year. These intervals are
predefined. You must define interval numbers for these intervals using the Interval
Numbers page before they can be selected during creation of plan elements.

The Interval Types page displays all intervals that have been created and enables
creation of new intervals. To view or define an interval type, perform the following
procedure.

Prerequisites
None
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Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Interval Types

Steps

To view details of an already created interval, perform the following procedure:

1.
2.

5.

Click the Administration tab and click the Incentive subtab.
Select Interval Types from the side panel menu.

The Interval Types page appears.

Click the name of the interval in the Name column.

The Interval Numbers page displays.

The Interval Number column shows the previously defined interval numbers,
based on the calendar and period type shown above.

Select a year from the drop-down list to view interval numbers for other years.

To create a new interval type, perform the following procedure:

1.
2.
3.

On the Interval Types page, click Create.
Enter a name and description for the new interval.

Click Update to save your work. If needed, click Restore to return to the
previously saved information.

From the drop-down list, select the year for which you want to enter interval
numbers.

The interval numbers all display as 1.
Enter interval numbers. See Guidelines for suggested formats.

Click Update to save.
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Guidelines

Interval numbers are user definable. When an interval is first created, all of the
interval number fields contain a single numeral 1. You must then manually enter
the interval numbers that you need for each year. After you have entered the
numbers and clicked Update, they will remain stored, even if you select other years
from the drop-down list.

Interval numbers must be unique for each period.
For example, for quarterly intervals:

JAN-01, FEB-01, MAR-01 are all numbered 2001001

APR-01, MAY-01, JUN-01 are all numbered 2001002, and so on.
For Monthly intervals:

JAN-01 is numbered 2001001

FEB-01 is numbered 2001002

MAR-01 is numbered 2001003, and so on.

4.38 Define Credit Types

Use this page to define all credit types to be used in Oracle Incentive Compensation.
Credit types include Functional Currency, points, air miles, or any custom form of
credit that you want. These definitions are optional, and nonmonetary credits must
be converted to functional currency to be paid. Only nonmonetary credit types can
be defined.

4.38.1 View, Change, or Remove a Credit Type

To view, change, or remove a credit type, perform the following procedure.

Prerequisites
None

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst
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Navigation
Administration > Incentive > Credit Type

Steps
1. Click the Administration tab and click the Incentive subtab.

2. Select Credit Type from the side panel menu.
The Credit Types page appears.

3. Optionally, use the search parameters at the top of the page. Enter a name or
description ahead of the percent sign and click Apply.

4. Change the values in the Precision and Extended Precision fields as needed.

Precision defines the number of decimal places in which the credit type can be
expressed.

5. If desired, check the Remove check box next to a credit type to remove it from
the listing when the next Update is performed.

6. If necessary, click Restore to return to the previously saved information.

7. Click Update to save your changes.

4.38.2 Add a New Credit Type

To add a new credit type, perform the following procedure.

Prerequisites
None

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Credit Type
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Steps
1. Enter a name for your credit type into the Name column in the topmost empty
row.

Click the eraser icon to erase any mistakes in the current row as you work.
2. Enter precision and extended precision information.

3. Check the functional currency check box if you want the new credit type to be
used as the functional currency.

4. If necessary, click Restore to return to the previously saved information.

5. Click Update to save your work.

4.39 Define Plan Elements

The following steps explain how to create a plan element using the Plan Element
Details page. You can access this page by clicking Create on the Plan Elements page.

Use the following procedure to create a plan element.

Prerequisites

If the plan element includes a formula, then the formula must exist (see Section 4.10,
"Define Formulas").

If the plan element includes a rate table, then the rate table must exist (see
Section 4.9, "Define Rate Tables").

If the plan element includes a revenue class, then the revenue class must exist (see
Section 4.34, "Define Revenue Classes").

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Incentive > Element > Create

Steps
1. Click the Incentive tab and click the Element subtab.
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The Plan Elements page appears.
2. C(Click Create.
The Plan Element Details page appears with blank fields.
3. Enter a Name and Description for the new plan element at the top of the page.

The Name field is required. The Description field can help you correctly
identify plan element with similar names when you are building a
compensation plan.

4. Select None, Bonus, or Quota from the Quota Group drop-down list.

This selection affects how the plan element is displayed in the Year to Date
Summary report. See Guidelines.

5. Select a Payment Group from the drop-down list. The default is Standard. This
field is required. See Guidelines.

6. Enter a start date for the plan element. This field is required.
7. Optionally, enter an end date.
Note: This setting affects how variables are distributed.

8. In the Parameters area, select an incentive type from the drop-down list. This
field is required.

Selections include Commission and Bonus, which are calculated differently. See
Guidelines.

9. Select an Interval Type from the drop-down list. This field is required.

Interval Type affects the length of time during which transactions are
accumulated for meeting sales goals. See Guidelines.

10. Select a Credit Type from the drop-down list. This field is required.

The credit type is normally the preset functional currency, but it can be any type
that you define in the application.

11. Select Formula or External from the Formula Type drop-down list. This field is
required. Each formula type requires a different action:

»  Formula: Enter four or more characters (including wildcards) in the
Formula field and click Go. Select a formula from the pop-up box. See
Guidelines.
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= External: Enter a PL/SQL package name in the Package Name field. This
enables the application to find the external formula. See the Note in
Guidelines.

12. Optionally, identify an expense account.
a. Enter four or more characters in the Expense Account field and click Go.
b. From the Code Combination window, select the desired expense account.

Expense accounts can be identified at the plan element level. Earnings for the
plan element are assigned to the specified expense account. See Guidelines.

13. Optionally, identify a liability account.
a. Enter four or more characters in the Liability Account field and click Go.
b. Inthe Code Combination window, select the desired liability account.

Liability accounts can be identified at the plan element level. Earnings for the
plan element are assigned to the specified liability account. See Guidelines.

14. Check the Eligible for Payee Assignment check box if you want to assign the
payment to someone other than the resource receiving the sales credit.

As an example, this check box may be used if the credit receiver leaves the
company and a new resource takes over an account.

15. In the Variables area, enter an optional Target, Goal, or Fixed Amount. The Sum
Revenue Classes check box lets you choose to combine the amounts from all
revenue classes assigned to the plan element to meet a target or goal.

16. Click Create to save your work.

Guidelines
The Quota Group drop-down list contains three choices. If you select:

= None: The plan element name does not display in the Year to Date Summary.

= Bonus: The plan element displays in the Bonus category of the Year to Date
Summary.

= Quota: The plan element name displays in the Quota category of the Year to
Date Summary.

The Payment Group setting enables you to assign multiple payment plans to a
resource as long as they are in different payment groups for a specific date range.
The payment group codes are customizable; the default setting is Standard.
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In step 8, the formulas are based on the commission incentive type of a
compensation plan. Bonus incentives are additional compensation based on
aggregated transactions. Note: On the Plan Element Create page, the Formula list of
values displays only formulas that match the incentive type value selected in the
Incentive Type drop-down list.

In step 9, the drop-down displays the commonly used intervals of Period (month),
Quarter, and Year. However, you can define a custom interval on the
Administration tab (Administration > Incentive > Interval). After a compensation
plan has been assigned to a sales role, in order to change the interval, you must
remove the plan assignment, change the plan element’s interval, then reassign the
compensation plan.

In step 11, if you choose an external formula type, you must enter the name of the
PL/SQL package in the Package Name field. If you select a formula type of
Formula, be sure to select a formula with a status of Complete.

Note: You can use an external formula in a plan element in this release of Oracle
Incentive Compensation. External formulas are similar to system generated
formulas, except that they contain customized material. This means that when you
upgrade the application, any changes that were made are not automatically applied
to the external formula, so they must be applied manually.

To use an external formula in a plan element, select External Formula type in the
Formula Type field and enter the name of the PL/SQL package in the Package
Name field.

To create an external formula, perform the following steps:

1. Start with a system generated formula that resembles your desired formula as
closely as possible.

2. Inthe PL/SQL code, rename the formula, changing the name in every place it
appears.

3. Change the formula number to Null.

4. Add customization as required.

4.39.1 Assign Revenue Classes

Revenue classes are user-defined categories of business revenue used to determine
whether sales credit is applied toward a compensation payment. Click Revenue
Classes in the side panel menu and use the Revenue Classes page to assign already
defined revenue classes to a plan element.
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To assign revenue classes to a plan element, perform the following procedure:

Prerequisites

Revenue classes must already be defined. Plan element details have been defined in
the Plan Element Details page.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Incentive > Element > Revenue Classes

Steps
1. Click the Incentive tab and the Element subtab.

The Plan Elements summary page appears.

2. C(lick a plan element link in the Name column.
The Plan Element Details page appears.

3. Click the Revenue Classes link in the side panel menu.
The Revenue Classes page appears.

4. Select a revenue class by clicking Go next to the first empty field in the Revenue
Class column under any previously assigned revenue classes.

A pop-up window appears listing all available revenue classes.
5. Click a revenue class to select it.

6. Assign a quota to the plan element for the selected revenue class and enter it in
the Quota column.

7. Assign a fixed amount to the revenue class for this plan element.
8. Assign a goal in the Goal column for this plan element.

9. Click Update to save your work. Before saving, you can click Restore to return
to the previously saved information.
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10. On the Revenue Classes page, click Details in the Details column to go to a Plan
Element Details page with sections for Accelerators and Transaction Factors. On
that page you can specify transaction factors and other factors that affect
commission payments. See Section 4.39.2, "Accelerators and Transaction
Factors" for a detailed procedure.

4.39.2 Accelerators and Transaction Factors

In a plan element, you can modify the incentive amounts by using payment and
quota accelerators, as well as transaction factors and other factors. You define the
effective period for these temporary changes by assigning a Start Date and an End
Date. Accelerators increase compensation during that time period, and can be used
as incentives for resources. Transaction factors stage sales credit over the live of a
sale.

4.39.2.1 Accelerators

For each revenue class, at plan element level, you can define incentives known as
accelerators. Oracle Incentive Compensation provides you with two types of
accelerators:

= Payment factor: Increases the resource’s commission payment without affecting
the level of quota achievement

= Quota factor: Increases a resource’s quota credit without affecting the payment

When you want to provide an incentive without affecting a resource’s quota
achievement, you can define a payment factor. The payment factor is a percentage
factor multiplied against the net sales credit, resulting in compensation credit. The
application then applies the compensation rate to this compensation credit to
calculate the compensation. Thus, a payment factor results in a higher
compensation amount but no higher quota achievement.

For example, a payment factor of 200% has been put onto the revenue class of
LIC-DB compensation plans for field salespeople to promote sales of this type of
license. When Salesrep A sells something with the revenue class of LIC-DB, the
application takes the transaction amount and calculates the amount of sales credit
due to Salesrep A. As an example, the net sales credit is $1,000. The payment factor
of 200% is multiplied against this amount to get to the total compensation amount
due to Salesrep A, which is $2,000.

How the Accelerators and transaction factors are used depends on how your
calculation expression is defined. For example, a common input expression that
complements a percentage rate table is as follows:
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EVENT_FACTOR* QUOTA_FACTOR*TRANSACTION_AMOUNT/TARGET.
A typical output expression looks like this:

Rate_ Result* TRANSACTION_AMOUNT* EVENT_FACTOR* PAYMENT _
FACTOR.

A quota factor enables a resource to reach higher levels of quota achievement more
quickly, resulting in higher compensation payments. This is because Oracle
Incentive Compensation uses quota achievement to determine which rate to use.

The payment factor or a quota factor is a percentage expressed as a whole number.

If there is no payment factor or quota factor, calculation defaults to 100%, which
means to multiply the calculated payment amount by 1. A factor of 200% (entered
as 200) means to multiply the commission amount by 200% or a factor of 2 (as in the
above examples).

If you enter a value for a payment or quota factor of less than 100, Oracle Incentive
Compensation reduces the incremental credit to the commission payment amount
for payment factors or the current quota performance level for quota factors.

Payment factors work only when they are used in the calculation output expression
assigned to the formula. For example:

(Rate Table Result*Transaction_Amount)*Payment_Factor

Quota factors work only when they are used by the calculation input expression
assigned to the formula. For example:

(Transaction_Amount*Quota_Factor)/Target

Payment factors can only be used when the Apply Txn Type is set to Individually as
they apply to each individual revenue class. Payment factors have no meaning if the
Apply Txn Type is set to Group by Interval.

4.39.2.2 Transaction Factors

Transaction factors help you stage sales credit over the life of a sale, assigning
percentages of the transaction amount to important events tin the sales process,
including Invoice, Order, and Payment.

Transaction factors must add up to 100% in total. For example, you can have 50% of
the commission calculated upon order, 20% calculated at invoice value and the final
30% calculated upon payment.

Other factors are used to indicate if any activity related to a sale, such as a credit
memo or order return, should be credited at a percentage other than 100 percent.
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These items include Clawbacks, Credit Memo, Deposit, Debit Memo, Giveback,
Manual Transaction, Payment Plan, Payment Plan Recovery, Order Return,
Upgrade, and Write-off.

Unlike transaction factors, other factors are each calculated separately, and do not
need to total 100%. Each can be over or under 100%. For example, you can set the
other factor of Order Return to be credited at 80%, or clawbacks at 110% to match
your business procedures.

To assign accelerators or transaction factors, perform the following procedure:

Prerequisites
Revenue classes must already be created.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Incentive > Element > Plan Elements

Steps
1. Click the Incentive tab and click the Element subtab.

The Plan Elements main page appears.
2. Select a plan element by clicking the link in the Name column.
The Plan Element Details page appears.
3. Click the Revenue Classes link in the side panel menu.
The Revenue Classes page appears.
4. Click the Details link.
The Plan Element Details page appears.

5. In the Accelerators area, enter a start date and end date for each accelerator.
Start Date is a required field.

Click the calendar icons to the right of each field to open a date selection
pop-up window.
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10.
11.

12.

13.

Enter numbers in the Payment% and Quota% fields to show the amount of
acceleration you want to assign. The default is 100, which is the full amount.
Entries can be above or below 100.

For already created accelerators, you can check the check box in the Remove
column and when you click Update, the accelerator is deleted.

As you create an accelerator, you can click the eraser icon in the Remove
column to clear the fields in that row before you click Update to save.

If necessary, click Restore to return to the previously saved information.
Click Update to save your work.

In the Transaction Factors area, enter numbers in the Factor% fields to stage the
payment of commission.

If there are more transaction factors than can be seen at one time, use the drop-
down list at the bottom of the area to scroll through them.

In the Other Factors area, assign any changes you want to make to the listed
events. The default entry for each Factor% column is 100.

If there are more other factors than can be seen at one time, use the drop-down
list at the bottom of the area to scroll through them.

Click Update to save your work. Before saving, you can click Restore to return
to the previously stored information.

4.39.3 Assign Rate Tables

You can assign parent rate tables and also a child formula to a plan element. See
Guidelines for an explanation of how child rate tables are created and used. To
assign rate tables, perform the following procedure.

Prerequisites
Rate tables must already be created.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst
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Navigation
Incentive > Element > Rate Tables

Steps
1. Click the Incentive tab and the Element subtab.

The Plan Elements summary page appears.

2. C(lick a plan element link in the Name column.
The Plan Element Details page appears.

3. Click the Rate Tables link in the side panel menu.
The Rate Tables page appears.

4. Enter a rate table name in the Name column. Click the flashlight icon to open a
pop-up list, from which you can select a rate table.

5. Enter an effective start date and end date. The start date field is required.

6. You can view the commission rates on the Rate Table Detail - Commission Rates
page by clicking Details in the Details column.

7. Enter a child formula from the drop-down list if desired. Use the same steps as
you used for the Parent Rate Table section. See Guidelines.

8. Click Apply to select a child formula.

9. When you are finished, click Update to save your work. Before saving, you can
click Restore to return to the previously saved information.

Guidelines

Child rate tables are referenced within embedded formulas. The following example
illustrates how child rate tables are used.

First, you create the formula to be embedded, and then create the formula that is
referenced by the plan element, which includes the embedded formula within it.
Assume that you want to calculate commissions based on percentage of quota, but
only for transactions where the sales credit is greater than $1,000. First you must
create an expression to determine if the sales credit is greater than $1000. The
expression looks like this:

Commission.Headers. TRANSACTION_AMOUNT /1000

Use this expression as the input expression for the embedded formula. If the result
is greater than 1, then you know that the sales credit is greater than $1000.
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Next, configure an amount rate table with two tiers (one tier for values less than 1
and one tier for values greater than 1):

Amount Rate
0-1 0
1-999,999,999 1

In this example, the first tier with an amount of less than 1 has a rate of 0, and in the
second tier, anything greater than one has a rate of 1.

Create an output expression that references the rate table result. Select Others from
the Type drop-down list and click Rate Table Result.

Next, you need to configure the embedded formula out of the input expression, rate
table, and output expression you have just created. It will be referenced by the other
formula.

Now you can configure the formula that will be referenced by your plan element.
First, configure an expression to reference the formula that you just created. This
expression looks like this:

Commission Headers. TRANSACTION_AMOUNT/(SRP Period Quota.TARGET_
AMOUNT*<embedded formula>).

Next, create the rate table for your formula, as follows:

Percent Rate
0-100% 3%
100-9999% 4%

Finally, create an output expression that multiplies your rate table result by the
transaction amount:

Rate Table Result*Transaction_Amount

When you build this formula, use the expressions and the rate table you have just
created. Then, when you configure your plan element, reference the second formula
that you created.

When you save the plan element, the rate tables associated with the formula and
with the embedded formula are both associated with the plan element. When you
view the rate tables associated with the plan element on the Incentive > Element >
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Rate Tables page, the Parent Rate Table section shows the rate table that was created
for the second formula, while the Child Rate Tables section displays the rate table
associated with the embedded formula. Because it is possible to create multiple
embedded formulas, OIC provides a drop-down menu that enables you to select
any one of the embedded formulas that you may have configured.

4.40 Define Compensation Plans

A compensation plan is built from plan elements. After the plan is assigned an
effective start date and an effective end date, it can be assigned to multiple sales
roles.

The Plan subtab contains five links:

= Summary: This page lists all defined compensation plans. It contains a Create
button to go to another page to create new compensation plans.

= Detail: When you click a link in the Name column of the Summary page, the
Compensation Plan Details page appears.

= Plan Elements: Click this link to assign plan elements to the compensation plan
or view plan elements that are already assigned.

= Sales Roles: Click this link to assign the plan to a sales role or to see the sales
roles to which the plan is currently assigned.

= Salespeople Assigned: Click this link to view to whom the compensation plan is
currently assigned.

4.40.1 Compensation Plan Details

The Compensation Plan Details page is where you can make changes to an
established compensation plan or create a new plan. If you have arrived at this page
by clicking the name of the plan on the Compensation Plan page, some fields will
be filled in already. If you clicked Create, the fields are blank. To create a new
compensation plan, perform the following procedure.

Prerequisites
Plan elements must already be created.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst
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Incentive Planning Analyst

Navigation
Incentive > Plan > Create

Steps
1. Click the Incentive tab and the Plan subtab.

The Compensation Plan page appears.
2. C(Click Create.
The Compensation Plan Details page appears.
3. Inthe Name field, assign a unique name to the new compensation plan.

4. Enter an objective description for this plan based on the associated sales role.
The description is used as part of a contract for the resource.

5. Assign a start date and end date to the plan. Click the calendar icon to open a
pop-up calendar.

6. Check the Allow Revenue Class Overlap check box if the plan elements
assigned to the plan have overlapping revenue classes.

Use this option when you need to compensate a resource more than once for a
transaction. For example, you may have a quota type plan element as well as a
bonus based on achieving revenue targets, both of which have the same
revenue classes.

7. If you are updating an existing plan, you can click Restore to return to the
previously saved information.

8. Click Update to save your work.
9. Click Assign Plan Elements to go to the Assign Plan Elements page.

10. On the Assign Plan Elements, assign the plan elements. (See Section 4.40.2,
"Assign Plan Elements" for specific steps.)

11. Return to the Compensation Plan Details Page.

12. Click Validate to complete the process.
Guidelines

For easy identification, define plan names by job titles or area of sales you are
compensating.
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You can change or restructure any aspect of a compensation plan. Because you can
assign the same plan to many resources, however, be aware of how the changes you
are making impact individual resources.

When you change a compensation plan, the changes propagate to the resources
assigned to the plans. For customized plans, the resource receives all changes except
the customized changes.

4.40.2 Assign Plan Elements

In the Name field of the Compensation Plan Details - Assign Plan Elements page,
perform the following procedure to assign the plan elements you want in the
compensation plan.

Prerequisites
Plan elements must already be created.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Incentive > Plan > Plan Elements

Steps
1. Click the Incentive tab and the Plan subtab.

The Compensation Plan page appears.
2. Click a plan element link in the Name column to select it.

Note: If you have just finished creating the plan, you can click the Plan Element
link directly from the Plan Element Details page.

The Plan Element Details page appears.
3. Click the Plan Elements link in the side panel menu.
The Compensation Plan Details - Assign Plan Elements page appears.

4. Enter a name or part of a name in the Name field and Click Go. This opens a
pop-up list of values. Click your selection.
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5. Enter a sequence number in the sequence column. This tells the application the
order in which to process the plan elements.

6. You can remove a plan element by checking the Remove check box and clicking
Update.

7. If you are updating an existing compensation plan, you can click Restore to
return to the previously saved information.

8. When you are finished, click Update to save the plan element assignment. The
Description, Start Date and End Date fields will populate automatically.

9. Optionally, you can click Details next to any plan element to review the plan
element details.

10. After the plan elements are assigned and saved, click the Detail link in the side
panel menu to return to the Compensation Plan Details page.

11. Click Validate to ensure that you have entered the plan information correctly. If
everything is correct, the status in the Status field changes from Incomplete to
Complete. See Guidelines.

12. Click Sales Roles to go to the Sales Roles page. That is where you assign the
compensation plan to a sales role.

Guidelines

When you validate a compensation plan, the following are verified:
s The plan has a name and start and end dates.

s The plan has one or more plan elements assigned with start and end dates
within the plan start and end dates.

= Each plan element has a rate table with contiguous tiers and with start and
end dates within the plan start and end dates.

=  Each plan element has at least one revenue class and uplift factors assigned,
with start and end dates within the plan start and end dates.

= Each plan element has a rate table structure that makes sense for the plan
element type.

= Each revenue class has at least one key transaction factor and at least one
other transaction factor.

If each of the above conditions is met, then the Status field shows Complete. If
the Status field displays Incomplete, the plan cannot be used to calculate
compensation.
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4.41 Define Roles

Roles are defined in Resource Manager. Refer to appropriate sections of the Oracle
CRM Foundation Implementation Guide (Defining Role Types) or Oracle CRM
Foundation Concepts and Procedures (Understanding Resource Manager).

4.42 Define Compensation Groups
See Section 4.20.

4.43 Define Resources
See Section 4.21.

4.44 Assign Resources to Roles and Groups
See Section 4.22.

4.45 Assign Compensation Plans to Roles

After you have created a compensation plan, you can assign it to multiple sales
roles. Perform the following procedures to assign sales roles to a compensation
plan.

Prerequisites
The sales roles and a valid compensation plan must already be created.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Incentive > Plan > Sales Roles
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Steps

1.

Click the Incentive tab and click the Plan Subtab. Or, alternatively, you can click
the Resource tab and click the Role subtab.

The Compensation Plan page opens.

2. In the Name column, click the compensation plan that you want to assign. Click
Search or use a saved search for quick access to a list of plans.
The Compensation Plan Details page appears.

3. Click Sales Roles to go to the Sales Roles page.
The sales roles already assigned to the compensation plan are listed.

4. Click Go next to the first blank name field to open pop-up list of sales roles.

5. Select a sales role and click it.

6. Enter a start date and an end date for the role. If desired, use the calendar icons
to open pop-up calendars.

7. Enter additional sales roles in the blank rows provided.

8. Asyou work, you can click the eraser icon at the left to clear information in a
specific row.

9. To delete a sales role, check the Remove check box. The sales role is deleted the
next time Update is clicked.

10. If you are updating a compensation plan assignment, you can click Restore to
return to the previously saved information.

11. Click Update to save your work. If the sales role has a description, it will be
displayed.

Guidelines

A sales role cannot be assigned overlapping plans.

4.46 Define Payment Plans

Payment plans are optional and are used to set up advance or deferred payments.
Use payment plans to set rules governing how, when, and how much is paid and at
what frequency. Payment plans guarantee that a minimum and/or maximum
amount will be paid to a resource. These are identified as advances/draws and
caps. The payment plans can be recoverable, non-recoverable, and use the earnings
in the accumulation period to calculate the draws.
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You can set up the recovery schedule and draw amount independently of the
earnings for the period, and you can waive a recovery amount due from a resource.
Note: For the Waive Recovery to work properly, the pay periods must be defined
correctly.

To define a new payment plan, perform the following procedure.

Prerequisites
Credit types must be defined.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Navigation
Administration > Incentive > Payment Plan

Steps
1. Click the Administration Tab and click the Incentive subtab.

2. Select Payment Plan on the side panel menu.
The Payment Plan page opens.
3. In the Name column, assign a unique name to the payment plan.

4. Enter a start date and an end date in the appropriate columns. Click the
calendar icons to use a pop-up calendar. The Start Date field is required.

5. Select a Payment Group from the drop-down list. This is a required field. The
default setting is Standard. See Guidelines.

6. In the Credit Type column, select a credit type from the drop-down list.
Functional Currency is the default, but you can select other, previously defined
credit types. The Credit Type field is required.

7. In the Payment Interval column, select a pay interval from the drop-down list.
Period is the default, but you can select any previously defined pay interval
from the list.
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8. Optionally, establish a minimum amount to be paid at the end of each pay
interval. Check the check box in the Recoverable column if it is recoverable from
later earnings.

9. Optionally, establish a maximum amount that can be paid for any pay interval.
If you check the check box in the Pay Later column, any amounts over the
maximum to be paid can be rolled over and paid in future periods.

10. Select a recovery interval from the drop-down list. The default setting is the
same as the pay interval.

Based on the recovery interval, the ‘true-up’ of draws against commissions
occurs at the end of the interval assigned. For example, if a quarter is defined as
April-June and a non-pay against commissions payment plan is valid from
February to May, the recovery occurs in June.

11. Check the Pay Against Commission check box if you want the payment plan to
apply its rules using earnings that have been collected in the application when
it calculates draw recovery at the end of the recovery interval.

12. If necessary, click Restore to return to the previously saved information
13. Click Update to save the payment plan.

The payment plan is assigned to a resource in the Resources subtab of the
Resource tab.

Guidelines

The Payment Group setting enables you to assign multiple payment plans to a
resource as long as they are in different payment groups for a specific date range.
The payment group codes are customizable; the default setting is Standard.

You can set up payment group codes in the Forms application using the following
procedure.

Prerequisites
None

Responsibility
Incentive Compensation Developer

Navigation
Forms instance > Lookups
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Steps
1. Log in to Forms using the Incentive Compensation Developer responsibility.

Navigate to Lookups.
Query the Lookup Type PAYMENT_GROUP_CODE.

2
3
4. Create the lookups you need for your business requirements.
5. Save.

6

Bounce the HTML server.
For more details on Lookups, see Appendix B, "Lookups".

Pay against commissions uses the commissions earned when determining the
minimum amount. For example, if the draw minimum is $1000 and the
representative earns $600, the draw amount is $400. But if the payment plan does
not incorporate the Pay against Commissions functionality, the draw is $1000. At
the end of the payment plan period and depending on the recovery period, the total
draw can be ‘trued-up’ against the commissions; the commissions accumulated over
the life of the plan would be used to recover the total draw.

The application checks first for the minimum amount and pays it. Recoverable
amounts are calculated after the minimum is met.

4.47 Assign Pay Groups to Resources

A pay group defines the length of eligibility and frequency of payments, such as
monthly or semi-monthly, for the resources who are assigned to the pay group. A
resource must be assigned to a pay group to receive compensation.

To assign a pay group to a resource, perform the following procedure.

Prerequisites

The pay group must be defined in Administration > Incentive > Pay Group. A valid
resource has been selected from the Employees page that is generated from an
advanced search request.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst

Incentive Planning Analyst
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Incentive Planning Contract Approver
Incentive Planning Finance Manager

Incentive Planning Sales Manager

Navigation
Resource > Resources > Pay Groups

Steps

1. In the Name field, enter the name of the pay group to be assigned. Click the
flashlight icon to open a pop-up list. Click the pay group name to select it.

2. Enter a start date and an end date. Click the calendar icons to open a pop-up
calendar.

3. If necessary, click Restore to return to the previously saved information.

4. Click Update to save the pay group assignment.

Guidelines

A resource can be assigned multiple pay groups, but only one pay group can be
active at a time.

Pay groups can be assigned to multiple resources at the same time and you can start
and end pay group assignments by individual resource at any time within the
duration of the pay group.

When you assigned a pay group to a resource, the application automatically checks
to see if there are any conflicts between the start and end dates of the pay group and
the start and end dates for every resource to which the pay group has been
assigned. For example, if you define a pay group starting Jan 1 and ending on Mar
31 and you have assigned it to a resource, the application will not let you change the
end date for the pay group assignment beyond Mar 31.

Pay group assignment is necessary for a resource to be paid, and is also required in
order for the compensation plan that is assigned to the role to appear when you
query for the compensation plan assignment using the Resource tab.

4.48 Assign Payment Plans to Resources

Payment plans are used to set up advance or deferred payments and to define
minimum and maximum payments. They are optional.
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To assign a payment plan to a resource, perform the following procedure.

Prerequisites
The payment plan must be defined in Administration > Payment Plan.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst

Incentive Planning Analyst

Incentive Planning Contract Approver

Incentive Planning Finance Manager

Incentive Planning Sales Manager

Navigation
Resource > Resources > Payment Plans

Steps

1.

On the Assign Payment Plans page, review the resource’s payment plan
information.

To assign a new payment plan, enter it in the Name column of the first blank
row. You can click the flashlight icon to open a pop-up list. Select the plan from
the list and click it.

Enter a start date in the next column. You can click the calendar icon to open a
calendar. Enter the date and it will appear in the Start Date field. This field is
required.

Optionally, enter an end date in the End Date column.

If you want to pay the resource either a minimum or maximum amount
regardless of commissions earned, then enter the amount in the Minimum or
Maximum column.

The Recoverable, Pay Later, Recoverable Interval, and Pay Against Commission
fields display read-only information about the payment plan as it was created
in the Administration tab.

If necessary, click Restore to return to the previously saved information.

Click Update to save your work.
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4.49 Customize Quota and Rates for Resources

Sometimes, you want to make changes to the plan elements of a compensation plan
for a specific resource. You can do this on the Resource Details page.

From this page you can access the Plan Element Details page. There, you can assign
and distribute variables (Target, Goal, and Fixed Amount).

To view information about a resource’s compensation plan and make some changes
to customize it, perform the following procedure.

Prerequisites
None

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst
Incentive Planning Analyst

Incentive Planning Contract Approver
Incentive Planning Finance Manager

Incentive Planning Sales Manager

Navigation
Resource > Resources > Compensation Plan

Steps
1. Click the Resource tab and click the Resources subtab.

The Resource Advanced Search page appears.
2. Enter search parameters into at least one field on the page.
3. Click Search.

The Employees page appears. It lists any resource that were found by the
search. If you see the resource you need, click the link in the Preferred Name
column and the Details page appears for the resource. If no listings appear, try
different search parameters.

4. Click Compensation Plan in the side panel menu.
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The Compensation Plans page appears.
5. Select the resource’s role in the Role Name list of values.
6. Click Apply.
7. Click the compensation plan Name link to display the plan elements.

The Plan Elements area lists the name as well as basic information about the
plan elements.

8. Check the check box in the Customized Flag column next to the plan element
that you want to customize for the resource.

Note: If you leave the Customized check box unchecked for a plan element,
then any changes you make to the quota or rates for that plan element are
automatically inherited by the resource. If you check the check box, the contents
of the customized plan element are not affected by any changes you make to the
plan element at the role level.

9. Click the plan element name in the Name column.
The Plan Element Details page is displayed.

10. The Plan Element Details page displays five fields of read only information at
the top relating to the resource.

= Name

= Description (of the plan element)
= Quota Group: Quota or Bonus

»  Start Date

= End Date

Note: This information is read-only because it was previously entered on the
Plan Element Details page (Incentive > Element).

11. The Parameters area lists five fields relating to the plan element details. These
fields include:

= Incentive Type: Commission or Bonus

= Interval Type: Period, Quarter, Year, or custom

s Credit Type: Functional Currency (default) or custom

»  Formula: The name of the formula if the formula type is Formula.

= Eligible for Payee Assignment check box.
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12. If you want to add or revise variables for a resource, add them in the Variables
area.

13. To distribute the variables equally to each period of the resource’s
compensation plan, click Distribute at the top or bottom of the page.

This takes you to the Resource Details - Distribute Variables page.

14. You can select an interval from the View drop-down list. Selections include
Period, Quarter, and Year.

Note: Regardless of the view, variables are distributed equally to each period.
15. Click Apply. The display changes to show the intervals selected in step 1.
16. To distribute variables, click Distribute Target.

The amounts are equally distributed to each period, duplicating the amount set
in the Variables area of the Plan Element Details page.

17. Click Update to save any changes you made on the Plan Element Details page.

4.50 Reports

Incentive Planning Reports

There are ten Incentive Planning reports. Click the link in the report name column
on the Reports subtab on the Quota tab to go to a search page. For the first nine
reports, you arrive at the Resource Search page. On the Resource Search page, enter
search parameters and click Apply, and the report appears.

For the Role To Compensation Plan Mapping Report, clicking the link takes you to a
specific search page with three fields. Enter search parameters, click Apply, and the
report appears.

Note: The report link name on the Reports summary page may vary slightly from
the actual name of the report.

These are the ten Incentive Planning reports:

= Section 4.50.1, "Quota Modeling Summary"

= Section 4.50.2, "Average Quota Report"

= Section 4.50.3, "Quota Overassignment Report"
= Section 4.50.4, "Quota Range Report"

= Section 4.50.5, "Compensation Contract Status"
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= Section 4.50.6, "Overlay Report"

= Section 4.50.7, "Vacancy Report"

= Section 4.50.8, "Transition Report"

= Section 4.50.9, "Plan Activation Status Report"

= Section 4.50.10, "Role to Compensation Plan Mapping Report"

Compensation Reports

Oracle Incentive Compensation provides eight Compensation Reports in HTML
format. The Summary of Compensation Reports page lists these reports. Click the
links to access them.

For some of the reports, when you click the link, a Resource Search page appears.
Use search parameters to get to a Resource Search Results page. A few reports
display another search parameter page after you make a selection from the
Resource Search Results page.

Three reports do not use the Resource Search page or Resource Search Results page.
The Classification Rules Report link leads to the Classification Rules Search page.
The Commission Summary Report and the Quota Performance Report open directly
from their Summary of Compensation Reports page links.

The steps below apply to the reports that use the Resource Search page and
Resource Search Results page.

The following reports are available in this release:

= Section 4.50.11, "Year to Date Summary"

s Section 4.50.12, "Transaction Details"

= Section 4.50.13, "Compensation Group Hierarchy"
= Section 4.50.14, "Classification Rules Report"

= Section 4.50.15, "Commission Summary Report"

s Section 4.50.16, "Quota Performance"”

s Section 4.50.17, "Commission Statement"

= Section 4.50.18, "Unprocessed Transactions"

4.50.1 Quota Modeling Summary

The Quota Modeling Summary report gives a snapshot of:
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= A compensation group’s total quota and its constituents
= A compensation group’s quota approval status by resource

= The overassignment effect accumulating through lower levels of the
organization hierarchy

You can see in one report the quota allocations to every resource or resource,
including the manager of a selected compensation group. The quota is broken down
by individual components that make up the total quota. Additionally, the user can
see the over assignment expressed in values as well as percentages between each
level of the organization hierarchy. These are represented by subtotals at the bottom
of the report for each level of resources; for example, the total quota for resources at
the bottom of the hierarchy (street level), the total quota for the immediate manager
(first line manager) and the total quota for the manager of the first line manager.

Responsibility

Incentive Compensation Super User
Incentive Planning Analyst

Incentive Planning Contract Approver
Incentive Planning Finance Manager

Incentive Planning Sales Manager (direct reports only)

Navigation
Quota > Report > Quota Model Summary

Parameters

Prompts Choices Mandatory

Name Search field No but the default is "All"
or %

Employee Number Search field No but the default is "All"
or %

Compensation Group Search field No but the default is "All"
or %

Organization List of Values No but the default is "Any"
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Prompts

Choices Mandatory

Effective Date

No but the default is
today’s date

Calendar pick list

The search criteria produces a list of Compensation Groups. You must select one

Compensation Group.

Data

The first table of information

Column Title

Description

Resource Name

Lists resources in the Compensation Group selected

Employee Number Displays associated employee numbers

Role Displays associated roles

Role Start Date Displays the start date of each resource’s assigned role
Role End Date Displays the end date of each resource’s assigned role

Component 1 Name

Displays the assigned quota against this user-defined
Component

Component 2 Name

Displays the assigned quota against this user-defined
Component

Component 3 Name

Displays the assigned quota against this user-defined
Component

Total Quota Displays the total assigned quota for all Components for each
role
Assigned Quota Displays the rounded figure of the total quota

Plan Status

Displays the approval status of the Compensation Plan

Overlay

Yes or No flag (see Concepts and Procedures for explanation of
overlay)

The second and last table of information:

Row Title

Description

Total quota for second

line manager

Displays column totals for all resources with Plan Level value
of 2 (see Sales Role Details screen and Plan Level field)
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Row Title Description

Total quota for first line  Displays column totals for all resources with Plan Level value
manager of 1

Total quota for street Displays column totals for all resources at the bottom of the

hierarchy for this Compensation Group and with Plan Level
value of 0 or null

Over assign from second Displays the second line manager’s quota as a percentage of the
line manager to first line  first line manager’s quota

manager
Over assign from first Displays the first line manager’s quota as a percentage of the
line manager to street street resources quota

4.50.2 Average Quota Report

The Average Quota report displays the average quota value by role for the selected
compensation group. It is useful to know the average quota value for comparable
roles in various compensation groups and organizations. In some companies,
compensation groups are organized by sales territory. Therefore, it is possible with
this report to compare the quota between comparable roles over various territories.

Additionally for reference, the planned sales figure to be delivered by the selected
compensation group is shown by means of a summary table that displays the total
quota, excluding overlay and a breakdown of total quota by role. (Refer to Oracle
Incentive Compensation Concepts and Procedures for explanation on overlay.) Against
each role, there is a headcount. In the next and subsequent tables for each role there
is a list of resources and a simple average of the quota assigned by role.

Note: The percentage values shown are percentages of the actual quota and not
rounded figures.

Responsibility

Incentive Compensation Super User
Incentive Planning Analyst

Incentive Planning Contract Approver
Incentive Planning Finance Manager

Incentive Planning Sales Manager (direct reports only)
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Navigation

Quota > Report > Average Quota Summary

Parameters

Prompts Choices Mandatory

Name Search field No but the default is "All" or %
Employee Number Search field No but the default is "All" or %
Compensation Group Search field No but the default is "All" or %
Organization List of Values No but the default is "Any"
Effective Date Calendar pick list No but the default is today’s date

The search criteria will produce a list of Compensation Groups and User is required
to select one Compensation Group.

Data

First table of information:

Column Title

Description

Role

Lists the roles available in the Compensation Group selected

Number of People

Displays the total number of people of each assigned role

Component 1 Name

Displays the total assigned quota against this user-defined
Component by role

Component 2 Name

Displays the total assigned quota against this user-defined
Component by role

Component 3 Name

Displays the total assigned quota against this user-defined
Component by role

Total Quota Displays the total assigned quota for all Components for each
role
Assigned Quota Displays the rounded figure of the total quota by role

The last row displays the grand total.

Second and subsequent tables of information are listed by role or Compensation

Plan:
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Column Title Description

Name Lists the resources with the relevant role or Compensation Plan

Component 1 Name Displays the assigned quota against this user-defined
Component for each resource

Component 2 Name Displays the assigned quota against this user-defined
Component for each resource

Component 3 Name Displays the assigned quota against this user-defined
Component for each resource

Total Quota Displays the total assigned quota for all Components for each
resource

Assigned Quota Displays the rounded figure of the total quota for each resource

The last row displays the total number of resources for the role and the simple
mathematical average for each column.

4.50.3 Quota Overassignment Report

The Quota Overassignment report shows in one report the over assignment value
and percentage effect on the immediate level of resources and the street level
resources. In the case of managers that have only street level resources reporting to
them, the overassignment figures are displayed under Direct Overassignment and
not Street Overassignment, even if the resources are street level. The Street
Overassignment column is populated only for a manager who has both managers
and street level resources as direct reports.

This report displays only resources with manager roles.

Responsibility
Incentive Compensation Super User

Incentive Planning Analyst
Incentive Planning Contract Approver
Incentive Planning Finance Manager

Incentive Planning Sales Manager (direct reports only)

Navigation
Quota > Report > Overassign Quota Summary
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Parameters

Prompts Choices Mandatory

Name Search field No but the default is "All" or %
Employee Number Search field No but the default is "All" or %
Compensation Group  Search field No but the default is "All" or %
Organization List of Values No but the default is "Any"
Effective Date Calendar pick list No but the default is today’s date

The search criteria will produce a list of Compensation Groups and User is required
to select one Compensation Group.

Data

Column Title Description

Name Lists the manager of the compensation group selected
Role Displays associated roles

Plan Start Date Displays the start date of each resource’s assigned plan
Plan End Date Displays the end date of each resource’s assigned plan
Final Quota Displays the rounded figure of the total quota assigned

Direct Overassignment  Displays the compensation group manager’s quota as a
percentage of his/her directs’ total quota

Street Overassignment Displays the compensation group manager’s quota as a
percentage of street-level resources’ total quota

4.50.4 Quota Range Report

The Quota Range Report enables you to scan the list for those resources who fall
outside the range of minimum and maximum quota values predefined for each role.
Contract Approvers can use this report as a means of rejecting compensation plans
or contracts that have been submitted for their scrutiny.

For each selected compensation group, the maximum and minimum quota range is
displayed for each role. In addition, there is a column that shows how each
resource’s assigned quota in the selected compensation group fared against the
minimum quota set for the role.
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Responsibility

Incentive Compensation Super User
Incentive Planning Analyst

Incentive Planning Contract Approver
Incentive Planning Finance Manager

Incentive Planning Sales Manager (direct reports only)

Navigation
Quota > Report > Quota Range Summary

Parameters

Prompts Choices Mandatory

Name Search field No but the default is "All" or %
Employee Number Search field No but the default is "All" or %
Compensation Group Search field No but the default is "All" or %
Organization List of Values No but the default is "Any"
Effective Date Calendar pick list No but the default is today’s date

The search criteria produce a list of Compensation Groups and you must select one
Compensation Group.

Data

Column Title Description

Resource Number Displays associated employee numbers

Resource Name Lists resources in the compensation group selected

Sales Role Displays associated roles

Assigned Quota Displays the rounded figure of the total quota assigned
Quota Minimum Displays the role’s minimum quota as defined under the Sales

Role Details screen
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Column Title Description

Quota Maximum Displays the role’s maximum quota as defined under the Sales

Role Details screen

Percent of Minimum Displays each resource’s actual assigned quota as a percentage
of each role’s quota minimum

4.50.5 Compensation Contract Status

The Compensation Contract Status report shows the number of people at each state
of the approval process for a selected manager in a compensation group. To create a
report for a specific manager, enter information into one or more fields below.

Responsibility

Incentive Compensation Super User
Incentive Planning Analyst
Incentive Planning Contract Approver

Incentive Planning Finance Manager

Incentive Planning Sales Manager (direct reports only)

Navigation
Quota > Report > Compensation Contract Status

Parameters

Prompts Choices Mandatory

Name Search field No but the default is "All" or %
Employee Number Search field No but the default is "All" or %

Compensation Group  Search field

No but the default is "All" or %

Organization List of Values

No but the default is "Any"

Effective Date Calendar pick list

No but the default is today’s date

The search criteria produce a list of Resources Found. Select a name in the resource

Name column.
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Data

In the Compensation Contract Status report, the columns represent lines of
business, including a total. The rows represent stages in the contract process,
including Pending Approval, Pending Distribution, Pending Acceptance, and
Accepted. There is a total row for each line of business.

4.50.6 Overlay Report

The Overlay report lists all overlay resources, if any, who are members of the
compensation group and groups below this group. (Refer to Concepts & Procedures
for explanation on overlay.) This report is a concise display of overlay resources as
distinct from previous reports where both overlay and nonoverlay resources are
displayed together.

Responsibility

Incentive Compensation Super User
Incentive Planning Analyst

Incentive Planning Contract Approver
Incentive Planning Finance Manager

Incentive Planning Sales Manager (direct reports only)

Navigation
Quota > Report > Overlay Summary

Parameters

Prompts Choices Mandatory

Name Search field No but the default is "All" or %
Employee Number Search field No but the default is "All" or %
Compensation Group  Search field No but the default is "All" or %
Organization List of Values No but the default is "Any"
Effective Date Calendar pick list No but the default is today’s date

The search criteria produce a list of Compensation Groups. You must select one
Compensation Group.
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Data

Column Title Description

Name Lists resources in the compensation group selected

Job Title Displays each resource’s job title as read from Oracle Resource
Manager

Role Displays associated roles

Assigned Quota Displays the rounded figure of the total quota assigned

4.50.7 Vacancy Report

The Vacancy report lists all positions, by sales role and compensation group, that
have not been filled for a particular manager. It is a concise means of listing
vacancies and additional headcount requirements on one report.

Responsibility

Incentive Compensation Super User
Incentive Planning Analyst
Incentive Planning Contract Approver

Incentive Planning Finance Manager

Incentive Planning Sales Manager (direct reports only)

Navigation
Quota > Report > Vacancy Summary

Parameters

Prompts Choices Mandatory

Name Search field No but the default is "All" or %
Employee Number Search field No but the default is "All" or %
Compensation Group Search field No but the default is "All" or %
Organization List of Values No but the default is "Any"
Effective Date Calendar pick list No but the default is today’s date
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The search criteria produce a list of Compensation Groups. You must select one
Compensation Group.

Data

Column Title Description

Name Lists vacancies in the compensation group selected
Compensation Group Lists the compensation group manager’s name

Role Displays associated roles

Plan Start Date Displays the start date of each resource’s assigned plan
Plan End Date Displays the end date of each resource’s assigned plan
Final Quota Displays the rounded figure of the total quota assigned

4.50.8 Transition Report

The Transition report lists all resources who have not been allocated a role, in the
selected compensation group and groups below. It is a means of identifying those
resources who do not have a role for the next contract cycle.

Responsibility
Incentive Compensation Super User

Incentive Planning Analyst
Incentive Planning Contract Approver
Incentive Planning Finance Manager

Incentive Planning Sales Manager (direct reports only)

Navigation
Quota > Report > Transitional Salespeople

Parameters
Prompts Choices Mandatory
Name Search field No but the default is "All" or %
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Prompts Choices Mandatory

Employee Number Search field No but the default is "All" or %
Compensation Group Search field No but the default is "All" or %
Organization List of Values No but the default is "Any"
Effective Date Calendar pick list No but the default is today’s date

The search criteria produce a list of Compensation Groups. You must select one
Compensation Group.

Data

Column Title Description

Name Lists resources in the compensation group selected

Resource Number Displays employee numbers of the resources in the selected

compensation group

Manager Name Lists the compensation group managet’s name

II\\I/Ianal;ger Employee Displays the compensation group manager’s employee number
umber

4.50.9 Plan Activation Status Report

The Plan Activation Status report lists the compensation plan activation status for
all resources in the selected compensation group. The activation process is related
to passing approved compensation plans from Incentive Planning to commission
processing. This report helps you to identify those compensation plans that have

not been activated for commission processing and to take action to investigate its
non-active status.

Responsibility

Incentive Compensation Super User
Incentive Planning Analyst

Incentive Planning Contract Approver
Incentive Planning Finance Manager

Incentive Planning Sales Manager (direct reports only)

4-156 Oracle Incentive Compensation Implementation Guide



Reports

Navigation
Quota > Report > Plan Status

Parameters

Prompts Choices Mandatory

Name Search field No but the default is "All" or %
Employee Number Search field No but the default is "All" or %
Compensation Group Search field No but the default is "All" or %
Organization List of Values No but the default is "Any"
Effective Date Calendar pick list No but the default is today’s date

The search criteria produce a list of Compensation Groups. You must select one
Compensation Group.

Data

Column Title Description

Resource Number Displays employee numbers of the resources in the selected
compensation group

Name Lists resources in the compensation group selected

Compensation Group Lists the compensation group’s name

Compensation Plan Displays compensation plan

Role Displays associated roles

Plan Status Displays the approval status of the Compensation Plan

Reason Displays the reason for any incomplete status

4.50.10 Role to Compensation Plan Mapping Report

The Role to Compensation Plan Mapping report lists all sales roles and how each
was mapped to job title(s) as read from Oracle Resource Manager, for each
compensation group selected.
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Responsibility

Incentive Compensation Super User
Incentive Planning Analyst

Incentive Planning Contract Approver
Incentive Planning Finance Manager

Incentive Planning Sales Manager (direct reports only)

Navigation
Quota > Report > Role to Compensation Plan Mapping

Parameters

Prompts Choices Mandatory

Effective Date Calendar pick list No but the default is today’s date
Role Name Search field No

Plan Name Search field No

Data

The first table of information:

Column Title Description

Role Displays all roles that satisfy the effective date search criteria
Compensation Plan Displays the name of each compensation plan

Start Date Displays the beginning date of the compensation plan

End Date Displays the lapsed date of the compensation plan

4.50.11 Year to Date Summary

The Year to Date Summary is an overview of a resource’s achievements,
commission and bonus earnings and advances or draws. This report is accessible by
default by the Manager, Salesperson, Incentive Compensation Payment, and
Incentive Compensation Super User responsibilities.
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The figures are grouped by period and by plan element. A Super User can control
which plan element appears as a quota or bonus category by checking the Quota
Group check box on the Plan Element page. If you check:

= Quota: The plan element name displays in the Quota category.
= Bonus: The plan element displays in the Bonus category.

= None: The plan element name does not display.

The pay out section is grouped by earnings type and by period.

You can click the Download button to save the report in a .csv file that can be
opened in a spreadsheet program. Note: If all of the digits do not display properly
in the downloaded report, right-click in the cell and format the cell as General.

Note: Any transactions from December must be posted in order to appear in the
January summary for the following year.

Note: To reset the salesrep subledger balances (cn_srp_periods) to zero at the
beginning of each fiscal year during calculation, set the Reset Balances Each Year
profile option to Yes. If it is set to No, the default setting, the balances carry over
across fiscal years. You should decide which option you want to use for carrying
forward balances and set it before using the application. If the profile is changed
after the application has been used and calculations are run, you must rerun
calculation to synchronize and accumulate the balances.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst
Incentive Compensation Payment

Incentive Compensation Reports

Navigation
Transaction > Report > Year to Date Summary

Parameters
Prompts Choices Mandatory
Resource Name/Number Search fields on Resource Yes

Search screen.
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Prompts Choices Mandatory

Credit Type List of Values No

Reporting Currency List of Values No, but defaults to
functional currency.

Fiscal Year List of Values No

Graph List of Values No

Data

Column Title Description

Quota Category Displays each quota assigned to the resource

Period Periods of the year displayed, for example, Jan-01 through

Dec-01, with earnings shown below them.

Other Begin Balance, Quota Earnings, and Payment rows shown
at the bottom for each column. Also, Recoverable Draw
Paid, Nonrecoverable Draw Paid, Draw Recovered. At the
bottom is End Balance.

4.50.12 Transaction Details

The Transaction Details report shows transactional details of the specified resource
and is used primarily by the Analyst. The report can be run to show results of any
specified period and by transaction status.

This report is configurable and for instructions on how to hide or show selected
columns, go to the section below.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst
Incentive Compensation Payment

Incentive Compensation Reports

Navigation
Transaction > Report > Transaction Details Report
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Parameters

Prompts Choices Mandatory
Resource Name List of Values Yes
Order Number Text Field No
Adjustment Status List of Values No
Invoice Number Text Field No
Processed Date From List of Values Yes
Processed Date To List of Values Yes
Transaction Type List of Values No
Adjustment Date List of Values No
Calculation Status List of Values No
Reporting Currency List of Values No

Data

This standard report lists the transactions a resource is eligible to receive
commission for during a specified period. The columns visible are controlled by
the System Administrator. You can display up to 12 columns without having to
scroll left or right. You can customize the report by adding columns, such as
Attributel shown in the table. Below is a sample of the available columns for this

report.

Column Title

Description

Invoice Number

Invoice Number

Invoice Date

Invoice Date

Order Date

Order Date

Order Number

Order Number

Creation Date

Creation Date (such as 03-JAN-2002)

Process Date

Process Date

Transaction Type

Transaction Type

Adjustment Status

Adjustment Status (Frozen, Reversal, etc.)
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Column Title Description

Adjusted By Adjusted By

Calculation Status Calculation Status (Rolled Up, etc.)
Original Currency Code Original Currency Code (USD, etc.)

Sales Credit Sales Credit

Commission Commission Amount

Attributel Customizable attribute (part number, etc.)

4.50.13 Compensation Group Hierarchy

The Compensation Group Hierarchy report is useful not only for displaying
compensation groups and the resources in each, but also for showing the roll up
hierarchy of the groups in relation to each other. In the first column, the number
indicates the level in the hierarchy of the compensation group. The Level 1 group is
at the top of the hierarchy, and is also at the top of the report. Where there is a
hyperlink, click the resource name to display a Year to Date Summary for that
person.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst
Incentive Compensation Payment

Incentive Compensation Reports

Navigation
Transaction > Report > Compensation Group Hierarchy Report

Parameters

Prompts Choices Mandatory

Resource Name Search field Yes

Compensation Group List of Values No

Effective Date List of Values No, but today is the default
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Data

Column Title Description

Level Read only numeral

Comp Group/Salesrep Name Two fields (Expandable hierarchy)
Role Role name (read only)

Start Date Start date (read only)

End Date End date (read only)

4.50.14 Classification Rules Report

The Classification Rules report displays the Rule Name, Revenue Class, and
Expression for classification rules selected from the list on the Rules Found page.

Click Download to generate a .csv file that can be opened in a spreadsheet.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst
Incentive Compensation Payment

Incentive Compensation Reports

Navigation
Transaction > Report > Classification Rules Report

Parameters

Prompts Choices Mandatory

Ruleset Name Search field Yes, but set in System
Parameters

Rule Name Search field No, but useful for narrowing
search

Effective Date Calendar icon No, but today is default
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Data

Column Title Description
Rule Name Rule Name
Revenue Classes Revenue Classes
Expression Expression

4.50.15 Commission Summary Report

The Commission Summary report is a snapshot of resources” achievement and
earnings. Achievements are shown against interval to date quota and annual quota.
Earnings total are broken down by period to date and interval to date.

This report is identical to the Quota Performance report except that there are 3 extra
columns (on the far right) available through this report. This report is accessible
through Incentive Compensation Payment responsibility by default. For users with
Manager and Salesperson responsibilities, the Quota Performance report is the
default report.

You can change four fields before displaying the report by selecting from drop-
down lists.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst
Incentive Compensation Payment

Incentive Compensation Reports

Navigation
Transaction > Report > Commission Summary

Guidelines

If you want to run this report using a currency other than Functional Currency, be
sure to configure the following system profile appropriately: OSC: Default
Conversion Type. See Appendix C, Profile Options, for more specific information.

4-164 Oracle Incentive Compensation Implementation Guide



Reports

Steps

1.

Select an Analyst from the drop-down list. The default is AlL

2. Select a period from the drop-down list.

3. Select Functional Currency in the Credit Type field.

4. Select a Reporting Currency for the report from the drop-down list.

5. Click Apply.

The report appears.

6. Click the Personalize button at the end of the report to customize the report.
The Quota Performance Personalization page appears. Check check boxes to
select Display Quota Groups (Bonus or Quota) and Display Periods (Annual,
Year to Date, Period to Date).

7. Click the Download button at the end of the report to download the report as a
file.

Parameters

Prompts Choices Mandatory

Analyst List of Values Yes

Period List of Values Yes

Credit Type List of Values Yes

Reporting Currency List of Values No

Data

Column Title Description

Name Resource Name

Resource Number Resource Number

Cost Center Resource Cost Center

Charge to Cost Center Cost Center where commission will be charged

Analyst Analyst Name

Sales Role Resource Sales Role
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Column Title

Description

Compensation Plan

Compensation Plan

Start Date

Start Date

End Date

End Date

Bonus Annual Quota

Bonus Annual Quota

Bonus Percent

Bonus Percent

Quota Annual Quota

Quota Annual Quota

Quota Percent

Quota Percent

YTD Bonus Target Year to date bonus target

YTD Bonus Credit Year to date bonus credit

YTD Bonus Earnings Year to date bonus earned

YTD Quota Target Year to date quota

YTD Quota Credit Year to date sales credit

YTD Quota Earnings Year to date quota-based earnings

YTD Total Earnings Year to date total earnings (quota-based earnings plus bonus
earned)

PTD Bonus Target Period to date bonus

PTD Bonus Credit Period to date bonus credit

PTD Bonus Earnings Period to date bonus earnings

PTD Quota Target Period to date quota

PTD Quota Credit Period to date sales credit

PTD Quota Earnings Period to date quota-based earnings

PTD Total Earnings Period to date total earnings (quota-based earnings plus

bonus)

Begin Balance

Beginning Balance of what is due to the resource

Draw

Amount of Draw paid

Net Due

Amount due after deductions
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4.50.16 Quota Performance

The Quota Performance report is a snapshot of resources’ achievement and
earnings. Achievements are shown against interval to date quota and annual quota.
Earnings totals are broken down by period to date and interval to date.

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst
Incentive Compensation Payment

Incentive Compensation Reports

Navigation
Transaction > Report > Quota Performance

Parameters

Prompts Choices Mandatory
Analyst List of Values Yes (only for super user)
Period List of Values Yes

Credit Type List of Values Yes
Reporting Currency List of Values No

Data

Column Title Description

Name Resource Name

Resource Number Resource’s Employee Number

Cost Center Resource Cost Center

Charge to Cost Center Cost Center where commission will be charged
Analyst Analyst Name

Sales Role Resource Sales Role

Compensation Plan Compensation plan name
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Column Title Description

Start Date Start date

End Date End date

YTD Draw Target Year to date draw

YTD Draw Credit Year to date Draw sales credit

YTD Draw Earnings Year to date draw earnings

YTD Formula Target Year to date formula

YTD Formula Credit Year to date formula credit

YTD Formula Earnings  Year to date formula earnings

YTD Quota Target Year to date quota

YTD Quota Credit Year to date sales credit

YTD Quota Earnings Year to date quota-based earnings

YTD Total Earnings Year to date total earnings (quota-based earnings plus bonus
earned)

PTD Draw Target Period to date draw

PTD Draw Credit Period to date Draw sales credit

PTD Draw Earnings Period to date draw earnings

PTD Formula Target Period to date formula

PTD Formula Credit Period to date formula credit

PTD Formula Earnings ~ Period to date formula earnings

PTD Quota Target Period to date quota

PTD Quota Credit Period to date sales credit

PTD Quota Earnings Period to date quota-based earnings

PTD Total Earnings Period to date total earnings (quota-based earnings plus bonus)

4.50.17 Commission Statement

The Commission Statement report shows transaction details broken down by
period for a resource. It is configurable. For instructions on how to hide or show
selected columns, see Section 4.50.21, "Configuring Reports".
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You can change four fields before displaying the report by selecting from drop-
down lists.

Prerequisites

The resource must have commission lines for the period for which you are running
the commission statement.

Responsibility
Incentive Compensation Super User

Incentive Compensation Analyst
Incentive Compensation Payment

Incentive Compensation Reports

Navigation
Transaction > Report > Commission Statement

Also, you can drill down to this report from the Year to Date Summary.

Steps
1. In the Period Type field select Period, Quarter, or Year from the drop-down list.

2. In the Period field select a period.
3. In the Plan Element field, make a selection. The default setting is All

4. Inthe Reporting Currency field, you can select from a list of currencies in
which to display the report.

5. Click Apply to display the report.

Guidelines

After the report is displayed, you can drill down on a amount in the Invoice
Number column to display the Invoice Detail page. This page displays the
following information:

= Number

s Payment Type
= Receipt Date

= Maturity Date
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s Customer Name
= From Bank
s From Account
Payment information includes the following:
s Currency
s Payment Amount
= Amount Applied
= On Account
= Unapplied Account

The Line Details area displays eleven columns of information related to the
transaction.

Click the amount in the Order Number column to display the Order Detail page.
This page shows the following general information:

= Number
= Date
s Type
= Resource
The Order Detail page displays the following shipping information:
= Ship to Person
= Ship to Address
= Ship Method
The area below the shipping information displays billing information:
= Bill to Person
= Bill to Address
= Taxable
s Currency
»  Freight Terms
= Total
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The Line Details area at the bottom of the screen displays nine fields of information
related to the order itself, including the product, quantity ordered, and extended

price.

Parameters

Prompts Choices Mandatory
Resource Name List of Values Yes

Period List of Values Yes

Period Type List of Values Yes

Plan Element List of Values No
Reporting Currency List of Values No

Data

This standard report lists the transactions a resource is eligible to receive

commission for during a specified period. The columns visible are controlled by the
System Administrator. You can display up to 12 columns without having to scroll

left or right. Below is a sample of the available columns for this report.

Column Title

Description

Invoice Number

Invoice Number

Invoice Date

Invoice Date

Order Date

Order Date

Order Number

Order Number

Creation Date

Creation date

Plan Element

Plan element

Transaction Type

Transaction type

Sales Credit

Sales credit

Commission Amount

Commission Amount

Credit Receiver

Credit Receiver

Attributel (-100)

Custom attributes
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4.50.18 Unprocessed Transactions

The Unprocessed Transactions report shows all transactions that:
s Have not been loaded, or
= Arein the status of Failed Classification, Classified, Rolled Up or Failed Rollup.

You can run this report for any calculation status, load status and adjustment status
for any specified resource, date, transaction type, order and invoice number.

This report is configurable. For instructions on how to hide or show selected
columns, see Section 4.50.21, "Configuring Reports".

Responsibility

Incentive Compensation Super User
Incentive Compensation Analyst
Incentive Compensation Payment

Incentive Compensation Reports

Navigation
Transaction > Report > Unprocessed Transactions

Parameters

Prompts Choices Mandatory
Resource Name List of Values Yes
Order Number List of Values No
Adjustment Status List of Values No
Load Status List of Values No
Invoice Number List of Values No
Processed Date From List of Values No
Processed Date To List of Values No
Transaction Type List of Values No
Adjustment Date List of Values No
Calculation Status List of Values No
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Prompts

Mandatory

Reporting Currency

List of Values

No

Data

This standard report lists the transactions a resource is eligible to receive
commission for during a specified period. The columns visible are controlled by
the System Administrator. You can display up to 12 columns without having to
scroll left or right. Below is a sample of the available columns for this report.

Column Title

Description

Invoice Number

Invoice Number

Invoice Date

Invoice Date

Order Date

Order Date

Order Number

Order Number

Creation Date

Creation date

Process Date

Process date

Transaction Type

Transaction type

Adjustment Status Adjustment status
Adjustment Date Adjustment date
Adjusted By Adjusted by

Load Status Load status

Calculation Status

Calculation status

Sales Credit

Sales credit

Attribute 1 (-100)

Custom attribute

4.50.19 Report Access by Responsibility

The headings list eight Incentive Compensation report users. An x indicates that the
report is accessible with the corresponding default responsibility. The Incentive
Compensation Developer responsibility does not have access to reports.

In the table below, Yes means the responsibility has access to the report; No means
the responsibility does not have access.
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Incentive Incentive Incentive Incentive
Incentive Planning Planning Planning Comp. Incentive Incentive Incentive
Planning Contract Finance Sales Super Comp. Comp. Comp.
Analyst Approver Manager Manager User Payment Analyst Reports
Incentive - - - - - - - -
Planning
Reports
(Quota tab)
Quota Model Yes Yes Yes Yes Yes No No No
Summary
Average Quota  Yes Yes Yes Yes Yes No No No
Summary
Quota Yes Yes Yes Yes Yes No No No
Overassignment
Report
Quota Range Yes Yes Yes Yes Yes No No No
Report
Compensation  Yes Yes Yes Yes Yes No No No
Contract Status
Overlay Report  Yes Yes Yes Yes Yes No No No
Vacancy Yes Yes Yes Yes Yes No No No
Summary
Transition Yes Yes Yes Yes Yes No No No
Report
Plan Activation Yes Yes Yes Yes Yes No No No
Status Report
Role To Yes Yes Yes Yes Yes No No No
Compensation
Plan Mapping
Report
Compensation - - - - - - - -
Reports
(Transaction
tab)
Year to Date No No No No Yes Yes Yes Yes
Summary
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Incentive Incentive Incentive Incentive

Incentive Planning Planning Planning Comp. Incentive Incentive Incentive
Planning Contract Finance Sales Super Comp. Comp. Comp.
Analyst Approver Manager Manager User Payment Analyst Reports
Transaction No No No No Yes Yes Yes Yes
Details
Compensation  No No No No Yes Yes Yes Yes
Group
Hierarchy
Classification No No No No Yes Yes Yes Yes
Rules
Commission No No No No Yes Yes Yes Yes
Summary
Quota No No No No Yes Yes Yes Yes
Performance
Commission No No No No Yes Yes Yes Yes
Statement
Unprocessed No No No No Yes Yes Yes Yes
Transactions

4.50.20 Road Map of Reports from Version to Version

In the table below, Yes means the report was available for the release; No means the
report was not available.

Release 3i 11.5.3 1154 11,55 1156 11.5.7 11.5.9* Notes

Yes means - - - - - - - *11.5.8 reports are the same as 11.5.9.
Report is
available

Planning - - - - - - - -
Reports

(Quota tab)

Quota Model No Yes Yes Yes Yes Yes Yes Changed from Quota Modeling
Summary Summary in 11.5.6

Average Quota No Yes Yes Yes Yes Yes Yes Started in 11.5.3.
Summary
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Release 3i 1153 11.5.4 11,55 11.5.6 11.5.7 11.5.9* Notes

Quota No Yes Yes Yes Yes Yes Yes Changed from Overassign Quota

Overassignment Summary in 11.5.6

Report

Quota Range No Yes Yes Yes Yes Yes Yes Changed from Quota Range

Report Summary in 11.5.6

Compensation  No No No Yes Yes Yes Yes Started in 11.5.5.

Contract Status

Overlay Report No Yes Yes Yes Yes Yes Yes Changed from Overlay Summary in
11.5.6

Vacancy No Yes Yes Yes Yes Yes Yes Changed from To-Be-Hired

Summary Summary in 11.5.6

Transition No Yes Yes Yes Yes Yes Yes Changed from Transitional

Report Salespeople Report in 11.5.6

Plan Activation No Yes Yes Yes Yes Yes Yes Changed from Plan Generation

Status Report Status in 11.5.4 and Plan Status in
11.5.5

Role To No Yes Yes Yes Yes Yes Yes Changed from Role to Plan

Compensation Mapping in 11.5.4

Plan Mapping

Report

Salesperson Yes No No No No No No Replaced by Role to Plan Mapping

Plan Report in 11i.

Assignments

Compensation - - - - - - - -

Reports

(Transaction

tab)

Compensation No Yes No No No No No Replaced in 11.5.4 by Year-To-Date

Summary Summary.

Compensation No Yes No No No No No Replaced in 11.5.4 by Year-To-Date

Details Summary.

Compensation  No Yes No No No No No Replaced in 11.5.4 by Year-To-Date

Details (Fiscal
View)

Summary

4-176 Oracle Incentive Compensation Implementation Guide



Reports

Release 3i 1153 11.54 1155 11.5.6 11.5.7 11.5.9* Notes

Year to Date No Yes Yes Yes Yes Yes Yes Replaced 61 Compensation

Summary Summary, Compensation Details,
Compensation Details (Fiscal View)
in11.5.4

Adjustments No Yes No No No No No Replaced by Transaction Details
report in 11.5.4

Transaction No No Yes Yes Yes Yes Yes Replaced Adjustments report in

Details 11.54

Compensation No Yes No Yes Yes Yes Yes Replaced by Hierarchy report in

Group 11.5.4. HTML version introduced in

Hierarchy 11.5.5

Salespeople No Yes No No No No No Replaced by Hierarchy report in

Hierarchy 11.54

Hierarchy Yes No Yes No No No No Replaced Compensation Group
Hierarchy and Salespeople
Hierarchy reports in 11.5.4

Classification ~ Yes Yes No Yes Yes Yes Yes 6i report decommissioned in 11.5.4.

Rules HTML report introduced in 11.5.5

Payrun Listing  Yes Yes No No No No No After 11.5.3, information available
on Payrun Details page in
application

Payrun Details No Yes No No No No No After 11.5.3, information available
on Payrun Details page in
application

Analyst No Yes No No No No No Replaced by Commission Summary

Consolidated in11.5.4

Summary

Commission Yes No Yes Yes Yes Yes Yes Replaced Analyst Consolidated

Summary Summary in 11.5.4

Quota Yes Yes Yes Yes Yes Yes Yes 6i report in 11.5.3 replaced by

Performance HTML report of same name in 11.5.4

Commission Yes Yes Yes Yes Yes Yes Yes Appears in all releases.

Statement

Performance No Yes No No No No No 6i report decommissioned after

Details 11.5.3

Blind Ranking  No Yes No No No No No 6i report decommissioned after

11.5.3
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Release 3i 1153 1154 1155 11.5.6 11.5.7 11.5.9* Notes

Top/Bottom No Yes No No No No No 6i report decommissioned after
Performers 11.5.3

Compensation  No Yes No No No No No 6i report decommissioned after
Trending 11.5.3

Unprocessed No Yes Yes Yes Yes Yes Yes Started in 11.5.3.

Transactions

Payment Hold No Yes No No No No No Decommissioned after 11.5.3
Pending No Yes No No No No No Decommissioned after 11.5.3
Payment

Pending No Yes No No No No No Decommissioned after 11.5.3
Transactions

4.50.21 Configuring Reports

Each JSP report has a corresponding region in the Applications Core Module. The
information in that region determines what end users see displayed on their screens
in the form of the reports. System Administrators can go into the Application
Developer Common Modules responsibility and configure the JSP reports.

For all 18 reports mentioned below, you can change the name of the column labels
in the report. For example, in the Commission Statement report, you can change the
name of the Resource Name column to Partner Name if you are trying to pay partners.
See Steps for Changing Label Names to perform this procedure.

Three reports can also be configured to hide or display certain columns. These
reports are:

s Transaction Details
s  Commission Statement

= Unprocessed Transactions

Changing Label Names

Note: Some JSP reports share the same region in the Application Core Module.
Therefore, any changes you make in the region to hide or show a column affect all
reports that reference the same region.

For example, the Commission Summary report and Quota Performance report share
the Quota Summary region name. Also, the Commission Statement report and
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Unprocessed Transactions report share the Adjustments Report region. To change
label names, perform the following procedure.

Prerequisites
None

Responsibility
System Administrator

Navigation
Forms instance > File

Steps

1. Log in to the Forms version of the application as the System Administrator.
The Navigator - System Administrator screen appears.
2. C(lick File in the toolbar and select Switch Responsibility.
The Responsibilities screen appears.
3. Select Application Developer Common Modules. Click OK.
The Navigator - Application Developer Common Modules screen appears.
4. Double-click Define Regions.
The Regions screen appears.

5. Query the specific JSP name of report. See Guidelines for a table of specific
Region IDs for the reports. To search, perform the following four steps:

a. With the cursor in the Region ID field, click View in the toolbar and select
Query by Example > Enter from the menus. The fields turn blue.

b. Enter the Region ID of the report. You can enter the first part of the name
followed by a percent sign (%).

c. Click View in the toolbar and select Query by Example > Run in the menus.
The Regions screen appears, displaying a list of Region IDs.

d. Scroll down to the Region ID you want and click in the field.
6. Click the Region Items button in the lower right corner.

The Region Items screen appears.
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7. Scroll over to the Long Label field and enter a descriptive name for the
attribute.

8. Click Save.
This process changes the label name.

9. Bounce the Middle Tier server.

Hiding or Displaying Columns

These steps apply only to the Transaction Details, Commission Statement, and
Unprocessed Transactions reports. To hide or display columns, perform the
following procedure.

Prerequisites
None

Responsibility
System Administrator

Navigation
Forms instance > File

Steps

1. Log in to the Forms version of the application as the System Administrator.
The Navigator - System Administrator screen appears.
2. C(lick File in the toolbar and select Switch Responsibility.
The Responsibilities screen appears.
3. Select Application Developer Common Modules. Click OK.
The Navigator - Application Developer Common Modules screen appears.
4. Double-click Define Regions.
The Regions screen appears.

5. Query the specific JSP name of report. See Guidelines for a table of specific
Region IDs for the reports. To search, perform the following four steps:

a. With the cursor in the Region ID field, click View in the toolbar and select
Query by Example > Enter from the menus. The fields turn blue.
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b. Enter the Region ID of the report. You can enter the first part of the name
followed by a percent sign (%).

c. Click View in the toolbar and select Query by Example > Run in the menus.
The Regions screen appears, displaying a list of Region IDs.

d. Scroll down to the Region ID you want and click in the field.
6. Click the Region Items button in the lower right corner.
The Region Items screen appears.

7. Find the Attribute or Column name in the list and then select the Node Display
check box to show the column or deselect the Node Display check box to hide
the column.

8. If you are setting a column to show, scroll over to the V Align column and
select Top from the List of Values.

9. Scroll over to the Long Label field and enter a descriptive name for the
attribute.

10. Click Save.

11. Bounce the Middle Tier server.

Guidelines

The table below displays the Region ID, Region Name, and jsp Name for each
report:

Report Region ID Region Name jsp Name

Year to Date Summary ~ CN1152_YTD_ Year to Date Summary  cnytdsum.jsp
SUMMARY

Transaction Details CN1152_ADJUST_DTL Adjustments Report cnadjdtljsp

Report

Compensation Group CN1152_CG_HIER Group Hierarchy Report cncghier.jsp
Hierarchy Report

Classification Rules CN1152_RULES CN1152_RULES enclrls.jsp
Report

Commission Summary  CN1152_QUOTA_ Quota Summary cnquota.jsp
Report SUMMARY1

Quota Performance CN1152_QUOTA_ Quota Summary cnquota.jsp
Report SUMMARY1
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Report Region ID Region Name jsp Name
Commission Statement ~ CN1152_ Adjustments Report cnCommStat
Report COMMISSION RepRun,jsp
Unprocessed CN1152_ADJUST_DTL Adjustments Report cnunprdljsp
Transactions

Quota Model Summary CN_QM_SUMMARY CN QM Summary cnrangms.jsp
Average Quota Report ~ CN1152_REP_AQS Average Quota cnranags.jsp

Quota Overassignment
Report

Quota Range Report

Compensation Contract
Status

Overlay Report
Vacancy Report
Transition Report

Plan Activation Status
Report

Role to Compensation
Plan Mapping

CN1152_REP_OAS

CN1152_REP_QMR

CN_ANAL_REP_
PLANSUMMARY

CN1152_REP_OSR
CN1152_REP_TBH
CN1152_REP_TSR

CN1152_COMP_GEN_
STS

CN1152_ROLE_PLAN_

MAP

Summary

Overassign Quota Sum

Quota Range Summary

Plan Summary Region

Overlay Summary
To be Hired Report
Transitional SP

Plan Generation Status

Role Plan Mapping

cnranoas.jsp

cnrangmt.jsp

cnranpsr.jsp

CNIVaosr.jsp
cnrvatbh.jsp
cnrvatsr.jsp

cnrgests.jsp

cnrgemap.jsp
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Post Implementation Tasks

This section of the Oracle Incentive Compensation Implementation Guide contains
the following chapters:

»  Chapter 5, "Verify the Implementation”
= Chapter 6, "Diagnostics and Troubleshooting"






O

Verify the Implementation

5.1 Oracle CRM Application Foundation Implementation Verification

Tasks

This chapter contains material useful in verifying the implementation of the Oracle
CRM Application Foundation modules and Oracle Incentive Compensation.

5.1.1 Use the Diagnostic Tests

After completing the implementation steps of the Application CRM Foundation
module, run the entire suite of diagnostic tests available through the HTML
Administrator Console. Implementors would most likely either verify using the
Basic tab or the Advanced tab. In the Basic tab, you can run the following tests:

RunAll

UserTest
AOQOLTests
PropertyManager
UserProfile
AKData

Security Manager

In the Advanced tab, you can modify the parameters used in the previously
mentioned tests.

Each test generates a report if a problem is encountered. The report identifies the
problem and provides a suggested resolution to the problem.
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5.1.2 Verificati

on Task List per Module

After you complete the configuration and setup of all the Oracle CRM Application
Foundation modules, verify that you can perform the tasks outlined in the
following table.

Table 5-1 CRM Application Foundation Verification List

JTF Module Task Reference

HTML Tech Stack Login to HTML Applications as System Oracle CRM Technology Foundation
Administrator Concepts and Procedures

User Management Register and approve a new user Oracle CRM Technology Foundation

Concepts and Procedures

Resource Manager

Creating an employee resource Oracle CRM Application
Foundation Implementation Guide

Resource Manager

Creating a group resource Oracle CRM Application
Foundation Implementation Guide

Resource Manager

Importing resources Oracle CRM Application
Foundation Implementation Guide

Resource Manager

Defining a resource group Oracle CRM Application
Foundation Implementation Guide

Resource Manager

Defining a resource team Oracle CRM Application
Foundation Implementation Guide

You must be able to complete each task successfully, or your Oracle CRM
Application Foundation modules will not work properly. If you are unable to
complete a task successfully, then correct the problem before continuing.

5.2 Confirmation of Minimum Setups in Oracle Incentive Compensation

Verification of the implementation can be done by confirming the minimum setups
required to activate the Oracle Incentive Compensation application and allow users
to begin entering setups and data. It is described in Section 5.2, "Confirmation of
Minimum Setups in Oracle Incentive Compensation". For additional information
refer to Implementation Guide Chapters 4 and 5.
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5.2.1 Define Profile Options

Prerequisites

None

Responsibility

System Administrator

Navigation
(Forms) Profile > System

Steps

1. Enter values for the fields as follows:

Site: Check

Application: Uncheck
Responsibility: Uncheck

User: Uncheck

Profiles with no value: Uncheck

Profile: OSC:%

2. C(lick Find.

3. See Implementation Guide Appendix C for a listing of profile options.

Guidelines

If custom responsibilities are being created for use with Planning modules of Oracle
Incentive Compensation, be sure to set the profile option ‘OSC: SFP Responsibility

Group’ at the appropriate responsibility level.

It is recommended that all debug and log file profile options be inactive during
regular operation. Activating these options generally incurs performance overhead
due to the recording of debug and log information. A common cause of unexpected
performance drops is the unknown or forgotten activation of such options. These
are the debug, logging profile options:

= OSC: Debug Mode
s OSC: Log File
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s OSC: Mark Events
= OSC: Salesforce Planning Debug Mode

5.2.2 Define System Parameters

Prerequisites
None

Responsibility
Incentive Compensation Super User

Navigation
Administration > Parameters

Steps

See Oracle Incentive Compensation User Guide Section 12.2 System Parameters.

Guidelines

The STATUS will change to active once the first accumulation period is changed
from 'Never Opened’. If the System Parameters Status is INACTIVE, users may be
able to access OIC screens, but will not be able to utilize most of the functions.

5.2.3 Define GL Calendar: Period Types

Use this form to define your accounting period types.

Prerequisites
None

Responsibility

Incentive Compensation Super User

Navigation
Administration > General > Calendar Type
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Steps
See Period Type (in Setup Chapter) of the Oracle General Ledger User Guide Release
11i for this procedure.

Guidelines

Do not create Period Types if they already exist.

Example:

Period Type Periods Per Year Year Type
Month 12 Calendar
Quarter 4 Fiscal
Year 1 Fiscal
Month 12 Fiscal

5.2.4 Administer Accumulation Periods

Specify the accounting periods you will include in your calendar and provide
detailed information for each of these periods. Select the Period Status, Forecast and
Freeze settings. Use the Accumulation Periods page to open and close accounting
periods in your Incentive Compensation calendar only.

Prerequisites
None

Responsibility
Incentive Compensation Super User

Navigation
Administration > Incentive > Accumulation Period

Example:

Name Year Qrir Start Date End Date Period Status Forecast Freeze
Jun-02 2003 1 01-Jun-2002  30-Jun-2002 Future-Entry Checked Unchecked
Jul-02 2003 1 01-Jul-2002  30-Jul-2002  Future-Entry Checked Unchecked
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Name Year Qrtr Start Date End Date Period Status Forecast Freeze
Aug-02 2003 1 01-Aug-2002 30-Aug-2002 Future-Entry = Checked Unchecked
Sep-02 2003 2 01-Sep-2002  30-Sep-2002 Future-Entry =~ Checked Unchecked
Oct-02 2003 2 01-Oct-2002  30-Oct-2002 Future-Entry =~ Checked Unchecked
Nov-02 2003 2 01-Nov-2002 30-Nov-2002 Future-Entry =~ Checked Unchecked
Dec-02 2003 3 01-Dec-2002 30-Dec-2002 Future-Entry =~ Checked Unchecked
Jan-03 2003 3 01-Jan-2003  30-Jan-2003  Future-Entry Checked Unchecked
Feb-03 2003 3 01-Feb-2003 30-Feb-2003 Future-Entry =~ Checked Unchecked
Mar-03 2003 4 01-Mar-2003 30-Mar-2003 Future-Entry =~ Checked Unchecked
Apr-03 2003 4 01-Apr-2003 30-Apr-2003 Future-Entry =~ Checked Unchecked
May-03 2003 4 01-May-2003 30-May-2003 Future-Entry =~ Checked Unchecked
Guidelines

Period Status Future-Entry” allows creation of setup information within these
periods, such as classification rules, compensation plans, and revenue class
hierarchies. Loading of transactions and calculations will not be allowed until the
Period Status is set to ‘Opened’.

See: Oracle Incentive Compensation User Guide, Section 12.5 Accumulation

Periods.

5.2.5 Define Interval Numbers

Use this form to update Interval Numbers

See Oracle Incentive Compensation User Guide Section 12.7.1 To View an Interval Type.

Prerequisites
None

Responsibility
Incentive Compensation Super User

Navigation
Administration > Interval Types
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Steps
1. Click the Period link

Period Name Start Date End Date Year Interval Number
JUN-02 01-JUN-02 30-JUN-02 2003 2003001
JUL-02 01-JUL-02 31-JUL-02 2003 2003002
AUG-02 01-AUG-02 31-AUG-02 2003 2003003
SEP-02 01-SEP-02 30-SEP-02 2003 2003004
OCT-02 01-OCT-02 31-OCT-02 2003 2003005
NOV-02 01-NOV-02 30-NOV-02 2003 2003006
DEC-02 01-DEC-02 31-DEC-02 2003 2003007
JAN-03 01-JAN-03 31-JAN-03 2003 2003008
FEB-03 01-FEB-03 28-FEB-03 2003 2003009
MAR-03 01-MAR-03 31-MAR-03 2003 2003010
APR-03 01-APR-03 30-APR-03 2003 2003011
MAY-03 01-MAY-03 31-MAY-03 2003 2003012

2. Click the Quarter link.

Period Name Start Date End Date Year Interval Number
JUN-02 01-JUN-02 30-JUN-02 2003 2003001
JUL-02 01-JUL-02 31-JUL-02 2003 2003001
AUG-02 01-AUG-02 31-AUG-02 2003 2003001
SEP-02 01-SEP-02 30-SEP-02 2003 2003002
OCT-02 01-OCT-02 31-OCT-02 2003 2003002
NOV-02 01-NOV-02 30-NOV-02 2003 2003002
DEC-02 01-DEC-02 31-DEC-02 2003 2003003
JAN-03 01-JAN-03 31-JAN-03 2003 2003003
FEB-03 01-FEB-03 28-FEB-03 2003 2003003
MAR-03 01-MAR-03 31-MAR-03 2003 2003004
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Period Name Start Date End Date Year Interval Number
APR-03 01-APR-03 30-APR-03 2003 2003004

MAY-03 01-MAY-03 31-MAY-03 2003 2003004

3. Click the Year link.

Period Name Start Date End Date Year Interval Number
JUN-02 01-JUN-02 30-JUN-02 2003 2003

JUL-02 01-JUL-02 31-JUL-02 2003 2003

AUG-02 01-AUG-02 31-AUG-02 2003 2003

SEP-02 01-SEP-02 30-SEP-02 2003 2003

OCT-02 01-OCT-02 31-OCT-02 2003 2003

NOV-02 01-NOV-02 30-NOV-02 2003 2003

DEC-02 01-DEC-02 31-DEC-02 2003 2003

JAN-03 01-JAN-03 31-JAN-03 2003 2003

FEB-03 01-FEB-03 28-FEB-03 2003 2003

MAR-03 01-MAR-03 31-MAR-03 2003 2003

APR-03 01-APR-03 30-APR-03 2003 2003

MAY-03 01-MAY-03 31-MAY-03 2003 2003

5.2.6 Assign User Name to Tables

Define the user names for tables depending on desired usage.

See Oracle Incentive Compensation User Guide Section 12.3 Tables.

Prerequisites

None

Navigation

Administration > Tables
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Responsibility
Incentive Compensation Super User

Example:

Schema Name User Name Alias Description Usage

CN CN_COMMISSION_ CN_COMMISSION_ CH NA Calculation
HEADERS HEADERS

CN CN_COMMISSION_ CN_COMMISSION_ CL NA Calculation
LINES LINES

CN CN_SRP_PERIOD_  CN_SRP_PERIOD_ CSPQ NA Calculation
QUOTAS QUOTAS

CN CN_SRP_QUOTA_ CN_SRP_QUOTA_ CSQA NA Calculation
ASSIGNS ASSIGNS

5.2.7 Define Table Column Settings

Define the column settings for the desired tables.

See Oracle Incentive Compensation User Guide Section 12.3.1 Columns.

Prerequisites
None

Responsibility

Incentive Compensation Super User

Navigation
Administration > Tables >Columns

5.2.8 Define Report Configuration

See: Oracle Incentive Compensation User Guide Section 11.5 Configuring Reports.

NOTE: Remember that changes will not be visible to the user until after the Middle
Tier is bounced. These settings apply to the basic report definition, so changing the
visible columns in a report will alter the report for any execution within the given
database instance, regardless of the organization from which the report is run. This
is important during a multi-org implementation; all organizations must agree on
the column layouts prior to modification.
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Diagnostics and Troubleshooting

This chapter contains material useful in troubleshooting the implementation of
Oracle Incentive Compensation.

6.1 Common Questions and Answers
Q: I can’t find Sales Compensation in the Role Type list of values.
A: In this case, try the following:
Run the following SQL query.
select table name, nullable
from dba tab columns
where column name = 'ROLE_MODEL ID’

and owner = ‘CN’ ;

The correct output for the above query is below:

TABLE_NAME Nullable
CN_PLAN_TEXTS Y
N_ROLE_MODELS_ALL
CN_ROLE_PLAN_MAPS
CN_ROLE_QUOTA_CATES
CN_SRP_QUOTA_CATES_ALL

< < =7
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TABLE_NAME Nullable
CN_SRP_ROLE_DTLS_ALL Y
CN_SRP_TOTAL_COMPS_ALL Y

If CN ROLE_QUOTA CATES, CN SRP QUOTA CATES ALL,and CN_SRP_ROLE
DTLS_ALL are not set to "Y’, run the following SQL scripts and commit after each
script:

ALTER TABLE CN.CN ROLE QUOTA CATES MODIFY (ROLE MODEL_ ID
NULL) ;

ALTER TABLE CN.CN SRP QUOTA CATES ALL MODIFY (ROLE MODEL_ ID
NULL) ;

ALTER TABLE CN.CN SRP ROLE DTLS ALL MODIFY (ROLE MODEL ID
NULL) ;

Q: Can I change a role type or delete a role if it already assigned to any resources?

A: No. This can cause corrupted data in the system. Only the member flag and
manager flag can be updated.

Q: Why does a transaction fail classification / rollup / population / calculation?

A: For some possible reasons of failure, see Oracle Incentive Compensation User
Guide Section 9.1.3 Phases of Calculation.

Q: Why can'’t the user view their commission reports?
A: Freeze Periods

This check box, found on the Accumulation Periods page, controls the ability for
Oracle Sales Online users to execute Commission Statement or YTD Summary
reports.

If resources have been assigned compensation plans and commissions have been
calculated, but Oracle Sales Online users are reporting that they cannot view their
Oracle Incentive Compensation-related reports, check the Freeze Period check box
for the corresponding periods.
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Note that the Freeze Period check box does not affect Oracle Incentive
Compensation responsibilities, and only applies to users using Oracle Sales Online
responsibilities to access Oracle Incentive Compensation reports.

See Oracle Incentive Compensation User Guide Section 12.5 Accumulation Periods for
more information.

Q: Why do payruns contain negative payment amounts?
A: Payment Plan Minimum Payment Amount

A common situation is where calculated commissions for a resource result in a
negative balance due to adjustments, take-backs, or other circumstances.
Depending on the business requirements, the user may or may not want negative
payments appearing in the payrun. To prevent this, create a payment plan with a
minimum payment amount of 0, and assign it to any resource who should not have
negative payment amounts in the payrun.

See Oracle Incentive Compensation User Guide Section 12.15 Payment Plans for more
information.

Q: Why does calculate / load transaction / setup task not work for period 2 when it
worked for period 1?

A: Accumulation Period Status

The Period Status of an Accumulation Period can affect many parts of the
application. Here is a description of the different Period Statuses:

Never Opened: This period has never been used by Oracle Incentive Compensation,
there will be no setups or transactions for this period.

Future-Entry: This period is available for the creation of setups such as
Compensation Plans or Rulesets. No Transactions can be loaded or created for this
period, nor can Calculations be submitted. This status is recommended for initial
setup stages where no transactions or calculations are expected.

Open: This period is available for full usage.

Closed: Users wish this period to be preserved as is. No transaction adjustments,
new transactions or calculations are allowed. However, a period with status Closed
can be reopened if desired.

Permanently Closed: This period is Closed and cannot be re-Opened.

Diagnostics and Troubleshooting 6-3



Common Questions and Answers

See Oracle Incentive Compensation User Guide Section 12.5 Accumulation Periods for
instructions on setting the Period Status.

Q: Why does the YTD Summary report execute but return no data?
A: Plan Element Quota Group Code / Accumulation Period Status

This issue assumes that the resource in question has a valid plan assigned and
calculated transactions. Also, the YTD Summary Report actually runs, but appears
to contain no information. There are two items to check first:

= Plan Element Quota Group Code. In order for a plan element’s data to be
displayed on the YTD Summary Report, it must be assigned a Quota Group
Code of Quota or Bonus. If not, it will not appear on the report. See Oracle
Incentive Compensation User Guide Section 6.7 Defining Plan Elements for
instructions on setting the Quota Group Code.

= Accumulation Period Status. If the accumulation period has not been opened, it
will not appear on the YTD Summary Report. This is because, if the period has
never been opened, there will not be any commissions-related data for that
period. See Oracle Incentive Compensation User Guide Section 12.5 Accumulation
Periods for instructions on setting the Period Status.

Q: Why is a Group by Interval type calculation always returning zero commission?
A: Interval Types Interval Number

The interval numbers for each period must be unique in order for a grouped by
interval formula to calculate correctly.

See Oracle Incentive Compensation User Guide Section 12.7 Interval Types for
information on setting the Interval Number.

Q: How can an attribute column be added to the Adjustments page?
A: Columns settings for the CN_COMMISSION_HEADERS table

To affect which attribute columns appear in the Adjustments page, navigate to the
Columns page and appropriately edit the Value check box under Classification
View and the Usage check box under Columns View. The displayed column
heading is the User Name value under the Classification View.

If the Value and Usage boxes are checked, the column will be displayed.
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See Oracle Incentive Compensation User Guide Section 12.3.1 Columns for navigation
steps and additional information.

Q: When commission for Salesperson A is calculated, Manager B is not receiving
commission, even though credit should roll from A to B, and B’s compensation plan
should pay some commission. What’s going on?

A: Calculation Submission parameters.

While there are many possible reasons why a receiver of rollup credit should not
receive commissions, a case such as the one above assumes that the manager
definitely should receive credit and commission, but for some reason is not. This
means that resources are linked in the rollup hierarchy with appropriate dates, that
the manager has an active compensation plan for the appropriate dates, as well as
all other appropriate setups.

The first thing to check is the method of submitting calculation. If the calculation
was submitted with Resource Option other than All Resources, which would have
included Salesperson A but not Manager B, the explanation is that Manager B
would be receiving the rollup credit, but that credit has not yet been calculated.
Running a Transaction Details report for Manager B should show Unprocessed
rollup credit from Salesperson A.

To avoid this situation, submit calculations with Resource Option All Resources, or
specify Manager B and check the Entire Hierarchy box. This will calculate for
Manager B and any subordinates.

See Oracle Incentive Compensation User Guide Section 9.4 Submitting Calculations for
steps of calculation submission.

Q: What are the rules of credit rollup?
A: There are a few basic rules governing credit rollup.
The rules for credit rollup are:

= If amember of a resource group receives direct credit (via collection or
transaction adjustments), all managers of that group will receive rollup credit.

= Ifresource group A is the parent of resource group B, all credit entering
resource group B (either directly or via rollup) will be rolled up to all members
and managers of resource group A.
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= If the profile option OSC: Multi Rollup Path is set to Yes, credit directly received
by a resource will roll up through all applicable resource groups. Otherwise,
the credit will only rol lup through one of the possible paths.

= Ifresource group A contains no members or managers, credit can still roll up
from a child group to any parents of group A.

s The path of credit through the resource groups and credit receivers is
determined by the rollup date associated with the credit and the start and end
dates of the resource groups and the resources’ group member roles.

See Oracle Incentive Compensation Implementation Guide Appendix C System Profile
Options for information on the Multi Rollup Path profile option.

Q: What is the rule regarding the boundaries of rate table tiers?
A: The highest tier is utilized.

When rate tables are defined, the upper bound of one tier is displayed as equal to
the lower bound of the next highest tier. For example:

0-25% =1%
25-50% = 2%
50-75% = 3%
75-100% = 4%

If an Input Expression generated a value of 25%, what Rate Table Result would be
returned from this rate table? The answer would be 2%; the application will take
the higher tier, or in other words, 0-25% can be interpreted as "from 0% up to but
not including 25%".

Note that the usual case is a transaction that will cross a tier boundary. In these
situations the split parameter becomes important. For example, if the
non-proportional split is selected, a transaction that crosses the 25% boundary
would result in two split transactions, one that applies to an Input Expression value
up to 25%, at 1% Rate Table Result, and another that applies to an Input Expression
value of 25% and up, at 2% Rate Table Result.
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Q: What happens when a rate table has no appropriate tiers?
A: The closest tier is utilized.

Rate tables are defined to encompass a range of possible values, but do not always
cover all the possibilities. For example:

0-25% =1%
25-50% = 2%
50-75% = 3%
75-100% = 4%

If an Input Expression returns a value of 150%, what Rate Table Result would be
returned? The answer: 4%. The application will utilize the closest possible tier.
This applies on either end of the table: a value of negative 50% would return a Rate
Table Result of 1%.

Understanding this behavior is important in the case where a user wishes no
commission to be calculated outside of the defined tiers. In this case, additional
tiers can be added.

-100-0% = 0%
0-25% =1%
25-50% = 2%
50-75% = 3%
75-100% = 4%
100% - 999% = 0%

Q: After assigning a compensation plan to a role and the role to a resource, the
resource does not have an assigned compensation plan.

A: Check to see if a pay group has been assigned to the resource.

If the resource does not yet have a pay group assigned, assigning a role to the
resource will not always result in the assignment of a compensation plan. If a pay
group is assigned to the resource after the role assignment, the compensation plan
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will be visible as attached to the resource. Note that the end date of the
compensation plan assignment may change to equal the end date of the pay group
assignment.

Q: When using the split transaction functionality, what are the restrictions regarding
split percentage?

A: Tt depends on the original transaction’s split percent value.

When adjusting a transaction, the original transaction will have a value of Split
Percent. The general rule is that the sum of the Split % values entered in the Split
Transaction screen must equal the original transaction’s Split Percent value, unless
the Split Percent value is 0.

= Example 1: Transaction has original Split Percent of 100%. If this transaction is
split, the Split % values must add up to 100 : 70 + 30, 50 + 50, etc. In this case,
the transaction amount of the original transaction will be split using the given
percentage values.

= Example 2: Transaction has original Split Percent of 70%. If this transaction is
split, the Split % values must add up to 70 : 30 + 40, 20 + 50, etc. In this case,
the transaction amount of the original transaction will be split proportionally
using these values: 30 + 40 would equal one split at 30/70 of the original
amount, and the other at 40/70 of the original amount.

=  Example 3: Transaction has original Split Percent of 0% (perhaps the value was
not collected). If this transaction is split, the Split % values can add up to any
value : 100 + 40, 20 + 25, etc. In this case, the transaction amount of the original
transaction will be split using the given percentage values.

Q: While trying to access the Administration Tab, I receive this error: "Failed to get
sales group ID or sales role for the current user. User must have at least one role in a
valid sales group."

A: The profile option 'Bypass Group Validation' can be set to 'Y' to avoid this error.
Set the profile at the appropriate level to maintain desired access levels.

Q: A resource has two roles assigned for the same date (in different resource
groups). Each role has an associated agreement. Why aren't both agreements visible
for the planning process?
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A: Each agreement needs to be processed separately. Once that is done, the other
agreement(s) will be visible.

This means that each agreement has to be taken through the entire process of
Submit, Generate, Approve, and Accept. At that point, the other applicable
agreements will be available for the same process. Likewise, Resource Activation
has to be done for one contract at a time.

Q: When querying for a sales role in the Resource Details page, the compensation
plan information is displayed, but no plan elements are shown.

A: Once the compensation plan is displayed, click the name (which should be a
hyperlink) and the plan elements are displayed.
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Part IV

Integration of Oracle Products

This section of the Oracle Incentive Compensation Implementation Guide contains
the following chapter:

= Chapter 7, "Integrating Oracle Incentive Compensation With Other Oracle
Products"






7

Integrating Oracle Incentive Compensation
With Other Oracle Products

Oracle Incentive Compensation integrates with other applications in the Oracle
e-Business Suite to optimize the functions of the product. Interface programs
systematically link two or more systems to each other. With Oracle Incentive
Compensation and custom interfaces, you can accomplish some of the critical tasks
of an incentive compensation process:

m  Collect sales transaction data from Oracle Receivables, Oracle Order
Management, and other sources

= Pay supplier contract type resources using Oracle Accounts Payable
= Integrate with Oracle Payroll for employee type resources

= Generate reports related to compensation and other useful sales benchmarks
(see 5.50).

s Use Oracle Sales Online for Income Planner and resource self service needs
Using Oracle CRM Foundation Resource Manager module, you can:

= Maintain sales roles and compensation groups

s Maintain resource information

As a customization, you can create multiple interfaces, referred to as application
programing interfaces (APIs), to bring transactions into Oracle Incentive
Compensation and to send transactions out to other systems. Oracle Incentive
Compensation transactions can originate from a sales order, a customer billing, a
customer payment, or other business functions.
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7.1 Overview

Oracle Incentive Compensation exchanges information with other products within
the Oracle e-Business Suite. Transactions, the raw material that fuels Oracle
Incentive Compensation, are primarily derived from Oracle Receivables and Oracle
Order Management.

Oracle Receivables and Oracle Order Management provide sales transaction
information that forms the basis for calculating incentive compensation.

Examples of the types of transaction data Oracle Receivables can provide include:
= Invoices
s Credit and debit memos
= Payment postings
s Write-off postings

s Take-back postings, which are generated when an invoice due date goes
beyond the set grace period. The credit for the sale is deducted from the
resource’s sales credit.

= Give-back postings which are generated when a past due invoice that has
been deducted from the resource’s sales credit is paid. The resource
receives the credit.

From Oracle Order Management, you can collect booked orders and adjustments to
booked orders. In release 11i of Oracle Applications, Order Management replaces
the Order Entry system interface for collecting order information. Oracle Incentive
Compensation, as well as all other applications in the Oracle e-Business Suite, must
use the Oracle Quoting - Forms module to interface to Order Management.

Resource Manager is the common source for resource definition, and the ability of
Oracle Incentive Compensation to read Resource Manager directly eliminates the
need to create commonly used definitions and relationships in multiple
applications. Use Resource Manager to:

= Create resources
= Create sales roles and assign them to resources
= Create compensation groups, the basis of a sales hierarchy

In addition to these traditional sources of information, release 11i of Oracle
Incentive Compensation provides two-way integration to applications such as
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Oracle Sales Online, Business Intelligence Systems (BIS), and other applications
within the e-Business Suite.

Oracle Sales Online provides a sales performance and compensation forecasting
tool for sales representatives and managers, based on current compensation plans.
It is also a means for monitoring sales force performance through self-service
compensation reports, the Year-to-Date Commission Summary and the Quota
Performance Report. Resources can view their compensation summary and break
down their commissions by deal, product line, period, adjustments, or transactions.
They can also use Sales Online to view projected compensation based on
opportunities they enter into the system or commit to the forecast.

Compensation information is also made available to Oracle Sales Intelligence.

7.2 Oracle Sales Online

The Compensation tab > Compensation Plan subtab in Oracle Sales Online can be
used by:

= Aresource to accept a compensation plan.
= A manager to view the performance of directs.

= A manager to distribute compensation plans for resources in his or her
hierarchy.

If resources have access to Oracle Sales Online, they can submit their estimate of
their own Quota and either accept or reject their Compensation Plans when the
Plans are distributed to them by their manager via Oracle Sales Online.

Perform the following procedure to enable access to the Compensation tab in Oracle
Sales Online.

Prerequisites

System Administrator responsibility is required. This procedure is performed in the
Forms version of Oracle Incentive Compensation.

Steps

1. Create an employee in HRMS manager.
2. Import the resource into Resource Manager.

3. Create a username and password for the resource in System Administrator with
Oracle Sales Online usage.
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10.

11.

12.

13.

In the System Administrator Navigator, select Security.
Expand the Security menu by double-clicking on Security.
Double-click User.

Double-click Define.

Enter your User’s name in the User Name field. Start the search from the Menu
bar by clicking View > Query by Example > Run. (Pressing the Control key and
the F11 key together performs the same function.)

Assign Sales Online User responsibility to the user.

In Resource Manager, assign the role type of Sales to the user with a manager or
member role.

Assign Group usage Sales and Telesales for the group to which the user
belongs.

Create all compensation plan setups in the HTML version of Oracle Incentive
Compensation.

To log in to Oracle Sales Online, use the username and password that were
created in step 3.

7.2.1 Year to Date Summary

This report is an overview of a resource's achievements, commission and bonus
earnings and advances or draws.

The figures are grouped by period and by plan element. Super user can control
which plan element appears as a quota or bonus category through the Quota Group
check box on the Plan Element form. The pay out section is grouped by earnings
type and by period.

Prerequisites

You must have access to Oracle Incentive Compensation through Oracle Sales
Online.

Steps

1.
2.

Click the Compensation tab and click the Year to Date Summary subtab.

Select a credit type from the drop-down list. Functional Currency is the default
setting.
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3. Select a reporting currency from the drop-down list. Functional Currency is the
default setting.

4. Select a fiscal year from the drop-down list.

5. Click Apply.

7.2.2 Planning

Planning allows both managers and resources to provide feedback about the
estimated sales amount that they feel is achievable.

Prerequisites
A compensation plan must already be created.

Steps
1. Click the Compensation tab and click the Planning subtab.

The My Compensation Groups page appears.
2. Select an organization from the drop-down list.

3. Select an effective date. You can click the calendar icon to open a pop-up
calendar.

4. Any compensation groups within the parameters is displayed below.

Guidelines
For more information, see Incentive Planning in Chapter 5.

7.2.3 Compensation Plan
This subtab is divided into two areas: My Compensation Plans and My Salespeople.

As a manager, you can see compensation plans for which you are responsible in the
first area and also the resources to whom the plans can be assigned. You can then
distribute compensation plans in the My Salespeople area.

Steps

In the Distribute column, check the check box for each plan you want to distribute.

Click Distribute.
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7.2.4 Income Planner

Income planner enables resources to plan their sales volumes to reach their
commission earning goals. A resource can enter a Commission Forecast number
and see the amount of commission he or she will earn, based on their compensation
plan. Click the Compensation tab in Oracle Sales Online to access Income Planner.

Before you can use Income Planner in Oracle Sales Online, you need to assign
forecast input and output formulas to your Compensation Plan in Oracle Incentive
Compensation. The forecast formulas are the same as the formulas used in the
elements of your compensation plan, except that you must insert Forecast Amount
as a calculation expression in order to use Income Planner in Oracle Sales Online.

Note: Income Planner does not project income on bonus plan elements. Forecast
expressions cannot be assigned to a bonus formula.

To enable Income Planner in Oracle Sales Online, perform the following procedures
in Oracle Incentive Compensation.

Steps

To create Forecast expressions, do the following;:

1. Click the Incentive tab and click the Expression subtab.
The Calculation Expression page appears.

Click Create to open a blank page.

Enter a name for the input formula.

In the Details area, enter Forecast Expressions from the Type drop down list.

a & © Db

In the Expression Block, select your Expression fields. Forecast Amount MUST
be one of the elements selected as part of your expression if it is to be used in
Oracle Sales Online.

6. Click Update to save your input expression.
7. Repeat steps 2 through 6 to create an output expression.

Note: The output expression must contain Rate Table Result as the first element
selected and Forecast Amount should appear in the expression as well.

8. Click Update to save your output expression.

To assign your Forecast expressions to the formula in your plan element, do the
following:

1. Click the Formula subtab in the Incentive tab.
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2, Select the formula you want from the table or use the search parameters to
search by name, type, or status.

The Formula Definition page appears.
3. Click Assign Expressions to open the Assign Expressions page.
4. Inthe Input area, select your input forecast expression from the drop down list.

5. Inthe Output area, select your output forecast expression from the drop down
list.

6. Click Update to save your work.
7. Perform this series of steps for each formula in your compensation plan.

8. When making revisions to a saved page, click Restore to return to the
previously saved version.

Guidelines

For example, a resource’s compensation is based on a revenue quota and the rate
table tiers relate to achievement as a percentage of the quota. Because the forecast
results are hypothetical figures, the forecast formula does not affect the actual
achievement result. In this case, suppose the input forecast formula is Forecast
amount/TARGET and the output forecast formula is Rate Table Result*Forecast
amount. The input formula expresses the proportion of the forecast amount to the
quota, and the output formula applies a commission rate to the forecast amount.
The commission rate chosen depends on the resource’s achievements to date as
compared to the commission rate tiers.

A forecast amount based on each plan element is displayed if the Interest Type from
Oracle Sales is mapped to the plan element.

A resource can forecast commission only for periods for which commission has not
yet been calculated.

7.2.5 Reports

Users of Oracle Sales Online can click the Reports subtab of the Compensation tab
to see these Oracle Incentive Compensation reports:

= Quota Performance: This report is a snapshot of a resource’s achievement and
earnings. Achievements are shown against interval to date quota and annual
quota. Earnings total are broken down by period to date and interval to date.
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s Commission Statement: This report shows transaction details broken down by
period for a resource. It is configurable and you can hide or show selected
columns. You can use search parameters to make the report specific to your
needs.

Prerequisites

You must have access to Oracle Incentive Compensation through Oracle Sales
Online.

Steps

1. Log on to Oracle Sales Online.
2. Click the Compensation tab and click the Reports subtab.
3. (lick a link in the Report Name column to open that report.

4. Inthe My Reports area you can work with customized versions of reports
which have been saved to be used again.

a. To see the stored parameters, click the link in the Report Name Column.
b. To run the report, click Run Report.
c. To delete the report, check the Remove check box and click Update.

7.2.6 Top Performers Bin

The Top Performers bin in Oracle Sales Online enables you to monitor the
performance of your direct reports and indirect reports in a number of ways. You
can:

= View total payments by quarter.

= Show reports for direct and indirect resources in the same organization.

= Show Year to Date as well as quarterly information.

= View payments and earnings in the currency you select.

= View the payments and earnings for the accounting calendar by manager.

The Top Performers bin contains two columns: Period and Payments. You can drill
down on the Period link to display a group of four reports. Each report displays
revenue and payment amounts and carries the period name at the end of its title:

s Top Paid: Displays information about your directs
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Top Paid Individual Contributors: Displays information for your directs and
your indirects (everyone who reports to your directs)

Top Paid Year To Date: Displays year to date information for your directs

Top Paid Individual Contributors Year To Date: Displays year to date
information for your directs and your indirects (everyone who reports to your
directs)

You can drill down on each resource listed in the Name column to view their Year
To Date Summary report.

To set up the Top Performers bin on your Oracle Sales Online home page, perform
the following procedure.

Steps

1.
2.

10.

Log on to Oracle Sales Online.

Click the Profile icon in the upper right.

A side panel menu opens.

Under Sales Online, click the Home Page link.
The Home Page Preferences page appears.

In the Narrow Bin Preferences area, any bins that have already been set up are
displayed. If no bins have been set up yet, the columns are contracted.

Click Add New Rows.

The Narrow Bin Preferences area expands and fields become available in the
Bin Name column.

Select a bin number in the Bin Number column.

This controls the order the bins are displayed on the Home page. This is a
required field. If this is the only bin on the Home page, select 1.

In the Bin Name column, select Top Performers from the drop-down list.
Click Update. A confirmation message appears at the top of the page.
Click the Home tab.

The Top Performers bin is displayed in the upper left part of the page.

You can edit the parameters of the Top Performers bin. Click Edit in the bin
itself or during setup steps 7 through 9 above.

Integrating Oracle Incentive Compensation With Other Oracle Products 7-9



Oracle Sales Online

The Top Performers Parameters page appears. Select appropriate scaling from
the drop-down list.

To make sure that current data is displayed in bins on the home page, Oracle Sales
Online requires that the bins be refreshed using a concurrent request in Forms. To
set up the ability to refresh the Top Performers bin, perform the following
procedure:

Prerequisites
Oracle Sales Administrator responsibility in Forms.

Steps

1. Log into Forms.

2. Select System Administrator responsibility and navigate to Security >
Responsibility > Define.

3. Query for Oracle Sales Administrator. (See Guidelines).

4. Note down the request group (Sales and Marketing Super User) that the
responsibility belongs to. (See Guidelines)

5. Return to the Navigator window and navigate to Security > Responsibility >
Requests.

6. Query for the Sales and Marketing Super User request group.
7. In the Requests area, add the Refresh Top Performers Report request.
8. Save.
9. Switch the responsibility to Oracle Sales Administrator.
10. Run these concurrent requests:
s AS_PERIOD_DAYS refresh
s AS_PERIOD_RATES refresh

= Refresh Top Performers

Guidelines

Setting up the Top Performers Bin (steps 1-8) needs to done only once. Refreshing
the bins (steps 9 and 10) is done whenever the information in the bins needs to be
refreshed.
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A request group saves time and effort by grouping individual requests so that an
administrator can assign all requests to a responsibility with one entry rather than
assigning each request individually.

7.2.7 Forecast Hierarchy Drilldown to Year to Date Summary

You can drill down to the Year to Date Summary from the Forecast page in Oracle
Sales Online. Perform the following procedure to do this:

Steps
1. Click the Forecast tab.

The Forecast page appears.

2. In the Subordinate Forecasts area, click the icon in the Compensation column to
the far right of the table.

3. The Year to Date Summary page appears.

7.3 Oracle Resource Manager

Defining Roles

A Role may encompass one or more job descriptions and job titles. Use Roles to
assign jobs to resources, resource groups and resource teams. Oracle Resource
Manager is delivered with pre-defined Roles for all CRM modules. Use this
procedure to define additional custom Roles for your enterprise.

Prerequisites
Make sure that a Role Type exists with which you can associate the new Role.

Steps
1. In the CRM Resource Manager responsibility, navigate to Setup > Roles.

The Roles window displays fields you can use to define a role.

2. Enter your values in the Code and Name fields. Choose a Role Type from the
list of values. For Incentive Compensation choose Incentive Compensation.

3. Select the Active box to make the Role active. Select one or more of the job title
boxes—Manager, Member, Admin, Lead-to associate the Role to job titles.

4. Use one or more of the Job lines to describe jobs associated with the Role.
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5. Select File > Save to complete the Role definition.

7.4 Oracle Payable

Oracle Payable recognizes resources for payment only if they are activated as
Suppliers through Oracle Purchasing. To pay full-time, regular employees, use
Payroll. Please refer to Oracle Purchasing documentation.

When a Payrun has been processed (Paid status against the Payrun name), the

Salespeople Sub-ledgers are updated to reflect the amounts paid in the appropriate

accounts and balances. When activated, the user will send payrun details to the
Oracle Payable Invoices Interface table.

The following two tables show the columns that map to the invoice interface in

Oracle Payable:

AP_INVOICES_INTERFACE

Populated with

INVOICE_ID
INVOICE_NUM

INVOICE_DATE

VENDOR_ID
VENDOR_SITE_ID
INVOICE_AMOUNT
INVOICE_CURRENCY_CODE
PAYMENT_CURRENCY_CODE
SOURCE

AP_INVOICES_INTERFACE_S.NEXTVAL

CN_POSTING_DETAILS_SUM.POSTING_
DETAIL_SUM_ID

CN_PAYRUNS.PAY_DATE
FND_USER.SUPPLIER_ID
PO_VENDOR_SITES.VENDOR_SITE_ID
CN_PAYMENT_TRANSACTIONS
FUNCTIONAL CURRENCY CODE
REP CURRENCY CODE
“OSC” (NEW quick code of type SOURCE)

AP_INVOICE_LINES_INTERFACE

Populated with

INVOICE_ID

INVOICE_LINE_ID
LINE_NUMBER
LINE_TYPE_LOOKUP_CODE
AMOUNT

Same value as entered for AP_INVOICES_
INTERFACE

AP_INVOICE_LINES_INTERFACE_S.NEXTVAL
CNPD.COMMISSION_LINE_ID

ITEM/ TAX / MISCELLANEOUS

CNPD
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The Liability Account will also be mapped to the Oracle Payable Interface. This will
be done using the account generator, accessible via the Ruleset Form or liability
account information entered at the plan element or revenue class level.

7.5 Oracle Payroll

You can integrate Oracle Incentive Compensation with Oracle Payroll for employee
type resources. After setting up a resource in Resource Manager and assigning the
resource to a role with compensation plan, you must map a plan element from the
compensation plan to a pay element in Payroll. This procedure is detailed below.

7.5.1 Mapping Plan Elements to Pay Elements

After the tables are registered you can map the plan element to the pay elements
using the following procedure.

Navigation
Administration > Incentive > Payroll

Prerequisites
Plan elements and pay elements must already be created.

Steps

If you want to make a change in mapping or dates to an existing line, perform the
following procedure.

1. Click the Administration tab and the Incentive subtab.
2. Click the Payroll link on the side panel menu.
The Payroll Mapping page appears.

3. Enter the changes. Click Go to open a pop-up list of choices, or the calendar
icon to open a calendar.

4. Check the Remove check box if you want to eliminate the plan element to pay
element mapping.

5. Check the Inactive Employees check box if you want to keep the mapping but
not use it now.

Steps 2 and 3 are completed when you click Update.
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You can click the Element Input link to go to the Pay Element Input Values
Mapping page.
Click Update.

If necessary, click Restore before clicking Update to return to the previously
stored information.

To enter a new mapping, perform the following procedure.

1.

o » 0D

Enter a plan element in the first blank plan element field. Click Go to use a
pop-up list.

Enter the pay element from Payroll that you want to use.

Enter a Start Date and an End Date.

If necessary, click Restore to return to the previously saved information.

Click Update to save your mapping.

7.5.2 Mapping Pay Element Input Values

After you have mapped the pay elements to the plan elements, use this page to map
table and column names to Payroll input values. Input values that have already
been mapped are displayed. To map table and column names to Payroll input
values, perform the following procedure.

Navigation
Administration > Incentive > Payroll > Element link

Prerequisites
Plan elements and pay elements must already be created.

Steps
1. Click Administration tab and the Incentive subtab.
2. Click the Payroll link in the side panel menu.
The Payroll Mapping page appears.
3. Click the link in the Element column.

The Pay Element Input Values Mapping page appears.
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Enter a table name in the first blank field in the Table Name column. Click Go
to open a pop-up list.

Enter a column name in the Column Name column. Click Go if needed.
In a line that is not yet saved, click the eraser icon to clear the fields.

To remove a saved line, check the check box in the Remove column.

If necessary, click Restore to return to previously saved information.

Click Update to save.
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Appendices

This section of the Oracle Incentive Compensation Implementation Guide contains
the following appendices:

= Appendix A, "Flexfields"

= Appendix B, "Lookups"

= Appendix C, "System Profile Options"
= Appendix D, "Road Map"

= Appendix E, "Responsibilities”






A

Flexfields

A.1 Flexfields

Flexfields are used for classification of transactions, in defining plan elements, and
in setting up compensation plans. Use a flexfield when you want to set up a text
field that is preset with a recognizable name and a specific type of data that it will
accept. For example, a field can be called Item Number, and be set up to be a
five-character numeric field. This helps minimize entry errors.

Oracle Incentive Compensation uses descriptive flexfields, which provide
customizable expansion space on a page. There are three flexfields used in this
release of Oracle Incentive Compensation:

Flexfield Name Flexfield Code

*CN Commission Headers CN_COMMISSION_HEADERS_ALL
*CN Compensation Plans CN_COMP_PLANS_ALL

*CN Quotas CN_QUOTAS_ALL

The flexfields are enabled in three tables:
s CN Commission Headers

Oracle Incentive Compensation contains 100 numbered attributes that can
be customized for use with classification of transactions. These attributes
are seeded with the application. A Context Value field appears on the
Transaction Detail - Adjust page.

= CN Compensation Plans
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A Context Value text field appears on the Compensation Plan Details page
(Incentive > Plan).

= CN Quotas

These flexfields are used with plan elements to define attributes used in
expressions.

See the Oracle Applications Flexfields Guide for information about setting up
flexfields.
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B.1 Lookups

Lookups enable quick selection from drop-down menus. Oracle Incentive
Compensation has 100 lookups incorporated into its system to speed the process of
entering data into forms. The lookups listed in the following table display the user
name in the left column; the Type name is shown in full caps in the right column
with the default selections below it. You can add lookups and add values to the
default lists.

To view lookups, perform the following procedure.

Prerequisites

Log in as the Incentive Compensation Developer responsibility in the Forms version
of the application.

Steps
1. In the Navigator - Incentive Compensation Developer window, double-click
Lookups.

The Oracle Sales Compensation Lookups window appears.
2. Press the F11 key.

The four search fields turn blue.
3. Enter Oracle Sales Compensation in the Application field.
4. In the Toolbar, click View.
5. Press Control and the F11 key.

The first lookup appears.
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Scroll through the lookups by using the up and down arrow keys or use Find in
the View drop-down menu. Leave the cursor in the Type field while scrolling.

The Oracle Sales Compensation Lookups window displays the lookups
individually as they are currently configured.

To edit or add values to a lookup, perform the following:

1.
2.
3.

5.

Perform steps 1 to 6 above.
For edits, click in the field you want to change and enter new data.

To add values, click the field in the first blank line of the table and enter the
appropriate data.

The From column automatically populates with the current date and the
Enabled check box is automatically selected. Change these as needed.

Save your work.

To add a new lookup, perform the following:

Steps

1.

o o > w

In the Navigator - Incentive Compensation Developer window, double-click
Lookups.

The Oracle Sales Compensation Lookups window appears.

Click the Application field and select Oracle Incentive Compensation from the
drop-down list.

Enter a name in the Type field. Use all caps with underlines between words.
Enter a user name in the User Name field.
Enter a description in the Description field if you wish.

In the table in the lower part of the window, enter one or more values that you
want to use in the lookup. Enter a code, meaning, and description that are easy
for users to understand.

Type in effective dates or click the calendar icons to enter dates from a graphic
calendar. Select the Enable check box if you want the lookup to be operational
within the effective date range.

Save your work.
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Guidelines

Note: Under the type of PE_OBJECT_TYPE in the table below, the codes START_
PERIOD_ID and END_PERIOD_ID are listed. However, starting with the 11i
version of Oracle Incentive Compensation, these period_ids are no longer used. Use
actual start and end dates instead.

The following table lists Oracle Incentive Compensation Lookups, including a
description, Access Level, and Seeded Values and Meanings.

OIC Lookup Type Description Lookup Code and Meaning

ACCESS_CODE Access Code UPDATE (Update)

VIEW (View)
ACTIVATE_STATUS Plan Activate Status CREATED (Created)

PUSHED (Activated)

UPDATED (Updated)
ADJUSTMENT_REASON Manual Adjustment Reason | AR_ERROR (Accounts Receivable

Processing Error)

OE_ERROR (Error During Order Entry)
OTHER (Other)

SHARED (Commission should be Split)

ADJUSTMENT_STATUS Manual Adjustment Status CANCELED (Canceled)
POSTED (Posted)
REVERSED (Reversed)
REVIEW (Review)
TRIAL (Trial)
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OIC Lookup Type

Description

Lookup Code and Meaning

ADJUST_STATUS

Transaction Adjust Status

DEALASGN (Deal Move)
DEALSPLIT (Deal Split)
FROZEN (Frozen)

INVLOAD (Invoice Captured)
MANUAL (Manual)
MASSADJ (Move Credits)
MASSASGN (Share Credits)
ORIGINAL (Original)
REVERSAL (Reversal)

SPLIT (Splits)

ADVANCED SEARCH

Advanced Search

ADJUSTED_BY (Adjusted By)
ADJUST_DATE (Adjust Date)
ADJUST_STATUS_DISP (Adjust Status)

DIRECT_SALESREP_NAME (Direct
Salesperson Name)

DIRECT_SALESREP_NUMBER (Direct
Salesperson Number)

INVOICE_DATE (Invoice Date)
INVOICE_NUMBER (Invoice Number)
LOAD_STATUS (Load Status)
ORDER_DATE (Order Date)
ORDER_NUMBER (Order Number)
PROCESSED_DATE (Processed Date)
QUANTITY (Quantity)
REVENUE_TYPE_DISP (Revenue Type)
ROLLUP_DATE (Roll Up Date)
STATUS_DISP (Calculation Status)

TRANSACTION_AMOUNT (Functional
Amount)

TRX_TYPE_DISP (Transaction Type)

AMS_CUSTOM_SET_OBJECTS

Parent Object for Cue Cards

PLAN_ELEMENT (Plan Element)
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OIC Lookup Type

Description

Lookup Code and Meaning

AMS_CUSTOM_SETUP_
OBJECTS

Parent Object for Cue Cards

PLAN_ELEMENT (Plan Element)

AMS_SYS_ARC_QUALIFIER

AMS System Architecture
Qualifier: Cue Card Codes
and Meanings

PE_ARC (Revenue Classes)
PE_ART (Rate Tables)
PE_DTLS (Main)

ANALYST_NOTE_REASON

Analyst Note Reason

SYSTEM_GENERATED (System
Generated)

USER_DEFINED (User Defined)

ANC_CALC_METHOD

Anchor Calc Method

LINE_CALC (Line Calculation)
STEP_CALC (Step Calculation)

APPL_STATUS

Applicable Status

NA (Not Applicable)

APPLICATION_TYPE

Application Type

AR (Oracle Receivables)

CN (Oracle Commissions) and Sales
Analysis

GL (Oracle General Ledger)
OE (Oracle Order Entry)
RA (Oracle Revenue Accounting)

BASE_RULE

Base Rule

BASE_RULE (Base Rule)

BATCH_STATUS

Batch Status

POSTED (Posted)
UNPOSTED (Unposted)

CALCULATION_STATUS

Calculation Status

COMPLETED (Completed)
FAILED (Failed)
INCOMPLETE (Incomplete)
PROCESSING (In Progress)

CALCULATION_TYPE

Types of Calculation

BONUS (Bonus)
COMMISSION (Commission)
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OIC Lookup Type

Description

Lookup Code and Meaning

CALC_SUBMISSION_OBJECT_

TYPE

Calculation Submission
Object

CALC_TYPE (Calculation Type)

CONCURRENT_FLAG (Concurrent
Calculation)

EMPLOYEE_NUMBER (Employee
Number)

EMPLOYEE_TYPE (Employee Type)
END_DATE (End Date)
HIERARCHY_FLAG (Entire Hierarchy)

INTELLIGENT_FLAG (Do incremental
calculation or not)

INTERVAL_TYPE (Interval Type)

NAME (Calculation Submission Batch
Name)

RESPONSIBILITY_NAME (Application
responsibility name)

SALESREP_OPTION (Resources)
START_DATE (Start Date)
USER_NAME (Application User Name)

CLASSIFICATION_DATATYPE Classification Datatype ALPN (Alpha Numeric)
DATE (Date)
NUMB (Numeric)
CLASSIFICATION_STATUS Classification Status CLS (Classified)

NEVER (Never Classified)
XCLS (Failed Classification)

CN_HEAD_TRX

Header Transaction Status

CALC (Calculated)
OBSOLETE (Obsoleted)
POP (Populated)

ROLL (Rolled Up)

XCALC (Failed Calculation)
XPOP (Failed Population)
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OIC Lookup Type

Description

Lookup Code and Meaning

CN_LEVEL_NUMBER

Level Number for Executive
Portal Report

0 (Self with No Levels)
1 (One Level Down)

2 (Two Levels Down)
3 (Three Levels Down)
4 (Four Levels Down)

5 (Five Levels Down)

CN_NOTES Notes NOTES (Notes)
CN_OPERAND Incentive Compensation 0 (AND)

Operand 1(OR)
CN_OPERATOR Incentive Compensation 0 (AND)

Operator 1(OR)
CN_PAY_GROUP_DTLS_TYPE_ | Lookup code for Pay Group | PERIODS (Periods)

CODE

Details Display by

SALESPEOPLE (Resources)

CN_PROMPTS

Prompt Texts used in Ul
interface

DIMENSION_NAME (Dimension Name)
EXP_NAME (Expression Name)
FORMULA_NAME (Formula Name)
RATE_TABLE_NAME (Rate Table Name)

CN_R2P_CLUB_ELIG Club Eligibility Flag Y (Yes)
N (No)
CN_RULE_CREATE_TYPE Rule Create Type ROOT (Root)
CHILD (Child)
SIB (Sibling)
CN_SEARCH_CATEGORIES Sales Compensation Search | JOBTITLE (Job Title)
Categories ROLE (Role)
SALESREP (Resource)
QUOTA (Quota)
CN_USAGE_FLAG Incentive Compensation C (Collection)
Usage Flag Y (Calculation)
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OIC Lookup Type

Description

Lookup Code and Meaning

COLLECTION_TYPE

Collection Type

CN_COLLECT_CLAWBACK (Clawbacks)

CN_COLLECT_CUSTOM (Collect Custom
Transaction Source)

CN_COLLECT_INVOICES (Collect
Invoices)

CN_COLLECT_ORDERS (Collect Orders)

CN_COLLECT_PAYMENTS (Collect
Payments)

CN_COLLECT_WRITEOFFS (Collect
Writeoffs)

CN_COLLECT_RAM (Collect Revenue
Adjustments)

COLUMN_TYPE

Column Type

CF (Commissions Factor)
CN (User Defined)

EF (Event Factor)

IN (System)

PF (Payment Factor)

CP_OBJECT_TYPE

Compensation Plan Objects

CP_NAME (Compensation Plan Name)
DESC (Description)
END_PERIOD (End Period)

REV_CLS_OVERLAP (Allow Revenue
Class Overlap)

START_DATE (Start Date)
START_PERIOD (Start Period)
STATUS_CODE (Status Code)

CP_PHASE_CODE

Concurrent Request Phase
Code

C (Completed)
I (Inactive)

P (Pending)

R (Running)
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OIC Lookup Type

Description

Lookup Code and Meaning

CP_STATUS _CODE

Concurrent Request Status
Code

A (Waiting)

B (Resuming)
C (Normal)

D (Cancelled)
E (Error)

G (Warning)

H (On Hold)

I (@Normal)

M (No Manager)
P (Scheduled)
Q (Standby)

R (@@Normal)
S (Suspended)
T (Terminating)
U (Disabled)

W (Paused)

X (Terminated)
Z (@Waiting)

CURRENCY_TYPE

Currency Type used in
reports

FUNCTIONAL_CURRENCY (Functional
Currency)

SALESREP_CURRENCY (Resource
Currency)

DATA_TYPE

Column Datatypes

DATE (Date)

LONG (Long)
NUMBER (Number)
VARCHAR?2 (Varchar2)
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OIC Lookup Type

Description

Lookup Code and Meaning

DELIMITER_TYPE

Delimiter Type

COMMA (Comma)

QUOTE (Single Quotation)
DOUBLEQ (Double Quotation)
SEMICOL (Semi-colon)

SPACE (Space)

TAB (Tab)

DISCOUNT_OPTION

Discount Option

NONE (Not apply discount percentage)
PAYMENT (Apply to payment factor)
QUOTA (Apply to quota factor)

DISTINGUISHED_
HIERARCHIES

Distinguished Hierarchies

REVENUE_CLASS (Revenue Class Rollup)
SALESREP (Sales Representative Rollup)

DISTRIBUTE_METHOD

Method for distributing
quota

EQUAL (Equal)
EVEN (Even)
MIN (Minimum)

DYNAMIC_PROMPT

Period Processing Status
Dynamic Prompt

DISTRIBUTE_DRAW (Distribute Draw)
DISTRIBUTE_TARGET (Distribute Target)
DRAW (Draw)

PAYMENT (Payment)

PERIOD_DRAW (Period Draw)
PERIOD_TARGETS (Period Targets)
TARGET (Targets)

ELEMENT_TYPE Element Type -1000 (Recoverable Payment)
-1001 (Nonrecoverable Payment)
ENCLOSED_TYPE Enclosed Type COMMA (Comma)

QUOTE (Single Quotation)
DOUBLEQ (Double Quotation)
SEMICOL (Semicolon)
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OIC Lookup Type

Description

Lookup Code and Meaning

EVENT_NAME

Event Name

CHANGE_CLS_HIER (Change a hierarchy
used in classification)

CHANGE_CLS_HIER_DATE (Change a
hierarchy date used in classification)

CHANGE_CLS_HIER_DELETE (Delete a
hierarchy interval used in classification)

CHANGE_CLS_HIER_PERIOD (Change a
hierarchy interval used in classification)

CHANGE_CLS_RULES(Change
classification rules)

CHANGE_CLS_RULES_ATTR (Change
classification rules attribute)

CHANGE_CLS_RULES_DATE (Change
classification ruleset date range)

CHANGE_CLS_RULES_HIER (Change
classification rules hierarchy)

CHANGE_CLS_RULES_REV (Change
classification rules revenue class)

CHANGE_CLS_RULES_SET (Change
classification rules set

CHANGE_COMP_PLAN (Change
compensation plan)

CHANGE_COMP_PLAN_OVER_LAP_
FLAG (Change compensation plan overlap
flag)

CHANGE_COMP_PLAN_PERIOD
(Change compensation plan effective
interval)

CHANGE_CP_ADD_MGR (Add a
manager to a compensation group)

CHANGE_CP_ADD_SRP (Add a
salesperson to a compensation group)
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OIC Lookup Type

Description

Lookup Code and Meaning

EVENT NAME (continued)

Event Name

CHANGE_CP_DELETE_MGR (Delete a
manager from a compensation group)

CHANGE_CP_DELETE_SRP (Delete a
salesperson from a compensation group)

CHANGE_CP_HIER_ADD (Add an edge
to compensation group hierarchy)

CHANGE_CP_HIER_DATE (Change date
range of a compensation group hierarchy
edge)

CHANGE_CP_HIER_DELETE (Delete an
edge from a compensation group
hierarchy)

CHANGE_CP_MGR_DATE (Change date
range of a manager)

CHANGE_CP_SRP_DATE (Change date
range of a salesperson)

CHANGE_DELETE_TRX (Delete
transactions)

CHANGE_FORMULA (Change a formula)

CHANGE_INSERT_TRX (Insert new
transactions)

CHANGE_PERIOD_INTERVAL _
NUMBER (Change a period’s interval
number)

CHANGE_PLAN_ASSIGN (Change plan
assignment

CHANGE_PLAN_ASSIGN_INS_DEL
(Insert or delete plan assignment)

CHANGE_PLAN_ASSIGN_PERIOD
(Change plan assignment effective
interval)

CHANGE_QUOTA_CALC (Change plan
element)
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OIC Lookup Type Description Lookup Code and Meaning

EVENT_NAME (continued) Event Name CHANGE_QUOTA_DATE (Change plan
element date range)

CHANGE_QUOTA_PERIOD (Change
plan element effective interval)

CHANGE_QUOTA_POP (Change plan
element revenue class factors)

CHANGE_QUOTA_ROLL (Change plan
element revenue class)

CHANGE_QUOTA_UPLIFT_DATE
(Change -plan element uplift factors date
range

CHANGE_RC_HIER_DATE (Change
revenue class hierarchy date range)

CHANGE_RC_HIER_DELETE (Delete
revenue class hierarchy effective interval)

CHANGE_RC_HIER_PERIOD (Change
revenue class hierarchy effective interval)

CHANGE_RT_INS_DEL (Insert or delete
rate tiers)

CHANGE_RT_RATES (Change rate table
rates)

CHANGE_RT_TIERS (Change rate table
tiers)

CHANGE_SRP_HIER (Change
salesperson hierarchy)

CHANGE_SRP_HIER_DELETE (Delete
salesperson hierarchy effective interval)

CHANGE_SRP_HIER_PERIOD (Change
salesperson hierarchy effective interval)

CHANGE_SRP_PAY_GROUP (Change
salesperson pay group)

CHANGE_SRP_PAY_GROUP_DATE
(Change salesperson’s pay group date)

CHANGE_SRP_QUOTA_CALC (Change
salesperson’s plan element setting)
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OIC Lookup Type

Description

Lookup Code and Meaning

EVENT_NAME (continued)

Event Name

CHANGE_SRP_QUOTA_PAYEE_DATE
(Change date range of payee assignment)

CHANGE_SRP_QUOTA_POP (Change
salesperson’s uplift factors or payee
assignment)

CHANGE_SRP_ROLE_PLAN (Change
role/plan or role/salesperson assignment)

CHANGE_SRP_ROLE_PLAN_DATE
(Change date range of
role/plan/salesperson assignment

CHANGE_SYS_PARA_RC (Change
revenue class hierarchy used)

CHANGE_SYS_PARA_SRP (Change
salesperson hierarchy and roll up flag)

CHANGE_UPDATE_TRX (Update
transactions)

EXPRESSION_MESSAGES

Messages Required for Rule
Attribute Expressions

AND (And)

BET (Between)

GT (Greater than)
ITH (Is in Hierarchy)
IS (Is)

LT (Less than)

NOT (Not)

OR (Or)

RES (Result)

WYV (With Value)
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OIC Lookup Type

Description

Lookup Code and Meaning

EXPRESSION_TYPE

Expression Type

EXPRESSIONS (Expressions)

EXTERNAL_ELEMENTS (External
Elements)

FORECAST_AMOUNT (Forecast Amount)
FORMULAS (Formulas)
GROUP_FUNCTIONS (Group Functions)

NUMBER_FUNCTIONS (Number
Functions)

OSC_ELEMENTS (Sales Compensation
Elements)

OTHERS (Others)
PLAN_ELTS (Plan_Elements)

RATE_TABLE_RESULT (Rate Table
Result)

SQL_FUNCTIONS (SQL Functions)

EXTERNAL_TABLE

External Table

ALIAS (Alias)
CN_CALC_EXT_TABLE_ID (Table)
COLUMN (Columns)

EXTERNAL_COLUMN_ID (External
Column Name)

EXTERNAL_TABLE_ID (External Table
Name)

INTERNAL_COLUMNL_ID (Internal
Column Name)

INTERNAL_TABLE_ID (Internal Table
Name)

NAME (Name)
SCHEMA (Schema)
USED_FLAG (Used Flag)
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OIC Lookup Type

Description

Lookup Code and Meaning

FORMULA_STATUS

Formula Status

COMPLETE (Complete)
FAILED (Failed)
INCOMPLETE (Incomplete)
IN_PROGRESS (In Progress)
INVALID (Invalid)

VALID (Valid)

FORMULA_TYPE

Formula Type

B (Bonus)

C (Commission)

HEADER_TRX_STATUS

Transaction Header Statuses

CLS (Classified)

COL (Unprocessed)

ROLL (Rolled Up)

XCLS (Failed Classification)
XROLL (Failed Rollup)

HOLD_REASON_CODE

Hold Reason Code

HOLD (Hold)

IMPORT_STATUS

Import Status

CANCELED (Canceled)
COMPLETED (Completed)

FAILED (Failed)

IMPORT_FAIL (Failed at Importing)
NEW (New)

SCHEDULED (Scheduled)

STAGED (Staged)

STAGE_FAIL (Failed at Staging)
SUBMITTED (Submitted)

IMPORT_TYPE

Import Type

CALCEXP (Expressions)
HIERARCHY (Hierarchy)
IMPORT (Import)
EXPORT (Export)

REVCL (Revenue Class)
RULES (Rules)

TRXAPI (Transaction APT)
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OIC Lookup Type

Description

Lookup Code and Meaning

INCENTIVE_TYPE

Incentive Type

BONUS (Bonus)
COMMISSION (Commission)
MANUAL (Manual)
PAYMENT (Payment)
QUOTA (Quota)

INCENTIVE_TYPES

Incentive Types

BONUS (Bonus)
COMMISSION (Commission)

MANUAL_PAY_AD] (Manual Pay
Adjustment)

PMTPLN (Payment Plan)
PMTPLN_REC (Payment Recovery)

INPUT_TOKEN

Input Token

CP_NAME (Comp Plan Name)
NAME (Name)

PE (Plan Element)

PE_NAME (Plan Element Name)
PERIOD_NAME (Period Name)
QC (Quota Category)

QSR (Quota Category/Sequence
Number/Role)

RC (Revenue Class)

RCS (Role/Compensation Plan
Name/Start Date)

ROLE_NAME (Role Name)
ROLLPERCENT (Rollover Percentage)
RP (Base Quota Component/Percent)
SD (Start Date)

SEQ (Sequence Number)

SPE (Source Plan Element)

SR_NAME (Salesrep Name)
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OIC Lookup Type

Description

Lookup Code and Meaning

JE_BATCH_REASON

Reason for creating JE batch

BONUS (Bonus)
CALC (Calculation)

DRAW_BONUS (Draw Recovery from

Bonus)

DRAW_COMM (Draw Recovery from

Commission)
PAYMENT (Payment)

PAY_AD] (Adjustment Payment)
PAY_BONUS (Payment from Bonus)
PAY_COMM (Payment from Commission)

PAY_DRAW (Draw Payment)

LOAD_STATUS

Load Status

LOADED (Loaded)
UNLOADED (Unloaded)

MAPPING_TYPE

Mapping Types

COL (Collection)
EVT (Event)
SLC (Slice)

MESSAGE_TYPE

Message Types

DEBUG (Debug)
ERROR (Error)
TRANSLATE (Translated)

MGR_REPORT

Top Bottom Performance
Report Hierarchy Level

1 (Directs)
2 (Level 1 Indirects)
3 (Level 2 Indirects)
4 (Level 3 Indirects)
5 (Level 4 Indirects)
ALL (All)

MODEL_ACTIVATE_STATUS

Model Activate Status

ACTIVATED (Activated)

NOT_ACTIVATED (Not Activated)

MODEL_STATUS

Model Status

MODELED (Modeled)
NEW (New)

PENDING (Pending)
GENERATED (Generated)
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OIC Lookup Type

Description

Lookup Code and Meaning

MODULE_STATUS

Module Status

CONCEFAIL (Concurrent Manager Down)
GENERATED (Complete)

INSTFAIL (Install Failed)

INSTINPG (Install Pending)

UNSYNC (Incomplete)

MODULE_STATUS_OLD

Old Module Status

DEF (Definition)

GEN (Generated)

GRQ (Generate Request)
INS (Instantiated)

IRQ (Instantiate Request)
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OIC Lookup Type

Description

Lookup Code and Meaning

MODULE_TYPE

Module Types

ACCGEN (Account Generation)
CALCULATION (Calculation)
CB (Clawback Collection Module)

CB/GB (Clawback/Giveback Collection
Module)

CLS (Classification Module)

COL (Collection Module)

CPAPI (Compensation Plan API Module)
INS (Commissions Instance Module)
INV (Invoice Collection Module)
LOADER (Transaction Interface Loader)
ORD (Order Collection Module)

PEAPI (Plan Element API Module)

PMT (Payment Collections Module)

PMT/GB (Payments/Giveback Collection
Module)

REVCLS (Revenue Classification)
RUP (Rollup Module)

SLC (Slice Module)

TRF (Transfer Module)

TRX (Commissions Transaction Table
Module)

WO (Writeoff Collection Module)

NOTIFY_ACTION

The action to be taken due to
events caused by changing
compensation group
hierarchy

DELETE (Delete transactions)
PULL (Pull transactions up)
ROLL (Roll transactions up)

ROLL_PULL (Roll and pull transactions
up)
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OIC Lookup Type

Description

Lookup Code and Meaning

NOTIF_LOOKUP_TYPE

Lookup used by SF Planning
workflow process

ACCEPT/REJECT (Accept)

APPROVE (Approve)

CUSTOMIZED (Customized)
DISTRIBUTE (Distribute)

NOTIFIED (Notification Sent)
NOT_NOTIFIED (Notification not Sent)
REMINDER (Reminder)

OBJECT_STATUS

Object Status

I (Invalid)
N (New)
V (Valid)

OBJECT_TYPE

Object Types

COL (Column)

DBL (Database Link)

IND (Index)

PKB (Package Body)

PKS (Package Specification)
PRC (Procedure)

SEQ (Sequence)

TBL (Table)

TRG (Trigger)

ORDER

Order

ASC (Ascending)
DESC (Descending)

ORGANIZATION

Organization

ALLIANCES (Alliances)
BOL (Business Online)
EDUCATION (Education)
ISD (Telesales)

SALES (Sales)

SC (Sales Consulting)
SUPPORT (Support)
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OIC Lookup Type Description Lookup Code and Meaning

PAYABLES_CCID_LEVEL Payables CCID Level REVCLS (Revenue Class)
PLANELEM (Plan Element)
CUSTOM (Custom)
CLASSIFICATION (Classification)

PAYGROUP_UPGRADE_TYPE Paygroup Upgrade Type UPGRADE_PAYGROUP (Upgrade Pay
group)

PAYMENT_CHANGE Payment Change BONUS (Bonus Change)
COMMISSION (Commission Change)

PAYMENT_GROUP_CODE Payment Group Code STANDARD (Standard)

PAYMENT_INCENTIVE_TYPE Payment Incentive Type ALL (All)
BONUS (Bonus)

COMMISSION (Commission)

PAYMENT PLAN_TYPE

Payment Plan Type

MIN/MAX (Minimum/Maximum Plan)

PAYRUN_ACTION

Payrun Action

CREATE (Create Payrun)
FREEZE (Freeze Payrun)

PAY (Pay Payrun)

REFRESH (Refresh Payrun)
REMOVE (Remove Payrun)
UNFREEZE (Unfreeze Payrun)

PAYRUN_STATUS

Payrun Status

PAID (Paid)

PAID_WITH_RETURNED_FUNDS (Paid
with Returned Funds)

POSTED (Posted)
RETURNED_FUNDS (Returned Funds)
UNPAID (Unpaid)

FROZEN (Frozen)

ALL (All)

PAY_GROUP_DTLS_TYPE_
CODE

Pay Group Details Type
Code

PERIODS (Period)
SALESPEOPLE (Resource Assignment)
ROLES (Role Assignment)
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OIC Lookup Type

Description

Lookup Code and Meaning

PAY_GROUP_VALIDATION_
TYPE

Pay Group Validation

END_DATE (Pay Group End Date)
PAY_GROUP_NAME (Pay Group Name)
PERIOD_SET_NAME (Calendar)
PERIOD_TYPE (Period Type)
START_DATE (Pay Group Start Date)

PAY_RUN_VALIDATION_TYPE

Payrun Validation

CREDIT_TYPE (Credit Type)

EMPLOYEE_NUMBER (Employee
Number)

EMPLOYEE_TYPE (Employee Type)
PAY_DATE (Pay Date)
PAY_GROUP_NAME (Pay Group Name)
PAY_PERIOD (Pay Period)
PAY_RUN_NAME (Payrun Name)
ROLE (Role)

SALES_PERSON (Salesperson)

PAY_STATUS

Pay Status

PAID (Paid)
UNPAID (Unpaid)

PA_OBJECT_TYPE

Compensation Plan
Assignment Objects

EMP_NUM (Employee Number)

PERIOD_PROCESSING_STATUS

Period Processing Status

CALCULATED (Calculated)
CLASSIFIED (Classified)
CLEAN (Clean)

POPULATED (Populated)
PROCESSING (In Progress)
ROLLED_UP (Rolled Up)
UNCLASSIFIED (Unclassified)

PERIOD_TARGET_DIST_RULE Period Target Distribution EQUAL (Equal)
Rule USER_DEFINED (User Defined)
PERIOD_TYPE_CODE Period Type PERIOD (Period)
QUARTER (Quarter)
YEAR (Year)
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OIC Lookup Type

Description

Lookup Code and Meaning

PE_OBJECT_TYPE

Plan Element Objects

CALC_FORMULA_ID (Formula ID)

CALC_FORMULA_NAME (Formula
Name)

CREDIT_TYPE (Credit Type)
CUM_FLAG (Accumulate Flag)
DESC (Description)

DISC_OPTION (Discount Option)
DISC_RATE_TB (Discount Rate Table)

DISC_RATE_TB_ID (Discount Rate Table
D)

DRAW_AMOUT (Draw Amount)
END_DATE(End Date)

END_PERIOD (End Period)
END_PERIOD_ID (End Period ID)
INCENTIVE_TYPE_CODE (Incentive
Type)

INTERVAL NAME (Interval Name)
ITD_FLAG (Interval to Date)
PACKAGE_NAME (Package Name)
PAYMENT_AMOUT (Payment Amount)
PAYMENT_FACTOR (Payment Uplift)
PAYMENT_TYPE (Payment Type)
PERIOD_TYPE (Interval Type)
PE_NAME (Plan Element Name)
QUOTA_FACTOR (Quota Uplift)
QUOTQ_TYPE (Element Type)
RATE_TB (Rate Table)

RATE_TB_ID (Rate Table ID)
REV_CLS_ID (Revenue Class ID)
REV_CLS_NAME (Revenue Class Name))
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OIC Lookup Type

Description

Lookup Code and Meaning

PE_OBJECT_TYPE (continued)

REV_CLS_TARGET (Revenue Class Target
SPLIT_FLAG (Split Flag)

START_DATE (Start Date)
START_PERIOD (Start Period)
START_PERIOD_ID (Start Period ID)
TARGET (Quota)

TRX_GROUP (Apply Trx)
UPLIFT_END_DATE (Uplift End Date)

UPLIFT_PAYMENT_FACTOR (Uplift
Payment Factor)

UPLIFT_QUOTA_FACTOR (Uplift Quota
Factor)

UPLIFT_START_DATE (Uplift Start Date)

PLAN_GENERATE_STATUS

Plan Generation Status

FAILED (Failed)
NOT_PUSHED (Not Activated)
PUSHED (Activated)

PLAN_OBJECT_STATUS

Compensation Plan Object
Status

COMPLETE (Complete)
INCOMPLETE (Incomplete)

PLAN_STATE

Plan State

ACTIVE (Active)
INACTIVE (Inactive)
IN_PROGRESS (In Progress)

PLAN_TYPE_STATUS

Plan Type Status

ACCEPTED (Accepted)
APPROVED (Approved)
GENERATED (Generated)
ISSUED (Distributed)
LOCKED (Locked)
PENDING (Pending)
REJECTED (Rejected)
SUBMITTED (Submitted)
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OIC Lookup Type

Description

Lookup Code and Meaning

PLAN_TYPE_SUMMARY_
STATUS

Plan Type Summary Status

PLGS (Pending Approval)
APPROVED (Pending Distribution)
ISSUED (Pending Acceptance)
ACCEPTED (Accepted)

PMT_PLAN_VALIDATION_
TYPE

Payment Plan Validation
Type

CREDIT_TYPE (Credit Type)

PMT_PLAN_NAME (Payment Plan
Name)

START_DATE (Start Date)

POSTING_TYPE

Posting Type

EXPENSE (Expense)
NON_REC (Non Recoverable)
REC (Recoverable)

TO_REC (To Recover)

PRE_PROCESSED_CODE

Preprocessed Code

CRPN (Skip Calculation)

CRPC (Skip Nothing)

CRNC (Skip Population)

CRNN (Skip Population and Calculation)
CNPC (Skip Rollup)

CNPN (Skip Rollup and Calculation)
CNNC (Skip Rollup and Population)
CNNN (Classification Only)

NRPC (Skip Classification)

NRPN (Skip Classification and Calculation

NRNC (Skip Classification and
Population)

NRNN (Rollup Only)

NNPC (Skip Classification and Rollup)
NNPN (Population Only)

NNNC (Calculation Only)

NNNN (Skip All)
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OIC Lookup Type

Description

Lookup Code and Meaning

PROCEDURE_TYPE

Procedure Types

F (Function)

P (Procedure)

PRIVATE (Private Procedure)
PUBLIC (Public Procedure)

PROCESSING_STATUS_CODE

Processing Status

CLEAN (No calculation has ever
happened in this period)

PROCESS_TYPE

Process Types

GEN (Generate)
INS (Instantiate)
XFR (Transfer)

QUOTA_CATEGORY

Quota Category Type

FIXED (Fixed)
TOTAL_QUOTA (Total Quota)

VAR_NON_QUOTA (Variable, Non
Quota Based)

VAR_NON_REVENUE (Variable, Non
Revenue Based)

VAR_QUOTA (Variable, Quota Based)

QUOTA_GROUP_CODE

Quota Group Code

BONUS (Bonus)
QUOTA (Quota)

QUOTA_PAYMENT_TYPE

Quota Payment Type

FIXED (Fixed Amount)
PAYMENT (Payment Amount Percentage)

TRANSACTION (Applied Transaction
Amount Percentage)

QUOTA_TRX_GROUP

Quota Transaction Group

GROUP (Grouped by Interval)
INDIVIDUAL (Individually)
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OIC Lookup Type

Description

Lookup Code and Meaning

QUOTA_TYPE

Quota Type

DISCOUNT (Discount)

DRAW (Draw)

EXTERNAL (External)
FORMULA (Formula)
MANUAL (Manual)

MARGIN (Margin)

NONE (None)

REVENUE (Revenue Non Quota)
TARGET (Revenue Quota)

UNIT_BASED_NON_QUOTA (Unit Non
Quota)

UNIT_BASED_QUOTA (Unit Quota)

RATE_CALC_METHOD

Rate Calculation Method

ANCHORS (Anchors)
SINGLE_RATE (Single Rate)

REPORT_SECURITY_LEVEL

Report Security Level

A (Analyst)
M (Manager)
R (Salesrep)

S (Super User)

REPOSITORY_STATUS

Repository Status

A (Active)

I (Inactive)

REPOSITORY_USAGE

Repository Usages

A (All)
P (Collector)
S (Calculator)

RESOURCE_PLAN_ACTIVATE_
STATUS

Resource Plan Activation
Status

FAILED (Failed)
NOT_PUSHED (Not Activated)
PUSHED (Activated)
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OIC Lookup Type

Description

Lookup Code and Meaning

RESPONSIBILITY_GROUPS

Salesforce Planning
Responsibility Groups

CN_SF_CONTRACT_APPROVER
(Contract Manager)

CN_SF_FINANCE_MGR (Finance
Manager)

CN_SF_SALES_MGR (Sales Manager)
CN_SF_SUPER_USER (Super User)
CN_SF_SALESREP (Sales Force User)

RETURN_STATUS

API Return Status

E (Error)

S (Success)

U (Unexpected Error)
W (Warning)

REVENUE_TYPE

Transaction Credit Type

NONREVENUE (Nonrevenue)
REVENUE (Revenue)

RS_OBJECT_TYPE

Rate Table Objects

COMM_AMT (Commission Amount)

COMM_UNIT_CODE (Commission Unit
Code)

MAX_AMT (To Tier Maximum Amount)
MIN_AMT (From Tier Minimum Amount)
RATE_TB_NAME (Rate Table Name)
TIER_UNIT_CODE (Tier Unit Code)

RULE_CREATE_TYPE

Rule Create Type for Root,
Sibling, Child

CHILD (Child)
ROOT (Root)
SIB (Sibling)

Lookups B-29



Lookups

OIC Lookup Type

Description

Lookup Code and Meaning

RULESET_TYPE

Ruleset Type

DATA_FLAG (Date Flag)
END_DATE (End Date)
EXPRESSION (Expressions)
MODULE_TYPE (Module Type)
OBJECT_NAME (Object Name)

PARENT_RULE_ID (Parent Rule
Identifier)

RULES (Rules)
RULE_ATTRIBUTES (Attributes)
RULESET_ID (Ruleset Identifier)
RULESET_NAME (Ruleset Name)

RULE_ATTRIBUTE _ID (Rule Attribute
Identifier)

RULE_ID (Rule Identifier)
RULE_NAME (Rule Name)

SEQUENCE_NUMBER (Sequence
Number)

START_DATE (Start Date)

SALESREP_OPTION

Salesrep Option

ALL_REPS (All Resources)

REPS_IN_NOTIFY_LOG (Resources in
Notify Log)

USER_SPECIFY (Resources specified by
you)

SALESREP_STATUS Salesrep Status A (Active)
I (Inactive)
SCALING_FACTOR OSC: Scaling Factor 0 (No Scaling)
1 (in tens)
2 (in hundreds)

3 (in thousands)
4 (in tens of thousands)
5 (in hundreds of thousands

6 (in millions)
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OIC Lookup Type

Description

Lookup Code and Meaning

SCENARIO_STATUS

Scenario Status

SET (Set)
NOT_SET (Not Set)

SF_FORMULA_TEXT

SF Formula Text

EXPR_RTRS_DESC (SF Planning Rate
Result)

EXPR_RTRS_NAME (SFP Rate_Rslt)

EXPR_RTRSXTXN_AMT-DESC (SF
Planning Rate Result times Transaction
Amount)

EXPR_RTRSXTXN_AMT-NAME (SFP
Rate_Rslt*Trx_amount)

EXPR-TRX_AMT-DESC (SF Planning
Transaction Amount)

EXPR-TRX_AMT-NAME (SFP Trx_
amount)

EXPR-TRX_AMT/QTA-DESC (SF
Planning Transaction Amount divided by
Quota)

EXPR-TRX_AMT/QTA-NAME (SFP Trx_
amount/quota)

FORMU-RQAP-DESC (SF Planning
Revenue Quota Applied Amount
Percentage)

FORMU-RQAP-NAME (SFP RQAP
Formula

FORMU-RQFA-DESC (SF Planning
Revenue Quota Fixed Amount)

FORMU-RQFA-NAME (SFP RQFA
Formula)

FORMU-UQFA-DESC (SF Unit Quota
Fixed Amount)

FORMU-UQFA-NAME (SFP UQFA
Formula)

RT_TBL_RESULT (Rate Table Result)
TARGET (Target)
TRN_AMOUNT (Transaction Amount)
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OIC Lookup Type

Description

Lookup Code and Meaning

SF_FORMULA_TYPE

SF Formula Type

RQAP (Revenue Based Quota Applied
Amount Percentage)

RQFA (Revenue Based Quota Fixed
Amount)

UQFA (Unit Based Quota Fixed Amount)

SPLIT_FLAG

Split Flag

N (No Split)
P (Proportional)
Y (Non-Proportional)

SRP_OBJECT_TYPE

Salesrep Object Type

ALL_ROLE (All Sales Roles)
EMP_NUM (Employee Number)
END_DATE (End Date)
PAY_GRP (Pay Group Name)
PMT_PLN (Payment Plan Name)
ROLE (Sales Role Name)
SRP_NAME (Salesperson Name)
SRP_TYPE (Salesperson Type)
START_DATE (Start Date)

SRP_PAYEE_OBJECTS

SRP Payee Assigns Objects

COMP_NAME (Compensation Name)

EMPLOYEE_NUMBER (Employee
Number)

END_DATE (Payee End Date)
PAYEE_NAME (Payee Name)
PAYEE_START_DATE (Payee Start Date)
PE_NAME (Plan Element Name)
ROLE_NAME (Role Name)
SALESREP_NAME (Resource Name)
START_DATE (@Payee Start Date)
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OIC Lookup Type

Description

Lookup Code and Meaning

TABLE_LEVEL

Table Levels

D (Dimension)

H (Header Level)
I (Internal)

L (Line +)

N (None)

S (Sales Line)

TABLE_TYPE

Table Types

T (Table)
V (View)

TABLE_USAGE

Table Usage

C (Collection)
N (None)
Y (Calculation)

TBL_COL_DETAIL

Table Column Detail

COL (Columns)

TIMESCALE

Timescale

PERIOD (Period)
QUARTER (Quarter)
YEAR (Year)

TIME_INTERVAL_TYPE

Time Interval Type

PTD (Period to Date)
QTD (Quarter to Date)
YTD (Year to Date)

TOP_BOTTOM_PERF

Top Bottom Performer

BOTTOM (Bottom)
TOP (Top)

TRIGGERING_EVENT

Triggering Event

D (Delete)
I (Insert)
U (Update)
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OIC Lookup Type

Description

Lookup Code and Meaning

TRX_TYPES

Transaction Types

BALANCE_UPGRADE (Balance Upgrade)
CBK (Clawback)

CM (Credit Memo)

DEP (Deposit)

DM (Debit Memo)

GBK (Giveback)

INV (Invoice)

MAN (Manual Transaction)

ORD (Order)

PMT (Payment)

PMTPLN (Payment Plan)
PMTPLN_REC (Payment Plan Recovery)
RET (Order Return)

UPGRADE (Upgrade)

WO (Writeoff)

TRX_ROLLUP_METHOD

Transaction Rollup Method

INV (Invoice Processing Date)
ORD (Order Processing Date)

TRX_STATUS

Commission Line Status

CALC (Calculated)

CLS (Classified)

COL (Unprocessed)
NCALC (No Calculation)
OBSOLETE (Obsoleted)
PAYEE (Payeed)

POP (Populated)

ROLL (Rolled Up)

XCALC (Failed Calculation)
XCLS (Failed Classification)
XPAYEE (Failed Payee)
XPOP (Failed Population)
XROLL (Failed Rollup)
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OIC Lookup Type

Description

Lookup Code and Meaning

UNIT_OF_MEASURE

Measurement unit

AMOUNT (Amount)
EXPRESSION (Expression)
PERCENT (Percent)
STRING (String)

UNIT_TYPE

Unit Type

UNIT (Unit)
REVENUE (Revenue)

VIEW_PROCESS_LOG_TYPE

View Process Log Type

ALL (All)

BRIEF (Brief)

MILESTONE (Milestone Only)
ERROR (Errors Only)

DEBUG (Debugs Only)

WORKSHEET_ACTION

Worksheet Action

APPROVE (Approve Worksheet)
CREATE (Create Worksheet)
LOCK (Lock Worksheet)
REFRESH (Refresh Worksheet)
REJECT (Reject Worksheet)
REMOVE (Remove Worksheet)
SUBMIT (Submit Worksheet)
UNLOCK (Unlock Worksheet)

WORKSHEET_STATUS

Payment Worksheet Status

APPROVED (Approved)
LOCKED (Locked)
SUBMITTED (Submitted)
UNPAID (Unpaid)

YES_NO

Yes or No

N (No)
Y (Yes)

YTD_GRAPH_TYPE

YTD Graph Type

A (All)

C (Achievement)
E (Earnings)

N (None)

P (Payment)
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System Profile Options

C.1 System Profile Options

The table below lists the profile options which need to be set to implement Oracle
Incentive Compensation after the product has been installed, but before the system
is ready to be used to build compensation plans, collect and process transactions,
and pay incentive compensation. The options can be set in any sequence.

To set system profile options:

1.

Log in to the Forms version of Oracle Incentive Compensation and choose the
System Administrator responsibility.

Double-click Profiles.
Double-click System.

In the Find System Profiles window, check the check box next to one of the
following, and then enter values or select from the List of Values:

Site: Select if the profile option applies to all users at your site.
Application: Oracle Sales Compensation

Responsibility: Select only if the profile option you are defining is specific to a
responsibility.

User: Select only if the profile option you are defining is specific to a user.

Profile: Enter OSC% to see all Incentive Compensation profiles, or enter another
more specific search parameter. You can use the percent sign (%) as a wildcard.

Click Find.
View or change the profile setting.

Save.
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Note: After you change the setting of a profile option, you must bounce the
server to reset it.

The following table contains information about Profile Options in Oracle Incentive
Compensation, along with a description of each.

Guidelines

The OSC: Multi Rollup Path profile option is used to set up managerial rollups for a
resource who is assigned the same role in multiple groups or multiple roles in the
same group. If a resource is assigned a role in multiple groups, it must be the same
role. This release of Oracle Incentive Compensation does not support rollup along
multiple paths when the managers receiving the credit have different roles in the
compensation groups along the rollup paths. This is because the application picks
the role at random.

In the table, the last four columns indicate the level where the profile option can be
applied.

Name/Default Description Site Application | Responsibility | User
OSC: Collect on The application collects only | Yes Yes Yes Yes
Account Credits invoices and regular credit
memos. If set to Yes, then the
Sﬁ_i(éTaT}ECT_ application will collect
CREDITS invoices, regular credit
memos, and on account credit
Default: No memos when running Oracle
Receivable Collection.
OSC: Commission | Determines the commission Yes Yes Yes Yes
Rate Precision precision in a rate table. For
CN COMM example, 1.035 has a precision
RATE_ of 3.
PRECISION
Default: Null
OSC:Complete Determines whether to run Yes Yes Yes Yes
Calculation complete calculation or not.
CN_COMPLETE_
CALCULATION
Default: Yes
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Name/Default Description Site Application | Responsibility | User
OSC: Currency Enter date for reading the Yes No No No
Exchange Rate exchange rate in Oracle GL.
Date
CN_SP_GL_
RATE_DATE
Default: System
date
OSC: Customized | This profile tells the Yes Yes Yes Yes
Summarization application whether you are
using default or customized
gga%U%l;gM— summarization code to
- aggregate transactions during
Default Null rollup. This profile option
works only if the Roll
Summarized Transactions
profile is set to Yes.
OSC: Debug Mode | Determines whether Yes Yes Yes Yes
CN DEBUG debugging messages are
- written to the process log
Default: Yes during execution of
programs, whether
concurrent or online. Setting
Debug Mode to Yes writes
these errors to an internal
audit table.
OSC: Default Select the type of currency Yes Yes Yes No
Conversion Type | conversion. For example,
CN corporate (usually budget
~ translation rate from Oracle
gg%VERSION— GL), spot (daily rate from
Oracle General Ledger), user
Default: Null (user-defined rate as entered
through form called Period
Rates). (Toolbar > Financial >
Currency Rates)
OSC: Default When set to Yes, the Yes Yes Yes Yes
Custom Flag compensation plans are
customized. Otherwise, they
%]151 A—gUSTOM— are not customized.
Default: Yes
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Name/Default Description Site Application | Responsibility | User
Display Draw In OSO, the draw related No Yes Yes No
Related Data in information is displayed on
YTD Report the YTD report when this

profile is set to Y. Otherwise,
CN_DISPLAY_ the draw related data is not
DRAW .

displayed.
Default: Null
Enable Enable Commission Yes Yes Yes Yes
Commission Statement drilldown.
Statement
Drilldowns
CN_ENABLE_
COMM_STMT_
DRILLDOWN
Default: Null
OSC: Enable Set whether to execute a
Hierarchy Edges portion of cn_hierarchy_
T4 Trigger edges_t4 trigger or not.
CN_
HIERARCHY_
EDGES_T4_
ENABLE
Default: Null
OSC: Import The absolute path where the Yes Yes Yes Yes
Server Side Data .csv files for server side
File Directory transaction import are
CN_IMP_ located.
SERVER_PATH
Default: Null
OSC: Import This is the directory where the | Yes Yes Yes Yes
Control File SQL Loader control file is
Directory stored. This profile should be
CN_IMP_ set to absolute path for $CN_

CONTROL_PATH
Default: Null

TOP /bin.
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Name/Default Description Site Application | Responsibility | User
OSC: Income Determines whether you use | Yes Yes Yes Yes
Planner the customized disclaimer in
Disclaimer the Pncome Planner.
CN_CUST_
DISCLAIMER
Default: No
OSC: Invoice Split | The end date for the invoice Yes Yes Yes Yes
Upgrade End Date | split upgrade process.
CN_INVOICE_
SPLIT_UPG_
END_DATE
Default: Null
OSC: Invoice Split | The start date for the invoice Yes Yes Yes Yes
Upgrade Start split upgrade process.
Date
CN_INVOICE_
SPLIT_UPG_
START_DATE
Default: Null
OSC: Log File If set to Yes, debugging Yes Yes Yes Yes
messages are written to a log
CN_LOG_FILE file. Only enable this profile
Default: No option for debugging
purposes if there are
suspected problems with the
application. If enabled, this
profile option generates log
files, which can affect
performance.
OSC: Log File Sets the directory where the Yes Yes Yes Yes

Directory

CN_LOG_FILE_
DIR

Default: Null

log file will be stored. When
you enter the directory path,
you do not need to enter a
slash after the name.
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Name/Default Description Site Application | Responsibility | User
OSC: LOV Input LOV input validation Yes Yes Yes No
Validation
CN_LOV_INPUT_
LEN_PROFILE
Default: Yes
OSC: Mark Rules | Determines whether to mark | Yes Yes Yes Yes
Change event of classification rules
CN_MARK_CLS._ change or not.
RULES_CHANGE
Default: Yes
OSC: Mark Events | If you select Yes, every event, | Yes Yes Yes Yes
such as a transaction, is put
ggﬁ%%RK_ into the Notify Log so that it
can be included in the next
Default: Yes calculation. Set it to No while
setting up your system, but
change to Yes when you are
ready to start collecting
transactions.
OSC: Multi Rollup | Enables rollup of sales credits | Yes Yes Yes Yes
Path through multiple paths of the
compensation group
Egiidli’I:EATH hierqrchy. See Gu'z'deline's for
restrictions on using this
Default: Null profile.
OSC: Negate Determines whether to negate | Yes Yes Yes Yes
during Revenue during Revenue Adjustments
Adjustments Collection.
Collection
CN_RAM_
NEGATE
Pay by Determines if application Yes No No No
Transaction pays by transaction or not.
CN_PAY_BY_
TRANSACTION

Default: Null
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Name/Default Description Site Application | Responsibility | User
OSC: Prior Allows prior adjustments. If | Yes Yes Yes Yes
Adjustment set to No, allows all plan
o roR | dementinaperod o e
ADJUSTMENT Before setting to No, be sure
Default: Yes that any transactions that
have a process date earlier
than the latest process date
shown in the System
Parameter window have been
calculated.
OSC: Report Report Security Level Yes No Yes Yes
Security Level
CN_REPORT _
SECURITY_
LEVEL
Default: Salesrep
OSC: Reset Error | Reset Error Transactions Yes Yes Yes Yes
Transactions
CN_RESET_
ERROR_TRX
Default: No
OSC: Roll This profile option sets up the | Yes Yes Yes Yes
Summarized application to aggregate
Transactions matching transactions.
CN_ROLL_SUM_
TRX
Default: Null
OSC: Sleep Time Sets the amount of wait time | Yes Yes Yes Yes
in Seconds in between each phase of
CN SLEEP TIME calculation. The wait time
- - gives each phase time to
Default: 30 complete the current process
seconds without being queried by the
system for a status. For high
volume transactions, use the
default setting.
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Name/Default Description Site Application | Responsibility | User
OSC: Salesforce Determines whether input Yes No No No
Planning Debug variables show on the
Mode window
CN_SP_DEBUG
Default: No
OSC: Salesforce This optional setting is used Yes No No No
Planning FY to set the fiscal year for which
CN SP you are currently planning.
PLANNING FY You can set a valid year, for
- example, 2002, or leave the

Default: Null profile unset. If the profile is

set to a valid year, the date on

search screens defaults to the

start of the fiscal year if the

current date is smaller than

the date of the start of the

fiscal year.
OSC: Scaling Select scaling factor. For Yes Yes Yes Yes
Factor example, in thousands will

display 1,000,000 as 1,000 and
CN_SCALING there will be a note at the top
Default: No of the table, "USD in
Scaling thousands".
OSC: SQL Spool Spool path for SQL scripts Yes Yes Yes Yes
Path
CN_SQL_SPOOL_
PATH
Default:
/d07/app/applesf
/hm000a/out
OSC: Workflow Enter number of hours before | Yes Yes Yes Yes
Initial Wait Time the first reminder is issued.
in Hours
CN_WEF_INIT_
WAIT_TIME

Default: Null
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Name/Default Description Site Application | Responsibility | User
OSC: Workflow Enter number of hours Yes Yes Yes Yes
Reminder interval between each
Frequency in subsequent reminder.
Hours
CN_WEF_
REMINDER _
TIME
Default: Null
OSC: SFP Profile that is to be set up for | No No Yes No
Responsibility each responsibility created for
Group use in Salesforce Planning.
CN SEP RESP The four permissible values
GROUP - are Super User, Contract
Approver, Finance Manager,
Default: Null and Sales Manager. The
profile setting identifies the
data access privileges that are
assigned to a particular
responsibility.
OSC: Tracking When this profile is set to 'Y’, | Yes Yes Yes Yes
Invoice Lines any splits or moves done to
CN TRACK Invoices are updated to the
INVOICE credit memos and payments,
unless the transactions are
Default: No delinked.
OSC: Use Work This profile enables use of the | Yes No Yes No
Day Calendar Workday Calendar in
proration calculation. (Default
‘SZVI}T{_I?SI;_\(USE_ is No). Only when this profile
is set to Yes is the Workday
Default: Null calendar that is defined for
the organization used in
proration calculation.
OSC:User’s User’s employee number No No No Yes
Employee
Number
CN_USER_EMP_
NUM

Default: Null
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fiscal years.

Name/Default Description Site Application | Responsibility | User
OSC: User’s Type | User’s Type Yes Yes Yes Yes
CN_USER_TYPE
Default: Null
OSC: SFP Disable | Profile to disable Workflow Yes No Yes No
Workflow Notifications being sent in
Notifications Incentive Planning. If set to
CN SEP Yes, no notification will be
DISABLE WF sent to appropriate authority
- in the case of compensation
Default: No plan submission, approval or
distribution.
OSO: Minimum Used in Incentive Yes No No No
Search String Compensation to set the
Length minimum number of
. characters required for any
Default: 4 search from a text field.
OSO: Search Lead | Indicates if % can be the first | Yes Yes Yes Yes
Wildcard character in a search sent to a
Default: No list of values
Bypass Group Set to Y to bypass group Yes Yes Yes No
Validation usages when defining a
ASF BYPASS resource and assigning that
GROUP - resource to a resource group.
VALIDATION
Default: No
Reset Balances If the profile is set to Yes, then | Yes No No No
Each Year the salesrep subledger
balances (cn_srp_periods) get
g&lﬁiisggs— reset to zero at the beginning
= of each fiscal year during
EACH_YEAR calculation. Otherwise the
Default: No balances carry over across
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Name/Default Description Site Application | Responsibility | User
AMS: Item This is required if you want to | Yes Yes Yes Yes
Validation Master | display the Product tab in
Organization Oracle Incentive
Compensation. The value is

AMS_ITEM .

" - selected by using an LOV
OI%GANIZATION (master organization for

Default: Blank

which items are defined).
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D.1 Moving from Forms to HTML Navigation

Road Map

Oracle Incentive Compensation switched from Forms to an HTML user interface
beginning with the 11.5.6 release. If you have upgraded from a release prior to
11.5.6, the following road map is provided to help you navigate in the newest
release to perform the tasks you did in the previous Forms instance. The final Forms
navigation and newest HTML navigation are shown.

Forms is still used for any procedures performed in Resource Manager.

The following tables contain five columns. The first two list the Navigation and
Screen Name in the 11.5.5 release. The third column details the changes made in the
11.5.6 through 11.5.9 releases. Columns four and five list the Navigation and Screen

Name in 11.5.9.
D.1.1 Financial
11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name
Menu bar - Financial > Set of Books No change. Still done  N/A N/A
Set of Books in GL.
Menu bar > /Financial > Accounting No change. Still done  N/A N/A
Calendar Calendar in GL.
Menu bar > Financial >  Period Types  No change. Stilldone  N/A N/A

Period Types

in GL.
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11.55

11.5.9

Navigation

Screen Name

Changes

Navigation

Screen Name

Menu bar > Financial >
Open Close Periods

Open and
Close Periods

New navigation flow.

Administration >
Compensation >
Financial > Open and
Close Periods

Open and
Close Periods

Menu bar > Financial >  Currencies No change Still donein N/A N/A
Define Currencies GL.
Menu bar > Financial >  Period Rates ~ No change. Stilldone ~ N/A N/A
Define Currency Rates in GL.
Menu bar > Financial >  Interval Type = New navigation flow. ~ Administration > Interval Types
Interval Types Incentive > Interval
Types
Menu bar > Financial >  Accumulation New navigation flow.  Administration > Accumulation
Accumulation Periods Periods Incentive > Periods
Accumulation Periods
Menu bar > Financial >  Pay Periods New navigation flow. ~ Administration > Pay Periods
Pay Periods Incentive > Pay Periods
Menu bar > Financial >  Credit Types =~ New navigation flow. ~ Administration > Credit Types
Credit Types Incentive > Credit Types
Menu bar > Financial >  Credit Type New navigation flow. ~ Administration > Conversion
Credit Type Conversion = Conversion Incentive > Credit Factor
Factor Conversion
D.1.2 System
11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name

Menu bar > System >
System Parameters

Menu bar > System >
System Profiles

System
Parameters

Find System
Profile Values

New navigation flow.

New HTML page fields

related to integration

with Oracle Payroll and

Oracle Accounts
Payable.

No change
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11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name
Menu bar > System > System Profile No change. N/A N/A
System Profiles Values
Menu bar > System > Security No change. N/A N/A
Security Profiles Profile
Menu bar > System > Oracle Sales No change. N/A N/A
Lookups Compensation
Lookups
Menu bar > System > Tables (with New navigation flow. ~ Administration > Tables
Tables and Columns Columns tab)  Columns tab moved to Incentive > Tables
separate HTML page
called Columns.
Menu bar > System > Tables (with New navigation flow. ~ Administration > Columns
Tables and Columns Columns tab)  Columns tab moved to Incentive > Tables >
Columns HTML page. Columns hyperlink >
Columns in View
drop-down
Menu bar > System > Tables (with New navigation flow. ~ Administration > Columns
Tables and Columns Dimensions Dimensions tab moved Incentive > Tables >
tab) to Columns HTML Columns hyperlink >
page. Dimensions in View
drop-down
Menu bar > System > Tables (with New navigation flow. ~ Administration > Columns
Tables and Columns Classification  Classification tab Incentive > Tables >
tab> moved to Columns Columns hyperlink >
HTML page. Classification in View
drop-down
Menu bar > System > Tables (with New navigation flow. ~ Administration > Columns
Tables and Columns Primary Key = Primary Key tab Incentive > Tables >
tab) moved to Columns Columns hyperlink >
HTML page. Primary Key in View
drop-down
Menu bar > System > Collection and No change. N/A N/A
Collections Mapping
(Collection
tab)
Menu bar > System > Collection and No change. N/A N/A
Collections Mapping
(Mapping tab)
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Moving from Forms to HTML Navigation

11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name
Menu bar > System > Collections No change. N/A N/A
Collections
Menu Bar > System > External Table New navigation flow.  Administration > External Tables
External Tables Detailed list of external Incentive > External - Join
tables is on summary Tables Conditions
page called External
Tables - Join
Conditions.
Menu bar > System > Descriptive No change. N/A N/A
Flexfields Flexfield
Segments
Menu bar > System > Segments No change. N/A N/A
Flexfields Summary New
Menu bar > System > Collections New navigation flow. ~ Administration > Collection -
Collection Parameters Runtime Collection > Queries > Queries
Parameters Parameter area

D.1.3 Tasks

11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name
Menu bar > Tasks > Selection Combined with N/A N/A
Import Resources Criterion Advanced Search

HTML page.
Menu bar > Tasks > Find Resources New navigation flow.  Quick Find > Resource > Advanced
Define Resources Page is in HTML style. Advanced Search Search
Menu bar > Tasks > Resource New navigation flow. = Resource > Resources >  Resources
Define Resources > Find  Search Results Page is in HTML style. Resource Advanced
button HTML page shows Search > Enter name

only employees; Search

for nonemployees is

through existing form.
Menu bar > Tasks > Resource No change, still in N/A N/A
Define Resources > Find  (Roles tab) Forms.

button > Resource
Details button
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Moving from Forms to HTML Navigation

11.5.5 11.5.9

Navigation Screen Name Changes Navigation Screen Name
Menu bar > Tasks > Resource No change, still in N/A N/A
Define Resources > Find  (Groups tab) Forms.

button > Resource

Details button

Menu bar > Tasks > Resource No change, still in N/A N/A
Define Resources > Find  (Teams tab) Forms.

button > Resource

Details button

Menu bar > Tasks > Resource No change, still in N/A N/A
Define Resources > Find  (Service tab) Forms.

button > Resource

Details button

Menu bar > Tasks > Resource No change, still in N/A N/A
Define Resources > Find  (Interaction Forms.

button > Resource tab)

Details button

Menu bar > Tasks > Resource No change, still in N/A N/A
Define Resources > Find (Compensatio Forms.

button > Resource n tab)

Details button

Menu bar > Tasks > Resource No change, still in N/A N/A
Define Resources > Find  (Receivables Forms.

button > Resource tab)

Details button

Menu bar > Tasks > Resource No change, still in N/A N/A
Define Resources > Find  (Miscellaneous Forms.

button > Resource tab)

Details button

Menu bar > Tasks > Roles No change, still in N/A N/A
Define Roles Forms.

Menu bar > Tasks > Define Groups No change, still in N/A N/A
Define Groups (Members tab) Forms.

Menu bar > Tasks > Define Groups No change, still in N/A N/A
Define Groups (Roles tab) Forms.

Menu bar > Tasks > Define Groups No change, still in N/A N/A
Define Groups (Usages tab) ~ Forms.
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Moving from Forms to HTML Navigation

11.5.5

11.5.9

Navigation

Screen Name

Changes

Navigation

Screen Name

Menu bar > Tasks >
Define Groups

Menu bar > Tasks >
Define Groups

Menu bar > Tasks >
Define Teams

Tasks > Adjustments

Tasks > Adjustments

Tasks > Adjustments >
New button or Adjust
Transaction button

Tasks > Adjustments >
New button or Adjust
Transaction button

Tasks > Adjustments >
New button or Adjust
Transaction button

Tasks > Adjustments >
New button or Adjust
Transaction button

Tasks > Adjustments >
Adjust Transaction
button > Move Credits
button

Define Groups

(Parent
Groups tab)

Define Groups

(Child Groups
tab)

Define Teams

Maintain
Transactions
(Basic tab)

Maintain
Transactions
(Advanced
tab)

Adjust
Transactions
(Commission
Lines tab)

Adjust

Transactions
(Transaction
History tab)

Adjust
Transactions
(Customer
Address tab)

Adjust
Transactions
(User Notes
tab)

Maintain
Transactions >
Move Credits

New navigation flow.
Page is in HTML style.

New navigation flow.
Page is in HTML style.

No change, still in
Forms.

New navigation flow.
Renamed field labels

New navigation flow.
Renamed field labels.
Column display and
sort selection.

New navigation flow.
New action buttons.
New UL

New navigation flow.
New action buttons.
New UL

New navigation flow.
New action buttons.
New UL

New navigation flow.
New action buttons.
New UL

New navigation flow.
New action buttons.
New UL
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Resource > Resources >

Hierarchy

Resource > Resources >

Hierarchy
N/A

Transaction >
Adjustments > Search

Transaction >
Adjustments >
Personalize

Transaction >
Adjustments

Transaction >
Adjustments

Transaction >
Adjustments

Transaction >
Adjustments

Transaction >
Adjustments > Move
Credits

Group Detail -
Child and
Parent Groups

Group Detail -
Child and
Parent Groups

N/A

Transaction
Search

Transaction
Search

Transaction
Summary

Transaction
Summary

Transaction
Summary

Transaction
Summary

Transactions



Moving from Forms to HTML Navigation

11.5.5

11.5.9

Navigation

Screen Name

Changes

Navigation

Screen Name

Tasks > Adjustments >
Adjust Transaction
button > Share Credits
button

Tasks > Adjustments >
Adjust Transaction
button > Deal Split
button

Tasks > Adjustments >
Adjust Transaction
button > Deal Move
button

Tasks > Submit
Calculation

Tasks > Process Log >
Find Processes

Tasks > Concurrent
Request Set

Tasks > Process Log

Tasks > Posting Details

HTML UI > Reports

Tasks > Rate Dimensions

Maintain
Transactions >
Share Credits

Splits

Deal Move

Calculation
Submission

Process Log

Multiple
Request Set

Find

Posting Details

Reports

Rate
Dimensions

New navigation flow.
New action buttons.
New UL

New navigation flow.
New action buttons.
New UL

New navigation flow.
New action buttons.
New UL

New navigation flow.
New fields. Notify log
and find resource on
Calculations tab.

New navigation flow.
One field only.

Does not exist in
HTML.

New navigation flow.

New navigation flow.
New UL New fields.

New navigation flow.
New reports, renamed
report, no Adjustments
Report.

New navigation flow.
Add Update and
Restore buttons.

Transaction >
Adjustments

Transaction > Adjust >
Split

Transaction >
Adjustments

Transaction > Calculate >
Create

Transaction > Calculate >
Details link in Process
Log column

N/A

Transaction > Calculate >
Process Log or

Transaction > Collect >
View Log

Transaction > Payment >
Total

Transaction > Report

Incentive > Rate > Rate
Table Details > Create

Transaction
Summary

Transactions

Transaction
Summary

Calculation
Submission

Process Log

N/A

Calculation
Process Log or
Process Log

Payrun Details

Reports

Rate Table
Details -
Dimensions
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Moving from Forms to HTML Navigation

11.55

11.5.9

Navigation

Screen Name

Changes

Navigation

Screen Name

Tasks > Run Concurrent  Single Request New navigation flow.  Transaction > Calculate > Calculation
Requests > Submit a Exists in HTML Create or Submission or
New Request > Single Calculation, Loading, Transaction > Load or Load
Request and Collection tabs. Transactions -
Transaction > Collect >  View Request
Create Status or
Submit
Request
Tasks > Run Concurrent ~ Request Set New navigation flow.  Transaction > Calculate > Calculation
Requests > Submit a Exists in HTML Create or Submission or
New Request > Request Calculation, Loading, T tion > Load Load
Set and Collection tabs. ransaction = Load or Transactions
Transaction > Collect >  or Submit
Create Request
Tasks > View Requests > Find Requests New navigation flow.  All search buttons, for Transaction
Find Requests Exists in HTML pages  example Transaction > Search
under Search button. Collect > Search
Tasks > User Notify Log Not replaced in HTML. N/A N/A
Notifications
D.1.4 Salespeople
11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name
N/A N/A New navigation flow.  Resource > Group > click Group
New HTML page from Advanced Search Advanced
Resource Manager. It ~ hyperlink Search

has the ability to search
for compensation
groups based on
certain search
parameters.
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Moving from Forms to HTML Navigation

11.5.5

11.5.9

Navigation

Screen Name

Changes

Navigation

Screen Name

Sales People icon >
Navigator > View by
Compensation Groups >
select Compensation
Group name

N/A

Sales People icon >
Navigator > View by
Compensation Groups >
select Compensation
Group name > Admins
button

Sales People icon >
Navigator > View by
Compensation Groups >
select person’s name.

Sales People icon >
Navigator > View by
Compensation Groups >
select person’s name >
Sales Role tab

Sales People icon >
Navigator > View by
Compensation Groups >
select person’s name >
Sales Role tab

Compensation
Groups

N/A

Admin Details

Salespeople
Workbench
(Salesperson
tab)

Salespeople
Workbench
(Sales Role tab)

Salespeople
Workbench
(Sales Role tab)

New navigation flow.
The new HTML page
lists all compensation
groups satisfying your
search criteria. List of
Group members is
found on the Group
Detail screen

New page from
Resource Manager with
more details on the

group.

No replacement.

New navigation flow.

New navigation flow.
For the list of the
compensation groups
which the selected
person is assigned, see
Details page, Group
Membership area.

New navigation flow.
Same page as above,
but different area. For
the list of the roles
which the selected
person is assigned, see
Details page, Resource
Role area.

Resource > Group

Resource > Groups >
click Group Name
hyperlink

N/A

Resource > Resources >
Pay Groups

Resource > Resources >
Resource Advanced
Search > Enter name

Resource > Resources >
Resource Advanced
Search > Enter Name

Groups

Group Detail

N/A

Resource
Detail, Assign
Pay Groups

Details:
[resource
name]

Details:
[resource
name}
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Moving from Forms to HTML Navigation

11.5.5

11.5.9

Navigation

Screen Name

Changes

Navigation

Screen Name

Sales People icon >
Navigator > View by
Compensation Groups >
select person’s name >
Compensation Plans tab

Sales People icon >
Navigator > View by
Compensation Groups >
select person’s name >
Compensation Plans tab

Sales People icon >
Navigator > View by
Compensation Groups >
select person’s name >
Compensation Plans tab
> Compensation
Summary button

Sales People icon >
Navigator > View by
Compensation Groups >
select person’s name >
Compensation Plans tab
> Compensation
Summary button >
Compensation Summary
> View Details button

Sales People icon >
Navigator > View by
Compensation Groups >
select person’s name >
Compensation Plans tab
> Compensation
Summary button >
Compensation Summary
> View Details button >
Compensation Detail >
View Performance button

Salespeople
Workbench
(Compensatio
n Plans tab)

Salespeople
Workbench
(Compensatio
n Plans tab)

Compensation
Summary

Compensation
Detail

Performance
Summary

New navigation flow.
For the list of plan
elements of the
compensation plan,
click a compensation
plan name.

HTML page contains
list of plan elements of
the selected
compensation plan.

New navigation flow.
Enter period name,
click Apply.

No replacement.

This information can be

found in the Quota
Performance Report.
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Resources > Resources >
Compensation Plan

Resource > Resources >
Compensation Plans >
Compensation Plan
name.

Resource > Resources >

Compensation Summary

N/A

Transaction > Report >
Quota Performance

Resource
Detail,
Compensation
Plans

Resource
Detail,
Compensation
Plan

Resource
Detail,
Compensation
Summary

N/A

Quota
Performance
Report



Moving from Forms to HTML Navigation

11.5.5 11.5.9

Navigation Screen Name Changes Navigation Screen Name
Sales People icon > Sales Credit This information canbe Transaction > Report >  Transaction
Navigator > View by found in the Click Transaction Details Details Report
Compensation Groups > Transaction Details Report hyperlink >

select person’s name > Report. Resource Search >

Compensation Plans tab Resource Search Results

> Compensation > Direct Resource Name

Summary button >

Compensation Summary

> View Sales Credit

button

Sales People icon > Salespeople New navigation flow. ~ Resource > Resources >  Resource
Navigator > View by Workbench Resource Advanced Detail, Assign
Compensation Groups > (Payment Search > Resources > Payment Plans
select person’s name > Plans tab) Payment Plans

Payment Plans tab

Sales People icon > Define Sales

Navigator > View by Roles
Sales Roles > select a

Role

N/A N/A
N/A N/A
N/A N/A
N/A N/A

New navigation flow.
Page is in HTML style.
List of Roles assigned
to each compensation
plan is found on
Compensation Plan
Details, Roles page. List
of people assigned to a
specific Role is not
available on HTML

page.
New HTML page from
Resource Manager.

New HTML page from
Resource Manager.

New HTML page from
Resource Manager

New HTML page from
Resource Manager

Incentive > Plan > Sales
Roles

Resource > Resources

Resource > Resources >
Advanced Search

Resource > Resources >
Advanced Search >
Employees > Resource
Name

Resource > Resources >
Enter Name > Click
Organization hyperlink

Compensation
Plan Details,
Sales Roles

Resource
Advanced
Search

Resources

Details:
[resource
name}

Organization
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Moving from Forms to HTML Navigation

D.1.5 Compensation Plans

11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name
Compensation Plansicon Compensation New navigation flow.  Incentive > Plan Compensation
> View by Compensation Plans Details of a Plan
Plans > select a compensation plan are
compensation plan found on the

Compensation Plan

Details HTML page.
Compensation Plansicon Compensation New navigation flow.  Incentive > Plan > select ~Compensation
> View by Compensation Plans a compensation plan Plan Details
Plans > select a name
compensation plan
Compensation Plansicon Compensation New navigation flow.  Incentive > Plan >Plan  Plan Details,

> View by Compensation
Plans > select a
compensation plan

Compensation Plans icon
> View by Compensation
Plans > select a
compensation plan >
Salesperson Assign tab

Compensation Plans icon
> View by Compensation
Plans > select a
compensation plan
>Sales Roles tab

Compensation Plans icon
> View by Plan Elements
> select a plan element

Compensation Plans icon
> View by Plan Elements
> select a plan element

Compensation Plans icon
> View by Plan Elements
> select a plan element >
Distribute Variables
button

Plans (Plan
Elements tab)

Compensation
Plans
(Salesperson
Assigns tab)

Compensation
Plans (Sales
Roles tab)

Plan Element

Plan Element
(General tab)

Plan Element
Distributions

Side panel menu link
added 11.5.8.

New navigation flow.

New navigation flow.

New navigation flow.

New navigation flow.
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Elements

Incentive > Plan >
Salespeople Assigned
hyperlink

Incentive > Plan > Sales
Roles

Incentive > Element

Incentive > Element >
select a plan element
name

Incentive > Element >
Plan Element Details >
Distribute button

Plan Elements

Plan Details -
Resources
Assigned

Compensation
Plan Details,
Sales Roles

Plan Elements

Plan Element
Details

Plan Element
Details -
Distribute
Variables



Moving from Forms to HTML Navigation

11.5.5

11.5.9

Navigation

Screen Name

Changes

Navigation

Screen Name

Compensation Plans icon
> View by Plan Elements
> select a plan element

Compensation Plans icon
> View by Plan Elements
> select a plan element

Compensation Plans icon
> View by Plan Elements
> select a plan element

Compensation Plans icon
> View by Formula >
select a formula

Compensation Plans icon
> View by Formula >
select a formula >
General tab

Compensation Plans icon
> View by Formula >
select a formula > Input
tab

Compensation Plans icon
> View by Formula >
select a formula > Rate
Table tab

Compensation Plan icon
> View by Formula >
select a formula > Output
tab

Compensation Plan icon
> View by Rate Tables

Plan Element
(Revenue
Classes tab)

Plan Element
(Revenue
Classes tab)

Plan Element
(Rate Tables
tab)

Formulas

Formulas
(General tab)

Formulas
(Input tab)

Formulas (Rate
Table tab)

Formulas
(Output tab)

Rate Tables

New navigation flow.
For accelerators and
transaction factors, see
Plan Element Details,
Accelerators page.

New navigation flow.

New navigation flow.

New navigation flow.

New navigation flow.
Performance Measure
expression now located
on the Formula Details,
Expressions HTML

page.

New navigation flow.
Details of the
expression are on the
Calculation Expression
Details HTML page.

New navigation flow.

New navigation flow.
Details of the
expression are on the
Calculation Expression
Details HTML page.

New navigation flow.
See Rate Table Details
HTML pages.

Incentive > Element >
Plan Element Details >
Revenue Classes

Incentive > Element >
Plan Element Details,
Revenue Classes >
Details hyperlink in the
Details column

Incentive > Element >
Plan Element Details,
Rate Tables hyperlink

Incentive > Formula

Incentive > Formula >
click hyperlink in Name
column

Incentive > Formula >
click hyperlink in Name
column > Expression
hyperlink

Incentive > Formula >
click hyperlink in Name
column > Rate Tables

Incentive > Formulas >
click hyperlink in Name
column > Expression
hyperlink

Incentive > Rate

Plan Element
Details -
Revenue
Classes

Plan Element
Details

Rate Tables

Formulas

Formula
Details

Expressions

Rate Tables

Expressions

Rate Tables
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Moving from Forms to HTML Navigation

11.55

11.5.9

Navigation

Screen Name

Changes

Navigation

Screen Name

Compensation Plan icon
> View by Rate Tables

Compensation Plan icon
> View by Rate Tables >
select a rate table

N/A

N/A

Compensation Plan icon
> View by Calculation
Expressions

Compensation Plan icon
> View by Calculation
Expressions > select an
expression

Rate Tables

Rate Tables

N/A

N/A

Calculation
Expressions

Calculation
Expressions

New navigation flow.

New navigation flow.

New HTML page.

New HTML page.

New navigation flow.

New navigation flow.

Incentive > Rate > select
a Rate Table name

Incentive > Rate >
Commission Rates

Incentive > Rate >
Formulas

Incentive > Rate > Plan
Elements

Incentive > Expression

Incentive > Expression >
select an expression
name

Rate Table
Details

Rate Table
Details-
Commission
Rates

Rate Table
Details,
Formula
Assignments

Rate Table
Details, Plan
Element
Assignments

Calculation
Expressions

Calculation
Expressions

D.1.6 Payment Setup

1155 11.5.9
Navigation Screen Name Changes Navigation Screen Name
Payment Setup icon > Pay Groups New navigation flow. ~ Administration > Pay Group
View by Pay Groups > Incentive > Pay Group
select a pay group
Payment Setup icon > Pay Groups New navigation flow. ~ Administration > Pay Group
View by Pay Groups > (Pay Periods  Information on both Incentive > Pay Group > Details
select a pay group and tabs in Forms has been Search for pay group,

Salespeople combined into one click Details

tabs) HTML page.
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Moving from Forms to HTML Navigation

11.5.5

11.5.9

Navigation

Screen Name

Changes

Navigation Screen Name

Payment Setup icon >
View by Payment Plan >
select a payment plan

Payment Plan

New navigation flow.
Edit details directly on
the page.

Administration >
Incentive > Payment Plan

Payment Plans

D.1.7 Classification Rules

11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name
Classification Rules icon ~Revenue New navigation flow. ~ Administration > Revenue
> Revenue Classes node  Classes Incentive > Revenue Classes
> Revenue Class name Class
Classification Rules icon Ruleset New navigation flow. ~ Administration > Rulesets
> Classification Rules Incentive > Ruleset
node > right click > New
N/A N/A New HTML page Administration > Rules
showing a list of rules  Incentive > Ruleset Hierarchy
and their details. hyperlink > Rules
hyperlink
Classification Rules icon  Rules (Rule New navigation flow. ~ Administration > Rule
> Classification Rules Attribute tab) Incentive > Ruleset > Attributes
node > Ruleset name > Rules Hierarchy >
Rules name Attributes hyperlink
Classification Rules icon Rules (Build New navigation flow. ~ Administration > Build
> Classification Rules Expression Incentive > Ruleset > Expression
node > Rulesetname >  tab) Rules Hierarchy >
Rules name > Build Expressions hyperlink

Expression tab
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Moving from Forms to HTML Navigation

D.1.8 Hierarchies

11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name
Hierarchies icon > Hierarchies New navigation flow. ~ Administration > Hierarchy
Hierarchies node > All hierarchies are Incentive > Hierarchy Types
Customers listed on the summary
HTML page called
Hierarchy Types.
Hierarchies icon > Hierarchies-  New navigation flow.  Administration > Hierarchies
Hierarchies node > Customers Incentive > Hierarchy
Customers > View Types > Details
Details hyperlink next to
Customers
Hierarchies icon > Hierarchies New navigation flow. ~ Administration > Hierarchies
Hierarchies node > All hierarchies are Incentive > Hierarchy
Revenue Classes listed on the summary Types > Details
HTML page called hyperlink next to
Hierarchies. Revenue Classes
Hierarchies icon > Hierarchies-  New navigation flow.  Administration > Intervals
Hierarchies node > Revenue Incentive > Hierarchy
Revenue Classes > View  Classes Types > Details
Details hyperlink next to
Revenue Classes >
Details hyperlink
Hierarchies icon > Hierarchies New navigation flow. ~ Administration > Hierarchies
Hierarchies node > Trx All hierarchies are Incentive > Hierarchy
Types listed on the summary Types > Details
HTML page called hyperlink next to Trx
Hierarchies. Types
Hierarchies icon > Hierarchies-  New navigation flow. ~ Administration > Intervals
Hierarchiesnode > Trx ~ Trx Types Incentive > Hierarchy

Types > View Details

Types > Details
hyperlink next to Trx
Types > Details
hyperlink
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Moving from Forms to HTML Navigation

D.1.9 Payment and Reports in HTML

11.5.5

11.5.9

Navigation

Screen Name

Changes

Navigation

Screen Name

Payment > Setups
Payment > Summary
Payment > Summary

Payment > Summary >
select a total

Payment > Summary >
Payrun Details > select a
total

Payment > Summary >
Payrun Details > select
Add a Payment Plan

Payment > Create
Payment > Reports

Payment > Reports >
Commission Summary

Payment > Reports >
Payrun Signoff

Reports > Compensation

Pay Element
Mapping

Payrun Search

Payrun
Summary

Payrun Details

Payment
Transactions

Payment Plans

Create Payrun

Payment
Reports

Commission
Summary
Report

Payrun Signoff
Report

Summary of
Compensation
Reports

New navigation flow.
New navigation flow.
New navigation flow.

New navigation flow.

New navigation flow.

New navigation flow.

New navigation flow.
No longer available.

New navigation flow.

New navigation flow.

New navigation flow.

Administration >
Incentive > Payroll

Transaction > Payment

Transaction > Payment >
Enter Payrun

Transaction > Payment >
Check Unassigned
Resources and My
Analysts check boxes >
click Apply Search

Transaction > Payment >
Payrun Details > select
Total Worksheet Amount

Transaction > Payment >
Worksheet Summary >
click Total Worksheet
Amount hyperlink >
click Add Payment Plan

Transaction > Payment >
Create Payrun

N/A

Transaction > Report >
Commission Summary

Transaction > Payment >
Worksheet Summary >
Payment Transactions >
Signoff Report hyperlink

Transaction > Report

Pay Element
Mapping

Payrun
Summary

Payments

Worksheet
Summary

Payment
Transactions

Payment Plans

Create Payrun
N/A

Commission
Summary
Report

Payrun
Sign-off
Report

Summary of
Compensation
Reports
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Moving from Forms to HTML Navigation

11.5.5

11.5.9

Navigation

Screen Name

Changes

Navigation

Screen Name

Reports > Compensation
> Year To Date Summary
> Salespeople Search
Results > Salesperson
Name

Reports > Compensation
> Transaction Details
Report > Salespeople
Search Results >
Salesperson Name

Reports > Compensation
> Compensation Group
Hierarchy Report >
Salespeople Search
Results > Salesperson
Name

Reports > Compensation
> Classification Rules
Search > Rules Found >
Rule Name

Reports > Compensation
> Commission Summary
Report

Reports > Compensation
> Quota Performance

Reports > Compensation
> Commission Statement
Report > Salespeople
Search Results >
Salesperson Name

Reports > Compensation
> Unprocessed
Transactions >
Salespeople Search
Results > Salesperson
Name

Year to Date
Summary

Transaction
Details Report

Compensation
Group
Hierarchy
Report

Classification
Rules Report

Commission
Summary
Report

Quota
Performance
Report

Commission
Statement

Unprocessed
Transactions

New navigation flow.

New navigation flow.

New navigation flow.

New navigation flow.

New navigation flow.

New navigation flow.

New navigation flow.

New navigation flow.

Transaction > Report >
Year to Date Summary

Transaction > Report >
Transaction Details
Report

Transaction > Report >
Compensation Group
Hierarchy Report

Transaction > Report >
Classification Rules
Report

Transaction > Report >
Commission Summary

Transaction > Report >
Quota Performance

Transaction > Report >
Commission Statement

Transaction > Report >
Unprocessed
Transactions

Year to Date
Summary

Transaction
Details Report

Compensation
Group
Hierarchy
Report

Classification
Rules Report

Commission
Summary
Report

Quota
Performance
Report

Commission
Statement
Report

Unprocessed
Transactions
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Moving from Forms to HTML Navigation

D.1.10 Salesforce Planning/Incentive Planning in HTML

11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name
Salesforce Resource New navigation flow.  Resource > Planning Resource
Search Search
Salesforce Resource New navigation flow. = Resource > Planning Resource
Search Results Search Results
Salesforce Resource New navigation flow.  Resource > Planning > Resource
Details - Main Resource Search > Details - Main
Resource Search Results
> Click Resource Name
hyperlink
Salesforce Resource The select field for Job  Resource > Planning > Job Titles
Details - Job Titles is on the Job Titles list of values
Titles Resource Details - Main
page. Job Titles is in a
separate, smaller
browser window.
Salesforce Resource On Target Earnings isa Resource > Planning > Resource
Details - On hyperlink in the Job Resource Search > Details - On
Target Titles column of the Resource Search Results ~ Target
Earnings Resource Details - Main > click Resource Name Earnings
page. hyperlink > click amount
in On Target Earnings
column
Salesforce Resource Customized Anchorsis Resource > Planning > Resource
Details - a field in the Job Titles ~ On Target Earnings > Details -
Customized section of the main Anchors hyperlink Customized
Anchors page. Anchors
Quota > Allocate My New navigation flow. Quota > Allocate > My My
Compensation Compensation Groups Compensation
Groups Search > My Groups
Compensation Groups
Quota > Allocate Quota New navigation flow.  Quota > Allocate > My Quota
Modeling Compensation Groups Allocation
Summary Search > My Details
Compensation Groups >
click hyperlink in Name
column
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Moving from Forms to HTML Navigation

11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name
Quota > Allocate Add New navigation flow. Quota > Allocate > My Add
To-be-hired Compensation Groups To-Be-Hired
Search > My
Compensation Groups >
click Name hyperlink >
click Add Vacancy
button
Quota > Allocate contract New navigation flow.  Quota > Allocate > Allocate
Allocate Contract Contract
Quota > Allocate Assign Quota New navigation flow.  Quota > Allocate > My  Allocation
New screen name. Compensation Groups Details - Quota
Search > My and Pay
Compensation Groups > Assignment
click value in Name
column drilldown >
Allocation Details
Quota > Allocate Quota from New navigation flow.  Quota > Allocate > My Allocation
Field New screen name. Compensation Groups Details - Quota
Search > My and Pay
Compensation Groups > Assignment
click value in Name
column drilldown >
Quota Allocation Details
> Final Prorated Quota
hyperlink
Quota > Allocate Compensation New navigation flow.  Quota > Allocate >My  Compensation
Plan History Compensation Groups Plan History
Search > My
Compensation Groups >
Quota Allocation Details
> click hyperlink in Plan
Status column >
Quota > Approve Approve New navigation flow.  Quota > Approve > Contract
Contracts Contract Approval Approval
Quota > Distribute Distribute New navigation flow.  Quota > Distribute > Distribute
Contracts Resource Search > Contract
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11.5.5

11.5.9

Navigation

Screen Name

Changes

Navigation

Screen Name

Quota > Activate

Reports
Reports

Reports

Reports

Reports

Reports

Reports

Activate
Contracts

Reports

Resources
Found

Quota
Modeling
Summary

Average Quota
Summary

Overassign
Quota
Summary

Quota Range
Summary

Compensation
Contract
Status

New navigation flow.

New navigation flow.

New navigation flow.

New navigation flow.

New navigation flow.

New navigation flow.
New report name.

New navigation flow.
New report name.

New navigation flow.

Quota > Activate >
Resource Search >
Resource Search Results
> click Resource Name
hyperlink

Quota > Report

Quota > Report > Quota
Model Summary (or any
other report name) >
Resource Search

Quota > Report > Quota
Model Summary >
Resource Search >
Resource Search Results
> click hyperlink in
Name column

Quota > Report >
Average Quota
Summary > Resource
Search > Resource Search
Results > click hyperlink
in Name column

Quota > Report >
Overassign Quota
Summary > Resource
Search > Resource Search
Results > click hyperlink
in Name column

Quota > Report > Quota
Range Summary >
Resource Search >
Resource Search Results
> click hyperlink in
Name column

Quota > Report >
Compensation Contract
Status > Resource Search
> Resource Search
Results > click hyperlink
in Name column

Compensation
Plan Activate

Reports

Resource
Search Results

Quota
Modeling
Summary

Average
Quota Report

Quota
Overassign-
ment Report

Quota Range
Report

Compensation
Contract
Status
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11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name
Reports Overlay New navigation flow.  Quota > Report > Overlay
Summary New report name. Overlay Summary > Report
Resource Search >
Resource Search Results
> click hyperlink in
Name column
Reports To-be-hired New navigation flow. ~ Quota > Report > Vacancy
Summary New report name. Vacancy Summary > Report
Resource Search >
Resource Search Results
> click hyperlink in
Name column
Reports Transitional New navigation flow.  Quota > Report > Transition
Salespeople New report name. Transitional Salespeople  Report
Summary > Resource Search >
Resource Search Results
> click hyperlink in
Name column
Reports Plan Status New navigation flow. = Quota > Report > Plan Plan
New report name. Status > Resource Search Activation
> Resource Search Status Report
Results > click hyperlink
in Name column
Reports Role to New navigation flow.  Quota > Report > Role to Role to
Compensation New report name. Compensation Plan Compensation
Plan Mapping Mapping > Enter Role Plan Mapping
Name or Plan Name > Report
click Apply
Setup > Sales Roles Sales Role New navigation flow.  Incentive > Agreement Agreements
Summary New screen name.
Setup > Sales Roles > Sales Role New navigation flow.  Incentive > Agreement > Sales Role
select a role Detail New screen name. Enter Name > Click Detail
Apply > Click Name
hyperlink
Setup > Sales Roles > Configure New navigation flow.  Incentive > Agreement > Agreement
Sales Role Detail > role Contract Text New screen name. Sales Role Detail > Role  Details -

name hyperlink
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11.5.5 11.5.9
Navigation Screen Name Changes Navigation Screen Name
Setup > Sales Roles > Edit New navigation flow.  Incentive > Agreement > Agreement
Sales Role Detail > edit ~ Computed New screen name. Sales Role Detail > click  Details -
formula hyperlink Component Edit Formula hyperlink ~ Computed
Formula Component
Formula
Setup > Sales Roles > Define Quota  New navigation flow.  Incentive > Agreement > Agreement
Sales Role Detail > define Anchors New screen name. Sales Role Detail > click  Details:
anchors hyperlink Anchors hyperlink in Variable Pay,
Details column Computed
Components,
Rates
Setup > Components Components ~ New navigation flow. =~ Administration > Quota
New screen name. Incentive > Component =~ Components
Setup > Attainment Attainment New navigation flow. ~ Administration > Attainment
Schedules New screen name. Incentive > Attainment  Schedule
Summary
Setup > Job Titles Job Titles New navigation flow.  Administration > Resource
Incentive > Job Titles > Detail - Job
click Job Title hyperlink  Titles

Setup > User Access
Setup > User Access >

select a name

Setup > Plan Text

Setup > Activate Roles

User Access

User Access
Details

Plan Text

Role
Activation

New navigation flow.

New navigation flow.

New navigation flow.
New screen name. New
field enables you to
select a transaction
calendar.

New navigation flow.

Administration >
Incentive > User Access

Administration >
Incentive > User Access
> click value in Name
column drilldown

Administration >
Incentive > Settings

Incentive > Activation

User Summary

User Access
Detail

Settings

Role
Activation
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Responsibilities

E.1 Responsibilities in Oracle Incentive Compensation

In Oracle Incentive Compensation, people are assigned different responsibilities to
allow them appropriate access to the application. In the table below, the
responsibilities in this release are listed on the left, with responsibilities for release
11.5.5 listed to the right. Release 11.5.5 was the last one to use Forms. One
responsibility, Incentive Compensation Developer, remains in Forms. It is used only
for making changes to lookups and profile options, and for submitting requests.

Be sure when setting up a resource who is an analyst to not assign him or her a
salesperson number. If you assign a salesperson number to an analyst, the
application treats that analyst as if he or she were a salesperson, therefore, the view
of reports is limited to those set up for the salesforce: Hierarchy Summary, Year to
Date Summary, Commission Statement, and Quota Performance.

OIC 11.5.9 (HTML) OIC 11.5.5 (Forms and HTML)

Incentive Compensation Super User Sales Compensation Super User (Forms)

Incentive Compensation Payment Sales Compensation Online Super User
(HTML)

Incentive Compensation Reports Sales Compensation Online Analyst (HTML)

Incentive Planning Analyst Salesforce Planning Super User

Incentive Planning Contract Approver Salesforce Planning Contract Approver

Incentive Planning Finance Manager Salesforce Planning Finance Manager

Incentive Planning Sales Manager Salesforce Planning Sales Manager

Incentive Compensation Analyst Sales Compensation Analyst

Incentive Compensation Developer (Forms) NA

Responsibilities E-1



Responsibilities in Oracle Incentive Compensation

E.1.1 Tab Usage in Oracle Incentive Compensation 11.5.9

The table below shows the tabs in Oracle Incentive Compensation, along with their
subtabs. If a responsibility has access to a tab or subtab, the word Yes appears in the
column below its name.

Notes:

= The Reports tab is used only by the Incentive Compensation Payment and
Incentive Compensation Reports responsibilities to view the set of reports
normally accessed from the Report subtab of the Transaction tab.

s The Incentive Compensation Developer responsibility, not shown in the table,
is used in the Forms environment only, and does not have access to the HTML

environment.
IC IP IP

Subtab Super IC IC IC IP Contract Finance IP Sales
Tab Name Name User Analyst Payment Reports Analyst Approver Manager Manager
Home NA Yes Yes Yes Yes Yes Yes Yes Yes
Incentive = Agreement Yes Yes

Activation Yes Yes

Plan Yes Yes Yes

Element Yes Yes Yes

Formula Yes Yes Yes

Rate Yes Yes Yes

Expression Yes Yes Yes
Modeling Agreement Yes Yes

Comparison  Yes Yes

Performance Yes Yes
Resource  Planning Yes Yes Yes Yes Yes

Resources Yes Yes Yes Yes Yes Yes

Role Yes Yes Yes

Group Yes Yes Yes Yes Yes Yes
Quota Allocate Yes Yes Yes Yes

Approve Yes Yes Yes
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Subtab g:uper IC IC IC IP I(l;ontract :Ei,nance IP Sales
Tab Name Name User Analyst Payment Reports Analyst Approver Manager Manager
Distribute Yes Yes
Activate Yes Yes
Report Yes Yes Yes Yes* Yes**
Trans- Collect Yes Yes
action
Import/ Yes Yes
Export
Adjust Yes Yes
Load Yes Yes
Calculate Yes Yes
Notification ~ Yes Yes
Log
Payment Yes Yes
Report Yes Yes
Requests  Collection Yes Yes
Transaction  Yes Yes
Calculation  Yes Yes
Payment Yes Yes
Product All Yes Yes Yes Yes Yes Yes
Admini-  All Yes Yes Yes
stration
Payment NA Yes
Reports NA Yes Yes

* Incentive Planning Finance Manager has access set by Incentive Compensation
Super User using the User Access page.

*Incentive Planning Sales Manager has access only to information regarding his or
her direct reports.
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Glossary

These are the terms most commonly used in Oracle Incentive Compensation.

Accelerators

Types of incentives that vary compensation. Payment accelerators are a multiplier
on the compensation rate without affecting the quota. Quota accelerators work on
sales credit, sometimes changing compensation amounts by moving calculation to a
different tier in a rate table

Accumulation Period

The time interval during for which commissions are collected. For example, a
resource can have an accumulation period of a month and a pay period of
semimonthly.

Agreement

An agreement is an early stage of a compensation plan used in the planning area of
Oracle Incentive Compensation. In the Modeling tab, incentive planners experiment
with creating an agreement and assigning it to a role before defining details and
associating a resource with a role in the Quota tab.

Anchor

When defining a sales role, use anchors to indicate the maximum that can be earned
at each tier of a rate table.

Application Programmable Interface (API)

A set of procedures to import or export information to and from Oracle Incentive
Compensation.
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Attainment Schedule

Attainment schedules enable planners to pay different levels of compensation
depending on the percentage of attainment of a set sales goal. Attainment schedules
are used in the Compensation Contract where earnings for each level of
achievement are displayed.

Bonus

Incentive compensation typically paid for meeting a goal, including quantitative
and qualitative goals.

Classification Rules

User defined categories used to classify sales transactions. The classified
transactions are part of a classification ruleset. Classification rules vary greatly from
one company to another, depending on the product or service provided and the
different ways that resources are compensated.

Classification Ruleset

A group of classification rules assigned to a specific time period or location that
sorts transactions into preset categories, so that they can be compared to revenue
classes in a resource’s compensation plan. Only one classification ruleset can be
active at a time.

Clawback
See Takeback.

Collection

The process of collecting transactions from feeder systems into Oracle Incentive
Compensation.

Compensation Group

A group of resources who share sales credit, directly or indirectly, when a sale is
made. They are placed together in a compensation group hierarchy to accurately
account for the payment of commission and sales credit. For example, at one
company, when resources close a sale, they receive commission, their managers
receive sales credit toward their quotas, territory sales managers receive sales credit
from the manager’s transactions, and territory sales consultants also receive indirect
credit for performing consulting work that helped to close the business.



Compensation Plan

A collection of one or more modular plan elements used to calculate a
compensation payment. One compensation plan is assigned to a sales role, which is
then assigned to a resource. Some parts of a compensation plan can be customized
for individual resources, such as a payment plan or pay group.

Concurrent Program

Concurrent programs run at the same time as other Oracle Incentive Compensation
functions. For example, you can run a concurrent program to collect transactions
from a transaction source while you are building compensation plans.

Credit Memo
A document generated when an invoice is fully or partially reversed. Credit memos
are later collected and applied against transactions.

Dimension

Rate dimensions define the tiers that a rate table uses to apply rates. A dimension
contains rate tiers to establish different levels of achievement to be compensated at
different rates.

Direct Sales Credit

Sales credit directly assigned to a resource in a transaction in a feeder system, such
as Order Capture or Order Management, or another non Oracle legacy system.
Formula

A set of instructions that determines how compensation will be calculated.
Formulas are built from input expressions, output expressions, and rate tables.
Indirect Sales Credit

Credit inherited by a resource according to his or her place in the resource
hierarchy. Indirect credit can roll up from a subordinate to a manager.

Interval

Intervals are time periods during which a compensation or a plan element is
effective. Plan element intervals must be contained within the effective interval of a
compensation plan.

Interval Type

The time period of the interval, for example, month, quarter, or year.
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Job Title

Job titles are used by Human Resources to categorize employees. Oracle Incentive
Compensation uses Roles, and a Job Title can be assigned to a particular Role by
using the Job Titles page.

Manual Transaction

A user-entered transaction created for reversing or changing sales credit.

Mapping
Rules defining collection that connect the table columns of a feeder system to the
transaction columns in Oracle Incentive Compensation.

Notification Log

The Notification log automatically records every change in the system that affects
calculation and lists what part of the calculation must be rerun as a result of an
event.

Pay Group
An assignment that determines the frequency with which a resource receives
payment. A resource cannot belong to more than one pay group at a time.

Payment
There are three types of payment:

= Regular Payment: The application collects data, prepares it, and formats it
to be used by a non-Oracle Payable system.

= Accounts Payable Integration: Used for vendors, this method prepares
payment for Oracle Accounts Payable by classifying the resources as
suppliers.

= Payroll Download File: The application collects data and creates a file that
can be used by Oracle Payroll

Payment Plan

An arrangement in affect for some resources who need to receive a minimum
payment regardless of their earnings. You can specify a minimum and/or a
maximum payment as well as whether any minimum payments are recoverable or
not against future amounts payable. Payment recovery can be on a separate
schedule from the pay period.



Performance Measure

An accumulation of transaction values that is captured by a Plan Element and
grouped for use in reports that compare achievements to Quota, Goal and
Performance Measure. Performance measures are not used to calculate commission.

Plan Element

Parts of a compensation plan that may reflect variations of commission or perhaps a
bonus based on the accumulated achievement of the resource. Plan elements can
also be configured for tracking nonmonetary credits such as managerial points or
production credits. Plan elements consist of modular components that can be freely
assigned in different combinations, including revenue classes, formulas, and rate
tables.

Push

Push is a way of referring to the movement of an approved and accepted
compensation plan from the planning area into the administrative area of Oracle
Incentive Compensation.

Rate Table

Part of a formula, along with input and output expressions, that determines the
amount of compensation based on amount or percentage of achievement compared
to quota.

Regoaling

A functionality that enables managers to change the quota or variable pay of a
resource’s compensation plan at any time. These changes could be required because
of a change in business circumstances, a resource is receiving too much or too little
commission, or if a resource receives a promotion to a new role with a new goal.
Regoaling can only be used if a plan is already accepted and activated.

Revenue Class

A user-defined category of business revenue used to classify a transaction for
compensation and calculation. Revenue classes are assigned to plan elements and
help Oracle Incentive Compensation determine whether classified sales credit is
applied toward a compensation payment.

Revenue Class Rules

One or more conditions a revenue class must meet to classify into a given revenue
class.
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Revenue Class Hierarchy

An arrangement of revenue classes and subclasses in which the broadest classes are
at the top of the structure. Classified transactions are

Role

A role describes a set of resources who share a common compensation structure.
Examples are Salesperson, Consultant, and Regional Sales Manager. In Oracle
Incentive Compensation, you assign each individual resource to a predetermined
role, which can be customized in some ways. Changes to a role affect everyone
assigned to that role who does not have the "Customized" check box checked on the
compensation plan. A resource can have more than one role at the same time.

Ruleset Types

Rulesets are of two types, Revenue Classification and Account Generation.

= Revenue Classification defines the rules that are used to identify a revenue class
for each transaction that the system processes as part of calculating
commissions.

= Account Generation is used to integrate Oracle Incentive Compensation
automatically with Accounts Payable and to classify transactions to identify
Expense and Liability Accounts.

Sales Credit

An amount of revenue or nonrevenue credit that is awarded to a resource.

Seasonality

Seasonality schedules show how a product/service income or cost/expense is
distributed throughout the year, expressed in percentages of the year’s total.
Seasonality schedules can be assigned to multiple agreements, and agreements can
use multiple seasonality schedules for different components.

Takeback

The amount of compensation credited for a sale that Oracle Incentive Compensation
takes back when the invoice due date grace period is exceeded. If the invoice is
subsequently paid, then a giveback can be used to restore credit to a resource.
Takebacks are sometimes called clawbacks.

Transaction Calendar (Workday Calendar)

A calendar that can be defined to contain only workdays and exclude weekends
and holidays. The workday calendar is a type of transaction calendar. A calendar’s



duration can be defined to match the organization’s financial year. A new workday
calendar can be assigned every year as the dates of holidays and weekends will
differ.

Transaction Factor

A multiplier on sales credit that determines net sales credit given for each type of
transaction.
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accelerators, 4-124
account generation, 4-8
account generator, 4-98
accumulation period status, 6-3, 6-4
accumulation periods, 4-13
adjustments, 4-96
Adjustments page
add attribute column, 6-4
administer accumulation periods, 5-5
Administration tab, 1-12
Accumulation Period subtab, 1-13
Attainment subtab, 1-14
Collection subtab, 1-13
Component subtab, 1-14
Credit Conversion subtab, 1-13
Credit Type subtab, 1-13
External Table subtab, 1-13
Hierarchy subtab, 1-13
Interval Types subtab, 1-13
Job Titles subtab, 1-14
Parameters subtab, 1-13
Pay Group subtab, 1-13
Pay Periods subtab, 1-13
Payment Plan subtab, 1-13
Payroll subtab, 1-13
Rate Dimensions subtab, 1-14
Revenue Class subtab, 1-13
Seasonality subtab, 1-14
Settings subtab, 1-14
Tables subtab, 1-13
User Access subtab, 1-14
anchor rate calculation, 4-52

anchors, 4-61
attainment schedules, 4-45
Average Quota Report, 4-147

Index

bonus calculation expressions,
bonus formula, 4-35,4-36
bonus plan element

example, 4-25

4-24

Bypass Group Validation profile option, 6-8

Cc

calculation expressions, 4-19
bonus, 4-24

calendar, 4-3

can’t view commission reports,

child node, 4-108

classification attributes, 4-104

classification rulesets

6-2

define for revenue classification, 4-111

Clear button, 1-8

collection attributes, 4-104

collection query, 4-76

collection submission, 4-88
runtime parameters, 4-88
submit a request, 4-88

viewing request status and logs, 4-90

collections
actions, 4-84
adjustments, 4-96
collection mapping, 4-78
generate, 4-86

Index-1



queries, 4-76

running, 4-88

set up transaction source, 4-72

setup, 4-72

source tables, 4-74
column attributes

definable, 4-20
columns

define, 4-16
commission formula, 4-36
Commission Rules Report, 4-163
Commission Statement Report, 4-168
Commission Summary Report, 4-164
Compensation Contract Status Report, 4-152
Compensation Group Hierarchy Report, 4-162
compensation plan details, 4-130
compensation plans

assign to roles, 4-134

define, 4-130
Compensation Reports, 4-144
components, quota

define, 4-43
Create button, 1-8
credit rollup rules, 6-5
credit types

add, 4-118

define, 4-117

view, change, remove, 4-117
cumulative check box, 4-36
currency, 4-4
customize quota and rates for resources, 4-141

D

default contract text, 4-38
define GL calendar
period types, 5-4
dependencies
conditional, 2-15
mandatory, 2-15
direct mapping tables, 4-74
direct mappings, 4-79

Index-2

E

error text field, 4-87

expense/liability account mapping,

account generator,

4-98

external elements, 4-23

external formula, 4-12
external table mapping,

F

2
4-18

498

filtering methods, 4-85

flexfields, A-1

Forms to HTML navigation

Road Map of change:
formula

external, 4-122
formulas

define, 4-33

s, D-1

free-form indirect mapping, 4-80

freeze periods, 6-2

G

General Ledger, 4-3
accounting calendar,

4-11

activate pay periods, 4-12

create period type,
open and close perio

H

4-10
ds, 4-10

hierarchy nodes, 4-108

Hierarchy Summary Re
Home tab, 1-8

port, 7-4

Incentive Planning
reports, 4-143

responsibility groups, 4-37

Incentive tab, 1-9
Activation subtab,
Agreement subtab,

1-9
1-9

Element subtab, 1-9

Expression subtab,

1-9



Formula subtab, 1-9 (0]

Plan subtab, 1-9 :
Rate subtab, 1-9 On target earnings, 4-61

Oracle Order Management, 7-2

Oracle Payable, 7-12

Oracle Payroll, 7-13

Oracle Receivables, 7-2

Oracle Resource Manager, 7-11

Oracle Sales Online, 7-3
Compensation Plan subtab, 7-5
Forecast hierarchy drilldown, 7-11
Income Planner, 7-6
Reports, 7-7

Income Planner, 7-6
Income Planner disclaimer, 4-9
indirect mappings, 4-80
input expressions, 4-20
interval numbers

verify definition, 5-6
interval types

define, 4-115

J resources accept plans, 4-69

job titles, 4-55 Top Performers Bin, 7-8

jobs Order Booking, 4-92,4-96
define, 4-55 output expressions, 4-21

Overlay Report, 4-153
L

line calculation, 4-52
lookups, B-1

P

parent node, 4-108
pay element input values mapping, 4-103,7-14
pay groups, 4-72,4-138

M assign, 4-138
mapping define, 4-71
classification attributes and collection multiple, 4-139
attributes, 4-104 pay periods, 4-72
direct, 4-79 activate, 4-70
indirect, 4-80 payment factor, 4-124,4-125
pay element input values, 4-103 payment plan minimum payment amount, 6-3
plan element to pay element, 4-101 payment plans, 4-139
mapping plan elements to pay elements, 7-13 define, 4-135
Modeling tab, 1-9 performance measures, 4-21,4-36
Agreement subtab, 1-9 period types, 4-3,4-72
Comparison subtab, 1-9 periods, 4-4
Performance subtab, 1-10 Plan Activation Status Report, 4-156
plan element quota group code, 6-4
N plan element to pay element mapping, 4-101
plan elements
navigation, 1-7 assign, 4-132
negative payment amounts, 6-3 define, 4-119
notification mailer, 4-65 Planning, 7-5
notification query, 4-76 population

four levels, 4-8
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Product tab, 1-12
profile options, C-1

Q

quota and rates

customize for a resource, 4-141
quota components

define, 4-43
quota factor, 4-124, 4-125
Quota Modeling Summary Report, 4-144
Quota Overassignment Report, 4-149
Quota Performance Report, 4-167
Quota Range Report, 4-150
Quota tab

Activate subtab, 1-11

Allocate subtab, 1-10

Approve subtab, 1-10

Distribute subtab, 1-11

Report subtab, 1-11

R

rate dimensions
define, 4-27
example, 4-28
Rate subtab, 4-31
rate tables
assign to plan element, 4-127
define, 4-31
tier boundaries, 6-6
Receivables Posting, 4-92, 4-94
relationship indirect mapping, 4-80
report access by responsibility, 4-173
report configuration
verify definition, 5-9
reports
configuring, 4-178
road map of version to version changes,
Requests tab, 1-12
Calculation subtab, 1-12
Collection subtab, 1-12
Payment subtab, 1-12
Transaction subtab, 1-12
Resource Manager, 7-2
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Resource tab, 1-10
Group subtab, 1-10
Planning subtab, 1-10
Resources subtab, 1-10
Role subtab, 1-10
resources
assign to groups, 4-57
responsibilities, 4-37, E-1
tab usage, E-2
responsibility groups, 4-37
Restore button, 1-8
revenue class hierarchy
define, 4-108
revenue classes
assign, 4-122
define, 4-106
role
define, 4-48
Role to Compensation Plan Mapping Report,
root node, 4-108
rules hierarchy, 4-112
runtime parameters, 4-88
Runtime Parameters page, 1-11

S

4-157

Seasonality Schedules page, 4-47
set of books, define, 4-4
source tables, 4-74
split
non-proportional, 4-35
proportional, 4-35
split tiers, 4-35
standard transaction source, setup, 4-92
step calculation, 4-52
Submit Request page, 1-11
system parameters, 4-4
calculation, 4-6
collection batch size, 4-6
payment, 4-8
set of books
select, 4-4
verify definition, 5-4
system profile options, C-1



T

table column settings
verify definition, 5-9
tables
define, 4-14
predefined, 4-23
task sequence, implementation, 3-1
team compensation, 4-57
Terms & Conditions text box, 4-39
Test Generate button, 4-86
Top Performers Bin, 7-8
Transaction Details report, 4-160
transaction factors, 4-124,4-125
transaction fail classification, 6-2
transaction filters, 4-84
transaction source
information, 4-74
setup, 4-72
Transaction tab, 1-11
Adjust subtab, 1-11
Calculate subtab, 1-11
Collect subtab, 1-11
Import/Export subtab, 1-11
Load subtab, 1-11
Notification Log subtab, 1-11
Payment subtab, 1-11
Report subtab, 1-11
Transition Report, 4-155
troubleshooting tips, 6-1

U

Unprocessed Transactions report, 4-172

Update button, 1-8
user access

define, 4-42
user code blocks, 4-84
user name

assign to tables, 5-8

\'}

Vacancy Report, 4-154
verification of implementation, 5-2
View Request Status page, 1-11

viewing request status and logs, 4-90

w

Workflow, 4-64

Y

Year to Date Summary, 4-158
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